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Release Notes

Learn about our releases, as well as the software policies and feature deprecations for Automation
Anywhere products.

Learn about what's new, changed, fixed, or the issues (limitations) in Automation 360 releases:

» Automation 360 Release Notes on page 15

« Community Edition Release Notes on page 684

» Previous Package SDK Release Notes on page 843
» Process Discovery Release Notes on page 850

» CoE Manager Release Notes on page 851

Comparison matrices

Compare features between products to review feature parity and understand compatibility in
order to update or move to our latest product release.

» Automation 360 feature comparison matrix on page 856
* Automation 360 1Q Bot feature comparison matrix on page 871
« Automation 360 1Q Bot version compatibility on page 876

Software lifecycle policy

The Automation Anywhere software lifecycle policy aims to provide predictability, quality, and
importantly nondisruptive access to the latest innovations and enhancements so that you can
control when and how you want to adopt these enhancements.

See Automation 360 software lifecycle policy on page 943.

Cloud Service status

Our Automation 360 Cloud Service Status site shows real-time operational status, historical
operational status, maintenance information, and incident history for all Automation 360 Cloud
services worldwide, across all hosting regions.

See Automation 360 Cloud Service Status site on page 933.

Feature deprecations

Learn about features and capabilities (from Automation Anywhere or third party) that are
deprecated or nearing deprecation to understand how they affect your automation and what
action is required.

See Feature deprecations affecting Automation Anywhere products on page 947.
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Automation 360 Release Notes

Review the new capabilities, changes, fixes (resolved issues), security fixes, deprecated features,
and limitations in each release.

Note:
The following products are renamed:

» AARIis called Automation Co-Pilot, and RPA Workspace is called Automation Workspace from
Automation 360 v.28 release. Although release notes earlier than v.28 will show the new name,
the content in these release notes is applicable and relevant to AARI and RPA Workspace.

e Enterprise A2019 is now called Automation 360. Although the release notes for releases earlier
than Automation 360 v.21 release reference the old product name, the content in these release
notes is applicable and relevant to Automation 360.

Use the links to view the release notes updates for each release.

Related concepts

Community Edition Release Notes on page 684

Review the new capabilities in different Automation 360 Community Edition releases.
Related reference

Automation 360 feature comparison matrix on page 856

Compare Automation 360 features with Enterprise 11.3.x and Enterprise 10 features to understand
the benefits to Automation 360. Review advantages of Automation 360 if you are a new user of
the product.

Automation 360 FAQ on page 887
For details and guestions on the latest Automation Anywhere platform, Automation 360, review
this FAQ.

Automation 360 v.29 Release Notes

Release date: 21 June 2023

Review the top 5 features in this release as well as other new features and exciting enhancements
for the Automation 360 v.29 release.

e Build 18324: Automation 360 (On-Premises) and 1Q Bot (On-Premises)
o Build 18302: Automation 360 (Cloud-Sandbox)

We have released an updated build for a fix after the Automation 360 v.29 Sandbox build, which

was Build 18277. For information about the fix in the updated build, see Updated release builds on
page 19.

Highlights of this release

Here are the top 5 features in the v.29 release:

Center of Excellence Accelerate your journey to automation success
with CoE Manager Plus Package: Use the
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CoE Manager Plus Package to track and
manage multiple automation programs across
multiple vendors, such as Power Automate and
ServiceNow, and integrate with other systems,
such as Jira. Gain deeper transaction-level ROI
metrics as you simultaneously recover lost
productivity as stakeholders exert minimal effort
to report data through business leadership
dashboards and automated report creation.

CoE Manager Plus Control Room

—
ot © | T
B ool ¢ ._J ,

Power Automate

CoE Manager on page 1865

Automation lifecycle management View and scale automation across your
organization: The Automation Command
Center is a personalized action center and
home page where you can quickly gain a clear
understanding of automation operations and
device dashboards. Easily view operational
details and metrics for scheduled automations,
automation run statuses, and license and
device utilization. With RBAC, admins can
create personalized views for different types of
users, including developers.

Automations Monitoring
e e O
)

Licenses Analysis
—_—

e

@ Devices Utilization
N

Automation Command Center on page 1858

Resilient automation Ensure automation is resistant to pop-ups: To
minimize system pop-up interruptions that
can occur during a bot run, enable the Handle
unexpected pop-ups option in the Run Task
Bot wizard to automatically detect and manage
these pop-ups. This feature is integrated into
the Automation 360 installation. Therefore, you
do not have to change the existing automation.
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[l Run bot now

Automation resiliency on page 925

Improve developer productivity: Use the
debugger tool to troubleshoot and focus on
correcting automation issues. While in debug
mode, the automation user can change or edit
variable values for basic data types to run the
automation successfully.

Find the error location

. Identify the error

Fix and validate the error

Analyze the error

Debugging your automations on page 2079

Reliably automate your remote applications
running on VMware Horizon VDIs: Use our
Next-Gen Recorder to easily exchange data
between your applications running on local
and remote machines. Citizen and professional
developers can automate remote applications
without making any configuration changes on
their local machines.

Automate applications running on remote
machines on page 2589

Business governance Strengthen governance for automation
creation: With code analysis and enforcement,
you can ensure your developers are creating
reliable, maintainable, and secure automations
according to best practices. The platform
enables the business to define and enforce
coding best practices as developers are
creating automations, and enables different
code quality thresholds to be enforced across
different sets of users.
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Process visualization and flow

Code analysis @
enforcement

ﬁﬁy Increases
°® efficiency
I

Improves security

Code analysis enforcement on page 1950

Simplify automation promotion: Use our

new Promotion wizard to avoid the multistep
export-import process. Leveraging a single

tool, developers can move automations, forms,
processes, and their dependencies easily across
the Dev-Test-Prod environments.

Move bots across environments on page 1854

Graphically gain actionable insights quickly: The
Process Discovery flow graph enables you to
easily visualize commonalities among variants
and loops within your business processes.
Provide your business analysts a clear view to
identify what processes are the best candidates
for optimization or automation to generate the
greatest ROl
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Note: We'll provide details of this feature at
the time of Cloud rollout planned for mid-July
2023.

> N Visualize commonalities
RO T | among path variants

o () Specify the paths for
visualization

Discover loops

Updated release builds

We have released the updated Build 18302 (Cloud Sandbox) to include a fix for an issue related to
recorder session management in the Control Room.

What's new and changed in each product

Navigate to the following pages for details on all the updates (what's new, changed, fixed, and
limitations) in each product:

Automation Workspace v.29 release on page 20

+ Updating to v.29 release on page 34
» Migration updates for v.29 release on page 34

CoE Manager v.29 release on page 45

Automation Co-Pilot v.29 release on page 45

Document Automation and 1Q Bot v.29 release on page 49

Bot Insight v.29 release on page 53

Package SDK v.29 release on page 54

Process Discovery Release Notes on page 850
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Automation Workspace v.29 release

Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.29 release.

Important: Starting from this release, we have moved information about updates in each (such
as what's new, changed, fixes, and limitations) to -specific pages. You can access these pages by
navigating to Package releases on page 764 > <-name> releases.

For a consolidated list of packages updated in this release, see Packages updated in v.29 on page
36.

What's new

Control Room, devices, and Bot Agent

Introducing Help Center: In-app help used to search for automation information

Help Center is a centralized location that contains all the information developers need to
develop automations. Wherever you navigate to in the Control Room, the Help Center
will show suggested topics related to the page you are on in the widget. Developers can
leverage the suggested topics or search for specific packages, actions, or information
they need help with. Additionally, the documentation link from contextual help loads the
content directly within the Help Center. This feature eliminates the developer from having
to switch back and forth between the Bot editor and the documentation portal providing a
distraction-free experience.

Help Center-In product help on page 884
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Control Room, devices, and Bot Agent

Enhancement to Bot Agent installer (Service Cloud case ID: 01857405)

We have enhanced the Bot Agent installer by including new .exe files for the Bot launcher,
Node manager, Triggers, and Child session launchers. When you create and run a bot
using actions from the File, Folder, or Excel advanced packages, and if your organization
has configured security policies such as Document Security Solution (NASCA) DRM (Digital
Rights Management), the files will be encrypted and secured by the security program.

The following changes occur in the installer when you:

¢ Install the Bot Agent, java.exe will be replaced by NodeManager.exe.

« Run abot, javaw.exe will be replaced by BotLauncher.exe.

« Configure a trigger, the trigger will be activated with TriggerListener.exe instead of
javaw.exe.

* Run a bot with Automation Co-Pilot (integrations) (AARI), javaw.exe will be replaced
with ChildSessionLauncher.exe.

Note:

e If your bots or scripts use java.exe or javaw.exe in the Bot Agent installer folder, we
recommend that you modify your bots or scripts using the new . exe files.

e Ensure that the Bot Agent version installed on your system is the version that is released
with Automation 360 v.29.

Install Bot Agent and register device on page 1194

Enhanced operational insights in Automation Command Center

As an administrator, you can have a comprehensive view of the automation landscape in
your homepage. The Automation Command Center (ACC) homepage combines all of the
different functional areas onto a single page thereby increasing productivity efficiency.

The homepage provides operational insights into automation and device statuses, license
utilization, and code analysis policy compliance metrics. You can navigate to automation
and device dashboards to review details for automation executions and related key
performance indicators, and gain actionable insights for devices. Additionally, you can
review total automation run hours, device utilization, and KPIs related to queues and work
items. ACC provides the ability to navigate to specific functional areas, such as Policy
management.

Using automation details dashboard on page 1860 | Using device dashboard on page
1863 | Configure and assign code analysis policy on page 1951
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Control Room, devices, and Bot Agent

Enforce code analysis for bots check-in

As an administrator, you can enforce code analysis during check-in of bots to the public
workspace. You can restrict the RPA developers or Citizen Developers from checking in
bots that contain code analysis violations. This is based on the permissions assigned to the
developer in a custom role.

When you create a custom role, you can use the following three new code analysis
enforcement permissions:

* Enable enforcement for bot check-in
* Allow check-in with low severity violations
« Allow check-in with high severity violations

All system roles only have the permission to check in bots without violations. If you only
use system defined roles you must create new roles to assign the permissions to check in
with violations.

Code analysis enforcement on page 1950

View license details (drill down) for users and Control Room instances

You can view license allocation details by users and license usage across different Control
Room instances. From the Licenses page, you can click a license type to view the License
details page that provides the following information:

« View the license allocation details by users in the Control Room where you are viewing
the license information.

» View the usage details for the license type across other Control Room instances.

Manage licenses on page 1622 | View license details on page 1624

Notifications for invalid login attempts

As a Control Room user, you are now notified for invalid login attempts. When you exceed
the maximum number of allowed invalid login attempts (set by your Control Room
administrator), the Control Room sends an instant email notification to your registered
email address. With this instant notification, you can trace the Control Room authentication
and restrict invalid access by resetting the Control Room password.

Platform events on page 1962

Time filter for historical activities

As a Control Room user with appropriate permissions, you can use the Time filter option
to search for and view specific historical activities based on time duration. Additionally, you
can customize the date and time to view these activities.

Time filter on page 1890

Integrate HashiCorp Vault to retrieve credentials (Service Cloud case ID: 00833916,
01275490, 01762964, 01839196)

Integrate HashiCorp Vault with the Control Room to retrieve credentials from the
HashiCorp Vault. The credentials are securely stored and managed on the HashiCorp Vault.

HashiCorp Vault integration on page 1799
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Control Room, devices, and Bot Agent

Automation capabilities for safe members from multiple CyberArk safes (Service Cloud case
ID: 01834131)

You can add multiple CyberArk safes on the Auto login settings page to enable safe
members to deploy bots for unattended Bot Runners.

CyberArk credential retrieval use cases on page 1761

Audit log events for Active Directory default and allowed domains
The following audit log events are logged for Active Directory:

« When a user or an existing mapping belongs to one or more domains
* When a user configures a domain as the default domain

* When a user adds a domain to the allowed domains list

*  When a user deletes a domain from the allowed domains list

Audit events list on page 1914

Edit multiple devices

As a Control Room administrator or a user with View and manage all devices role, you can
select and edit multiple devices at the same time. Additionally, On-Premises Control Room
users can change Lifespan, Device type, and Log collection configuration settings across
all registered devices at the same time.

Edit multiple devices simultaneously on page 1709

Run bot in elevated mode

After updating to this release, an administrator can use the A360Elevater.exe
application to run a bot in an elevated or administrative mode. This enables the On-
Premises Control Room users to run bots that might access any application that requires
administrator credentials.

Run a bot in elevated mode on page 2027
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Control Room, devices, and Bot Agent

Change variable values while debugging

You can use the Debugger tool to edit the values of the following variable types added to
the Watched variables list when you pause in debug mode during a bot run:

e Number

« String

« Boolean

« Datetime

This enables you to troubleshoot and fix any bot related errors, determine the correct value
to use during bot execution, and resolve the issue without stopping the debugger.

Note:

* You cannot edit constant variables.

e Ensure that the Bot Agent version installed on your system is the version that was
released with Automation 360 v.29.

Debugger tool on page 2078 | Debugging your automations on page 2079

On-Premises Control Room diagnostic utility

Use the On-Premises Control Room diagnostic utility to collect logs to troubleshoot any
Control Room related issues.

Using the diagnostics utility

Building and running bots

Ability to edit workload management automations

You can now edit a workload management (WLM) automation to add more run-as users
and switch device pools for faster processing time. You can update the processing time,
run-as users, and device pool details for queues that are currently being used.

Edit workload management automations on page 1838

Move bots across environments

As an administrator or a user with Import bots, Export bots, and all folder level
permissions, you can move bots and files, their dependencies, and packages between
Control Room instances in a single flow. The promote bot feature simplifies the process
by avoiding the multi-step export and import process when moving bots across different
Control Room environments (Dev to UAT).

Move bots across environments on page 1854
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Building and running bots

Recover private repository of a deleted user (Service Cloud case I1D: 01854109, 01956050)

As an administrator, you can recover the bots and files created in the private repository
of a deleted user (Bot Creator or Citizen Developer). You can transfer the recovered bots
and files to an existing user (Bot Creator or Citizen Developer). Whenever users leave an
organization, any automations they created are not lost and can be used by others in the
organization.

Recover bots and files on page 1856

Improved searchability for bots and files in subfolders (Service Cloud case ID: 01759969,
01838997, 01858215, 01888077)

You can quickly search and locate bots, files, processes, and forms within a folder and its
subfolders in public and the private workspaces even if your repository contains multiple
folders and subfolders. To enable this enhanced search feature, select the Include items
within sub-folders check box. A new column, Folder path, is displayed which contains the
location of the folder and subfolders for the bot.

View references for non-bot file dependencies (Service Cloud case ID: 01793080)

You can view the references (immediate parents) for non-bot file dependencies such as:
CSV, PDF, JPG, GIF, XLS, DOC, and PPT in public and private workspaces. You can use this
feature to identify the bots, processes, or forms that refer to a non-bot file dependency.
When you have many automations dependent on various file dependencies, it is easier to
modify or delete the dependencies when you understand the impact of this change on
the automations. You can efficiently check the effect of either modifying or deleting the
dependency on the automations that refer to it.

APIs and integrations

New delete device API (Service Cloud case ID: 01805692, 01822981)

To remove a registered device from your Control Room, use the new DELETE /v1/
devices/1id API. Before deleting a user, you can use this APl to remove the device
connected to the user, and then re-connect the device to another user.

Device API
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What's changed

Control Room, devices, and Bot Agent

Permissions for users to view only scheduled activities (Service Cloud case ID: 01885651,
01875383, 00788548, 00823729, 01776437, 01793759)

e You can use the View ALL scheduled activity option to view all the schedules in the
system.

*  You can use the View ALL scheduled activity from my Folders option to view all
scheduled activities for the bot folders to which users have access.

Feature permissions for a role on page 1590

Audit log events for secure recording
Audit log entries are logged when you configure the following Secure recording options:

* Enable or disable the option to preview image in the Bot editor.
« Change the role-based access control (RBAC) configuration on secure recording.

Audit events list on page 1914

Enhanced workload management capacity and performance

You can process more number of queues and work items in workload management
automations than previously. With this enhancement, you can improve your automation
goals with optimum utilization of resources.

Capacity and performance planning on page 1038

Simplified notifications categories

The in-app notification panel displays all the notifications as a single list without
categorizing them by severity. You can use the Attention needed filter to view the high-
risk and cautionary event notifications which require immediate action. Otherwise, all the
notifications are visible as a simple list of events.

Notifications filter

Optimized audit log entries for automated code analysis

The audit event logs generated for automated background code analysis scanning are
optimized to include the following two audit events when code analysis runs automatically:

¢ Automated code analysis started
* Automated code analysis completed

The audit log entries contain consolidated information about the code analysis events. The
audit entry also contains information for any change made to the existing policy.
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Control Room, devices, and Bot Agent

Upload workitems to a queue API (Service Cloud Case ID: 01945087)

The /queues/id/workitems/upload APl was changed to the /queues/id/file API
because the previous version of the APl was reporting a status of N/A. You can continue to
add workitems to your workload management (WLM) queue using the /queues/id/file
API.

Workload Management API

More visibility of variable types

Now the currentValue and current Key variables of all types are displayed in the variable
picker. Previously these variables had to be of string type to be visible.

Enhancement to Bot Scanner utility

We have enhanced the Bot Scanner utility and it now includes the option to scan bots that
contain any of the Email package actions and Triggers that use the EWS option.

Note: Microsoft has deprecated EWS API for Exchange Online and has recommended that
users move to Graph API. We recommend that you update the impacted bots by replacing
each email-related action with the equivalent new action in the Microsoft 365 Outlook
package (based on Graph API).

Microsoft 365 Outlook package releases on page 807 | Microsoft 365 Outlook package
on page 2516

Scan Automation 360 bots for Email action with Basic authentication usage on page 993

Notification on package update in On-Premises Control Room

If you have disabled the automatic update option for packages (Administration > Settings
> Packages > Package update > Disable), a notification icon is displayed for these
packages installed in your Control Room when a more recent version is available.

Automatic package updates for On-Premises Control Room on page 1726

Fixes

When you sort the schedules data on the Scheduled activity page by the Next occurrence
column, the schedules are sorted correctly.

Previously, the schedules on each page were sorted individually instead of sorting all the
schedules collectively. As a result, schedules were sorted and displayed incorrectly.

Service Cloud case ID: 01936672, 01948336
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The Botinsight API- Get Task Log Data will retrieve automation execution information for
all automations in public folders, irrespective of whether they pre-existed in a private folder
or not. Additionally, the API expected an automation name and returned data only for that
automation.

Previously, the GetTaskLogData API retrieved information only for the following:

* |If a bot pre-existed in a private folder and will not work for bots directly uploaded to the
public folder.

*  When the bot name (optional parameter) is specified in the request.

Service Cloud case |D: 01805000, 01965480, 01804312, 01854057, 01861154, 01905063,
01901693, 01932388, 01943438, 01911251, 1946327

You can renew and install licenses using your Control Room GUID without encountering
an error.

Previously, an error occurred in such a case.

Service Cloud case ID: 01958580

After you update Windows Server 12 with Update for Universal C Runtime in Windows
patch, the Automation Anywhere Control Room Discovery Bot ML Service no longer fails
during Automation 360 installation.

When you create or edit a locker, you can add multiple roles when updating the
Consumers option.

Previously, you were unable to add multiple roles.
Service Cloud case ID: 01946827

You can use the User authentication setting when enabling SSO authentication without
encountering an error.

Previously, an error was displayed when you clicked the Edit button for the User
authentication settings.

Service Cloud case |D: 01946770, 01958619, 01984261, 01962097, 01964711, 01966644,
01971461

On the In progress activity page, the details page of an activity displays the Last modified
date consistently.

Previously, this date was not consistently displayed.
Service Cloud case ID: 01943780

In an Oracle Database environment, when you update from Automation 360 v.26 to later
versions, the new package versions that are shipped though the installer are now enabled
and set as the default version.

Previously, you must have enabled each updated or new package manually and set it as
default version.

Bots that are in the Queued status appear automatically on the In progress activity page.

Previously, you had to click the Refresh table button to view the queued bots.
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With the bot.dependency.timeout = <value in seconds> property, network connections
no longer stuck. Also, a scheduled bot no longer remains in the Pending execution status.
As a result, Bot Agent can download the dependencies and thebot executes successfully.

Previously, during dependency download phase, the downloads were stuck due to
unreliable network. As a result, Bot Agent could not download the dependencies and the
bot did not execute.

Service Cloud case ID: 00951927, 01822836, 01801869, 01874596

You can edit and save device credentials on the My Settings page without encountering
errors.

Previously, you were unable to save the device credentials.

Service Cloud case |D: 01941151, 01943701, 01958822, 01858205, 01867974, 01862001,
01867845, 01921703, 01905028

Audit log details page displays complete text for all fields.
Previously, text that displayed for some of the fields were truncated.
Service Cloud case ID: 01908673

On the Historical page, the activities details page displays the correct status for bots that
are stopped from executing.

Previously, the status for such bots was displayed as failed.
Service Cloud case ID: 01835612, 01962900

When an AAE_Admin tries to delete a user, a prompt is displayed with the list of resources
that the user is associated with. This list includes resources such as licenses, schedules,
pools, lockers, queues, and credentials. This information helps the administrator to
disassociate the user from the resources before deleting the user.

Previously, a generic message was displayed before a user was deleted.

Service Cloud case |ID: 01255043, 01761442, 01764557, 01800227, 01807149, 01927012,
01804960, 01949491, 01970079

Bot Agent can now successfully download the packages to device during bot deployment
even if the repository path is a Distributed File System (DFS) path.

Previously, if the repository path was set to a DFS path, Bot Agent was not able to
download the packages to device and bot deployment failed.

Service Cloud case ID: 01940976

When Bot validation feature is enabled and if you pass a File type variable from the parent
to child bot, you no longer encounter the preprocessing error during runtime. As a result,
you can run the bot successfully.

Previously, a File sub-type was handled incorrectly and validated against string rule during
bot validation. As a result, you were unable to run the bot when file variable was used in the
Task Bot.

Service Cloud case ID: 01969744
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When you update the cloned bots by replacing older dependencies with the new ones
and check in these bots to the public workspace, the update is retained when another user
checks out this updated bot.

Previously, when another user checked out this updated cloned bot, the older dependency
remained along with the new one.

Service Cloud case ID: 01948590

When you restore your bots and their dependent files from Git to your server repository,
the version information is retained in the correct order. When the Git restoration process is
complete, the bots and files contain the same version as the source.

Previously, version information was not restored in the correct order. The bot restored was
not of the same version as its source.

Service Cloud case ID: 01924034

When you update to Automation 360 v.24 and the Control Room server repository is on a
user network file path, if you import bots that contain a large number of bot or non-bot file
dependencies, the bot now imports successfully.

Previously, the bot import failed with an error.
Service Cloud case ID: 01807824, 1815889, 01831729

When a large number of users perform concurrent bot check-in operations and if the bot
contains multiple dependencies, the concurrent check-ins are completed without delay.

Previously, the check-in operation was slow, affecting other repository actions and the
Control Room performance.

Service Cloud case ID: 01944887, 01964122

When you update from Automation 360 v.25 to Automation 360 v.27, code analysis
remains enabled, and the rules set in the policy are retained post-update.

Previously, even though code analysis remained enabled in the Control Room, the rules set
in the policy were not retained post-update.

On the Audit log page, when you select the source type as Event type or Source, the
corresponding drop-down values are sorted in alphabetical order.

Previously, the order was random for these source types.
Service Cloud case ID: 00805794, 01908670, 01766369

On the Create Active Directory role mappings page, the Active Directory domain option
lists domain names as NetBIOS names.

Previously, domain names were displayed as fully qualified domain names (FQDN).

API Task is designed for Automation 360 cloud deployments only and is not available for
On-Premises deployments.

Previously, during the beta release, APl Task was made available in the On-Premises
deployments for a brief period.
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You no longer encounter issues when you create a bot and disable any action (the disabled
action has no data or contains errors) in the code.

Previously when you executed such bots, it failed with an error.
Service Cloud case ID: 01952661

You can now replace a specific variable in a number expression when you select Search
type > Variable name in the Search and replace feature.

Service Cloud Case ID: 01950021

After a successful installation of the Bot Agent on a device, the Bot Agent service is
registered correctly and is displayed on the Windows Services page.

Service Cloud Case ID: 01797914

After updating to this release, you can delete a registered device from the Control Room
without any issues.

Service Cloud Case ID: 01903472, 01914698

Security vulnerability issue fixed in the crutils. jar file.
Service Cloud case ID: 01955093

Automation Co-Pilot (integrations) (AARI) end points include the HTTP Strict Transport
Security (HSTS) response headers.

Previously, the response headers were missing in the Automation Co-Pilot (integrations)
end points.

Service Cloud case ID: 01926041

In a form with a text field that has a max character limit, when a value from a previous task
is inherited an error will display. This was fixed in Cloud build 17557 and On-Prem build
17571.

Service Cloud case ID: 01969999

The format of date data passed from bot to form now transfers accurately. Previously, the
date format was changed during transfer.

You can now manually enter any time value between 00:00 to 00:45 when entering time
(24-hour format) in forms. Previously, the values entered defaulted to the nearest 15-minute
interval.

Service Cloud case ID: 01963769

In the Bot editor, the Create a request action in the Process Composer package now
supports table variables. This allows you to pass the data of a table to the initial form during
run time in Automation Co-Pilot.

If an error is present in a mandatory field the submit button is disabled. Previously, when
using forms in build 16667 the button remained enabled during first attempts.

Service Cloud case ID: 01949368
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Check box values render as expected in web forms. Previously, an inconsistency occurred
from designing the form, causing the rendered check box value to be inaccurate.

Service Cloud case ID: 01951738

Limitations

For a queue in draft mode, when you edit the general settings such as Max auto retry
attempt, you cannot save the changes. Additionally, it generates an error message.

For users with more than 1000 schedules (active or inactive), the Scheduled activity page
might not load properly. At times, you might encounter an error message while browsing
the schedules across pages.

Workaround: To view the list of schedules, you can filter and sort the schedules by status.

Process Discovery (Discovery Bot) has been removed from the Community Edition, but
there is a non-functional link to Process Discovery (Discovery Bot) on the home page that
needs to be ignored.

Workaround: Ignore the non-functional link in the Community Edition.

There might be a mismatch in the Bot Agent update required data in device dashboard
with that of the Devices page. This mismatch is because the Devices page shows the data
about only online devices whereas the device dashboard shows the data about all devices
(online and offline).

When you export or promote bots or files that are checked in before January 2021, you
might encounter an export or bot promotion error.

Workaround:
1. Check out the bot.

2. Check in the bot without making any changes to it. A new version of the bot is
created.

3. Export or promote the bot.

Trigger listeners is not supported when you use an auto login that is configured from an
external key vault.

Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation.
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The user interface for the Automation 360 product will no longer support Italian, Russian,
and Simplified Chinese languages. In addition, updated release documentation will no
longer be available in these three languages though English documentation will be
accessible.

For a complete list of deprecations, see Feature deprecations affecting Automation
Anywhere products on page 947.

Microsoft has deprecated EWS API for Exchange Online and has recommended that
users move to Graph API. See Upcoming API Deprecations in Exchange Web Services for
Exchange Online.

Note: We recommend that you update the impacted bots by replacing each email-related
action with the equivalent new action in the Microsoft 365 Outlook package (based on
Graph API).

Microsoft 365 Outlook package releases on page 807 | Microsoft 365 Outlook package
on page 2516

Updates to the interface

Review the updates to the interface in this release.

See the following video for the updates in the interface for Automation 360 v.29 release:

The External Key Vault Integration page is simplified to easily select and configure key
vaults when installing the Control Room.

Integrate HashiCorp Vault to retrieve credentials

The Licenses page is simplified to segregate the licensing information.

View license drill down for users and Control Rooms

The Attention needed filter is added in the notification panel to simplify the notification
categories.

Simplified notifications categories

The Time filter field is added to search, view, and customize the historical activities based
on the selected time duration.

Time filter for historical activities

The Edit option is added for in-use queues to update the queue details and process queues
faster.

Ability to edit workload management automations

Move bots across environment easily with bot promotion.

Move bots across environments

The icon for a process has been updated in the Bot editor.
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Variables for currentValue and currenKey are now visible in the variable picker, regardless of
variable type.

More visibility for variables

Updating to v.29 release

Review requirements and support information about updating your Control Room and Bot Agent
for the v.29 release.

Bot Agent updates

Note: This release includes an optional Bot Agent update. You can continue to run your existing
bots without updating the Bot Agent. However, if you want to use the new features in Automation
360 v.29, you must update the Bot Agent available with this release.

For more information on updating to this release, see these resources:

« Automatically update the Bot Agent on page 1207 | Manually update the Bot Agent on page
1209

« Compatibility with release builds on page 1182

Certified Control Room builds for direct update

You can update to the latest version of Automation 360 from the previous three releases (that is,
from n—3 releases, where n refers to the latest release).

The following previous releases are certified for update to Automation 360 v.29:

e v28 (Build 17571, 17566, 17542, 17506)
« v.27 (Build 16685, 16667)
e V.26 (Build 15450, 15459, 15439, 15436)

If you are on one of these previous releases, for information about updating, see Update
Automation 360 to latest version on page 1266. If you are not on an n-3 release, update

Automation 360 to one of the n—3 releases before updating to Automation 360 v.29.

Migration updates for v.29 release

Review what's changed and fixed in Automation 360 v.29.

What's changed

Migrate botsbots with greater than 10 nested loops

You can successfully migrate bots than contain more than 10 nested loops without any
issues. The maximum number of nested loops supported is 97.

Service cloud case ID: 01936674
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Fixes

When you migrate MetaBots that include large content variables using the Bot Migration
Wizard, a new text file is generated and the filename for the text file is correctly displayed in
the Target Name field on the migration wizard Results page.

Previously, the filename was not displayed.

You can successfully migrate an Enterprise 11 bot created using the nested email loop
condition (the first loop is not commented, whereas the second loop action is commented
or vice versa), having an Email Automation command.

Previously, migration of such bots showed nested email loop conditions (first and second
loop), as commented.

You no longer encounter issues when you run an Enterprise 11 bot in Automation 360
containing the SAP Standard BAPI command. The scalar parameter now maps to
Automation 360 variables even if you have not enabled the Write to CSV check box in the
SAP Standard BAPI command.

You can successfully migrate an Enterprise 11 bot when it is using an array variable within a
Loop While condition and the index position of the variable is greater than the size of the
array.

Previously, such a bot encountered an error if the index position of the variable was greater
than the size of the array.

After updating to this release, errors are no longer displayed when you select the Excel
contains charts check box in the Open action of the Excel advanced package to open an
Excel file that contains a graph sheet.

After updating to this release, actions from the App integration package that uses
Windows SDK will timeout when the target application stops responding or is in ‘Not
responding’ state.

When you migrate a bot from Enterprise 11 that contains the Run standard workflow
action from the SAP BAPI package, the scalar parameters are assigned to the
corresponding variables correctly.

When you migrate an Enterprise 11 bot that uses the Loop action with File exists condition
and if the variable value inside the condition changes, then the bot picks up the latest value
of the variable with every loop iteration.

When you migrate an Enterprise 11 bot that uses the Comment action, the action will
always remain in the enabled state even if it consists of variables as the variables will now
be represented as $$. For example, when you add $vArray$ variable in the Comment
action and migrate the bot, after migration it will be represented as $$vArraySs$.

You can migrate bots that use the Delay package in a loop where the delay value is set to
0.

Previously, such bots encountered an error during bot execution.

When you migrate an Enterprise 11 bot which has Object Cloning command with Image
play mode, the migration no longer fails for the currently selected active window. Also, it
does not generate any error message.

Service Cloud case ID: 01947195
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When you use the String > Before or after command in Enterprise 11 and if the number
specified in the No. of characters to be extracted field is greater than the actual number of
characters available before or after the specified text, the output shows consistent results.
Additionally, it does not generate any error message.

When you migrate a bot that contains disabled if-else commands inside any active if-else
block, the entire code in the bot is migrated without any issues.

Previously, when you opened the migrated bot in Automation 360, some lines of code
were found missing. This issue occurred because when you migrated the bot, the disabled
if-else code in the bot was skipped, and no error or warning was displayed in the migration
wizard.

Service Cloud case ID: 01885648

Packages updated in v.29

Review updates to packages released with Automation 360 v.29 including the compatible Control
Room and Bot Agent versions.

Packages released with v.29 release

The following table lists packages updated for this release. Click the package version to view
updates (what's new, changed, or fixed) in this package.
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Packages not updated in v.29 release

The following table lists packages that have not been updated in the Automation 360 v.29 release
but are compatible with this release.
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CoE Manager v.29 release

Review what's new in CoE Manager for the v.29 release.

What's new

Expand organization hierarchy for focused ROI tracking

You can expand the existing business units in CokE Manager to create multiple sub-level
units (geographies, business units, departments, and teams) and link opportunities to

these sub-level units. For example, consider the business unit Finance. You can build
sub-level units of Accounts Receivable and Accounts Payable under Finance. You can
further build sub-levels such as Invoicing, Credit and Collections, Debt Management, and
Cash Application under Accounts Receivable. This hierarchy capability provides a clear
understanding of how many opportunities were submitted from different areas of the
organization, how many were automated, and measures the ROl generated from each
area. At every level, the ROI is rolled up from sub-levels to provide a comprehensive view of
how each department or business unit is performing.

Set up organization hierarchy and link opportunities on page 1871

Standardize activity types with predefined activities template

Based on their organizational standards, an administrator can define additional activity
types to add to the following predefined activity types:

* Business Case
* Requirements

» Design

* Infrastructure Setup
« Build

e Test

* Deploy

To maintain consistency across all opportunities, users can select activities from these
predefined templates to build automation projects. Using predefined templates drives
standardization and provides better visibility and reporting capabilities.

Automation Co-Pilot v.29 release

Review what's new and changed, and the fixes and limitations in Automation Co-Pilot for the v.29
release.

Important: Starting from this release, we have moved information about updates in each (such
as what's new, changed, fixes, and limitations) to -specific pages. You can access these pages by
navigating to Package releases on page 764 > <-name> releases.

For a consolidated list of packages updated in this release, see Packages updated in v.29 on page
36.
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What's new

Queue automations

In the Automation Co-Pilot Desktop Assistant, you can view multiple bot deployments in a
gueue. You can refer to the Queue page to view pending bots that are sorted by progress,
including bots with trigger events that were initiated. This also grants you more control
over each bot instance, with your ability to remove queues individually or bulk, and to start
or stop any bot progress.

Queue automations on page 2923

Dropdown Multi-Select form element

In the form composer, you can use the new Dropdown Multi-Select form element to
create a drop-down menu with values in your forms. This element will enable you to
specify more than one value in a drop-down menu that another user can select in a form.

Using the Dropdown Multi-Select element on page 2927

Map host data with input variables

You can use attended bots with input variables to map data in a host application. When
you run your automations in the embedded widget, the values of input variables will be
populated based on data of the host application that you configured.

Set supported language as URL parameters

You can set specific language settings to your URL for host applications using Automation
Co-Pilot. This provides you with instant localization for supported languages without the
need for you to access language options in a settings menu. For instance, you can add
lang=en_US or lang=fr_FR at the end of your URL to localize your contents to a specified
language.

Automation Co-Pilot supported features on page 2878

View hidden elements in form composer

In form composer, when you define hidden elements, you will be able to view the hidden
element as URL parameters in your URL address. For example, if a hidden element is set
to a language value, the URL will reflect this and show as hiddenelementO=EN_US in the
URL. This gives you a quick reference of your defined hidden elements when you view the
URL.

Automation Co-Pilot supported features on page 2878

Attention toggle in notifications

The Need Attention toggle in the notifications tab enables you the ability to filter between
all notifications and notifications that requires action, for your embedded widget. When
you select this toggle, only notifications that require your attention is filtered. This helps
you focus and prioritize on the important notifications. You can also refresh to load new
notifications.

Automation Co-Pilot supported features on page 2878
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Search and filter in an embedded widget

You can search and filter your automation list in your embedded widget. When you filter,
you can use the name toggle to organize by ascending or descending names. You can also
search for specific keywords to quickly identify your automation.

Assign a process to roles

Processes can now be assigned to roles. Adding a role to a process makes it available to
cross-functional team members, regardless of their assigned team. A process can still be
added to a team. However, managing a process by role can make common business tasks
consistent and accessible for all users with a set role.

Manage a process in Automation Co-Pilot on page 3011

What's changed

Improvements for running processes

Documentation has improved to provide clarity on running a sub-process containing a
form within a parent process.

Service Cloud case ID: 01966950

Run a process on page 2984

Delete requests by any status

For easier storage clean up of processes in a private folder, you can now delete requests
(by users with permission) regardless of what status the request is in. Previously, you could
not delete requests in open status.

Service Cloud case ID: 01959212

Fixes

In historic activity, when you view bots that have encountered an error, you can view the
error message details in the Error message section. Previously, error messages would not
generate.

Service Cloud case |ID: 01850454, 01908923

When you use a date element in your forms, and you generate a date data in the date
field and then delete the data, the date data will be removed or updated if you specified a
different data.

Service Cloud case ID: 01944363

In Automation Co-Pilot Desktop Assistant, when you use the search and replace feature
for form variables, you are now able to search and replace your form variables.
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Limitations

In Automation Co-Pilot Desktop Assistant, when you log in as an attended user, but you
do not have access to a child bot, and you attempt to run a parent bot instead, an error
message will prompt and notify you that you no longer have permission to access the child
bot and will not return to a normal state. This error message still persists when you log in
again.

Workaround: You can press the F5 key to refresh the page and it will load to a normal state.

When you use a Table element in your forms, the Duplicate row option is not available for
you to select. Though there are no workarounds for this limitation, you can continue to
add rows to your table, and duplicate rows that were previously created are not effected.

Updates to the interface

Review the updates made to the interface for Automation Co-Pilot v.29 release.

Requests in a private folder can now be sent to the recycle bin or hard deleted (by users
with permission).

Delete any request

When completing a form, a search field is now available in drop-down menus with ten or
more options.

Service Cloud case ID: 01875095

A process can now be added to roles.

Assign process to role

View the queue of your attended bot automation.

Queue automations

Use the Dropdown Multi-select Element in form composer.

Dropdown Multi-Select element

Specify a supported language as a URL parameter.

Supported language URL parameter

Use the Need attention toggle to filter your notifications that requires attention.

Need attention toggle
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Document Automation and 1Q Bot v.29 release

Review what's new and changed, and the fixes and limitations in 1Q Bot and Document
Automation for the v.29 release.

Important: Starting from this release, we have moved information about updates in each (such
as what's new, changed, fixes, and limitations) to -specific pages. You can access these pages by
navigating to Package releases on page 764 > <-name> releases.

For a consolidated list of packages updated in this release, see Packages updated in v.29 on page
36.

Document Automation

What's new

Validate table data quicker using auto fill

You can use the Auto fill button in the validation interface to extract hundreds of rows of
data from multipage tables. After you manually validate three cells in a column, auto fill
extracts the remaining values from that column in the document.

Use Advanced Classifier package in Document Automation

You can use the Document Automation Advanced Classifier package to classify documents
and pages, and split documents into a folder structure. You can upload documents

from the folders to their respective learning instance to extract content in Document
Automation. You must set up a Skillja license in a credential vault to run a bot containing
actions from this package.

Advanced Classifier package on page 2113

Document Automation support for Google Customer Document Extractor

You can now create a user-trained learning instance in Document Automation and extract
it using a Google Custom Document Extractor (CDE) processor. You can use this new
capability to train a model using Google CDE for any document type, and it supports

30 languages. After you deploy a model, you can embed the processor URL within the
Document Automation extraction process. To use this capability, you must have an
Automation Anywhere Document Workspace license and a valid subscription to Google
CDE.

Improved heuristic feedback with form and table extraction

Document Automation provides an improved extraction through heuristic feedback with
a focus on complex scenarios, such as multi-tables. Additionally, there are extraction
improvements for both form fields and out-of-the-box performance (specifically for table
fields).
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What's new

Document-level data validation in Document Automation

With document-level data validation, you can create rules to ensure the accuracy of
extracted data across multiple fields in your documents. You can define various conditions,
such as pattern matching or equality checks. When those conditions are met, you can
effortlessly take action to flag errors or warnings, clean up or replace values, or set new
values.

Validation rules in Document Automation on page 3169

What's changed

In Standard Forms, you can create and train new models in Microsoft Form Recognizer
v3.0 only. You can use existing models in Microsoft Form Recognizer v2.1, however, you
cannot create new models.

Microsoft Form Recognizer uses MS Form Studio to label and train custom models. You
must integrate Document Automation with MS Form Studio to be compatible with v3.0
models and any other future model versions created by Microsoft.

As of Automation 360 v.29, Document Automation Standard Forms supports the check
box type for forms and table fields. The Standard Forms learning instance has an additional
check box field data type and the extraction result can be one of the following:

e Checked

¢ Unchecked
» Not found (if the system is unable to extract the result)

For any Standard Forms learning instance that was created before Automation 360 v.29
and has a check box field, you must update the data type for the check box field at the
learning instance level.

Enhancements were made in the Validator to improve the validation process in Document
Automation.

For Automation 360 v.29 release and later releases, the learning instance export and import
functionality has been enhanced to include the ability to copy heuristic feedback data with
the configuration. You can seamlessly move your feedback data from one environment

to another without any data loss. As a result, this feature significantly reduces the need for
rework, ultimately saving valuable time.

Fixes

If a table name in the Validator has more than 50 characters, the field name in the table is
now displayed when you hover over it. Previously, the table name was not displayed.

If a field name in the Validator has more than 100 characters, the scroll bar appears and
you can see the value of the form field. Previously, the form field name was not displayed.

The run analysis result is displayed in Standard Forms when creating a v3.0 model with
multiple pages.
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Fixes

You can now use the advanced check-out options for bots that contain actions from the
Document Extraction package.

If you upload documents to a custom process instead of a Document Automation auto-
created process, the Download bot now successfully downloads the CSV of extracted data
and deletes the uploaded files from temporary storage.

The Automation Anywhere Control Room now tracks Document Automation license
consumption in newly-installed cluster Linux environments.

Imported learning instances now have pattern-based validation enabled by default.

You can now submit a document that has a pattern validation rule with a regular
expression that contains the pipe symbol (|).

The Unknown option under OCR type for Google Document Al provider has been
removed. You no longer see the Unknown option in the OCR Engine filter for new data.
Instead, the filter will accurately display ABBYY as the OCR engine for Google Document Al
provider, ensuring better clarity and consistency in the filtering options.

Extraction is now successful when creating a learning instance in Document Automation
using a custom domain. Previously, uploading a document for the learning instance using a
custom domain would result in extraction failure, but this issue has been resolved.

Documents with Windows OS user-names containing more than 17 characters can now

be processed successfully in the latest package of Document Automation. Previously,

attempting to process such documents would trigger an error message stating, The File
cannot be processed, it may be corrupted. Please contact technical
support if the file is wvalid.

The Document Extraction package now successfully extracts documents when the option
to store the output files on the server is chosen in a stand-alone setup. Previously, selecting
the option to upload the output to the server would result in a failure of the Extraction
action, accompanied by the error message DW_EXTRACT FAILURE 500.

Limitations

The check box feature (in preview mode) might result in inconsistent extraction for the
check boxes field, which could lead to inconsistent results. In such cases, if the system is
unable to accurately extract the check box field value, it will be labeled as Not Found.

If a learning instance name contains a space, then the downloaded file name will have the
space replaced with the encoded value %$20. For example, if the exported learning instance
name is Test 123, then the file name is displayed as Test%20123.

With the implementation of new document level rules, if the condition is based on a Form
Field and the resulting action should affect a Table Field, the expected outcome is not
reflected in the Validator.

You will not be able to use the Extract field using pattern for a table field with a custom
alias.

Workaround: On removing the regular expressions (regex), the extraction works as
expected with the custom alias.
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Limitations

For the table fields in Validator, validation is performed only when the entire column has
been entered with the correct values, rather than individual fields separately. Even if the
entire column is corrected, if the customer deletes a row in between, the error will not be
validated.

When the table name in the Microsoft Form Recognizer Studio Ul exceeds 99 characters,
the Ul does not handle it properly.

IQ Bot

Fixes

The first time you click a learning instance connected from Automation 360 IQ Bot, you
are directed to the details page for that learning instance. Previously, you were redirected
to the 1Q Bot home page instead.

Automation 360 IQ Bot now shows the correct error message if you upload a corrupted
document to a manual group.

You can now use more than 54 categories for the Train and Retrain actions. This allows
classification according to the provided training model files. Previously, the Classifier was
unable to classify the files into categories if the number exceeded 54 categories.

You can now create and run the 1Q Bot Classifier package with a variable in the child task
bot. Previously, when you ran the task bot command with a variable to call the child task
bot, it displayed an error.

You can now view the full Python script that is added to the Python Logic tab when you
navigate from fullscreen to smallscreen after a test run. All the options such as Test Run,
Clear Box, fullscreen, and Save are also visible. Previously, when you navigated from
fullscreen to smallscreen, you could not view the Python script and the other options were
hidden.

Healthcheck for an 1Q Bot instance shows the correct OK status even if the instance is idle
or accessed after a day. Previously, healthcheck showed a status of NOT_OK when the 1Q
Bot instance was idle or accessed after one day.

You can now export, import, upload, and download an IQ Bot archive (IQBA) file with a
maximum file size of 5 GB.

Previously, if the IQBA file size was greater than 268 MB, then the file storage did not
upload the exported file from the output folder to the desired location.

You can now import an IQBA file successfully into the learning instance. Previously, IQBA
import was failing when the exported learning instance had certain training embedded in it
with line break characters.
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Updates to the interface

Review the updates to the interface made to the interface for Automation 360 v.29 release.

Document Automation and 1Q Bot

With document-level data validation, you can create rules to ensure the accuracy of
extracted data across multiple fields in your documents.

Document-level rules for improved extraction

You can leverage export and import functionality with the ability to copy heuristic feedback
data with the configuration.

Validation feedback in export and import of learning instances

Create a user-trained learning instance in Document Automation and extract it using a
Google Custom Document Extractor (CDE) processor.

Support for Google Custom Document Extractor (CDE)

You can create and train new models using Microsoft Form Recognizer v3.0 only.

Standard Forms support for v3.0 model

Bot Insight v.29 release

Review the fixes in Bot Insight for the v.29 release.

Important: Starting from this release, we have moved information about updates in each (such
as what's new, changed, fixes, and limitations) to -specific pages. You can access these pages by
navigating to Package releases on page 764 > <-name> releases.

For a consolidated list of packages updated in this release, see Packages updated in v.29 on page
36.

Fixes

Bot Insight dashboards now show complete operational data without an administrator role.
With appropriate folder permissions to view and access the bots, you can view the data for
the bot in the dashboard.

Previously, you needed an administrator role to access all bots in the Bot Insight
dashboard. Thus, the dashboard showed no data or incomplete data for non-administrator
roles.

Bot Insight dashboards now sort all the widgets data and show it in correct sort order
(ascending or descending).

Previously, the sort order setting was not working accurately and impacted the widgets
data for all the domain dashboards. As a result, it always showed the old datasets only.

Service Cloud case ID: 01942061

© 2023 Automation Anywhere. All rights reserved. 53



product-flagshipAutomation Anywhere - Release Notes

When you hover over the charts x-axis, the device utilization widget in the Bot Insight
device dashboard now shows the correct tooltip text for the Device Name label.

Service Cloud case ID: 01941392

Package SDK v.29 release

Review what's new in the Automation 360 Package SDK for the v.29 release.

What's new

SDK download link: A360-package-sdk-2.8.0.zip

return_Direct attribute

A new attribute return_Direct= true is added at the action level. It will show only a single
option to select the Record type variable in the output.

For example:

@BotCommand

@CommandPkg (
return label = "[[AddColumn.return label]]",
node label = "[[AddColumn.node label]]",
label = "[[AddColumn.label]]",
description = "[[AddColumn.description]]",
name = "addColumn",
icon = "record.svg",
return type = DataType.RECORD,
return Direct = true,
return required = true,
minimum controlroom version = "17917",
minimum botagent version = "21.134",

documentation url = RECORD ADD COLUMN URL,

documentation widget page = RECORD ADD COLUMN WIDGET,

allowed Agent Targets = AllowedTarget.HEADLESS)

OAUTHCONNECTION attribute

A new attribute type, OAUTHCONNECTION, is added to get an access token from the
Control Room's preconfigured OAuth Connection value.

For example:

@Idx (index = "1", type = AttributeType.OAUTHCONNECTION)
@Pkg (label = "[[OAuthConnectionTypeDemo.connection.label]]")
OAuthConnection connection
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A new rule VariableMapAllowedDataTypes is added to the VARIABLEMAP

VariableMapAllowedDataTypes allows you to filter the Ul for a particular variable
type. VariableMap is a control that allows you to add variable selection for any action
(in the bot editor Ul). With the VariableMapAllowedDataTypes filter, you can restrict
the datatype of variables that can be used in an action. For instance, if you set the
VariableMapAllowedDataTypes tO String, it will list only string variables within an
action.

@Idx (index = "4", type = VARIABLEMAP)
@Pkg (label = "[[LogVariables.selectVariable.label]]")
@NotEmpty

@VariableType (DataType.VARIABLEMAP)

@VariableMapAllowedDataTypes ({
DataType.STRING,
DataType.NUMBER,
DataType.BOOLEAN,
DataType.DATETIME

})
Map<String, Value> variables
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@DesktopOperationContext annotation

The new annotation @DesktopOperationContextis used to inject
the DesktopOperationContext in DesktopOperation, similar to
GlobalSessionContext

This annotation is applied on property with the setter method so that the generated file can
set DesktopOperationContext to the target file.

By injecting DesktopOperationContext, the following property can be accessible in
DesktopOperation from the GlobalSessionContext

getUserToken

getCrUrl
resolveResource
getExternalEnvironment
getProxyConfig

botId

N o o s~ wDdRE

getResources

@BotCommand (commandType =
BotCommand.CommandType .DESKTOP OPERATION BUTTON)
@CommandPkg (name = "RESTRecorder", desktop operation name =
"RESTRecorder")

public class RecorderOperation {

private static final Logger LOGGER =
LogManager.getLogger (RecorderOperation.class) ;

@Request private DesktopOperationButtonRequest request;

@DesktopOperationContext private
com.automationanywhere.toolchain.runtime.operation.context.DesktopOperationCont
context;

public void setRequest (DesktopOperationButtonRequest request)

this.request = request;

}
public void setContext (
com.automationanywhere.toolchain.runtime.operation.context.DesktopOperationCont

context) {
this.context = context;

Related reference
Previous Package SDK Release Notes on page 843
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Review the new, changed, fixed, and deprecated features, and security fixes, known issues, and
limitations for the previous Automation 360 (formerly Enterprise A2019) Package SDK.

Automation 360 v.28 Release Notes

Release date: 5 April 2023

Review the top 5 features in this release as well as other new features and exciting enhancements
for Automation 360 v.28 release.

o Build 17566: Automation 360 (Cloud and Cloud Sandbox) and 1Q Bot (Cloud)
e Build 17571: Automation 360 (On-Premises) and 1Q Bot (On-Premises)

We have released updated builds for fixes after the Automation 360 v.28 GA builds, which were
Cloud Build 17524 and On-Premises Build 17506. For information about the fixes in these updated
builds, see Updated release builds on page 59.

Highlights of this release

Here are the top 5 features in the v.28 release:

Document Automation and Google Document  Validation-based improvement on Google

Al Document Al extractions: Empower your
employees to save time and automate more
documents using Document Automation and
Google Document Al validation feedback,
which in turn provides improved extraction
accuracy for Document Al learning instances.

Leverage integration update with the latest
Google Document Al parsers: Improve
extraction accuracy and enable 7 additional
languages (including Italian and Portuguese)
for Document Al invoices, and Japanese for
Document Al expense receipts.

Create a learning instance in Document
Automation on page 3158

CoE Manager: Value tracking for On-Premises  Calculate ROI for automations running on an

automations On-Premises Control Room by running a bot
to push automation-run data to CokE Manager.
View your ROI data in real-time dashboards and
create a healthy pipeline of automations that
will help propel your business forward.

Integrate CoE Manager with On-Premises
Control Room on page 1878

Empower business users with Automation Co-  Bring automation to your employees in their
Pilot and Microsoft Teams favorite collaboration tool Microsoft Teams.
Employees can be in a chat or team channel,
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Workday package

Enhance developer productivity

or open Automation Co-Pilot from the Apps
menu to view a list of the Automation Co-Pilot
processes and desktop automations they have
access to. They can start and monitor these
automations, without having to leave Team:s.

Integrate Automation Co-Pilot with Microsoft
Teams on page 2916

Easily automate your Workday processes
such as reporting, data upload/download, or
triggering workflows with our new point-and-
click experience. Our new package provides
deep API-level integration with Workday that
enables you to build automations easily,
without having to code.

The following video shows how you can
automate processes in ServiceNow and
Workday using APl integration.

Workday package on page 2767

Next-gen Recorder: Improve automation
reliability for web applications when the Ul
element is not visible on the screen. The
Recorder will automatically work around this
without any developer intervention.

Recorder package on page 2564

Quickly search and replace any text or variables
in the action properties of the bot: Save time
and improve developer productivity with an
automatic search and replace tool in Bot
Assistant. Users can quickly search for any
specific text or variable, navigate through

the search results, and selectively replace

each occurrence of the text or variable in the
automation.

Search and replace option in Bot editor on
page 2093

Email automation through a shared mailbox:
Automate email tasks over a shared mailbox
in Microsoft 365 Outlook using IMAP or EWS
protocols and Client Credential flow or PKCE
flow with Exchange Online. This feature saves
you money, time, and effort in maintaining
individual personal mailboxes.

Email package on page 2234

Enhancement to bulk package update: As an
automation administrator, update multiple
packages in bulk or perform updates to specific
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bots and view outcomes of these applied
updates in a system-generated report.

Updating package versions on page 1728 |
Update bots to default package version on
page 1730

Bot runtime alerts: Gain visibility into your
automations with notifications on various
platform events and take actions based on
these notifications. Get notified on events such
as automation runtime and device pools from
within the application (default) or through email
reports based on your preference.

Automation events on page 1961 | Platform
events on page 1962

The following video shows the developer
enhancements available in this release:

Updated release builds

» We have released the updated Build 17571 (On-Premises)for the following:

Fix for users (excluding users assigned the AAE_Admin role) who do not have a license
assigned to them: the Audit log page no longer displays unsuccessful entries for any
activity performed by these users on the Control Room. (Service Cloud case ID: 01969726,
01970583, 01970990, 01971435, 01971171, 01970869, 01971854, 01970915, 01970523,
01971411, 01971788, 01971827, 01971482, 01971736, 01970333, 01972128, 01970497,
01972025, 01971459, 01971561, 01971068, 01972148, 01975216, 01975980, 01977479)

Fix for an issue when multiple users try to check-in bots simultaneously, the Control Room
Ul might become unresponsive due to a database connection issue. (Service Cloud case ID:
01944887)

Fix for an issue when the access lock in Git causes the lock not to be released. (Service
Cloud case ID: 01944887)

Fix for a critical security vulnerability present in the Credential Vaultmodule of v.28 and
earlier releases. The vulnerability allows a user who has permission to modify a locker to
access credential attributes in another locker.

Fix for an issue where the Automation Co-Pilot (AARI) request page does not load correctly
due to AARI form not rendering table data when the data variable assigned to the form has
more columns than the columns specified in the table.

Fix for an issue in the Automation Co-Pilot form where the form does not display an error
when a textbox inherits a value from a previous task and the value exceeds the maximum
character limit of the textbox.

* We have released the updated Build 17566 (Cloud)for the following:

Fix for an issue when multiple users try to check-in bots simultaneously, the Control Room
Ul might become unresponsive due to a database connection issue. (Service Cloud case ID:
01944887)

Fix for an issue when the access lock in Git causes the lock not to be released. (Service
Cloud case I1D: 01944887)
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Fix for a critical security vulnerability present in the Credential Vaultmodule of v.28 and

earlier releases. The vulnerability allows a user who has permission to modify a locker to
access credential attributes in another locker.

We have released the updated Build 17557 (Cloud) for the following:

Fix for an issue where the Automation Co-Pilot (AARI) request page does not load correctly

due to AARI form not rendering table data when the data variable assigned to the form has

more columns than the columns specified in the table.

Fix for an issue in the AARI form where the form does not display an error when a textbox
inherits a value from a previous task and the value exceeds the maximum character limit of

the textbox.

We have released the updated Build 17542 (Cloud and On-Premises) for the following:

Fix for an issue when bot preview is unavailable when you check out a bot that is using
metadata in actions (for example, Image Recognition, Recorder, and Screen Capture).

Fix for an issue where editing a bot from a folder fails when a policy is assigned to the folder
and its subfolders and one of the subfolders is deleted.

We have released the updated Build 17533 (Cloud) to include a fix for an issue found when
exporting a bot.

Exporting a bot fails when you perform the following steps:

o v kA WD PE

Log in to the Control Room.

Create a main bot and child bot using the Recorder actions.

Check in the bot.

Check out the bot and delete the Recorder actions from the main bot.
Check in the bot.

Export the bot.

What's new and changed in each product

Navigate to the following pages for details on all the updates (what's new, changed, fixed, and
limitations) in each product:

Automation Workspace v.28 release on page 61

Cok Manager v.28 release on page 105

Automation Co-Pilot v.28 release on page 106

IQ Bot and Document Automation v.28 release on page 110

Bot Insight v.28 release on page 115
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Automation Workspace v.28 release

Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.28 release.

What's new

Control Room, devices, and Bot Agent

Select the Control Room services to run at startup (Service Cloud case ID: 00781074,
00804237, 00799057, 01260425, 01271130, 01793867)

You can optimize application process utilization on your device by selecting the Control
Room services that you want to automatically run at startup during the On-Premises
installation.

Installing Control Room on Linux on page 1145 | Select the Control Room services to
automatically run at startup on page 1105

Improved notifications administration to manage user access

A Control Room administrator can manage a user's access to the event categories

set in the Administration > Settings > Notification settings section. A Control Room
administrator can lock the required preferences and notifications only for those enabled
event categories that are sent to the end users.

Lock event categories on page 1966

Monitor bot runtime, device pool, and license events through notifications
Through notifications, you can monitor all:

« Bot runtime events: Bot runtime event notifications are sent to the respective users
based on bot access permissions.

» Device pool related events: Device pool-related event notifications are sent to users
based on their user role and permission in the Control Room.

» License events (such as license over subscription or consumption): Email notifications
are sent for license over subscription or consumption events.

Automation events on page 1961 | Platform events on page 1962

Monitor Automation Co-Pilot events through Control Room notifications

With the Process events category, the Control Room notifies you about various
Automation Co-Pilot events related to requests and tasks through notifications. The task
and request event notifications are sent to the task owner and request creator team,
respectively.

Process events on page 1963

Audit log event when a package is deleted (Service Cloud case ID: 01780700, 01885638)
An audit log event is logged when a user deletes a package.

Audit events list on page 1914
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Control Room, devices, and Bot Agent

Import intermediate certificates for secure access to Control Room (Service Cloud case
ID: 00673966, 01889608)

An intermediate certificate is used to determine if a certificate was issued by a valid and
trusted root CA (certificate authority). If the intermediate certificate is not installed on the
server where the TLS certificate is installed, applications might not trust the TLS certificate.
To have clients trust the TLS certificate, you must make the intermediate certificates
available on the server.

You can import the intermediate certificates when you install the Control Room or after
you install the Control Room using the Windows command prompt.

Intermediate certificates on page 1231 | Configure application Transport Layer Security on
page 1101 | Import HTTPS, intermediate, and CA certificates on page 1231

Validate remote deployments to avoid unauthorized device access (Service Cloud case ID:
01608589)

Prior to assigning a device for bot deployment, you can reset the bot running device for
Bot Creator, Citizen Developer, and attended Bot Runner users to prevent unauthorized
deployments. This enhancement enables you to clear an existing bot running device when
users log into the Control Room and there is no Bot Agent available on the local device.

Switch device registration between Control Room instances on page 1643

Configure username for different Automation 360 services using the CyberArk secret
response (Service Cloud case ID: 01852428, 00675147, 01950039, 00819460, 00830696,
00822765)

You can configure usernames for auto-login, Lightweight Directory Access Protocol
(LDAP), and service credentials using the CyberArk secret response. Usernames can be

a combination of values from the secret response or string literals. The CyberArk secret
response contains field values that you must enclose within dollar signs ($S) to construct
the username. For example, to configure the username in the format domain\username,
you must enter: $$domain$s\$Susernamess$. The domain and username values in this
expression will be replaced with the corresponding values from the secret response.

External key vault naming conventions on page 1740 | CyberArk credential retrieval use
cases on page 1761 | On-Premises initial installation using CyberArk Password Vault on
page 1753

Customize device registration settings

Control Room administrator can customize the device registration settings while adding
a device. For example, if there are multiple users who will log into a single device, an
administrator can change the Device type to Multiple users.

Configure device registration on page 1636

Minimize security risk for trigger-based bot deployment

Prior to deploying a trigger-based bot, you can select to validate the device credentials
for Bot Creator, Citizen Developer, and attended and unattended Bot Runner users. This
provides users additional security for trigger-based bot deployment.

Switch device registration between Control Room instances on page 1643
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Control Room, devices, and Bot Agent

Auto-connect to non-Ul triggers for unattended users

As an unattended user who uses non-Ul triggers (such as File/Folder trigger that do not
require user session) you can auto-connect to the Automation Workspace when the
machine is rebooted. You do not need to log in to ensure the triggers are running.

Service Cloud case I1D: 00758775, 01754312, 01754887, 01803179, 01844357, 01845563,
01568082, 01866287, 01920491, 01951355, 01951355, 01957771

Packages, actions, and Bot editor

Workday package

You can use the new Workday package from Automation 360 to automate your Workday
processes such as reporting, data upload/download, or triggering workflows with our new
point-and-click experience. The package provides deep API-level integration with Workday
that enables you to build automations easily, without having to code.

Workday package on page 2767

Apigee package

You can use the new Disconnect and Resume Integration features in the Apigee package.
You can disconnect from your Apigee instance and clear the session using the Apigee
Disconnect action. You can resume an integration that is suspended in Apigee using the
Apigee Resume Integration action.

Apigee Disconnect on page 2128 | Apigee Resume Integration on page 2133

Goto package

You can migrate bots from other vendors into Automation 360.

Important: The Goto package was specifically designed for migrating bots from other
vendors into Automation 360 and is only available on request. This package is not available
as part of the standard Automation 360 installation as it cannot be used to build any bots.

Goto

Salesforce package

You can retrieve the entire result set in the response of the Salesforce Execute SOQL
actions. In the previous version, the response was limited to retrieve the first 2000 records
and this limit has been removed.

View mode supports the ability to copy

You can use the Copy to shared clipboard functionality to copy actions, triggers, and
metadata from a bot in a private repository that is in View mode. You can then use the
Paste from shared clipboard to paste the information to an editable bot.

Actions to build bots on page 2088

Credential Picker listing enhancement

For easier navigation when you pick a credential, the Credential Picket option displays the
Locker, Credential, and Attributes items alphabetically across the bot packages.
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Packages, actions, and Bot editor

Extended attributes supported in the Terminal Emulator Package (Service Cloud case ID:
01870633, 01928396, 01809815)

The TN3270E terminal type supports extended attributes. To enable extended attributes for
TN3270E terminals, select the Extended Attribute check box in the Connect action.

Enhanced Packages landing page

The Package Manager landing page has been enhanced to provide more clarity with
consolidated rows. When all versions of a package are disabled the status displays as
Disabled. All related fields, such as recommended Control Room version, Bot Agent
version, and Last modified, will show the status as Not Available.

The Version column has been renamed to Default version.

Enhanced error messages display errors from the child bots (Service Cloud case ID:
01264352)

When you create a bot where the parent bot calls a child bot, and if an error occurs in the
child bot, the error message provides the following details:

e Line number of the parent bot which ran the child bot.

* Line number of the child bot where the error occurred.

e Error message details, such as what went wrong with that line number and the
corresponding corrective action.

Using Bot editor on page 1974

Timeout option in Database Connect action (Service Cloud case ID: 00753858)

We added a timeout option in the Connect action of the Database Package. When you
connect with Microsoft SQL Server to automate database-related tasks, and if the database
is down or experiences any network issues, the automation will time out and fail if the
database connection is not established in the specified time.

Using Connect action for database on page 2195

Improved readability with new formatting capabilities in XML document (Service Cloud
case ID: 01886455, 01925386)

When you insert, update, or delete nodes, the XML package does not remove carriage
return characters between nodes but does remove all blank text nodes from the XML
document. By using Prettyprint to format XML files, developers can easily improve the
readability of a document. Developers can save time by using the following new options
that have been added to the XML Package:

« Use Prettyprint: The Save session data action supports the Prettyprint format in the
XML document. When you select the Use Prettyprint check box and use the Insert
node, Update node, or Delete node actions and then save the XML document, the
code is formatted with proper indentation as per Prettyprint.

» Remove text nodes that contain only white space: The Start Session action provides
an option to remove blank text nodes when you parse the XML document.

Save session data action in XML on page 2794 | Start session action in XML on page 2795
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New features added to the Email Package (Service Cloud case ID: 01835214, 01846425,
01756713, 01882482)

To support extensive process automation, we added the following action-related features
to the Email Package:

« Ability to use the Reply All action.
* Enhanced the Delete all action to delete all emails from a specific folder. Additionally,
you can apply filter parameters to emails such as:

« All, Read, and Unread

« Subject

« From a specific sender

» Before, on, or after a received date

« The dictionary variable for email properties includes a new variable,
emailNoOfAttachments, used to retrieve the attachment count.

Reply All action on page 2249 | Example using Email actions in a bot on page 2852 |
Delete all action on page 2239

Automate controls using Microsoft Ul Automation (COM) technology

You can use the Microsoft Ul Automation (COM) technology to automate the following
scenarios:

e Capture and automate link controls
« Capture and automate tree controls

Capture using specific technology on page 2587 | Actions performed on objects captured
with Universal Recorder on page 2568

Insert Custom column in Data Table

A new Custom column option has been added to the Data Table > Insert column action
that enables you to insert a new column at a specified index in a data table. When you read
an Excel spreadsheet and assign it to a data table, you can modify the table by adding a
new column and entering any required data.

Insert column action on page 2182

New Label option in Loop package

A new Label option has been added to the Loop package that enables you to break or
continue a specific loop from the nested loops.

Loop package on page 2455

Add and configure If action conditions

You can add and configure a maximum of 32 conditions in a single If action.
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Improved automation reliability for web applications

When you use the Recorder > Capture action to automate web pages running on Google
Chrome and Microsoft Edge browsers, the Recorder > Capture action no longer scrolls
down the web page if the target object is visible on the screen. This feature improves the
user experience and reliability of automation when there is a fixed top pane on the web
page and if some physical actions such as mouse clicks do not work as expected.

Note: Ensure that you install the browser extension (version 3.0.8.0) and use the Recorder
package (version 2.10.2) to capture the control.

Preferred view retained as default view in the Bot editor

As a bot developer, you no longer have to manually select the preferred view when you
open the Bot editor. To improve the developer's productivity and user experience, when
creating bots in the Bot editor, your preferred view (List, Flow, or Dual) in the Bot editor will
persist across user sessions and browsers. When you navigate in the Control Room or after
your next log in, the Bot editor will retain your last used or selected view.

Using Bot editor on page 1974

Line markers for collapsible sections of code in the Bot editor

When you create bots using Loop, If/If-else, Step, Trigger-loop, Try, Catch, and
Finally statements, the Bot editor clearly shows the collapsible sections. When building
automations, developers can use these visual indicator line markers at the beginning and
end of the collapsible section to improve their productivity.

Note: The visual indicator line marker for the collapsible section applies only to the List
view in the Bot editor.

Using Bot editor on page 1974

Enhanced user experience through refreshed and intuitive icons

With the new and intuitive icons for actions in the Bot editor, Citizen Developers and RPA
developers can quickly locate the correct action while creating automation for a day-to-

day task. These unique and renewed icons are developed according to brand and global

standards.

Update to the Capture text of window action

The Capture text of window action in the App Integration package can be used to capture
a text from a window on two different user sessions.

Capture text of window action on page 2138

Search and replace in Bot editor (Service Cloud case ID: 00792784, 01943783)

Use the Search and replace feature in the Bot editor to search for any text or variables,
string within an action and replace it.

Search and replace option in Bot editor on page 2093
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The experience of building a process has improved.
« Copy, cut, and paste behaviors are the same in Process Composer as in the Bot editor.

Behaviors supported in the Process Composer on page 3005

* You can access hidden variables for all applicable conditions, through the variable picker
in the Process Composer.

Using form hidden variables inside Process Composer on page 3002

The Process Composer supports Global Values. You can enter Global Values as variables
and select them from the variable picker.

Upload Storage file action added to Process Composer package

You can use the new Upload Storage file action in a task bot to upload data to storage for
further consumption in a process. This makes Automation Co-Pilot requests more versatile
by enabling bots to process files rather than requiring users to upload at request creation.

Process Composer package on page 2545

Building and running bots

Notification for bot import

You are informed through Notifications when you import a bot from the Control Room.
However, this notification is sent only to the user who imported the bot.

Capabilities supporting notifications on page 1967 | Import bots on page 1852

Bulk update of multiple packages to default version for multiple bots (Service Cloud
case ID: 00712719, 00728499, 00737694, 00803673, 01255722, 00838604, 00772147,
01760236, 01762679, 01771416, 01761859, 01782588, 01778220, 01784255, 01789551,
01809167, 01818690, 01831969, 01813413, 01287311, 01923711, 01927867, 01945464,
01946912, 01819540, 01945315)

You can update multiple packages to default version for multiple bots. This feature enables
you to update multiple package versions across all available bots with one action thereby
increasing the efficiency of a bulk package update. Additionally, you can review the bots
and dependencies before a bulk update.

Updating package versions on page 1728 | Update bots to default package version on
page 1730 | Example of updating default package version across bots on page 2845

© 2023 Automation Anywhere. All rights reserved. 67



product-flagshipAutomation Anywhere - Release Notes

Building and running bots

Enhancements to code analysis

e You can access the new administration settings tab for policy management. The enable
or disable functionality of code analysis has been moved from Administration >
Policies to Administration > Settings > Policies.

* You can define multiple named policies with different rules that have different severity
levels.

*  You can apply different policies to different folders in the Automation page. When
you run code analysis on a file, it uses the applicable policy for the folder (assigned or
inherited) where the file is located.

Code analysis policy management on page 1943 | Configure and assign code analysis
policy on page 1951

Notifications integration in embedded automations

Notifications in embedded automations (such as Workday, Salesforce) provide you
information about automations initiated from these applications and remote bot
executions. It enhances the user experience by notifying you about the remote
bot executions in their respective applications, thereby increasing the notifications
effectiveness.

Capabilities supporting notifications on page 1967

Enhanced Automation Command Centre home page

The Automation Command Center (ACC) home page provides comprehensive visibility,
actionable insight, and oversight capability into all aspects of your automation domain.
The ACC home page provides operational insights such as automation and device status,
license utilization information, and code analysis policy compliance metrics.

This enhanced home page provides the following benefits and capabilities:
« Effective monitoring of the automation landscape, leading to:
e Improved reliability

« Improved utilization

e Ensures compliance by highlighting results of code analysis
* Helps Coks scale efficiently and achieve automation success

« Easier navigation to other areas such as Automation Co-Pilot, CoE Manager, and Bot
Insight

Automation Command Center on page 1858

APIs and integrations

Export repository bots by version or label (Service Cloud case ID: 01805699, 01838251)

Use the new POST /v2/blm/export/version APl to export repository bots by
specifying the label or version of the files. These bots are exported to an archived file.

BLM API

© 2023 Automation Anywhere. All rights reserved. 68


blm-api.html

product-flagshipAutomation Anywhere - Release Notes

APIs and integrations

Process composer APIs

Use the Process Composer APIs to create a new request from AARI processes. You can
also retrieve the initial form and request by specifying the reference ID. You can use the
following endpoints in the process composer APIs:

e /requests/create: Create a new AARI request.
e /requests/ref/{refId}: Retrieve a request.
e /processes/{id}/form: Retrieve initial form.

Process Composer API

What's changed

Control Room, devices, and Bot Agent

Improved secure registration for Community Edition or Automation 360 users

When a user registers for the Community Edition or Automation 360 account, the
reqgistration email sent to the user contains a temporary registration link used to create
the user credentials. This registration method is more secure than sending the user their
password in plain text.

Licenses page enhancements

To provide easy access to license usage and availability, the Licenses page includes
information for the following elements:

* License mode

« Control Room expiration date and time

« Date when the Licenses page was last updated
» List of products with license availability

* License total details and where used

Manage licenses on page 1622

Upgrade changes in code analysis policy from Automation 360 v.28 or later versions

If you have configured a policy for code analysis prior to upgrading to Automation 360
v.28, this policy is migrated to Automation 360 v.28 and is named default policy. This policy
is applied to the Automation root folder and is applicable for all bots prior to Automation
360 v.28 release.

Upgrade changes in code analysis policy for Automation 360 v.28 or later versions on page
1954
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Active Directory enhancements for configuring domains (Service Cloud case ID: 00733422,
01853744, 01862164, 01794663)

The following enhancements were made for administrators who configure domains for
Active Directory (AD):

» The Control Room login and the Create user pages automatically select the default
domain that is configured. You can select a different domain by either entering the
letters of the domain or selecting the domain from the drop-down list.

» You can configure the domains listed on the Control Room login, the Create user, and
the Create an Active Directory role mappings pages to hide domains.

Create an Active Directory user on page 1581 | Configure Control Room for Active
Directory: manual mode on page 1220 | Manage domain on page 1650

Support for multiple roles in Active Directory role mappings (Service Cloud case ID:
01133364, 01133364, 01929400, 01776684)

When you create multiple Active Directory (AD) role mappings for multiple security groups,
the roles used in the mappings are combined for the users who belong to the security
groups.

Manage Active Directory role mapping on page 1614

Users who have an Attended Bot Runner license can no longer add Bot deployments to a
queue. However, there are no changes for triggers.

As part of the OpenSearch service adoption, when you upgrade nodes in a cluster setup,
you must perform a workaround to fix an installation issue.

Note: This behaviour is applicable to all the customers who are on the Elasticsearch muilti-
node cluster and are upgrading to the OpenSearch cluster.

Upgrade nodes in a cluster setup on page 1116

To accommodate multiple package updates, the /v2/repository/files/
packageVersionUpdate APl name was modified to /v2/repository/files/
packagesVersionUpdate from the v.28 version. The change in file name will

be reflected in Swagger from the v.29 version. The /v2/repository/files/
packageVersionUpdate APl will no longer work and will instead show a flag disable
message.

Automatically deploy event triggers (Service Cloud case ID: 00758775, 01754312,
01754887, 01803179, 01844357, 01845563, 01568082, 01866287, 01920491, 01951355,
01957771)

You can use the Automatically deploy to unattended Bot Runners option when you add
an event trigger to automatically deploy triggers. When you reboot your system or Bot
Agent, this option will continue the trigger deployment with the current user.

Packages, actions, and Bot editor

The name of the AARI Web package has been changed to Process Composer.
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Build 17566: This build includes the following fixes (along with fixes from the previous builds):

For users (excluding the users who are assigned the AAE_Admin role) who do not have any
license assigned to them (Bot Creator, UnattendedBot Runner, Attended Bot Runner, or
Citizen Developer), the Audit log page no longer displays unsuccessful entries related to
the Default device set event for any activity performed by the users on the Control Room.

Previously, multiple unsuccessful entries were displayed for such users.

Service Cloud case ID: 01969726, 01970583, 01970990, 01971435, 01971171, 01970869,
01971854, 01970915, 01970523, 01971411, 01971788, 01971827, 01971482, 01971736,
01970333, 01972128, 01970497, 01972025, 01971459, 01971561, 01971068, 01972148,
01975216, 01975980, 01977479

When you check-in or check-out a bot, the automation page loads successfully without
any delay. Also, there is no impact on the bot create and commit process.

Previously, the automaton page was not loading during bot check-in and check-out due to
database connection. This behavior caused poor user experience and impact on the bot
create and commit process.

Service Cloud case ID: 01963796, 01959945

Build 17542: This build includes the following fixes (along with fixes from the previous builds):

When you check out a bot that contains metadata in actions (for example, Image
Recognition, Recorder, or Screen Capture), you no longer encounter an error and a
broken image. As a result, the image preview of bots renders properly.

Previously, in such cases, image preview failed and generated an error. As as result, you
were not able to check out, copy, or clone the bot.

Service Cloud case |ID: 01971324, 01972601, 01977090, 01976820, 01976757, 01976571,
01976597, 01976629, 01977130, 01976845, 01977497, 01976639, 01977546, 01976736,
01977054, 01977392, 01978707, 01978097, 01969070, 01976549, 01978951, 01978955,
01979180, 01977511, 01979014, 01979687, 01979741, 01975299, 01980410, 01980114

Build 17533: This build includes the following fixes (along with fixes from the previous builds):

Bot export now completes successfully when you export a bot containing actions that
store an image, such as actions from Recorder, Image Recognition, or Screen package.

Previously, bot export failed when it contained actions that stored an image, and the export
error was displayed in the audit log and the historical activity page.

Control Room now sends email notifications when a scheduled bot fails prior to its
execution for example, when the Bot Runner machine is not available.

Service Cloud case ID: 01768120
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The Schedule column on the Scheduled activity page shows the frequency of a
scheduled bot in your local language.

Previously, the frequency of a scheduled bot was not translated and not shown in the
user's local language, for example, Japanese.

Service Cloud case ID: 01936850

When you restart the Control Room services and execute a bot, the bot deployment no
longer fails on the connected devices nor generates an error on the In progress and Audit
log pages.

Previously, the AtmosphereResource Cancelled error displayed on the In progress
page and the error was registered on the Audit log page.

Service Cloud case ID: 01937388

You no longer see duplicate deployments (current and previous) for the same device on
the In Progress page.

Previously, duplicate deployments were displayed.
Service Cloud case ID: 01954716

On the In progress activity page, the Activity type column displays the correct bot activity
type.

Previously, the column displayed inconsistent activity types.
Service Cloud case ID: 01958801

When you create a locker, the Create locker page displays tabs such as Credentials,
Owners, Managers, and so on.

Previously, tabs were not displayed.
Service Cloud case ID: 01949499

Attended Bot Runner users can view the Schedule bot menu on the following pages:

+ Automation (Run bot > Schedule bot)
* In progress activity

* Scheduled activity

» Devices

* Device pools

Previously, this menu was not displayed on these pages.
Service Cloud case ID: 01085127, 01805063

You can run bots in Debug mode even when the data table variables contain a large
amount of data (up to 3 MB for a single data table variable that is being watched only).
Previously, the browser stopped responding.

Service Cloud case ID: 01949707, 01955034
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The query parameters URLs are now parsed even with empty values, resulting in the API
server executing them successfully.

Previously, an exception error occurred in such cases.

Service Cloud case ID: 01903082

If you deploy a task with a Bot Runner that has a disconnected default device and no
device pool is selected, an error message displays in your local language.

Previously, an error message displayed in English even when the user's local language (for
example, Japanese) was selected.

Service Cloud case ID: 01919213

The Bot Runner device will unregister from the Control Room only if there is a valid
authentication error.

Previously, during the Bot Runner authentication, the device was unregistered from the
Control Room after two unsuccessful authentication attempts. The reason for the error
could be due to a valid unsuccessful authentication attempt or any other error.

Service Cloud case ID: 01947943, 01946249, 01956026, 01945438

When a bot is deployed with multiple run-as users and if one or more devices disconnect
from the Control Room during the bot execution, reconciliation of reconnecting devices
no longer triggers the NonUniqueResultException error.

Previously, when you select X number of run-as users (where X > 1), the query returned
X number of entries from the table, which results in the NonUniqueResultException
error. As a result, reconciliation failed and also the bot execution was terminated.

You no longer encounter issues when you create a bot using the DLL Open and Close
actions and then use the If > DUl session exists condition to check whether a DLL session
is closed in a bot.

Previously when you used the If > Dll session exists condition, it failed to check a closed
DLL session and displayed an error.

Service Cloud case ID: 01868691

When you use the Get node value to retrieve the JSON object in the JSON package, it
returns the JSON value in the correct format.

Previously, the Get node value action displayed the output in the wrong format.
Service Cloud case ID: 01864551

You can use the Connect action to establish a connection with the FTP/SFTP server with
keyfile authentication and automate a task.

Previously, the bot could not automate the FTP/SFTP operations if the SFTP keyfile server
was installed on a Windows machine.

Service Cloud case ID: 01858323

You no longer encounter any errors when you create a bot using the Create workbook
action from the Google Sheets package.

Service Cloud case ID: 01918952
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When you use the Connect action in the Active Directory package, you can select objects
in the Object Explorer window successfully.

Previously, an error was displayed when you selected objects in the Object Explorer
window.

Service Cloud case ID: 01925109

In the Email package, you can use the Email > Send action to send an email without
issues.

Previously, when you used Email package version 3.14.3-20220923-220748 or later,
an issue occurred when using the Email > Send action.

Service Cloud case |D: 01912097, 01931592, 01934137, 01940215, 01932494, 01942202,
01942055, 01946339, 01949164

You can create bots using the Run stored procedure action of the Database package even
when you include a large amount of data as an Input parameter.

When you use the Connect action of the Terminal Emulator package with the prompt
value and then the Wait action, the Wait action waits for the prompt value to appear on
the terminal screen.

When a new package (first version) is added to the Control Room and you select Disable
setting for the new version of the package, the package will show the status as Disabled.

Previously, it showed the status as Enabled and set as default.

In the Datetime > Add action, you can now specify a fraction value in the Time value to
add field to increase the value in the Datetime variable by that specific fraction value.

When you use any browser action to automate a browser window or a tab, and run the
bot, the browser action now waits for the time specified in the Time out after field to
execute action on the browser tab before the bot fails. Previously, the browser action failed
after 30 seconds when the bot did not execute successfully, regardless of the wait time set
in the Time out after field was less than or greater than 30 seconds.

Note:

e As aresult of this fix, if the Time out after field has a value other than 30 seconds, you
might have to change the value for your existing bots. This will ensure that your bots
continue to run properly with the latest Browser package.

e This fix does not apply for the Find broken links action.

Service Cloud case ID: 01880159
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When you perform the following sequence of actions and then rename the variable that
was used in these actions, the name of the variable will now be updated for the Group
conditions and the conditions in the Condition tab:

e Use the If package

« Add a specific condition with a variable
* Add a specific condition with a variable
* Save the bot.

In the Datetime > Subtract action you can now specify a fraction value in the Time unit
to subtract field to decrease the value in the Datetime variable by a specific time value and
unit.

When you use the Capture action with the Recorder package (version 2.9.x or earlier) to
navigate to another web page in the Google Chrome browser (version 105.0 or later), and
then use another Capture action to automate objects in the navigated web page, the bot
no longer encounters an error.

In any package, when you select the Add argument option, select String or Number as
the Argument type, and try to insert a value, you can now use the mouse to scroll or click
the scroll bar to navigate through the options.

When you use multiple Recorder actions in a bot to automate a specific web page running
in Microsoft Edge with [E mode, and then run the bot, the second Recorder action now
works properly, and the bot no longer encounters an error.

Service Cloud case |ID: 01848824, 01868337

You can now use the Folder > Unzip action to extract compressed files and folders from
an AES-256 encrypted zip file.

Service Cloud case ID: 01854767

When you try to automate web applications, the Click action in the Recorder now works
properly with the MV3 extension on Google Chrome and Microsoft Edge browsers.
Previously, when the object on a web page contained inline JavaScripts and the document
to be automated was secured, the Recorder failed to perform the Click action.

Service Cloud case ID: 01927058, 01951022

When you use the Click action in the Recorder to automate applications running on
Microsoft Edge with [E mode, the bots now time out automatically and no longer freeze
when a pop-up appears during bot execution.

Service Cloud case ID: 01790352

When you assign a Production label to a Task Bot and deploy it, the bot no longer
encounters an error at the Image Recognition > Find window in window action and runs
successfully.

Service Cloud case ID: 01825541
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When you use the Recorder package (version 2.10.2 or later) to capture a control on a web
page, select Currently active window from the Application tab and then run the bot in

a loop, the bot now captures the target control accurately and runs through all the loop
iterations successfully even if the control appears behind the bot runtime window.

Service Cloud case ID: 01904537

When you use any of the following actions to determine if a window does not exist, select
the web page opened in the Google Chrome browser from the list of active tabs in the
Browser tab, and then run the bot, the following actions now wait for the specified time
value to close the browser tabs before the bot fails.

«  Window does not exist condition in the If and Loop packages

*  Window with same title does not exist condition in the If and Loop packages

+  Window does not exist condition in the Wait > Wait for condition action

«  Window with same title does not exist condition in the Wait > Wait for condition
action

«  Wait > Wait for window action

Note: When you run the bot, the actions might wait for an additional two to three seconds
later than the specified time out value to execute actions before the bot fails.

Service Cloud case ID: 00790336, 00822573, 00832864, 01268577, 01586174, 00790336,
01778857, 01804828, 01809565, 01791209, 01848262, 01867832, 01877740, 01959172,
01959278

When you create or delete a folder (or form) that contains .. characters in the folder (or
form) name, the folder structure no longer affected.

Previously, when you deleted a folder (or form) that contained . . characters in its name,
the parent folder was deleted which caused issues with the folder structure.

Service Cloud case ID: 01886058

The resiliency of the File/Folder trigger has been improved to continue listening after a
network disruption has occurred. Previously, a network error caused the trigger to lose
connection with the Bot Agent.

Service Cloud case ID: 01769532, 01773584, 01834098, 01867418

When you check in a bot that contains the string "bot " in its name and some recorder
metadata, the metadata is no longer deleted. As a result, you can check out a bot without
generating an exception or error message.

Previously, the recorder metadata was deleted and you were blocked from making
recorder changes to any of the bots that contain "bot " in its name. The bot checkout
failed and generated an exception or error message.

Service Cloud case ID: 01915726, 01933409, 01939124, 01944665, 01939124

When you upgrade the Control Room to Automation 360 v.27, the work items are
deployed successfully for all scenarios.

Previously, when you upgraded the Control Room to Automation 360 v.27, the work item
failed to deploy when gueues were paused or stopped.

Service Cloud case ID: 01948038, 01950948
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When you run a bot with a queue and select the queue category, the task bot (that
contains a TABLE type variable and no row data) no longer fails and shows the Missing
work item template error message.

Previously, when there was no row content for a TABLE type variable, you could not select
the queue category while running a bot with a queue. As a result, the Missing work
item template error message was shown even if a template was mapped.

Service Cloud case ID: 01922641

When you import a BLM package (zip file) to the Control Room, the Automation Anywhere
Control Room Messaging service restarts and you no longer get an error message.
Additionally, the bot import and export operations complete successfully.

Previously, when the ActiveMQ broker service is stopped, the broker is stopped

but the process did not exit due to which the Automation Anywhere Control Room
Messaging service was not restarted. As a result, when you import a BLM package, the
JMSExpection: failover time 5000ms exceeded error was displayed.

Service Cloud case ID: 01924119

When you compare bot versions from the View history Task Bot page in the public
workspace, the Compare versions displays any modifications made in the latest two
versions of your bot without any error.

Previously, an error was displayed if you used the Compare versions feature through the
View history Task Bot page.

Service Cloud case ID: 01949094, 01946533

After you update the Bot Agent to the 21.240.19897 version, you can deploy multiple bots
using the APl without any failure caused by the AA-DB file size.

Previously, when you deployed multiple bots using the APl the AA-DB.mv.db and AA-
DB.trace.db file sizes continued to increase and eventually caused the bots to fail.
Additionally, the device configuration refresh initiated message continuously displayed.

Service Cloud case ID: 01776544

The following issues were fixed on the In progress activity page:

* Active bot deployments no longer disappear after a page refresh.
* Duplicate bot entries were removed whose status was displayed as active.

Service Cloud case ID: 01937581

Variables that you configure as input type are encrypted in the log files generated for
Control Room.

Previously, input type variables were not encrypted and displayed as plain text in the log
files.

Service Cloud case ID: 01768904
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Users can only view activities to which they have permission on the Activity > In progress
page.

Previously, some users were able to view the activities of other users even though they did
not have permission.

Service Cloud case ID: 01839276, 01919244, 01940793, 01941503

In attended and unattended automation, if a bot fails to run and generates the "Node
Manager went Down unexpectedly and could not complete this bot execution.” error, the
start time on the Historical and Audit log pages display correctly.

Previously, the start time was displayed incorrectly.
Service Cloud case ID: 01881736

All users can view the scheduled activities on the Scheduled activity page.
Previously, some users were unable to view the scheduled activities.
Service Cloud case ID: 01885890, 01848429

The Control Room Access URL length is set to a maximum of 4,000 characters.
Previously, the URL length was not set.
Service Cloud case ID: 01923035

Sorting users using the Last login option on the Users page sorts users correctly.
Previously, sorting users by last login was not sorting the users correctly.
Service Cloud case ID: 01813134

If you created a bot using the REST APl command, the REST GET command is parsed
without any errors even when the response body is empty.

Service Cloud case ID: 01922332

Japanese characters are supported in the REST APl commands with the multipart/form-
data option and the output PDF name is rendered correctly.

Service Cloud case ID: 01909753

All files in the specified OneDrive location are downloaded successfully when you use the
Download file action from the Microsoft 365 OneDrive package.

Service Cloud case ID: 01886501

If you selected the Read cell value option in the Read row action of the Excel advanced
package, the data from the next sheet of the specified Excel file is extracted correctly using
the Switch to sheet action.

Service Cloud case ID: 01904504

If a bot contains Get multiple cells or Get single cell action from the Excel advanced
package to retrieve the underlying scientific values, the values from the specified Excel file
are successfully extracted when you run this bot.

Service Cloud case ID: 01882225, 01938812
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Exception errors are no longer displayed for the following actions in the Excel advanced
package:

* Getsingle cell

* Getcell color

e Get multiple cell

*  Get number of cells

* Get worksheet as data table
* Insert/Delete rows/columns
* Read cell formula

 Read column

* Read row

* Remove blank row

*« Rename worksheet

* Replace

» Select cells/rows/columns
e Setcall

* Switch to sheet

* Close

Service Cloud case ID: 01780178, 01926325

If there are many (more than 500) bots deployed in one of the device when there are
multiple devices connected to a Control Room, bot deployments across other devices are
no longer blocked.

Service Cloud case |D: 01791784, 01950118, 01904686, 01795862, 01945357, 01941048

If you create a folder with the same name as an existing folder in the private workspace, an
error message is now displayed, and the folder is not created.

Previously, a false successful folder creation message was displayed, but the last modified
date of that particular folder remained the same as that of the previously existing folder.

When you create, view, or edit roles and then navigate to the Bots section, the folder list is
sorted alphabetically making it easier to find a specific folder.

Previously, the folders were not sorted alphabetically, and it was difficult to find a particular
folder when there were many folders in the repository.

Service Cloud case ID: 01762755, 01843015, 01874823

When you import a bot using the overwrite option and do not have permission to access
one or more dependent folders, the import dependency is not broken because of the
import failure on the dependent folder.

Previously, importing the bot when you had no permission to access the dependent folder
resulted in a break in the dependency if the file or folder was already present.

Service Cloud case ID: 01929592, 01946078
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When you import a bot that has more than 2,100 manual dependencies, the import is
successful without any issues.

Previously, the bot import failed when the bot contained more than 2,100 manual
dependencies. You had to reduce the number of dependencies to import the bot
successfully.

Service Cloud case ID: 01913648, 01942373

The group Managed Service Account (gMSA) provides functionalities such as install, update
and perform LDAP authentication within a domain, and also extends those functionalities
across multiple servers.

When you update Automation 360 to the v.28 release, the Elasticsearch service is replaced
with OpenSearch service as the underlying technology for core product capabilities such
as audit, Bot Insight, and so on.

Automation 360 for auto-login and RDP-based deployment supports the user name in the
User Principal Name (UPN) format (username@domain.com).

Service Cloud Case ID: 01816116, 01906692

An error no longer displays when you click your trigger in the event trigger page.

You no longer encounter random bot deployment issues in the Bot editor.

Previously, during bot deployment, the LockAcquisitionException error was observed
randomly, and the bot execution status remained as Pending execution in the In progress
activity tab. As a result, the user had to retry deployment for it to succeed.

Limitations

Bots that are in the Queued status do not appear automatically on the In progress activity
page.

Workaround: Click the Refresh table button on the top-right corner of the Activity table to
view the queued bots.

For users (excluding the users who are assigned the AAE_Admin role) who do not have any
license assigned to them (Bot Creator, UnattendedBot Runner, Attended Bot Runner, or
Citizen Developer), the Audit log page displays multiple unsuccessful entries related to the
Default device set event for any activity performed by the users on the Control Room.

Workaround: See A360.28 On-Prem & Cloud | After upgrading to A360.28, multiple events
are getting created in Audit logs ‘Default device set Unsuccessful'.

Service Cloud case ID: 01969726, 01970583, 01970990, 01971435, 01971171, 01970869,
01971854, 01970915, 01970523, 01971411, 01971788, 01971827, 01971482, 01971736,
01970333, 01972128, 01970497, 01972025, 01971459, 01971561, 01971068, 01972148,
01975216, 01975980, 01977479

© 2023 Automation Anywhere. All rights reserved. 80


https://apeople.automationanywhere.com/s/article/A360-28-On-Prem-Cloud-After-upgrading-to-A360-28-multiple-events-is-getting-created-in-Audit-logs-Default-device-set-Unsuccessful
https://apeople.automationanywhere.com/s/article/A360-28-On-Prem-Cloud-After-upgrading-to-A360-28-multiple-events-is-getting-created-in-Audit-logs-Default-device-set-Unsuccessful

product-flagshipAutomation Anywhere - Release Notes

(Service Cloud case ID: 01833352)

When you want to move emails from one folder to another, and if you apply multiple
filters such as Subject, From specific sender, When received date is on or after,

or When received date is before, you cannot move an email when its sender id is:
noreply@**.com.

Note: You might observe this issue when you use Save All attachments, Delete All, Move
All, and Loop actions.

Workaround: Use only the From specific sender filter to move emails.

The Create User audit log entry page shows a valid device license even when the license
allocation for a user had failed.

In a clustered environment, when you update bots to the default package versions, the
Bot update list page shows Failed status and bots are auto-checked out even if they are
updated with the latest default packages.

In an Oracle environment, the Bot update list page shows an Code:
db.connection.exception error message.

Workaround:
1. Loginasan administrator.

2. Navigate to Manage > Packages and set the required package version as the default
version.

3. Loginas a Bot Creator, and then check out and edit the bot.
4. In the Bot editor, click the three vertical ellipses at the top right corner.

5. Select required Packages and update the package version manually.

While updating bots to the default package version, when you select the Production label
bots, the package update is applied for the latest version of bots instead of the Production
label bots.

When you check out and edit a bot after the bot updates to the default package version,
an error is displayed in the System Date for these commands: SystemsDate, REST Web
Service, and Number.

Workaround:
1. Edit the bot and navigate to Manage > Packages.

2. Setthe Date and Time for the non-default package, and then set it back to the default
Date and Time.

Note:

» |f previous version of the package does not exist, then upload the package and
assign the default Date and Time.

» |f previous version of package is available, then edit the bot, assign it to the previous
package and save. Then, re-assign the bot to the new default package.
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When a user (who created the workload automation) is deleted, work items are not
processed even if they are available to process. As a result, you must delete and re-create
the automation.

If you select the Search type as Variable name in the Search and replace feature, the
content is not replaced when you use a number variable in the expression.

Workaround: To replace a specific variable in a number expression, open that action and
change the variable manually.

(Service Cloud Case ID: 01950021)

If Auto update is enabled for the Bot Agent in Control Room, registered devices running
Windows10 Enterprise might restart intermittently after the Bot Agent update has
completed.

Bot deployments might fail if the Log collector and Sync log collector options are enabled
while updating Automation 360 to v.28.

Workaround: Before updating Automation 360 to v.28 from any of the previous versions
(such as v.25), ensure that the Log collector option within Administration > Settings

> Devices > Advanced options and Sync log collector option within Administration >
Settings > Devices > Log collection configuration are disabled.

Note: For information on resolving bot deployment issues caused when the Log collector
or Sync log collector options were enabled while updating Automation 360 to v.28
release, see .Troubleshoot bot deployment issue caused if Log collector is enabled (A-
People login required)

API Task is a beta feature in the v.28 release and is designed for Automation 360 cloud
deployments only.

However, after you upgrade your On-Premises deployment to v.28, users with a Bot
Creator license can create an APl Task and users with either Device pool owner or Device
pool admin permission can create an API Device pool. But you will not be able to execute
the API Tasks. In an upcoming update, the API Task feature will be fully turned off on On-
Premises deployments and will be available only on the upcoming Automation 360 cloud
deployments.

Bot export fails when you export a bot that contains actions that store an image, such as
actions from Recorder, Image Recognition, or Screen package. You can view the export
error in the audit log and the historical activity page.

Workaround: Contact Automation Anywhere Support.

Limitations from previous releases

While running a bot in debug mode, the bot will fail if the variable size gets greater than 3
MB. An error message appears showing that a variable has exceeded the 3 MB limit.

When you create a device pool with a temporary (disconnected) device, the device
deletion job does not complete successfully. Additionally, the Audit log page shows the
device is deleted, whereas the Device list page shows the deleted device in the list.
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Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation.

Deprecated weaker Transport Layer Security protocols: TLS 1.0 and TLS 1.1

Automation Anywhere has deprecated weaker communication protocols TLS 1.0 and TLS
1.1, and their corresponding ciphers (Cryptographic algorithms) in Automation 360 Cloud
deployments (AWS and GCP). Automation 360 Cloud deployments support TLS 1.2 and
later versions only.

Feature deprecations affecting Automation Anywhere products on page 947

Manifest V2 extensions for Google Chrome and Microsoft Edge

From Automation 360 v.26 and later releases, we have published new Google Chrome and
Microsoft Edge Manifest V3 extensions. Starting on October 23, 2023, we will deprecate
support for Manifest V2 extensions on Automation 360 v.26 and later releases. After

this date, we will not address any issues relating to Manifest v2 extensions. If you are on
Automation 360 v.26 or a later release and still using Manifest V2 extensions for Google
Chrome and Microsoft Edge, we recommend that you upgrade your Google Chrome and
Microsoft Edge browser extensions to Manifest V3 extensions before October 23, 2023.

Note: If you are on Automation 360 v.25 or earlier releases, then you will not be impacted.

Updates to the interface

Review the updates to the interface in this release.

See the following video for the updates made to the interface for Automation 360 v.28 release:

The Enter property set to your CyberArk username option is introduced on the Service
Credentials page to configure usernames using the CyberArk secret response.

Configure username for different Automation 360 services using the CyberArk secret
response

You can import intermediate certificates when installing Control Room On-Premises.

Import intermediate certificates for secure access to Control Room

The Control Room Service Startup Options page is introduced when installing the
Automation 360 Control Room to select the services to run at Control Room startup.

Select the Control Room services to run at startup

The bot updates to default package version functionality is enhanced and moved from
Manage > Packages to Administration > Bot update page.

Bulk update of multiple packages to default version for multiple bots
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The Allow users to control notifications settings option is added to control and lock the
user preferences for notifications.

Improved notifications administration to manage user access

The Process events notifications category is introduced to monitor Automation Co-Pilot
events.

Monitor Automation Co-Pilot events through Control Room notifications

A check box is added to clear the existing default device for the logged-in Bot Creator,
attended Bot Runner, or Citizen DeveloperCitizen developer users.

Validate remote deployments to avoid unauthorized device access

Updated and intuitive icons for all the actions and contextual help for various actions within
packages. For example, contextual help is available for all the actions within the Excel
advanced package.

Enhanced user experience through refreshed and intuitive icons

The enable or disable functionality of code analysis is moved from Administration >
Policies to Administration > Settings > Policies.

Enhancements to code analysis

The visual indicator line marker for the collapsible section helps you see where in the bot
you are and editing.

Line markers for collapsible sections of the code in the Bot editor

We provide implicit preference to retain the default view in the Bot editor, and the system
will display the same view upon your subsequent login.

Default view in the Bot editor

You can now copy, cut, and paste the entire node in the Process Composer. These actions
apply to all properties and attributes of the node, including child and branch elements.

Copy, cut, and paste actions

The Process Composer supports Global Values in variables.

Global values as variable

Updating to v.28 release

Review requirements and support information about updating your Control Room and Bot Agent
for the v.28 release.

Bot Agent updates

Note: This release includes an optional Bot Agent update. You can continue to run your existing
bots without updating the Bot Agent. However, if you want to use the new features in Automation
360 v.28, you must update the Bot Agent available with this release.

For more information on updating to this release, see these resources:
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« Automatically update the Bot Agent on page 1207 | Manually update the Bot Agent on page
1209

« Compatibility with release builds on page 1182

Certified Control Room builds for direct update

You can update to the latest version of Automation 360 from the previous three releases (that is,
from n—3 releases, where n refers to the latest release).

The following previous releases are certified for update to Automation 360 v.28:

e V.27 (Build 16685, 16667)
e V.26 (Build 15450, 15459, 15439, 15436)
e v.25 (Build 15112, 15118, 15097)

If you are on one of these previous releases, for information about updating, see Update
Automation 360 to latest version on page 1266. If you are not on an n-3 release, update
Automation 360 to one of the n—-3 releases before updating to Automation 360 v.28.

Important: Before you update to Automation 360 v.28 On-Premises from any of the earlier
versions, review the following article: Automation 360 On-Premise Edition | A360.28 — Upgrade
Considerations (A-People login required). This article is applicable only to On-Premises customers
who started using Automation 360 from v.15 or previous versions. To successfully update to
Automation 360 v.28, you must perform the pre-upgrade steps in the KB article.

Packages updated inv.28

Review updates to the packages in Automation 360 v.28, including the compatible Control Room
and Bot Agent versions.

The following table lists the updates in the packages for this release:

Note: For information about packages related to previous releases, see the PDFs for these
releases: Automation 360 previous release versions.

Baditage

Apdwbes

version
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Oirectory
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© 2023 Automation Anywhere. All rights reserved. 87



product-flagshipAutomation Anywhere - Release Notes

HBadiinge
Bpdwbes

version

Bipp@o4r221222-050025
an

lsgee

related

to

data

logging

at

debug

level

Bifidtnent
ortuitive
Eekage
icon

Bigg@er0izd0104-151556
an

later

related

to

renaming

of

an

attribute

(no

impact

to
existing#bots#on
upgrade)

Badfder 0221229-045349
DKUitive

ekage

icon

LA
el s,

e 30104-151847

K2k

Or feature

Lat%efect
fix

o Defect
fix
1

BlEA| 20230106-071425
tedlee
later

© 2023 Automation Anywhere. All rights reserved. 88



product-flagshipAutomation Anywhere - Release Notes

HBadiinge
Bpdwbes

version

BaRSHR{E1 30104-114826
Or fix
later
o Defect
fix
2

Bigad 2 0230104-151127
on

lstere

related

to

renaming

of

an

attribute

(no

impact

to
existing#bots#on
upgrade)

Baghaers0104-114813
gmaming

tatter

an

attribute

(no

impact

to

existing#bots#on
upgrade)

BEE280230103-110720
Or fix
later
o Defect
fix
2

BiRBE hent
extraction
later

BBRD:20230106-082520

Or feature

Lat%efect
fix

© 2023 Automation Anywhere. All rights reserved. 89



product-flagshipAutomation Anywhere - Release Notes

Eeatitage

Bpdwbes

version
BE@ARY0230106-091325
onytEes

later
Bafi®@420230106-100001
maodies

[ekage
icon

BiRP:20221221-171419
evanced
later

§-20201221-171419

documentation
added

FEA30105-072958

documentation
added

REHR20221014-182105
end
taberer

B@E=P 0221227-142432
ox
later

BB 0221223-132614
kTP
later

PRRB 5
Or available
latety,
API
as
a
service
» Security
updates

BB 0221230-040440
Opdtear
later

© 2023 Automation Anywhere. All rights reserved. 90



product-flagshipAutomation Anywhere - Release Notes

HBadiinge
Bpdwbes

version

BafiiR0221230-041416
Opdetes
later

PRERPSO220616-091303
Brecument
faltererabilities

reported

in

the

security

scan

BBy R0220416-235104
or

Gee
BigBR20221230-041629

Bheets
later

NABe20220715-220729
key

BERR20230106-055132
Grature
later

#HABC 0230106-082442
Becognition
later

BiEdRRe802 30105-100123

aorms

Latqfixed
parsing
issues
with
binary
data

e Fixed
security
vulnerability
issues

R@EiE20230106-195659
orgger
later

© 2023 Automation Anywhere. All rights reserved. 91



product-flagshipAutomation Anywhere - Release Notes

HBadiinge
Bpdwbes

version

}20221219-065939

RIS
Bt
latkererabilities
reported

in

the

security

scan

RBR?0221219-065852
Bt

(atEgsifadilities

reported

in

the

security

scan

2 0221219-065610

Bierezabilities
EPCHSEDr

in

the

security

scan

3B&EFDR(21229-051614
opdates
later

latererability
issues

PB@AE§0221219-144922
BfSense

keunrity

vulnerability

issue

© 2023 Automation Anywhere. All rights reserved. 92



product-flagshipAutomation Anywhere - Release Notes
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Migration updates for v.28 release

Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10
versions to Automation 360 v.28.

What's changed

Migration of new formatting capabilities in the XML package (Service Cloud case ID:
01886455, 01925386)

*  When you migrate bots from Enterprise 11 to Automation 360 that are using the Start
session action, the Remove text nodes that contain only white space check box is
selected by default.

*  When you migrate bots from Enterprise 11 to Automation 360 that are using the Save
session data action, the Use Prettyprint check box is selected by default.

Start session action in XML on page 2795 | Save session data action in XML on page 2794

Fixes

You can migrate bots with filenames that contain up to 160 characters, and might use an
action with an encrypted value or Credential Value (CV) type variable.

Previously, these bots failed when migrating to Automation 360.
Service Cloud case ID: 01813733

You can successfully run the migrated bots in the following scenarios:

e If there is more than one xmlns (default XML namespace) defined in the XML document.

» If the root element does not have a namespace and the child element of the XML
package has a default namespace.

Service Cloud case ID: 01798339
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You can migrate the MetaBots that are using Microsoft.Exchange.WebServices.dll
as the dependency DLL, use the Get DLL details option during bot design, and then
execute the DLL Run function action without encountering an error.

Previously, an error was encountered when the
Microsoft.Exchange.WebServices.dll was used a dependency DLL of a bot.

Service Cloud case ID: 01819485, 01857278

You can migrate MetaBots that are using multiple logics without using the overwrite option
even if some of the logics already exist in Automation 360.

Previously, such MetaBots encountered an error during migration.
Service Cloud case ID: 01905986

You can migrate MetaBots which include logic that calls another logic whose file name
includes a dollar sign (S).

Previously, such MetaBots were displaying a review message on the migration results page.

If you set the Set production version permission in Enterprise 11, after migration to
Automation 360, the Label bots permission is selected and replaces the previous Set
production version permission. If you are upgrading from a previous Automation 360
release to v.28 (or later release) and you selected the Set production version permission,
then the Label bots permission is selected as the default.

Service Cloud case ID: 01868097

In Enterprise 11, if a bot is using the String Operation command and includes a backslash (\)
in the Replace string, after migration, the bot executes properly.

Previously, such a bot encountered an error when a backslash (\) was used in the Replace
string.

Note: This fix is currently not available in Automation 360 v.28 and v.29. We plan to
provide a fix in an upcoming release. For more information, contact your CSM.

In Enterprise 11, if a bot was using the Normal, Gray-Scale, or Monochrome comparison
mode in the Image Recognition command, after migration, the performance of the bot run
is improved.

Previously, the performance of such a bot was impacted during a bot run.
Service Cloud case ID: 01889347, 01922609, 01920990

In Enterprise 11, if bots are using the recorder commands, some unused hidden properties
remain in Enterprise 11 only after you migrate to Automation 360.

Previously, some unused hidden properties were migrated.
Service Cloud case ID: 01608928
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You can migrate a bot that contains a Database with a Loop command and run it
successfully in Automation 360.

Previously, when you ran the bot in Automation 360 using the Read from action with
append and UTF-8 encoding with the loop, after the first iteration, the retrieved data would
show a double quote for the first cell value in the CSV file.

Service Cloud case ID: 01911654

When you migrate a bot that contains the XML > Get single node command , after
migration, when you run the bot in Automation 360, it retrieves the value of a single node
and no longer displays an error on execution.

Previously, if the XPath started with open brackets, and you ran the bot in Automation
360, the bot encountered the following error: No node found at XPath while
executing the Get Single node command.

Service Cloud case ID: 01854326

You can migrate bots that are using the If Variable command with the following
conditions:

e Includes multiple Excel Cell variables.
e Includes one or more AND or OR operators for comparison.
* The Excel Cell variables are compared with array type variables.

Previously, such bots failed to migrate.
Service Cloud case ID: 01856986

You can migrate bots that are using commands that include the Session Name field that
contains the year (SyearS) system variable.

Previously, such bots failed to migrate.
Service Cloud case ID: 01867380

When you migrate bots that are using Table type variables and then call those migrated
bots from another Task Bot, the input variables are displayed on the Set input variables
window.

Previously, when migrated bots containing Table type variables were called from another
Task Bot, the input variables did not display.

Service Cloud case ID: 01920824, 01931439, 01945917, 01910787, 01930540, 01923133,
01931439, 01923133, 01934727

You can successfully migrate bots when you provide a clipboard value as a parameter to a
VBScript file without any issues.

Previously, if you provided a clipboard value as a parameter in a bot, the bot migration
failed with an error message indicating there was no proper variable selection for the
clipboard.

© 2023 Automation Anywhere. All rights reserved. 103



product-flagshipAutomation Anywhere - Release Notes

In Automation 360, when you use the SOAP Web Service command in a bot, you
can access the specific XML node from the XPath expression which has a namespace
declaration from the SOAP response.

Previously, XPath expressions containing a namespace could not be parsed.
Service Cloud case ID: 01907999

When you migrate a bot that uses the Send Email command with the HTML option and
run the migrated bot in Automation 360, the output is displayed in the appropriate format.

Previously, if you had used a variable in the HTML code section of the email body and ran
the migrated bot in Automation 360, the code was not converted to HTML format. As a
result, the output was displayed in an incorrect format.

Service Cloud case ID: 01908010

The Review Required count in the Bot Scanner report and Bot Assistant display consistent
information.

Previously, there was inconsistency in the count.
Service Cloud case ID: 01816554, 01856822

Remote agent v.2.2.0 updates

A new version of the Remote agent is released with Automation 360 v.28. This section includes
the fixes for Remote agent version 2.2.0.

Fixes

Improved automation reliability for web applications

When you use the Recorder > Capture action to automate web pages running on Google
Chrome and Microsoft Edge browsers, the Recorder > Capture action no longer scrolls
down the web page if the target object is visible on the screen. This feature improves the
user experience and reliability of automation when there is a fixed top pane on the web
page and if some physical actions such as mouse clicks do not work as expected.

Note: Ensure that you install the browser extension (version 3.0.8.0) and use the Recorder
package (version 2.10.2) to capture the control.

When you use the Recorder package (version 2.10.2 or later) to capture a control on a web
page, select Currently active window from the Application tab and then run the bot in

a loop, the bot now captures the target control accurately and runs through all the loop
iterations successfully even if the control appears behind the bot runtime window.

Service Cloud case ID: 01904537

When you use multiple Recorder actions in a bot to automate a specific web page running
in Microsoft Edge with IE mode, and then run the bot, the second Recorder action now
works properly, and the bot no longer encounters an error.

Service Cloud case ID: 01848824, 01868337
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When you use the Click action in the Recorder to automate applications running on
Microsoft Edge with IE mode, the bots now time out automatically and no longer freeze
when a pop-up appears during bot execution.

Service Cloud case ID: 01790352

When you use the Capture action with the Recorder package (version 2.9.x or earlier) to
navigate to another web page in the Google Chrome browser (version 105.0 or later), and
then use another Capture action to automate objects in the navigated web page, the bot
no longer encounters an error.

CoE Manager v.28 release

Review what's new and changed, and the fixes and limitations in CokE Manager for the v.28
release.

What's new

Access CoE Manager from the Control Room

As an administrator, you can enable access to CoE Manager from the Control Room. This
enhances the user experience because the user no longer needs to open CokE Manager
through a separate browser tab. Once CokE Manager is enabled, users can directly access
the CoE Manager login page from the quick link section on the Control Room home page.

Enable CoE Manager on page 1879

Support for ROI tracking in On-Premises Control Room

You can integrate both the Cloud and the On-Premises Control Room with the CokE
Manager. This enables you to monitor your automations and analyze the savings achieved.
You can connect up to 3 Control Room instances in your CokE Manager.

For the On-Premises Control Room, to upload the bot activity data from the Control Room
to the Cok Manager, download and run the CoE Manager bot available in the Bot Store. To
run this bot, you must have a valid license such as a Bot Creator, Bot Runner, or a Citizen
Developer.

Integrate CokE Manager with On-Premises Control Room on page 1878

What's changed

Plan delivery for your opportunities from the pipeline stage

The Activities tab is available in the pipeline stage enabling you to start the delivery
planning of an opportunity when it moves into the pipeline stage.

Previously, you could plan delivery of an opportunity using the Activities tab only after the
opportunity had moved into the in-progress stage.
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Automation Co-Pilot v.28 release

Review what's new and changed, and the fixes and limitations in Automation Co-Pilot for the v.28
release.

What's new

Enhanced automation experience for Automation Co-Pilot

We have improved the automation experience for your automation activities to run
attended bots:

* As a prerequisite, you must have the Manage my activity permission to use the bot
controls.

« When you run your attended automation, its progress, execution status, and controls
for pause, start (resume), and stop, are located on the new progress page inside the
Automation Co-Pilot application.

e You can easily switch between the Automation tab to execute additional automations
and navigate back to the progress view, to monitor the running automations.

Automation Co-Pilot supported features on page 2878

Platform alerts and notifications

You will be notified with real-time message alerts based on recent automation events that
occurred in Automation Co-Pilot.

* The Notifications tab in the Automation Co-Pilot will alert you of your automation
outcomes (failed, successful) and provide as detailed information for each bot, such as
the start and end times.

« When required, there is a short message describing if any specific issues occured.

* The New task assigned message will notify you if any new tasks were assigned to you,
and you can click that alert message to be redirected to the newly assigned tasks.

« Similarly, if you receive multiple new notifications, you can click the Load New
Notification message, located at the top of the naotification list, to load additional unread
notifications.

Automation Co-Pilot supported features on page 2878

Stationary action buttons

While completing forms in Automation Co-Pilot, action buttons are positioned in the fixed
footer of the form. The footer and its contents are responsive to the size of your window
and adjust to fit buttons and minimize the footprint.

Add Human Task to a process on page 2994
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What's changed

Enhancements to tags

When you configure a process, tag improvements provide a more accurate tag selection
when you look for available tags:

* You can select and manage up to 500 tags at a time, in tag selector.
* Your search results will vary depending on the number of search terms you use with the
most recently created tags always showing at the top.

* You can use the search all tags option to search for all available tags.

Configure a process on page 3031 | Automation Co-Pilot supported features on page
2878

Process level URL parameters

These process level URL improvements make it easier for you to pass URL data to your
requests:

* You can pass custom data from applications to requests.

« Supported data types include: dates, time, number, text box, check box, radio button,
text area, and drop-down.

» Hidden variable types in a form are supported to receive URL data.

Automation Co-Pilot supported features on page 2878

Improved formatting options for Label element

The Label element has been improved with new formatting properties where you can
configure the font sizes, colors, and text alignments in a form.

Using the Label element on page 2930

The name of the Process Editor has been changed to Process Composer to better reflect
its comprehensive capabilities.

Forms have improved responsiveness due to this next generation of form rendering
technology.

Users receive a notification in the Warning tab when a task is assigned or reassigned to
them.

Service Cloud case ID: 01869263

Fixes

Build 17571 (On-Premises) and Build 17557 (Cloud):These builds includes the following fix (along
with fixes from the previous builds):
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When you open a request, that is in an open status, the request page will now render
properly. Previously, when you use a form that contains a table and you pass a data variable
to more than the column numbers that was specified, this caused the form to not render
properly. This issue has been fixed.

Service Cloud case ID: 01970938, 01970524, 01969797, 01973370

When you use a table element in your form which contains a text area data type, the text
area generates data from the database without issues.

Service Cloud case ID: 01905252

In a table cell field, when you enter Chinese, Japanese, and Korean characters, the
characters renders correctly.

Service Cloud case ID: 01914818

When you create a form with a column width that is less than 20% in Automation 360 v.26
and you open the form in the current version, the will now render without issues.

Service Cloud case ID: 01944387

In an Automation Co-Pilot process, when you use the if/else condition, a process error no
longer occurs when you add the else if condition after the if condition.

Service Cloud case ID: 01949808

In Automation Co-Pilot Web forms, the text area size renders as specified. Previously, the
height did not render as designed.

Service Cloud case |D: 01911488, 01910936, 01914476, 01924252, 01929268, 01946479,
01958805, 01961238

When filtering Automation Co-Pilot requests by date, the date displays correctly.
Service Cloud case ID: 01915259

Automation Co-Pilot forms works as expected when adding a new rule to an existing form.
Service Cloud case |D: 01925778

When a required field has not been completed, the process prevents users from submitting
the task.

Service Cloud case |D: 01932933, 01958556

When a parent process in a private folder references a child process in a public folder the
Process Composer alerts the user to the missing dependency with a local error. Previously
a process with this dependency would fail when run, throwing a global error.

Service Cloud case ID: 01849502

In Automation Co-Pilot Desktop Assistant, the last runtime information no longer causes
performance issues.
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Limitations

When you view your bot details in the Historical Activity page, the description for the bot
errors are not populated.

Workaround: To access the description of the bot error, you can access the error log from
the Audit Logs panel.

Service Cloud case ID: 01850454, 01908923

When you use the Search and Replace option to replace a form variable in a bot, the
Search and Replace option does not function properly and cannot locate the form variable.

When using a form with an image, users require the View permission to access the image
and have it render in forms.

In Automation Co-Pilot Desktop Assistant, when you use the Email Automation command
with the email server option and set Google Chrome as the default browser, and you run
your bot, the browser does not open to generate email details. This issue does not occur if
you select a non-interactive mode of authentication.

Updates to the interface

Review the updates to the interface in this release. Use the following video to orient yourself to
these changes.

While completing forms in Automation Co-Pilot, action buttons are positioned in the fixed
footer of the form.

Stationary action buttons

We have improved the automation experience for your automation activities to run
attended bots.

Enhanced automation activities

You will be notified with real-time message alerts based on recent automation events that
occurred Embedded Automation.

Platform alerts and notifications

The Label element has been improved with new formatting properties where you can
configure the font sizes, colors, and text alignments in a form.

Label element
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1Q Bot and Document Automation v.28 release

Review what's new and changed, and the fixes and limitations in IQ Bot and Document
Automation for the v.28 release.

Document Automation

What's new

Standardize the format of extracted numbers and dates

You can configure your learning instances to convert extracted dates and numbers to
a standard format. This ensures consistency and accuracy in your databases and other
systems of record.

For example, if you select to standardize dates to MM/DD/YYYY and a processed document
contains a date that appears as 12 Feb 2023, the learning instance will reformat the date
t0 02/12/2023.

If you select to standardize numbers to the English (United States) locale and a processed
document contains a number that appears as 100, 00, the learning instance will reformat
the number as 100.00.

Create a learning instance in Document Automation on page 3158

The new Document Workspace license tracks consumption for customers who brought
their own license for Google Document Al or Standard Forms.

New Google Document Al features

« Validation feedback is available for new and existing learning instances that use Google
Document Al to extract data.

Improving extraction accuracy through validation on page 3161

Note: You must manually enable validation feedback for existing learning instances

» The invoices document type supports these additional languages: Estonian, French,
German, Latvian, Lithuanian, Portuguese (Continental), Romanian, Spanish, and Swedish.

* The receipts document type supports Japanese language documents and can extract
two new fields: payment type and last four digits of credit card.

New features for the Document Workspace dashboard in Bot Insight

+ Create custom widgets
e TheValidator performance by # of documents validated widget includes
invalid documents.

Document Workspace dashboard on page 3392
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What's changed

Download bots have the highest priority in a queue

To optimize system performance, the Control Room prioritizes running the download
bot of one process before running the extraction bot for another process. Previously, the
system was configured with the extraction bots at equal priority to the download bots,
which created a large queue of extracted data waiting to download.

Note: For users with Control Room environments configured prior to v.28: The Control
Room admin must edit the aari-document-processor custom role to assign the new
Set automation priority to high permission.

Create a custom role for Document Automation on page 3153

Important: New Community Edition users will have access to Document Automation but
not 1Q Bot

As of Automation 360 v.27 release and later, only Document Automation will be
provisioned to new Community Edition users. New users will not have 1Q Bot permissions,
however, 1Q Bot will be available for existing, registered users.

Fixes

When you create a learning instance, the interface allows field names that start with a letter
only. Previously, the interface allowed field names to start with a number, which caused
processing errors.

The Test regular expression field supports a maximum of 100 characters.

You can create a learning instance with custom fields that do not have a field name and
field label, as long as the custom fields are unselected.

Document Automation extracts multiline fields without adding an extra space after each
line.

Document Automation supports document processing on devices configured with an
authenticated or unauthenticated Proxy Auto-Configuration (PAC) file.

The Document Workspace dashboard shows the correct page consumption metrics for
On-Premises Control Room instances.

The "Average validation time" and "Validator performance by number of documents’
widgets show the correct values when you mouse over the data points.

In Document Automation, the correct error message is displayed while fetching a Standard
Forms model that is missing configuration settings. Previously, an incorrect error message
was displayed.

While reconfiguring a table, you can add a table name within the 99 character limit and a
table field name within the 154 character limit. Previously, you could add more characters
than the default limit of 100 characters and 155 characters, respectively.
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Fixes

You can create a new project for Standard Forms in the Linux environment. Previously, the
ability to create a project using Create project for Standard Forms was not supported in
Linux.

Limitations

Document Automation supports a device username of 17 characters or fewer.

Pattern-based validation is not enabled by default in imported learning instances. You must
edit the learning instance and select the Validation option in the Validation rules section.

Bots containing actions from the Document Extraction package do not support the
advanced check-out options.

For a public learning instance, if you delete a learning instance and then try to create a new
learning instance using that same name, an error is displayed.

Workaround:If you delete a learning instance as well as the learning instance folder, then
yOU Can create a new learning instance using the same name.

When you create a learning instance with Google Document Al, an UNKNOWN option is
displayed under the OCR Engine filter in the Document Workspace dashboard.

If you apply a filter that includes User Name, Status, or OCR Engine, the Accuracy% by
field widget does not show the correct results.

If you submit a document that contains a validation error due to a regular expression,
the page keeps loading and you must refresh the page to continue. You cannot submit a
document that has a pattern validation rule with a regular expression that contains pipe
symbol (]).

For example, the following expression has (|) characters and will show an error:
(~0[1-9]1112][0-9]|3[01])-(O[1-91[1[0-2])-(\d{4}$)

However, you can edit the regular expression in the learning instance and reprocess the
document to continue with validation.

As of Automation 360 v.28, document extraction fails via proxy in the bring your own key
(BYOK) use case.

If you process a document by uploading it through the default or customized process
instead of processing it through Document Automation learning instances, then Download
CSV remains in the In progress state during validation.

Workaround:You must update the Download Bot task bot by unchecking Delete files
associated to this document from the server after downloading.

For Document Automation, the license consumption is not tracked on a fresh cluster Linux
environment.
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1Q Bot

Fixes

If you test an invalid Python script when configuring custom logic, the system displays an
error message without any file path. Previously, the error message included the execution
file path.

When you upload high-resolution or invalid documents to a custom group, if the
document is not processed, it is either moved to the validator folder or the fail folder. You
can eventually download the files from the fail or invalid folder.

Previously, the validator or the fail folder did not receive the uploaded files. You had to
transition the learning instance from production to staging and back again to move the file
to the output folder.

Service Cloud case ID: 01926196

The ability to create or edit a bot for a manual group has been fixed. You can now create a
bot with a manual group that has invalid or corrupted documents. You can also move the
created bot from staging to production and back again.

Previously, after creating a manual group for a learning instance with an invalid or
corrupted document, you were unable to create a bot.

Service Cloud case ID: 01878143

Limitations

If the 1Q Bot archive (IQBA) file size is above 268 MB, then the file storage does not upload
the exported file from the output folder to the desired location. You should restart the
Project Services from 1Q Bot Services if the system is stuck and you are unable to perform
any actions.

If IQ Bot Cloud is configured with a proxy server, learning instances cannot access Google
Vision API or Microsoft Azure Computer Vision OCR engine.

The maximum upload file size limitis set to 2 GB when importing and exporting files in
the 1Q Bot archive (IQBA) file. If the file size is greater than 2 GB, then you must delete

unwanted groups to decrease the file size and migrate successfully. Earlier, maximum

upload file size limit was 5 GB.

When you change from full screen mode to small screen mode in the Logic window, the
Python scripts and these options are hidden: Test Run, Clear Box, Fullscreen, and Save.

Workaround:
1. Click Logic to minimize the window
2. Click Logic to expand the window and view the Python scripts.

3. Place a cursor inside the Python script screen and click Enter.

For an existing Community Edition user, the Help icon is not available on IQ Bot interface.
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Limitations

functionality is not impacted.

If you are an Automation Anywhere free trial version user and you upgrade to Automation
360 v.28, the Community Edition logo displays on the homepage. However, the

The size of the toggle icon for Set to production is not consistent with all the other icons
displayed on the learning instance details page.

Updates to the interface

Review the updates to the interface made to the interface for Automation 360 v.28 release.

1Q Bot and Document Automation

The new Google Document Al features include an improved validation feedback for new
and existing learning instances and supports additional languages.

Create Learning Instance

Narme

Test

Description (optional)

Demo test scenario

Document Type

Invoices

Language

English

Locale

English {United States)

Provider

Google Document Al

Google Document Al can

Improve accuracy

The system |eams from user-provided changes in the Validator

Improvements to Google Document Al
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1Q Bot and Document Automation
You can configure your learning instances to convert extracted dates and numbers to a
standard format.
Cancel |
Field name
Field label
Invoice Date
Confidence (0-100) Data type
80 * || Date -
Text
Format Date @
Updates the appearance of extracted datgs b Number
Date
Address
Required
@ Required
Optional
Default aliases (read-only)
invoice date invoice date ny date
inv date inv, date ny. date
Standardize the format of extracted numbers and dates

Bot Insight v.28 release

Review what's new and changed, and the fixes and limitations in Bot Insight for the v.28 release.

What's new

Enhanced Bot Insight filters and widget setting for Document Workspace dashboard

In a Document Workspace dashboard, you can use the custom dashboard filters to
build custom widgets. Additionally, you can edit the widget settings for an effective data
visualization.

Document Workspace dashboard on page 3392 | Edit widget settings on page 3394
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What's changed

RBAC applied to /data/api/gettasklogdata and /data/api/
gettaskvariableprofile APIs to secure business data (Service Cloud case ID:
01870469)

Role-based access control (RBAC) is applied to the /data/api/gettasklogdata and
/data/api/gettaskvariableprofile APIs to access the Business dashboard data.
With this role restriction, you cannot access the business data using the /data/api/
gettasklogdata and /data/api/gettaskvariableprofile APIs when you do not
have access to the folders.

Fixes

For Bot Insight business analytics reporting, you can use the Bot Insight APIs to export all
the available data records from the Operations Bots dashboard’'s DataTable widget.

Previously, you could export a maximum of 100 records at a time from the Operations Bots
dashboard's DataTable widget.

Service Cloud case ID: 00760252, 01819244, 01857905, 01945720

Bot Insight Operations dashboard (which includes links to the Audit, Bots, and Device
dashboards) now retrieves and shows the complete volume count for a bot run.

Previously, due to a maximum volume count limit in KPI charts, the Bot Insight Operations
dashboard could not retrieve the complete volume count. Additionally, a maximum count
of 10,000 was shown as the total bot run in the Bots dashboard which led to incorrect
results.

Service Cloud case ID: 01825287

A user with the AAE_Bot Insight Consumer role can only view a published analyze
dashboard. The Delete dashboard action is greyed out and no longer available.

Previously, the Delete action was available and when the user tried to delete a dashboard,
an error message was displayed preventing the user from deleting the dashboard.

Service Cloud case ID: 01870477

Limitations

In the Bots dashboard, the Total Bot Runs count does not match what the total count
should be when the Total Completed (Success), Total in Progress, and Total Failed
counts are added together.
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Automation 360 v.27 Release Notes

Release date: 11 January 2023

Review the top five features in this release and view other new features and exciting

enhancements for Automation 360 v.27 release.

o Build 16701: Automation 360 (Cloud and Cloud Sandbox) and |1Q Bot (Cloud)
o Build 16685: Automation 360 (On-Premises) and 1Q Bot (On-Premises)

We have released updated builds for fixes after the Automation 360 v.27 GA build, which was Build
16667. For information about the fixes in these updated builds, see Updated release builds on page

118.

Highlights of this release

Here are the top 5 features in the v.27 release:

Embedded smart forms and dynamic data
mapping for embedded widgets

Enhanced citizen developer experience

Faster design and use of your embedded
automation: You can now design your forms
using a responsive and real-time canvas that
automatically adjusts to the desired form size.
This feature provides a faster way to create
embedded interfaces that interact with any
web applications. You can also configure these
forms in your business applications, such as
Workday or ServiceNow, to securely retrieve
data when embedded as an iFrame widget.

Eliminate data re-entry and save time: Use our
new PostMessage APl to map and prepopulate
data from business applications in embedded
widgets. Dynamic data mapping provides safe
and secure communication of data from your
business (host) applications to initial process
forms in the widget.

See Smart embedded forms and dynamic data
mapping on page 2881

Our updated and intuitive icons enable citizen
developers to quickly select actions and use the
Help for contextual information about actions,
providing a more seamless development of
automations. We have also enhanced the
AlSense Recorder user experience so that

you can use anchors easily and automate Ul
objects that are not detected by the recorder
automatically.

See AlSense recorder enhancements.
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Strengthen governance and management

Standard forms

PEG enhancements

Updated release builds

We have released the following updated builds:

Notifications: Our new notifications capability
provides a centralized, consistent, and
proactive medium for users to stay informed
on their automation estate and to take actions
based on the events they are alerted on. Alerts
on various platform events, bot events, and
other automation lifecycle events are delivered
via in-app (default) and email (based on user
preference).

See Notifications on page 1954.

Automatically pick available Bot Runner users:
Scale your automations easily by selecting

all the Bot Runner users that can run a given
automation and the number of Bot Runners
to use. This capability ensures that when you
run or schedule an automation, the system
automatically picks the available run-as users
from the specified list.

Standard forms is now integrated in Document
Automation with the other document
processing capabilities. With enhanced
accuracy, this feature enables you to extract
data from densely structured forms including
those with handwritten input. Use cases for
structured documents include tax forms,
mortgages, vehicle registration address, and so
on.

See Using Document Automation for Standard
Forms on page 3191.

We continue to improve our Privacy Enhanced
Gateway (PEG) for sensitive information
redaction with a new configuration Ul so you
can easily change the configurations in the

Ul instead of the command line. We have

also recently released a new PEG serverless
architecture for higher-scale data collection use
cases.

See Configure PEG image redaction on page
3329.

+ Build 16701 Service Cloud case ID: 01829572, 01947340, 01949323, 01950696, 01944637,
01951100,01953055, 01950639, 01951722, 01949415, 01949033, 01949372
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» Fix for bots that were failing when all of these conditions were met:

» Bot contained more than 2,000 steps
« Bot had one or more nested actions (such as IF or loop)
» Atleast one of the nested actions contained more than 250 steps

» Fix for inconsistencies that were observed on the In-progress activity page.

» Fix for bots that were failing because of file dependency or interactive form that included
multibyte characters in file names.

» Changes to Automation Co-Pilot on the desktop Assistant to manage and clear automations
with start, stop, and resume actions.

» Build 16685 (for US West, Canada, and Japan regions only) Service Cloud case ID: 01947340

This updated build includes a fix for this issue: If a bot has a file dependency and the file name
contains multibyte characters, then when the Bot Agent downloads the file, the download will
fail during run time causing the bot to fail as well.

What's new and changed in each product

Navigate to the following pages for details on all the updates (what's new, changed, fixed, and
limitations) in each product:

Automation Workspace v.27 release on page 120

» Updating to v.27 release on page 148
» Packages updated in v.27 on page 149
» Migration updates for v.27 release on page 163

Process Discovery v.27 release on page 172

Automation Co-Pilot v.27 release on page 173

IQ Bot and Document Automation v.27 release on page 182

Bot Insight v.27 release on page 189

Related reference

Automation Workspace v.27 release on page 120

Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.27 release.

Process Discovery v.27 release on page 172
Review what's new in Process Discovery for the v.27 release.

Automation Co-Pilot v.27 release on page 173
Review what's new and changed, and the fixes and limitations in Automation Co-Pilot for the v.27
release.

IQ Bot and Document Automation v.27 release on page 182
Review what's new and changed, and the fixes and limitations in 1Q Bot and Document
Automation for the v.27 release.

Bot Insight v.27 release on page 189
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Review the fixes in Bot Insight for the v.27 release.

Packages updated in v.27 on page 149
Review updates to the packages in Automation 360 v.27, including the compatible Control Room
and Bot Agent versions.

Browser extensions for Automation 360 on page 852

Create automation from supported browsers by using browser extensions. Extensions are
periodically updated to support feature enhancements and fixes. Therefore, ensure that you have
the latest versions of extensions for the Google Chrome, Microsoft Edge, and Mozilla Firefox
browsers.

Automation Workspace v.27 release

Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.27 release.

What's new

Control Room, devices, and Bot Agent

Windows 365 Cloud PC now supported as Bot Runner (Service Cloud case ID: 01792699)

We support Windows 365 Cloud PC as a Bot Runner to create and run bots on Windows
365 Cloud PC.

Bot Runner device requirements on page 1023

Oracle Database is now supported on Linux (Service Cloud case ID: 00726728)

We now support Control Room with Oracle Database on Linux, so you can now choose to
install the Control Room with Oracle Database on Linux.

Installing Control Room on Linux on page 1145 | Database requirements on page 1042

Microsoft Edge offline extension is supported (Service Cloud case ID: 01829649,
01880289)

You can now install the Microsoft Edge offline extension for Microsoft Edge Enterprise
browser users even when the device is offline.

When the Bot Runner machines do not have Internet connectivity, you can use these
features with the Microsoft Edge offline extension:

* Automation of web apps
o User interface triggers
¢ Device registration

The Microsoft Edge offline extension is transparent and works similarly to the Microsoft
Edge online extension for users.

Install Bot Agent and register device on page 1194 | Browser extensions for Automation
360 on page 852
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Control Room, devices, and Bot Agent

Centralized notifications repository for various events and capability updates

You can now track all the platform and automation events through a centralized repository.
With this feature, you can identify the severity of events, consider possible actions based
on the severity of events, and then take appropriate actions. You can also be notified about
platform updates, such as bot export and package updates. Thus, it improves platform and
user productivity.

Notifications on page 1954

Automatically select the number of Bot Runners (Service Cloud case ID: 00821020,
00715598, 00723191, 00784822, 01830238, 01870817)

You can enable Automation 360 to automatically select the Bot Runner users for specific
tasks to:

» Scale automations easily
* Run bots concurrently
* Use resources efficiently

This capability ensures that when you run or schedule an automation, the system
automatically picks the available run-as users from the specified list.

Automatically select the number of Bot Runners users on page 1901 | Schedule a bot on
page 1895

Manage domain accounts using gMSA (Service Cloud case ID: 00731119)

You can use a group Managed Service Account (gMSA) to manage and run Control Room
and other Automation 360 services.

Configure service credentials on page 1103

View keyboard shortcuts in Bot editor
In Bot editor, you can now open a menu to view the available keyboard shortcuts.

Keyboard shortcuts list on page 1977

Validate device credentials prior to bot deployment

Prior to bot deployment, you can select to validate the device credentials for Bot Creator,
attended Bot Runner, Citizen Developer, and unattended Bot Runner users. This provides
users additional security for bot deployment.

Switch device registration between Control Room instances on page 1643

Export roles to view users and their permissions (Service Cloud case ID: 01804955)

You can export selected roles and their permissions to CSV files to view the following
information:

e Userinformation

¢ Run-as user information
o User permissions

« Folder permissions

Export roles on page 1614
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Control Room, devices, and Bot Agent

TLS 1.3 encryption support for a more secure connection to Control Room services
(Service Cloud case ID: 00549240, 00606859, 01925085)

Automation 360 On-Premises supports both TLS 1.3 and TLS 1.2 cryptographic protocols
for HTTPS and TCP communications between our components.

Support for secure protocols on page 915 | Configure application Transport Layer
Security on page 1101

Enhanced Automation Anywhere Debugger tool

The Automation Anywhere Debugger tool is available in the Bot Assistant utility to provide
a better user experience. When you invoke the Debugger tool from the Bot editor, you can
add, update, or delete actions and variables in a bot.

By default, the Watched variables lists is empty. With a single click, you can add all the
used variables in a bot. These variables display in a pop-up window where you can select or
deselect, one or more variables, from the list.

Debugger tool

Google Chrome and Microsoft Edge certification for operating systems

Google Chrome and Microsoft Edge extensions are certified for the following operating
systems:

Microsoft Windows Server 2012 Standard R2
«  Microsoft Windows Server 2016
e« Microsoft Windows Server 2019

Packages, actions, and Bot editor

Notification for package updates

When you add or update a package or upload a custom package to the Control Room, you
are now notified about this platform event. This notification is displayed to all the Control
Room users through the Notifications repository.

Capabilities supporting notifications on page 1967 | Add packages to the Control Room
on page 1728 | Add custom package to your Control Room on page 3106 | Upload
custom package to your Control Room on page 3046

ServiceNow package

You can use the ServiceNow package from Automation 360 to authenticate and perform
several actions with records and attachments in ServiceNow tables.

ServiceNow package on page 2648

ServiceNow triggers
You can use ServiceNow triggers to call an action when there is a new or updated record.

ServiceNow New Record trigger on page 2953
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Packages, actions, and Bot editor

Cut, copy, paste keyboard shortcuts added for TN3270 and TN5250 Terminal Emulator

In the Terminal Emulator package, the following keyboard shortcuts are now available
specifically for TN3270 and TN5250:

e Shift + Control + A = Select all
Shift + Control + C = Copy
Shift + Control + X = Cut

Shift + Control + V = Paste

Using Send text action on page 2747

Quick assistance at hand for the developers in the Bot editor

The accessibility and usability of the Bot editor, actions, and packages have been improved.
As a citizen developer or an RPA developer, when you are creating bots, you can quickly
look up information about the actions without navigating outside the Bot editor. Under the
Actions pane, quick help is enabled with contextual information about actions. Additionally,
an icon is configured with a link to the documentation. If you want more information
about an action, you can click the link, which redirects you to the relevant page in the
documentation portal. This feature is currently available in the following actions and
packages.

« Database
o Email

Enhanced user experience through refreshed and intuitive icons

With the new and intuitive icons for actions in the Bot editor, citizen developers and RPA
developers can quickly locate the correct action while creating automation for a day-to-
day task. These unique and renewed icons are developed according to brand and global
standards.

Seamless package updates

When a package version is added to the Control Room, either from a Cloud download
or Control Room upgrade, as an administrator, you have the flexibility to disable the new
version of packages. This feature helps you to restrict users from using the new package
version until it is verified.

Updating packages in Control Room on page 1725 | Automatic package updates for On-
Premises Control Room on page 1726 | Automatic package updates for Cloud Control
Room on page 1727

New option in Read from action of Database package (Service Cloud case ID: 01263940)

A new check box is available when you use the Read from action to retrieve records from
the database and save the retrieved data in a CSV file. When you select this check box, no
CSV file is created if the executed SQL query does not return any data.

Proxy support for EWS-OAuth2 (Service Cloud case ID: 00771400, 01574715, 01815888)

When you create a bot with the Email package that uses EWS OAuth2 for authentication
and the Bot Runner machine is configured behind the firewall, then all outbound requests
are routed through the proxy server configured on the Bot Runner machine.
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Packages, actions, and Bot editor

64-bit ODBC driver now supported in Database package (Service Cloud case ID:
01256142, 01829360, 01849908)

We now support connecting to databases by using the 64-bit ODBC driver. This option is
available when the connection mode is the default. Organizations transitioning to Office
365 will benefit from leveraging this enhancement and can sustain automation build with
32-bit ODBC drivers.

Using Connect action for database on page 2195

OAuth 2.0 support in Email and Email trigger packages (Service Cloud case ID: 01798311,
01803702, 01791859, 01828526)

Microsoft is deprecating the ability to use Basic authentication in Exchange Online for
these specific protocols:

« [IMAP
« POP3
e EWS

We support OAuth 2.0 authentication for these protocols in the Email and Email trigger
packages. For enhanced security, you can maintain the business continuity of your
email automations by switching the authentication type from Basic to OAuth 2.0, (as
recommended by Microsoft).

Using Connect action for Email on page 2240

Retry mechanism supported in credential variables (Service Cloud case ID: 01786319,
01887182)

The credential variables support the retry mechanism. When you create a bot that uses
credential variables, if the bot fails during run time to retrieve those variables from the
Credential Vault because the Control Room is disconnected or the Control Room services
stop intermittently, then the bot tries three times to retrieve the credential variables from
the Credential Vault.

Note: Ensure that the Bot Agent version installed on your system is the version that is
released with Automation 360 v.27.
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Packages, actions, and Bot editor

Support of other domain name in the Active Directory package (Service Cloud case ID:
01807358, 01910765)

We now support Active Directory user operations by logon name with domain and can
provide the domain name to extract user details. When you retrieve the user property or
perform any user operation based on the logon name (userPrincipalName), and if the user
domain name differs from the domain specified in the LDAP path, the user properties are
now successfully retrieved with or without a domain name.

For example, LDAP Path: LDAP://ADServer/DC=automation, DC=net

User Logon name

userPrincipalName: kim@aaengg.net User can provide logon name as
kim@aaengg.net.

userPrincipalName: shaun@aasales.net User can provide logon name as
shaun@aasales.net.

userPrincipalName:sarah@automation.netiser can provide a logon name as either
sarah Or sarah@automation.net.

The following list of actions supports logon name with domain.

* Update user details

e Rename user

e Delete user

¢ Enable user account
» Disable user account
e Setuser property

*  Get user property

User account operations on page 2107

Shared mailbox support for Email automation (Service Cloud case ID: 00797231,
01816574, 01829499, 01854615, 01871861, 01933058, 01834152, 01829684, 01853949,
01880386, 01869636, 01894591, 01867553, 01911371. 01925438)

The Email package supports the email automation of a shared mailbox in Outlook for
Office 365/Microsoft 365 using IMAP/EWS protocols, and OAuth 2.0 authentication using
Client Credentials and Authorization Code with PKCE grant flows. You can automate
emails retrieved from a shared mailbox and perform all email-related tasks by accessing
each folder(s) and its subfolder(s) in the shared mailbox.

© 2023 Automation Anywhere. All rights reserved. 125



product-flagshipAutomation Anywhere - Release Notes

Packages, actions, and Bot editor

New action in Text file package

You can use the new Read variables action in the Text file package to read the values of
variables from the text file.

Note: The Import string from text file action in the String package has been deprecated
and will not be available for new bots. We recommend that you use the new Read
variables action with enhanced capabilities. This deprecation does not impact any existing
bots or bots which were migrated previously and they will continue to run properly. See
Support and deprecation policy for packages on page 946 for package lifecycle and
deprecation policy.

Read variables action on page 2752

Call an existing JavaScript function in a webpage

You can use the new Call a JavaScript function action in the Browser package to call

an existing JavaScript function directly in a webpage or in an iFrame within a webpage in
Google Chrome and Chromium-based Microsoft Edge browsers. In the bot, you can also
pass one or more input parameters to the JavaScript function and process the return value
from the function.

Call a JavaScript function action on page 2163

Automate controls using Microsoft Ul Automation (COM) technology

You can use the Microsoft Ul Automation (COM) technology to automate the following
scenarios:

« Capture and automate client controls
e Capture and automate password text controls
» Capture and automate page tab controls

Actions performed on objects captured with Universal Recorder on page 2568 | Capture
using specific technology on page 2587

Capture objects on applications running in administrator mode

You can use the Recorder to capture objects on applications running in administrator
mode. To capture the object, select the Capture and run with admin privileges option
from the Bot editor.

Recorder package on page 2564

Enhanced bot performance when using global values across bots

When you use global values across a parent bot and a child bot, the bot performance is
enhanced by reducing the bot execution time. To enable enhanced bot performance,
you must set the Bot compatibility version to 3 in the Advanced settings page of the Bot
editor.

Note: Ensure that the Bot Agent version installed on your system is the version that is
released with Automation 360 v.27.

Bot compatibility version on page 2048
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Packages, actions, and Bot editor

Enhanced user interface for Define functionality in AlSense Recorder

*  We have enhanced the user interface of Define window in the AlSense Recorder that
enables you to use anchors easily and automate Ul objects that are not detected by
AlSense Recorder automatically. To improve functional clarity, the following object
types are renamed:

» Active text is renamed to Link
» Passive text is renamed to Text value

» If you unintentionally click the screen or click before the highlighter appears, the
AlSense Recorder provides visibility into it. You must confirm to capture the object again
or use the Define functionality to define the object on the screen.

* In the Define window, the AlSense Recorder shows embedded help for each of the
control types so you can select the correct control types for custom objects.

Use variable anchor on page 2015 | Capture Textbox, Radio, Checkbox, and Combobox
on page 2010 | Capture text value through AlSense Recorder on page 2009 | Capture link
button through AlSense Recorder on page 2008 | Capture Image button through AlSense
Recorder on page 2006

New virtual key added to the Simulate keystrokes package

In the Simulate Keystrokes > Keystrokes action, a new key named Return has been
added to the virtual keyboard for Enter functionality and the Enter key in the Number pad
has been renamed to Num Enter. As a result, the Return key is the main Enter key on
the keyboard. This enhancement keeps the keyboard in sync with the physical keyboard.
The nomenclature has been changed to avoid confusion between the Enter key on the
keyboard and the Enter key on the Number pad.

Support for global variable for all Datetime actions

In the Datetime package, you can use the Datetime global variable across all Datetime
actions. You can select to use either String variable or a Global variable in the Source date
and time variable option. This avoids creating multiple local variables and reduces the total
number of actions used in a bot.

Datetime package on page 2210

The resiliency of the File/Folder trigger has been improved to continue listening after a
network disruption has occurred. Previously, a network error caused the trigger to lose
connection with the Bot Agent.

Service Cloud case ID: 01769532, 01773584, 01834098, 01867418

Important: For information about the supported packages for this release, see Packages updated
inv.27 on page 149.
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Building and running bots

Notification for bot export

When you export a bot in the Control Room, you are now informed through the
Notifications repository. This notification is sent only to the user who exported the bot.

Capabilities supporting notifications on page 1967 | Export bots on page 1850

Code analysis runs automatically for all unscanned bots in public workspace

Code analysis now runs automatically on all the bots with the Not Scanned status in

the public workspace. This ensures visibility on the coding best practices for policies
configured in the Control Room and will show the results of code analysis for all the bots
in the public workspace without the need to run code analysis on each bot one by one.

Check out multiple bots and files (Service Cloud case ID: 00628344, 00822352)

You can now select multiple bots and their dependent files from different folders that
belong to the same process and check them out from the public to the private workspace.
You can check out a maximum of 10 parent bots, but there is no limitation on the number
of dependent child bots.

Check out multiple bots on page 2032

Choose specific version of non-bot dependency to check out with parent bot

When you check out a parent bot, you can now choose the version of a non-bot file
dependency to check out. Every version of a parent bot can have different versions of
non-bot file dependencies.

With this feature, you can roll back the dependencies while rolling back the parent bot. You
can make changes to a specific version of the dependent non-bot file.

Check out non-bot file dependencies on page 2086

Compare bot version in private workspace (Service Cloud case I1D: 01761840, 01771389,
01763432, 01904500, 00798356, 01780116)

You can now see the changes made to your bot logic in the private workspace before
checking in your bot. As a Bot Creator, it was difficult to identify the changes made to the
bot logic, input, and output parameters. With this functionality, you can now easily identify
where you have made the modifications to the bot logic, variables, triggers, dependencies,
and packages compared to the latest version or any other previous version of the bot.

Compare bot versions on page 2039

Edit non-empty folder description in public workspace (Service Cloud case ID: 01820406)

You can edit the description of non-empty folders in the public workspace. Meaningful
descriptions provide more insight of the bots contained in that folder. This feature enables
an administrator or a user with rename folder permissions to better manage the repository
when it contains many folders.

Create and rename folders on page 2051
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Building and running bots

Specify gueue running times in workload automations (Service Cloud case ID: 01816260,
00331357, 01924895, 01274769)

You can set the specific time period when to run a workload automation. When creating
the workload automation, you can set the queue running days and time to ensure that the
automation does not run during these scenarios:

* Applications are not available
» During scheduled upgrades
* Non-working days (holidays, weekends)

Run bot with queue on page 1825

Check for duplicates when adding work items (Service Cloud case ID: 00825850,
01792046, 01806516)

You can check for duplicate work items before adding them to the queue. This feature
prevents re-processing the same work items multiple times, thus saving time and
resources. You can either move the work items marked as duplicate for re-processing or
discard them.

Insert Work Items on page 1824

Generation of APl Key is audited

The generation of the APl key is now audited and will display the expiry time of the api-key
in the audit logs.

APIs and integrations

Workato Integration

You can integrate the Automation 360 platform and Workato by using the Automation
Anywhere connector. You can establish a connection with the Automation Anywhere
Control Room and perform various operations using the Control Room APIs.

Workato integration

Snaplogic Integration

You can now integrate the Automation 360 platform and Snaplogic. You can establish a
connection with the Automation Anywhere Control Room and perform various operations
by using the Control Room APIs.

Snaplogic integration

RPA Bots for Salesforce

Now when creating new connections, you have the option to include an APl Gateway
certificate.
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What's changed

Control Room, devices, and Bot Agent

Automated reprocessing of failed WLM work items (Service Cloud case I1D: 00825872)

When you create or edit a queue, you can now use the Max auto retry attempt option to
ensure that failed WLM work items are reprocessed automatically. With this option, you can
specify the number of times for which the automatic reprocessing of failed work items will
be attempted.

Automatic reprocessing of failed work items is attempted after all the work items in a
gueue are processed.

Better device management with improved device permissions (Service Cloud case ID:
01264963, 01871530)

You can now view and manage Bot Agent devices even if you have not registered them
by using the enhanced Edit the device(s) permission. The Edit the device(s) permission is
improved as follows:

» Device(s) from my device pools: To edit devices from device pools
» Run as users default device(s): To edit Run as user(s) default device

The Control Room administrator grants you access to a specific set of devices based on
your role. When the Edit the device(s) permission with the Device(s) from my device
pools and Run as users default device(s) options is selected, you can view and manage all
(registered and non-registered) devices from a specific accessible group.

Enhanced bot Compare versions page

The bot Compare versions page shows changes in the dependencies between two
versions of the bot. It shows changes for the first level of dependencies only and displays
those dependencies sorted in alphabetical order.

Specify time period to put work item on hold (Service Cloud case ID: 00825875)

You can put a work item on hold for a specific date and time. This ensures that the work
item moves automatically to processing (new state) on the specified date and time and no
longer requires you to manually move it for re-processing. A new column in the Edit queue
page displays the hold status of the work item, either date and time or indefinite if you do
not specify the date and time.

Edit queues on page 1831

Packages, actions, and Bot editor

Control Room version compatibility check with specific packages

When you manually upload a package or a bot in the Control Room, the system now
checks if the specific packages used in the bot are compatible with the Control Room
version.
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Packages, actions, and Bot editor

Analyze button renamed in Bot editor

The analyze button of Bot Insight (Analyze Task Bot) has been renamed to Bot Insight
"Analyze" dashboard in the Bot editor page.

Fixes

Build 16701: This build includes the following fixes (along with fixes from the previous builds):

Fix for inconsistencies that were observed on the In-progress activity page.

Service Cloud case ID: 01949323, 01950696, 01944637, 01951100, 01953055, 01950639,
01951722, 01929156, 01954486, 01954920

Build 16694: This build includes the following fixes (along with fixes from the previous builds):

If the Manage my activity feature is enabled for a user role, then the user can view the
pause, resume, and stop status on the In progress activity page. If this feature is disabled,
then the user cannot view these statuses.

Previously, users were able to view these statuses even when the feature was disabled.

Service Cloud case ID: 01937106

Build 16667: This build includes the following fixes:

When synching with the Active Directory (AD), the user mapping no longer overwrites the
Description field in the Control Room with blanks.

The Automation 360 Control Room no longer generates an error in the User Management
log when a mapped security group has no members.

The In progress activity page no longer shows bots after they are run.
Previously, the page incorrectly showed bots in the active state even after execution.

Service Cloud case ID:

01914651, 01924866, 01923265, 01928088, 1918956, 01922321, 01931985, 01921849,
01938985, 01939812,

01940084, 01940585, 01940258, 01938868, 01934451, 01940222, 01941187, 01940900,
01941742, 01939639,

01941503, 01941496, 01939639, 01942720, 01942430, 01943379, 01943617, 01938885

When a user is assigned an admin role to create schedules and later the admin access is
removed for that user, an audit log will be logged when the schedule is canceled because
of the user not having the admin privileges.

Previously, when such schedules were canceled, no audit logs were logged indicating that
the schedule was canceled because the user did not have the required privileges.

Service Cloud case ID: 01830359
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The Administration > Licenses page and the Control Room banner displayed on the same
licenses page now display correct information about license expiry.

Previously, the correct information about license expiry was not displayed.
Service Cloud case ID: 01807324

When you edit a role, the Edit role audit log page now displays the correct old, new, and
run-as user values.

Previously, these values were not displayed.
Service Cloud case ID: 01759116

When you edit your first or last name on the My profile page, the description and auto
login values on the Edit user audit log page will not be updated.

Service Cloud case ID: 01846878

You can correctly filter the status for activities on the Activity > Historical page.
Previously, some filters were not displaying the correct status for activities.
Service Cloud case ID: 01869361, 01875216

Users without permission cannot view the activities of other users on the In progress
activity page.

Previously, some users were able to view the activities of other users even though they did
not have permission.

Service Cloud case |D: 01911289, 01910582

If you configured the log collection level as Debug, the logs collected from some
packages do not include customer data.

Previously, the logs collected from some packages included customer data.
Service Cloud case ID: 01862053, 01870001

If the CPU utilization and device memory threshold values are outside the percentage
range defined by the Control Room administrator in the Administration > Settings >
Devices > Threshold settings for multi-user devices, a clear error message now indicates
the device unavailability and provides an appropriate action.

Previously, when the CPU utilization and device memory thresholds values exceeded the
defined value, bot deployment failed with an unknown error message.

Device shows an accurate status when the Bot Agent is disconnected from the Control
Room.

Previously, due to the default time (15 minutes) of the WebSocket connection, a device was
shown as connected even when the Bot Agent was disconnected from the Control Room.

Service Cloud case ID: 01843990

In the Oracle Database environment, a checked-in bot is now automatically refreshed and
can be viewed in the Public folder.

Previously, to view a checked-in bot in the Public folder, you had to manually refresh the
Automation page by using the Refresh button.
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When a Stop Task command is used, WLM work items are now marked as completed
successfully and show the correct status in the Control Room.

Previously, WLM work items were marked as failed even if the bot was executed
successfully.

Service Cloud case ID: 01841320, 01840748

When you run WLM automations, if the Control Room restarts during deployment, the
WLM deployment continues without delay when Control Room services are active.

Previously, after the Control Room restarted, there was a delay of 15 minutes before the
WLM deployment continued.

When you run a bot by using the Run bot with queue option, the correct value of the work
item is now selected, irrespective of the modification source. Previously, when the value of
a work item was modified through the APl or bot setting, the older value was selected by
the bot

Service Cloud case ID: 01786785

In an Oracle Database environment, when you select the number format and sort order for
the work items in a queue and then run bot by using the Run bot with queue option, the
queues are now deployed successfully. Also, the correct log entry is shown in the Audit
log or Activity page.

Previously, queues were not deployed, and no errors were shown in the Audit log or
Activity page.

In a clustered environment, the bot deployment progress is no longer stuck and the Bot
Runner device connects to the Control Room successfully.

Previously, the bot deployment progress would get stuck sometimes and show an error
message Waiting for user: <username> and/or device: <device-name> ONn
the In progress > In progress activity page.

Service Cloud case ID: 01830285

When a bot keeps running for a few hours, an error no longer occurs due to high memory
usage with the Recorder package version 2.9.2 or later.

Previously, an increase in memory usage caused the bot to fail after a few hours with a
Java heap space error.

Service Cloud case ID: 01911565

When you read emails within a loop using a Microsoft Outlook Client connection with

a subject filter, use the Delete action and run the bot, the bot now completes the set
iteration and deletes the emails from the specified folder. Additionally, the variable that was
used to display the count of total emails versus deleted emails now displays the correct
counts in the message box.

Service Cloud case ID: 01845642,01857791,01880424
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When you establish a connection with the EWS server, and emails are read within a loop to
filter and move all emails from a subfolder created within the custom folder, the bot now
executes without an error.

Previously, an error occurred because the bot could not read the emails from the folders
created outside the predefined folder, such as Inbox, Junk, or Draft.

Service Cloud case ID: 01823238

You can now successfully create a bot by using the Upload file action from the Microsoft
365 OneDrive package.

Previously, the bot displayed an error when you used the Upload file action and if the file
name had special characters such as brackets [].

Note: Brackets [] are now supported in the file name.

Service Cloud case ID: 01798568

When you choose the variable option to perform a task and during bot creation process
you delete the variable you created (Your variables), and when you click the Add option in
the variable field to insert a variable (such as global variable), the option is now enabled.

Previously, the Add option for inserting the variable was disabled.
Service Cloud case ID: 01869139

When you create a bot, you can now use the Update node action of the XML package to
update the value of a node. Previously, the attributes were removed when you updated the
text value of an XML element.

Service Cloud case ID: 01805643

In the Email package, connect to the EWS server and use Loop > For each mail in
mail box. If the source mail is sent on behalf of some other user, for example, user
xyzQaa.com sent mail on behalf of user abcRaa . com, the email dictionary variable
emailFrom now returns the correct sender ID, which is abc@aa . com.

Previously, the email dictionary variable emailFrom returned the sender ID as xyzRaa . com.
Service Cloud case ID: 01856149

When you run a stored procedure in Oracle and it returns SYS_REFCURSOR, the Run
stored procedure action closes the cursors.

Previously, the Run stored procedure action was not closing the cursor after the
maximum cursor limit was reached.

Service Cloud case ID: 01842046, 01898572

In the Active Directory package, when you perform a user account operation such as Add
users to group, Delete user, Disable user account, or Rename user, and if the username
has an asterisk (*), open parenthesis, or close parenthesis, you can now add a user without
any error.

Previously, the username did not support the following special characters: asterisk (*), open
parenthesis, and close parentheses.

Service Cloud case ID: 01884962
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When you create a folder in Outlook with a percentage (%) in its name (for example,
Clients%ClientAl), create a bot using the Connect action from the Email package and
then use the Folder exists or Folder does not exist condition, the bot finds the Clients
%$ClientA and retrieves mail from it.

Previously, the bot was not able to retrieve mails from the folder because percentage (%)
was not supported in the folder name.

When you connect to the Microsoft Access Database with JDBC and specify the database
path, if you use the following specific aggregation functions in the query, an error is no
longer encountered when you run the bot:

ASC, ATN, SQR, CBOOL, CCUR, CDATE,
CDBL, CDEC, CDATE, CDBL, CINT, CLONG, CLNG,

CSIGN, CSTR, CVAR, DATEADD, DATEDIFF, DATEPART,
DATESERIAL, DATEVALUE, FORMAT, IIF, INSTR, INSTRREV,
ISDATE, IsNull, ISNUMERIC, LEFT, LEFTS, LEN, MID,
MONTHNAME, DATE, NOW, NZ, SIGN, SPACE, STR, TIME, VAL,
WEEKDAYNAME, WEEKDAY, STRING, TIMESERIAL, CONCAT

When using the Task Bot: Run action, you can search dictionary and session variables to
use as input parameters. Previously, no results displayed when using this Advanced search
feature.

Service Cloud case ID: 01879539

A Task Bot no longer fails when you debug or run it when any in_Window input variable is
set.

Previously, in edit mode, when you debugged or ran a Task Bot with an input variable by
selecting the Use as input check box, the bot failed.

Service Cloud case ID: 01919263

When you use the Save action in the Email package, and if the email subject includes a
comma (,), the emails are saved successfully.

Previously, if the email subject included a comma (,) and you saved the email, the comma
(,) was replaced with an underscore (_).

Service Cloud case ID: 01786211

When you select the Package details page, and select the Availability tab, if the package
(all users or selected roles) is changed, then the Package details page displays the last
modified information of the user who made the changes, and the changes made at the
access level (all users or selected roles).

You can create bots using the Download file action of the Google Drive package.

Previously, when you used the Download file action and marked the Overwrite existing
file option to overwrite the file of the same name, the downloaded file became corrupted.
If you then used the Excel advanced > Open action to open this file, or manually tried to
open the Excel file, an error message displayed indicating that the Excel file was corrupted.

Service Cloud case ID: 01833815
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You no longer have an incorrect starting date when you create an event using the Google
Calendar package.

Previously, when you created an event in Google Calendar and entered the value in
the Start Date field with the event type set to All Day, the Google Calendar package
decremented the day value by one when you selected the All Day option.

Service Cloud case ID: 01815644

When you use the Excel advanced > Open action to open an Excel spreadsheet which did
not exist and then run the bot, the bot now displays the correct error message in Japanese.

Service Cloud case ID: 01857992, 01925567

You can successfully extract fields from a PDF file when you use the PDF > Extract field or
Extract text actions.

Service Cloud case ID: 01818304

When you use the 3.6.1-20220428-010115 version of the Simulate keystrokes package to
enter keystrokes against specific webpages running in the Microsoft Edge browser with IE
mode, the bot processes the keystrokes faster.

Service Cloud case ID: 01820418

When you use the PDF > Split document action to split multiple PDFs into various folders
and then use the For each file in folder iterator to run the bot in a loop to split each file in
the specified folder, the bot no longer encounters an error.

Service Cloud case ID: 01803983

When you use the File > Copy Control Room file action and choose the dynamic file path
option to select a file from the Control Room repository, the bot no longer encounters an
error. Previously, even if the uploaded file was available in the Control Room, the bot failed
and displayed this error message: Get Resource failed: Error: Could not find
the file at the Control Room path. Check the file path and try again.

Service Cloud case ID: 01805364

When you use the File > Rename action to rename and overwrite an existing file, the bot
Nno longer shows an incorrect error message. Previously, when you tried to rename an
existing file, the bot showed an incorrect file name in the error message.

Service Cloud case ID: 01845943, 01858350

You can successfully rename the file and remove an extension from the file name by
using the File > Rename action. Previously, when used the Rename action to remove
an extension from the file name, the bot trimmed the last character from the file name
instead.

Service Cloud case ID: 01842995

When you use the Recorder to capture objects on an application that is installed on a
virtual machine, finish the recording after the objects are captured, and then relaunch the
Recorder, the bot successfully launches the Recorder and no longer inserts any actions
that were recorded earlier.
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When you use the Recorder > Capture action to automate Citrix virtual apps running on
Google Chrome and Microsoft Edge browsers, add a delay of 60 seconds and run the bot,
then if the object does not exist, the bot waits for the specified time (60 seconds) in the
Keep trying for (seconds) field before executing the next steps.

When you run the bot using the following sequence of actions, the bot shows accurate
data for each loop iteration:

1. Use the Database > Connect action to connect to the database

2. Use the Database > Read action to read the values from the database

3. Use the For each row in a SQL query dataset iterator to run the bot in a loop
4

Use the Database > Disconnect action to disconnect from the database and select
the Keep database schema in cache until bot finishes running option.

Previously, during the second loop iteration, the action picked up data from the previous
loop.

Service Cloud case ID: 01817192, 01853717, 01880154, 01940546

An error no longer occurs when you use Recorder package 2.8.6 and later versions to
perform a click operation on a link element that opens a pop-up window on a web page
running in Microsoft Edge with IE mode.

Service Cloud case |D: 01845776, 01858872, 01923003

When you install the AARemoteAgent_2.0, the DLL files are now copied to the correct
A360 Remote Agent folder and the AARemoteAgent_2.0 runs properly. Previously when
you installed the AARemoteAgent_2.0, the DLL files were copied to an incorrect A360
Remote Agent\Java folder.

Service Cloud case ID: 01935630

You can now successfully use the PDF > Extract field action to extract values from a PDF
that contains a string data type with the dollar sign ($).

Service Cloud case ID: 01848220

You can now successfully run all migrated web actions of the Legacy Automation package
in multiple steps of a bot in Microsoft Edge with IE mode.

Service Cloud case ID: 01853563, 01865846

In the File > Copy Desktop file action, when you use a variable that contains a number
sign (#) instead of a file path to locate the file that you want to copy, the bot no longer
encounters an error.

Service Cloud case ID: 01808009, 01845923

When exporting data to Excel CSV files, Boolean values return accurately. Previously, a bug
caused values to return as -1 while using OLE DB Driver for SQL Server (version 18 or later).

Service Cloud case ID: 01826530

Updating the Bot Agent version sometimes failed. However, when you select the
Automatically update all bot agents option, the Bot Agent updates to the latest version
without failures.
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Control Room now supports Windows NT in French.
Service Cloud case ID: 00682337

Al DELETE /vl/configurations endpoints are not accessible anymore.
Service Cloud case ID: 01920980

While installing Automation 360 on a three-node cluster, the installer prompts you to enter
the Elasticsearch password for the first node only and replicates this data across the other
two nodes.

Bots that are running for longer duration display correctly on the In progress activity page.

Previously, these bots displayed only after bot updates and were removed after the page
refresh.

Service Cloud case ID: 01921149

You can now update Internet Explorer bots created in Automation 360 to Microsoft Edge
with IE mode using the Update Bot wizard even if these bots (or its dependencies) contain
a . (dot) character in its name.

Service Cloud case ID: 01809003, 01814904, 01822014, 01858820

If you selected the Log off windows session post bot execution option under Auto-login
settings in the Control Room, data in the resource folder is cleared after the bot run.

Service Cloud case ID: 01795752, 01778828, 01804711,01864871,01923299, 01823515

If you delete a device entry fromm Manage > Devices in the Control Room, the device
reqgistration properties are removed. This enables you to reregister the device.

Service Cloud case ID: 01808450

You can successfully log in to Automation 360 using Active Directory credentials when the
Auto-login users into Control Room option is enabled, without encountering any issues..

Service Cloud case ID: 01808170, 01826805

The generated Control Room operational log files contain readable characters.
Service Cloud case ID: 01872473

The Repository Management (/v2/repository/files/<file_id>/content) APl now returns file
contents only for the files the logged-in user has permission to view. The content of these
files cannot be updated using a different API.

Previously, this Repository Management API returned file contents for the files that the
logged-in user did not have permission to view. And the user could update the content of
these files.

Service Cloud case ID: 01819101

Bot deployment now resumes and completes without any issue when the Task Bot >
Pause action executes before or while the runtime window is loading.

Previously, the resume option was not displayed in the runtime window, and the bot
deployment was not completed.

Service Cloud case ID: 01835794
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You can create a folder within the Bots folder in the public workspace.
Previously, folder creation failed with an error in the public workspace.
Service Cloud case ID: 01257981

You can now successfully compare different versions of your bots and dependencies in
both the public and the private workspaces.

Previously, comparing the bot versions failed with a timeout error.
Service Cloud case ID: 01770115, 01905037

When you export the user data to a CSV file, it now shows the correct user type and device
license information for all users.

Previously, user data exported to the CSV file showed incorrect information.
Service Cloud case ID: 01840507

You can now check in a bot successfully to the public workspace.
Previously, the bot check in failed because the audit trial was processed unsuccessfully.
Service Cloud case ID: 01860361

The BLM export is an asynchronous call and when used with the existing APl endpoint
/v2/blm/status/{requestId}, thereis a delay associated with the API call. Due to
this delay, you cannot retrieve the current status of the export if there is not enough time
gap between the export and the status call. To bypass this limitation, a new APl endpoint
has been added GET /v2/blm/status/{requestId}/timeout/{timeout} which
introduces a time delay that waits for the export process to complete and then retrieves
the status.

Service Cloud case ID: 01806109

Upgraded Swagger Ul and Swagger Editor to version 4.15.5 to fix a security vulnerability.
Service Cloud case ID: 01843148

When you create bots that use the Excel advanced > Select cells/rows/

column action and set the Cell Range with an expression (such as B1:
$SampleNumber.Number:toString$), the Bot editor no longer displays an error and the
action now works properly.

Service Cloud case ID: 01941537

When you use the File trigger to modify a BAT or VBS file, the trigger is generated once.
Previously, the trigger would generate twice when you enabled the file modified scenario.

Service Cloud case |ID: 01816589, 01877498

You no longer encounter issues with bot check-in or cancel check-out after the bulk
package update operation. When you try multiple bulk updates of packages, now an
appropriate error message indicates to perform bulk updates of one package at a time.

Previously, when you performed multiple bulk updates of packages, it resulted in check-in
or cancel check-out errors.

Service Cloud case ID: 01849828, 01881950
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Bots with a large number of automations complete successfully without any pre-
processing iSsues or errors.

Service Cloud case ID: 01949415, 01949372, 01949033

Security fixes

The version of Springframe Work is updated to 5.3.22 and does not exhibit the security
vulnerability.

Service Cloud case ID: 01850811

Limitations

When you create a device pool with a temporary (disconnected) device, the device
deletion job does not complete successfully. Additionally, the Audit log page shows the
device is deleted, whereas the Device list page shows the deleted device in the list.

When you check out bots in bulk, you cannot check out the bots for which you have the
required permissions. This is because bots for which you have the required permissions are
also excluded along with the bots for which you do not have the required permissions.

The bot checkout fails in the following scenarios:

« If a bot with same name (but different case) exists in your private workspace with the
same path.

Note: In such cases, the bot checkout or overwrite fails even when an overwrite
confirmation message displays.

« |f a folder with the same name exists in your private workspace with the same path.

When you compare bot versions from the View history page in a Public workspace, the
Compare versions page shows an error message.

Workaround: To fix this error, perform one of the following actions:

* In a Public workspace, click the three dots icon next to the required bot in the Action
menu and click Compare versions.

Note: You cannot compare the bot versions when only one bot version is available.

» |f you check out a bot to a Private workspace and then modify and save it, click the
three dots icon in the Action menu and click Compare versions.

Service Cloud case ID: 01949094, 01946533

In Windows and Linux operating system, notifications are not working with the Oracle
Database.
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We use a third-party parser to convert from HTML format to plain text. As a result, when
you convert an email from HTML format to plain text, you will see that, sometimes, the text
is not converted into plain text and is not displayed in the correct format. For example, you
might see that some lines are added or skipped.

Service Cloud case ID: 01822614

In any package, when you select the Add argument option, select String or Number
as the Argument type, and then try to insert a value, you might not be able to navigate
through the options using the scroll functionality.

When you use the System > Get environment variable action to select the list of
environment variables to return the system parameters of the device, some environment
variables might not be visible.

After you upgrade to Automation 360 v.27, if a new package (first version) is added to the
Control Room and in the setting for packages you selected Disable for the new version
of package, you will see that the package will have status as Enabled and set as default
instead of Disable.

In an Oracle Database environment, when you upgrade to Automation 360 v.27, the new
package versions that are shipped through the installer remain in the disabled state and are
not set as the default version.

Workaround: You must enable each updated or new package manually and set the
package as the default version.

In the Automation page, column customizations made on the Files and folders are not
retained when you navigate away from that page. For example, if you customize the
columns in the private workspace, move out, and navigate back to the private workspace,
the previous customization is not retained. It returns to the default view.

Similarly, searches and customizations such as filters, sort orders, custom columns, and
partially completed edits are not retained when you navigate away from the page.

Limitations from previous releases

When you run a bot in the Google Chrome or Microsoft Edge browser, use the If, Loop,
or Wait action, select the webpage from the list of active tabs in the Browser tab, close
the browser window, and then run the bot, the bot might take two minutes to open the
webpage in the browser irrespective of the timeout value mentioned.

Workaround: Move the If, Loop, or Wait action inside the If block and use the Application
is running condition with same browser application to check whether the browser is
running.

You will encounter an error when you run a standard workflow in the SAP BAPI package.

Workaround: To execute SAP BAPI, use the Run Function call (RFC) with a combination of
Create function, Set or Get field value, Set or Get structure, and Set or Get table actions.

A360 : SAP BAPI functions - Run Standard Workflow - Error while selecting
BAPI_SALESORDER_CHANGE (A-people login required)
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Limitations from previous releases

When you migrate a bot that contains XML command > Get single node, after migration,
the bot encounters the following error: No node found at XPath while executing
the Get Single node command Workaround: If the XPath expression is not starting
with (/) , apply XPath starting with “/™ so that at the time of execution, the modification
can be skipped or the XPath expression can be designed to get the desired result.

When you use the Capture action with the Recorder package (version 2.9.x or earlier) to
navigate to another web page in the Google Chrome browser (version 105.0 or later), and
then use another Capture action to automate objects in the navigated web page, the bot
might encounter an error.

Workaround: Before you use the Recorder > Capture action in the bot, maximize the
Google Chrome window .

When you use the If package, add a specific condition with a variable, then add specific
conditions within a group, save the bot, and if you rename the variable that was used, the
name of the variable might not update for the Group conditions but is only updated for the
conditions in the Condition tab.

Command prompt APl allows you to switch the device registration even if the Allow
devices (single user) to be switched to another Control Room without reinstalling bot
agent option is disabled.

When you upgrade from Automation 360 v.25 to a later version, although you enabled
code analysis in the Control Room, the rules set in the policy are not retained after the
upgrade.

Workaround: Before upgrading, we recommend that you keep a note of the rules enabled
in Automation 360 v.25 and then re-enable them after upgrading to a later version.

When you uninstall Automation 360 from the Control Panel, the name of the file is
displayed incorrectly (for example, 3¢592.ms1) on the User Account Control window.

While running a bot in debug mode, the bot will fail if the variable size gets greater than 3
MB. An error message appears showing that a variable has exceeded the 3 MB limit.

Updates to the interface
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Automation Workspace

The Max auto retry attempt option is added to reprocess the failed WLM work items
automatically.

Create queue Cancel

General © General settings

Name

* Auto-retry-gl

s tocomplete the cueus

1 work itemis) Queus name Description (optional)
Max auto retry attermnpt Auto-retry-gl

» 2 tiris

Time it takes
. Reactivation Threshold

1 work items
Owners (]
+ L use selecied Time it takes for a person to complete 1 work itern [optional)
+ n
Participants (/] - |seconds -
leptianall Max aulo retry attempt
a0 c ¥
I E| times
Consumers ® Nurmber of times the Iailed work ibems have to be re-processed
fopionall

» 0 roles selected

Define work item o
structure

Next »

Automated reprocessing of failed WLM work items

The drop-down menu in the Bot editor now includes an option to open a menu for
keyboard shortcuts.

Action details 22 Analyze Task Bot... Dual Action detai [ File properties
22 Bot Insight "Analyze” dashboard...

Packages

Dependencies and references [ Packages

Select details Se alls
- Work item template e ¥ Dependencies and references

Advanced settings 1 Work item template

= . i3 Advanced settings
== Properties

Keyboard Shertcuts

B Capture and run with admin privileges

Keyboard shortcuts
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Automation Workspace

The Device(s) from my device pools and Run as users default device(s) options are added
in the Edit the device(s) permission to manage registered and non-registered devices.

AUTOMATION
ANYWHERE
(y Home
. Automation
M Activity

» I} Manage

ﬁl Administration

Audit log

DEVICES
Regist

Edit the device(s

Device(s) frem my device pools

M Fun as users default device(s

WORKLOAD

Better device management with improved device permissions

The gMSA option enables you to manage your domain accounts across multiple

Setvice Credentials

«Control Room windows service credentials

Service Credentials

Control Room windows service credentials

[ Jvocal System Account

User Name:
andumin\el\ie.hmwn

For eg. Domain\Username:

Password:
I ssasensne |

Confirm password:
I LTI |

[Jvocal System Account

| [ Use a Group Managed Service Account |

User Name:

|mydommn\euue.trown

For eg. Domain\Username

Password:

ssesnnsene

Confirm password:

sresnnsene

stallShield

< Back

servers

Manage domain accounts using gMSA

=
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Automation Workspace

The Custom number of bot runners option allows you to
choose the number of Bot Runners that you want to use to run

Schedule bot
Schedule ©  Botrunners
ifa Run-as user’does not have 2 bot running device, 2 device pool must be selected on the next tab to continue
Botand [ -
dependencies ‘ B o ‘ ‘ - o
Name
sEonse Available bot runners (0) c Selected (1) c
Verson
- [ usemamet Device Status [ Usemamet Device Status
Runas ®© [ santhosh v-migration Picked at run time Autologin set
fum s seected 1
Device pools @
Define number of bot runners to use
Custom number of bot runners
General
N
S =

< Medum

<Back Next>

bots

Customize the number of Bot Runners

The Automation Anywhere Debugger tool is now available within the Bot Assistant utility to
provide a better user experience.

@ Assistant

>

£ Debugger

Watched variables (0) (),

No watched variables
Click here to add used variables

Enhanced Automation Anywhere Debugger tool
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Automation Workspace

Updated and intuitive icons for all the actions and contextual help for Database and Email

actions.
DB-example-bot v Saved | @ Assistant | B Run s Debugger :
Actions ® ma B X L Database: Connect B
B Move 4 Connects to a database
B Reply Triggers Reguired bot
B3 Save all attachments
B Save attachments Drag a trigger here Session name
8 Save email ‘ 99 Default ()
B Send »
v Error handler I Connection mode
A Ty ‘ Default v
A Catch .
A Finaly ! 2 1 Connection string
4 Throw @ Enterthe text
v Excel advanced Database: Connect
@l Access password S n ses - —
@ Append workbook ‘ . )
&l Append worksheet |
@ Close End Select credential
@ Con cel to PDF
@ Create workbook
Triggers Show o2
Enhanced user experience through intuitive icons | Quick assistance at hand for the
developers in the Bot editor
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Automation Workspace

The drop-down menu in the Bot editor now includes the Capture and run with admin
privileges option that enables you to capture objects on applications running in

ant » Run 3 Debugger

administrator mode.
Cancel ’ Save

Recorder: Ci [ File properties

22 Bot Insight “Analyze” dashboard... -
Captures an ac
Required bot a B Packages
A Window :

22 Dependencies and references

‘ Browser | £

b Work item template

= Swind . () ’

.*. Advanced settings

Window ti
™ Calc Keyboard Shortcuts

Capture and run with admin privileges
Case ‘—‘ P | Priviteg

Capture objects in admin mode

Related reference

Automation 360 v.27 Release Notes on page 117

Process Discovery v.27 release on page 172

Review what's new in Process Discovery for the v.27 release.

Automation Co-Pilot v.27 release on page 173
Review what's new and changed, and the fixes and limitations in Automation Co-Pilot for the v.27
release.

IQ Bot and Document Automation v.27 release on page 182
Review what's new and changed, and the fixes and limitations in 1Q Bot and Document
Automation for the v.27 release.

Bot Insight v.27 release on page 189
Review the fixes in Bot Insight for the v.27 release.

Packages updated in v.27 on page 149
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Review updates to the packages in Automation 360 v.27, including the compatible Control Room
and Bot Agent versions.

Updating to v.27 release on page 148
Review requirements and support information about updating your Control Room and Bot Agent
for the v.27 release.

Migration updates for v.27 release on page 163
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10
versions to Automation 360 v.27.

Browser extensions for Automation 360 on page 852

Create automation from supported browsers by using browser extensions. Extensions are
periodically updated to support feature enhancements and fixes. Therefore, ensure that you have
the latest versions of extensions for the Google Chrome, Microsoft Edge, and Mozilla Firefox
browsers.

Updating to v.27 release

Review requirements and support information about updating your Control Room and Bot Agent
for the v.27 release.

Bot Agent updates

Note: This release includes an optional Bot Agent update. You can continue to run your existing
bots without updating the Bot Agent. However, if you want to use the new features in Automation
360 v.27, you must update the Bot Agent available with this release.

For more information on updating to this release, see these resources:

« Automatically update the Bot Agent on page 1207 | Manually update the Bot Agent on page
1209
« Compatibility with release builds on page 1182

Certified Control Room builds for direct update

You can update to the latest version of Automation 360 from the previous three releases (that is,
from n—3 releases, where n refers to the latest release).

The following previous releases are certified for update to Automation 360 v.27:

e Vv26 (Build 15450)
e V.25 (Build 15112)
» Vv.24R2 (Build 13343) and v.24 (Build 12350)

If you are on one of these previous releases, for information about updating, see Update
Automation 360 to latest version on page 1266. If you are not on an n-3 release, update
Automation 360 to one of the n—-3 releases before updating to Automation 360 v.27.

For the latest updates to the Automation 360 extensions for Google Chrome, Microsoft Edge, and
Mozilla Firefox, see Browser extensions for Automation 360 on page 852.

Related reference
Automation 360 v.27 Release Notes on page 117
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Automation Workspace v.27 release on page 120
Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.27 release.

Packages updated in v.27 on page 149
Review updates to the packages in Automation 360 v.27, including the compatible Control Room
and Bot Agent versions.

Packages updated in v.27

Review updates to the packages in Automation 360 v.27, including the compatible Control Room
and Bot Agent versions.

The following table lists the updates in the packages for this release:

Note: Forinformation about packages related to previous releases, see the PDFs for these
releases: Automation 360 previous release versions.
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Eeatitage
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HBadiinge
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version
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EBetisgt
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version
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HBadiinge
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© 2023 Automation Anywhere. All rights reserved. 154

session.



product-flagshipAutomation Anywhere - Release Notes
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HBadiinge
Bpdwbes

version

B#EAR20220919-103920
gmaming
tater

an
attribute
(no
impact
to
existing
bots

on
upgrade)

BBf:20220416-233918
[0)o)
tater

B#ERA0220928-191723
@naming
ater

an
attribute
(no
impact

to
existing
bots

on
upgrade)

Bléiifte(¢220416-233919

Box
later

PAHEME>0221021-043050
dre

\atkererabilities

reported

in

the

security

scan

B0 220928-104414
ortuitive

ekage

icon

8-20220502-204318

later

© 2023 Automation Anywhere. All rights reserved. 157



product-flagshipAutomation Anywhere - Release Notes
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Hetitogk
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HBadiinge
Bpdwbes

version

B#ERR30220929-044740
gmaming
tater

an
attribute
(no
impact
to
existing
bots

on
upgrade)

BEfRE2 0221006-094641
Grature
later

Rfi@iEa 0220921-062556
@naming
ater

an
attribute
(no
impact

to
existing
bots

on
upgrade)

Bis20221020-114450
Bt
\ategion
for
botRunTime
and
bot
APT

BR3P0 20923-172123
Gratuletor
later

Rkt 20221004-130231
tiature
later

BitG10220715-220725
op
later

© 2023 Automation Anywhere. All rights reserved. 161



product-flagshipAutomation Anywhere - Release Notes
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* These fixes are minor, internal updates, so they do not include an update or further details on
our documentation site. As these updates relate to improvements in security, resiliency, and
efficiency, we recommend that you use the latest package versions to include these updates in
your existing bots.

Related reference
Updating to v.27 release on page 148
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Review requirements and support information about updating your Control Room and Bot Agent
for the v.27 release.

Automation Workspace v.27 release on page 120
Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.27 release.

Automation 360 v.27 Release Notes on page 117

Migration updates for v.27 release

Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10
versions to Automation 360 v.27.

What's new

Enterprise 11 and Enterprise 10

Scan Automation 360 bots that use Basic authentication in Email action

This release introduces an option to use the Bot Scanner to scan all Automation 360 bots
and identifies those that use Basic authentication in the Email package and Email trigger
action so that you do not have to identify them manually.

You can use the Bot Scanner report to analyze the impact to the bots due to the Basic
authentication and the estimated effort required to switch the authentication mode from
Basic to OAuth 2.0.

For more information, see Scan Automation 360 bots for Email action with Basic
authentication usage on page 993 | Basic authentication scanning messages on page
996

Variables created automatically after migration

In the Bot Scanner utility, bots that contain the following non-referenced system variables
are no longer flagged as Action Required or Review Required:

o SExcel Column$

o SFiledata Column$
« SDataset Column$
o STable Column$

o SXML Data Node$
« SPDFTitle$

« SPDFSubject$

o SPDFFileName$

o SPDFAuthor$

After migration, the system automatically creates these variables based on the Automation
360 naming convention, and the migrated bots run successfully.
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Enterprise 11 and Enterprise 10

Support for SMTP server type with Send Email command

When you migrate bots with the Send Email command, you can select the Use outgoing
Email server settings option in the Bot Migration Wizard to identify and select the server
type for the Enterprise 11 bots. You can configure required server details using a new SMTP
server type option.

See Migrate Enterprise bots on page 1431.

Improved automated editing ability for legacy bots

When you migrated legacy bots that contained the Log To File command, the Carriage
Return and Line Feed (CRLF) characters were converted to LF characters automatically.
In Automation 360, the text is displayed in a single line with no line feed, whereas in
Enterprise 11, the CRLF is added at the end of each line as a line feed. As a result, you had
to add the $String:Newline$ variable to insert a CRLF in the migrated bot.

The new Convert \n characters to \rn\n Log to File action option in the Bot Migration
Wizard enables you to add a new CRLF automatically to migrated bots and avoid manual
edits. Migrated bots that use the Log To File sub-commands to log files can use the CRLF
characters in a string.

See Migrate Enterprise bots on page 1431

© 2023 Automation Anywhere. All rights reserved. 164



product-flagshipAutomation Anywhere - Release Notes

Enterprise 11 only

Migration enhancement to packages and actions

*  When you migrate Enterprise 11 bots with variables whose values are read from a text
file, the system adds the String: Import string from text file subcommand to import the
variables from the text file into a string variable. As a result, extra lines are added in the
migrated bots.

The Read variables action has been added in the Text filepackage to address the extra
lines.

You can use this action to read the values of all variables in a text file as a single line in
a migrated bot which simplifies the post-migration efforts and reduces the number of
lines added in a migrated bot.

See Read variables action on page 2752
* Microsoft is removing the capability to use Basic authentication in Exchange Online for
the following protocols:

« RPC

« MAPI

« Offline Address Book (OAB)

+ Exchange Web Services (EWS)
- POP

o IMAP

« Exchange ActiveSync (EAS)

« PowerShell

For those customers running bot for Email automation that connect to Exchange
Online using the IMAP, POP3, or EWS protocol with Basic authentication, we have
added authentication options to support OAuth2 authentication.

You can migrate Enterprise 11 botswith the authentication type set to the OAuth2
option with Authorization code with PKCE or Client credentials.

* In the Read from action of the Database package, the following option is introduced:
Don't create file if no data is found. This option is selected by default for migrated bots
with the Database package, and the migrated bots now follow the same behavior as
Enterprise 11. If the executed SQL query does not return any data, the behavior is as
follows:

« |If this option is selected, no CSV file is created.
« If this option is not selected, a 0 KB CSV file is created.

For more information, see Using the Read from action on page 2200.

» Migrated bots support the newly added Return key in the Simulate Keystrokes >
Keystrokes action. These bots will continue to display the Enter key (which has been
renamed to Num Enter) and the newly added Return key.

« Migrated bots support access to the Datetime global variable across all actions in the
Datetime commands.
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Enterprise 11 only

You can successfully migrate Task Bots that contain references to multiple MetaBots which
include DLLs with same name. The session name of the first DLL is created using the
name of the DLL. When the subsequent DLL with the same name from another MetaBot is
migrated, the ID of the folder in which the DLL resides is used as a session name.

For example: M DLL Session-<MetabotFolderId> <DLLName>.

Fixes

If the Enterprise 11 bots used the Send Email command without configuring authentication,
now after migration the Email server host, Email server port, and My server requires
authentication values are set to the appropriate values.

Previously, after migration, these values were set to null variables and authentication failed.
Service Cloud case ID: 01849475

After migration, bots that are using Visual Basic script or JavaScript in the Run Script legacy
automation action and using multiple parameters that include spaces without quotation
marks will now display the correct output after execution.

Previously, such bots were displaying incorrect output.
Service Cloud case ID: 01901882

An error no longer occurs during migration when the Select Query bot runs validation.
Previously, the following error randomly occurred with text drivers.

[Microsoft][ODBC Text Driver] Object invalid or no longer set.

After migrating to Automation 360, if the Application window does not exist for the bots
that use the If, IF/ELSE, or Loop in Windows control, then these bots no longer encounter
errors during bot run.

Service Cloud case ID: 01846262

The Stored Procedure parameters are set correctly with Nvarchar when you migrate bots
to Automation 360.

When a bot that contained the File and Folder loop was migrated to Automation 360, an
error was displayed if the corresponding folder did not exist. You can migrate such bots like
the corresponding legacy bot as the If condition is now added before the File and Folder
loop to check if the folder exists.

You can migrate bots that contain the Substring command from the String package to
Automation 360, even if the optional Length attribute is blank.

When you migrate a bot that has $counter variable within a nested loop to Automation
360, the child loop counter is now set to the parent loop counter and the child loop
iteration is processed correctly.

When you run a Select query inside a Loop package, and you reiterate its result set further,
the resultant Loop now reiterates the latest record as expected.

Service Cloud case ID: 01799961

© 2023 Automation Anywhere. All rights reserved. 166



product-flagshipAutomation Anywhere - Release Notes

You can successfully migrate bots that have the Wait for object to exist value option set to
0 seconds in the Object Cloning command.

When you use the Run Logic command with an IF/ELSE condition that uses a Credential
variable, all credential variables migrate successfully.

When you migrate Enterprise 11 bots with string variables that have static values, variable
parsing through legacy expressions is no longer performed. This avoids unnecessary parse
expressions from being added to the migrated bots.

Service Cloud case ID: 01819830

You can successfully run migrated bots that contain multiple Clipboard variables as an
output. Automation 360 adds the Clipboard:Copy to action after every variable so that
migrated bot is run properly.

Service Cloud case ID: 01815938

When you migrate Enterprise 11 bots that use the Connect action with the Terminal
Emulator command, and if the Hostname field contains a Credential Variable, then the
field is mapped correctly after migration.

Service Cloud case ID: 01861600

When you run migrated bots that contain the Legacy Automation > Manage web controls
> Select Item by Text action, the list that contains variables is now displayed as expected.

Service Cloud case ID: 01782998

You can now change, reallocate, or delete the license of a Bot Runner user in a migrated
Automation 360 Control Room, even if the Bot Runner user had logged in to Enterprise 11
Client at least once.

Previously, an error was displayed in such cases.
Service Cloud case ID: 01829547

You can run migrated bots successfully on SMTP servers when you include the Send Email
command inside a Loop, and that loop iterates more than 100 times.

Service Cloud case ID: 01792886

Migrated bots do not create duplicate variables when the Error description variable is
case-sensitive.

Service Cloud case ID: 01861530

You can now successfully migrate audit logs using the audit log export utility on a multi-
node setup from the Enterprise 11 Control Room.

Previously, the audit log export utility displayed an exception error in such cases and the
audit logs could not be migrated.

Service Cloud case ID: 01912835
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Limitations

In Enterprise 11, if bots were using certain keys (such as: Ctrl, Shift, Caps Lock, Num Lock,
and so on) in the Insert Keystrokes command, the keys were reset when an error was
encountered during the execution of child bots. However; after migration, these keys are
not reset when an error is encountered during the execution of child bots. As a result,
different output or behavior might occur during the execution of the other subsequent
child bots or the main bot.

Service Cloud case ID: 00773679

When you migrate a bot that uses the Send email command and run the bot in
Automation 360, the predefined placeholders in the email body are not replaced with their
actual content.

For example:

Task Name: <taskname>
Repeat: <repeat>

Status: <status>

Last Run Time: <lastruntime>

Whereas when you run the bot in Enterprise 11 with these placeholders, the following
output is generated:

Task Name: PLACEHOLDER SEND.atmx
Repeat: Do not Repeat

Status: Failed

Last Run Time: 11/29/2022 13:04:22

Service Cloud case ID: 01908010

When you run a migrated bot with an XML package that contains an Xpath expression, the
running bot might fail and generate this error message: No node found at XPath

This issue might occur for these specific scenarios:

« |f the root element does not have a namespace, and the child element of the XML
package has a default namespace.

e If there are more than one xmilns (the default XML namespace) defined in the XML
document.

Service Cloud case ID: 01874203, 01798339

See XML path is not working which works fine in Enterprise 11

Updates to the interface
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Migration

The Bots using Email action with Basic authentication option is added to the Bot
Scanner to scan bots that use basic authentication in the Email package and Email

Automation 360 Bot Scanner for EOL Features

Welcome to the Automation 360

Bot Scanner

What do you want to scan?

Bots using Email action with Basic authentication -

This utility will help you to scan your bots and provide summary report for analysis.

Scan Automation 360 bots that use Basic authentication in Email action

trigger
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Migration

The Use outgoing Email server settings option is added to the

Bot Migration Wizard to specify the type of email server you use.
Migrate bots

Migrate bots

iine o Settings
Name
« MIgration TN 25 01.04.. Name Description (optional)
Description ‘ Migration.admin.23.01.04.08 48 12 ‘
Mamum = 255 d
Bots @ Bot Migration settings

« Bots sslacted (0]

(] Overwrite if a bot with the same name exists
Bot Runners

[ Exclude bot dependencies

If this option is selected, all the bot dependencies wil be excluded while migrating,

Bots and Dependent ) § )
Bots Bot behaviour configuration
[ Use Excel Cell Row’ legacy behavier

If you are migrating from 11 3.0 and below, we recommend selecting this option.

Us outgoing Email server settings

s option is selected, settings will be applicable to bots that contain send email action. You may need to update the global value if required
) SMTP email server

[ Server uses secure connection (SSL/TLS]

[] server requires authentication

() EWS email server

[ Include web services settings

This allows you to migrate along with the web services proxy host and part. If this value is selected, pre-created global values wil be availzble to
the bot for connecting with web services proxy.

D Convert bots built using Internet Explorer to Edge with Internet Explorer mode
If you are migrating bots built on Internet Explorer, we recommend sel

g this option to convert them to Edge with Intermnet Explorer mode.

(] convert \n characters to
This allows you to conv:

nin 'Log to File' action

\n characters (LF) into \rin characters (CRLF), which automatic.
Bot Insight configuration

Ity take new line in bots using Log to File action.

(] Tag bots and variables for analytics

This allows you to tag bots and variables for analytics through Bot Insight. If you are not using Bot Insight in legacy bots, we recommend you not
to select this option

Next »

Support for SMTP server type with Send Email command
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Migration

The Convert \n characters to \rn\n Log to File action option is added
to the Bot Migration Wizard to provide you an option to not have to edit
the bots manually and a new line is added automatically in migrated

Migrate bots

« Bots sslected (D)

(] Ovenwrite if a bot with the same name exists

Bot Runners

e grating
Bots and Dependent ) . .
Bot behaviour configuration

[] Use "Excel Cell Row’ legacy behavior

Ifyou are migrating from 113.0 and below, we recommend selecting this option

[] Use outgoing Email server settings

d, settings will be applicable to bots that contain send email action. You may need to update the global value i required
th the web services proxy host and port. If this value is selected, pre-created global values will be available to
the bot for connecting

[] convert bots bu

If you are migratin

Internet Explorer mode

ts built on Internet Explor me this option to convert them to Edge with Internet Explorer mode
to \rinin "Log to File” action
\n characters (LF] into \rin characters (CRLF), which automatically take new line in bots using Log to File action

Bot Insight configuration

[ Tag bots and variables for ana

analytics through Bot Insight. If you are not using 8ot Insight in

bots.

Improved automated editing ability for legacy bots

Related reference

Automation 360 v.27 Release Notes on page 117

Automation Workspace v.27 release on page 120

Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.27 release.

Updating to v.27 release on page 148

Review requirements and support information about updating your Control Room and Bot Agent
for the v.27 release.

Remote agent v.2.1.0 updates

A new version of the Remote agent is released with Automation 360v.27. This section includes the
fixes for Remote agent version 2.1.0.

Fixes

When a bot keeps running for a few hours, an error no longer occurs due to high memory
usage with the Recorder package version 2.9.2 or later.

Previously, an increase in memory usage caused the bot to fail after a few hours with a
Java heap space error.

Service Cloud case ID: 01911565
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An error no longer occurs when you use Recorder package 2.8.6 and later versions to
perform a click operation on a link element that opens a pop-up window on a web page
running in Microsoft Edge with IE mode.

Service Cloud case ID: 01845776, 01858872, 01923003

When you install the AARemoteAgent_2.0, the DLL files are now copied to the correct
A360 Remote Agent folder and the AARemoteAgent_2.0 runs properly. Previously when
you installed the AARemoteAgent_2.0, the DLL files were copied to an incorrect A360
Remote Agent\Java folder.

Service Cloud case ID: 01935630

In the Recorder package, you can now use the Left click, Right click, and Set Text with
delay actions for cross-domain IFrames to automate web pages on Google Chrome and
Microsoft Edge browsers with Manifest V3 extensions. Previously, these actions were not
working for cross-domain IFrames with Manifest V3 extensions.

In the Recorder package, you can now use the Click action for the Link and Form tag
controls that have inline scripting with JavaScript using Manifest V3 extensions.

When you use the Recorder > Capture action to automate Citrix virtual apps running on
Google Chrome and Microsoft Edge browsers, add a delay of 60 seconds and run the bot,
then if the object does not exist, the bot waits for the specified time (60 seconds) in the
Keep trying for (seconds) field before executing the next steps.

Process Discovery v.27 release

Review what's new in Process Discovery for the v.27 release.

What's new

PEG Serverless

With support of up to 100 simultaneous sensors, businesses can easily redact sensitive
data at scale before the data is sent to the Process Discovery platform. Businesses can
run Process Discovery data collection across multiple teams simultaneously, while still
providing one interface for IT Admins to manage the configuration, and one interface for
the business to review the redactions.

PEG Configuration Ul

IT Admins can easily manage forwarding configurations, redaction configurations, and
export logs from a web Ul instead of having to run commands on the command line.

Configure PEG image redaction on page 3329
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Fixes

Discovery Bot admins can now view all created processes without having the Discovery
Bot recorder license.

Previously, if a Discovery Bot admin did not have a Discovery Bot recorder license and was
using version A360.24, A360.25, or A360.26, all created processes did not display on the
Processes page.

Service Cloud case ID: 01859123, 01877311, 01860901

Related reference

Automation 360 v.27 Release Notes on page 117

Automation Workspace v.27 release on page 120

Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.27 release.

Automation Co-Pilot v.27 release on page 173
Review what's new and changed, and the fixes and limitations in Automation Co-Pilot for the v.27
release.

IQ Bot and Document Automation v.27 release on page 182
Review what's new and changed, and the fixes and limitations in 1Q Bot and Document
Automation for the v.27 release.

Bot Insight v.27 release on page 189
Review the fixes in Bot Insight for the v.27 release.

Packages updated in v.27 on page 149
Review updates to the packages in Automation 360 v.27, including the compatible Control Room
and Bot Agent versions.

Automation Co-Pilot v.27 release

Review what's new and changed, and the fixes and limitations in Automation Co-Pilot for the v.27
release.

What's new

Smart embedded forms and dynamic data mapping for embedded widgets

You can now design your forms using a responsive and real-time canvas that can
automatically adjust to the desired form size. This enables a faster way for you to create an
embedded interface for use in any web application. You can also use these forms in your
business applications to securely retrieve data when embedded as an iFrame widget.

To save time and eliminate data re-entry, you can use the postMessage APl to map

and pre-populate data from business applications in embedded widgets. Dynamic data
mapping provides a safe and secure communication from your business (host) applications
to the initial process forms in the widget.

Smart embedded forms and dynamic data mapping on page 2881
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Build forms easily by dragging elements to form builder

You can now build your forms by just dragging your elements to a blank form builder. As
you add elements to the form builder, it automatically adjusts without your input, letting
you focus on the form-building experience. You can also re-size the columns of your
elements.

Create a form

Map data in host web applications for Automation Co-Pilot (integrations)

You can now map your host applications data to your AARI forms so that when you create
a request, the initial form field will be automatically populated with the mapped data.

Map host data to process on page 2883

URL parameters support for iFrame widget

You can use URL parameters to pass data types (date, time, number, and text box) through
query parameters for your initial forms in the iFrame widget. Because the iFrame URL
allows you to modify the URL to add data types, you can now directly populate data from a
host application for form elements without having to keep re-entering the data.

Deploy automations in web application on page 2876 | URL parameters on page 2989

Virtual window support for iFrame widget

You can now run your bots in a virtual window (picture-in-picture view) for Automation Co-
Pilot (integrations). With this option, you can run an attended bot in a small virtual window
on your screen (instead of another desktop page or application) simultaneously while you
complete tasks on the same page without obstructing your automation experience.

Deploy automations in web application on page 2876 | Configure a bot on page 3030

Select tags in widget setup

When you configure your widget in the Integrations page, the Filter automations option
allows for you to select existing tags that can be added to your widget. You can now
reference tags with the corresponding widgets in the widgets tab for easier reference in
the tags column.

Setup iFrame widget using Automation Co-Pilot on page 2869

View status and run time details in automation list

You can now view the status and run time of your bots and processes in the automation
list. The status and run time are based on your bots and processes last activities. You can
quickly review whether a bot was completed in x amount of days or time ago, or shows no
activity at all.

Deploy automations in web application on page 2876

AARI shortcut link

You can now access Automation Co-Pilot directly from your Automation Workspace. The
Explore AARI link in the new AARI tab from the homepage is a shortcut that redirects you
to the Automation Co-Pilot portal. This is an easier way for you to access Automation Co-
Pilot if you forget how to access AARI or need to modify the URL to access Automation
Co-Pilot.

Deploy processes on page 3009
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New actions in the Process Composer

In the Process Composer, you can now use a set of actions when you build out your
process. For example, you can double-click a task, such as Bot Task and Human Task, and
the task will be updated in your process flow automatically. With this, you can save time
because you do not need to task specific tasks to your process. In addition, you can now
copy, cut, and paste using CTRL + C, CTRL + X and CTRL + V, respectively to retain, reuse,
or replace data.

Behaviors supported in the Process Composer on page 3005 | Create a process in
Process Composer on page 2991

Use a reference ID meta type in Process Composer

You can now use a reference ID with a Meta variable type for your variables in the Process
Composer. When you set a reference ID as a meta variable type, you can now use your
reference ID data when you run your tasks in the web interface. This simplifies your
references because you only need to rely on using the reference ID instead of relying on
other variable types or references.

Create a process in Process Composer on page 2991

Center your forms in preview

You can now preview your forms in the new preview window and get an accurate
assessment on how your form will look when it is rendered. You can select the Make form
preview centered option to enable the preview window. You can also set the appropriate
display resolution, x and y coordinates, and even center your form.

Create a form

Upload images directly to the form composer

You can now upload images directly to the form composer by using the Image element.
This saves you time to view the images in the form without a file reference, rather than in
the initial step, where the image requires a file reference to be viewed.

Note: Image files are limited to 150 kb (like a logo).

Using the Image element on page 2929

Change label action for Button element

The change label action in the form rules now applies to the Button element. When you
use the change label action in form rules and apply it to the buttons in your form, the
changes will be automatically applied to the buttons where you set the rules. This keeps
the flow consistent with the elements that you are using because all the buttons inherit the
same rule.

Add rules to form elements on page 2939

© 2023 Automation Anywhere. All rights reserved. 175



product-flagshipAutomation Anywhere - Release Notes

Rules editor for Table element

The rules editor is now applicable to the Table element. When you use the rules editor for
your tables, the rules conditions are applied for each individual columns while any actions
that you set are applied for each row in the row level. This makes things consistent for
each new or existing row that you use because all the rows inherit the same rule.

Add rules to form elements on page 2939

What's changed

Build 16701: This build includes the following enhancement:

Enhanced automation experience in Automation Co-Pilot Desktop Assistant

We have improved the automation experience for your automation activities in
Automation Co-Pilot Desktop Assistant.

*  You must have the Manage my activity permission as a prerequisite to use the bot
controls.

*  When you run your automation, the bot, its progress page, controls for pause, start
(resume), and stop, are all unified inside Automation Co-Pilot Desktop Assistant.
Previously, there was a seperate window for the bot run and its controls. (This will still
be seen in this version but will be hidden in future releases.)

* You can view the status of your bot progress and its details, and is reflected on the
activity page.

* You can view and manage pending automation that have been initiated and users can
navigate between bot list view and progress view. If you have multiple Automation
Co-Pilot Desktop Assistant instances or disconnect and then reconnect to a different
instance, the pending automation will be visible from the progress page for you to
control.

Service Cloud case |ID: 01793119, 1815462

Automation Co-Pilot Desktop Assistant automation activities on page 2920

Build 16667: This build includes the following enhancements:

Define tags in process configuration

When you edit a process, you can use the Tags field to search and specify tags based on
keywords, to define your process. You can add tags from new or existing tags and use
them to reference specific tags related to your process.

Configure a process on page 3031

Fixes

Build 16701: This build includes the following fixes (along with fixes from the previous builds):
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In Automation Co-Pilot Desktop Assistant, you can continue your pending automation
in different Automation Co-Pilot Desktop Assistant instances. Automations are no longer
stuck, and you can run bots as usual.

Service Cloud case ID: 01829572

Note: This fix was first included with Build 16694 for Cloud Sandbox and Community
Edition. Build 16701 now includes this fix for Cloud, Cloud Sandbox, and Community
Edition.

Build 16685: This build includes the following fixes (along with fixes from the previous builds):

When bots have a file dependency or an interactive form that includes any multibyte
character in its name, the bots run as expected. Previously, having the multibyte character
in a form name caused an error.

Service Cloud case ID: 01947340

Build 16667: This build includes the following fixes:

You can now view signatures when you preview files using the AARI document viewer.
Previously, signatures could be viewed only when files were opened in a separate tab.

Service Cloud case ID: 01879533

Bots are no longer triggered when you modify a file in an authenticated network.
Previously, bots would trigger when you maodified a bot in a network that required
authentication.

Service Cloud case |ID: 01256344, 01756709, 01854164, 01888188

The resiliency of the Create > Request action has improved in the Process package.
Service Cloud case I1D: 01886231

You can add, delete, and change values to the column cells when you create forms using
the Column Filter function. Previously, an error altered the accuracy of this operation by
sometimes changing rows or filtering newly edited values.

Service Cloud case |D: 01854490, 01941416

When scrolling past 100 task bots in Automation Co-Pilot Desktop Assistant page, fresh
bots now load to successfully complete the list of bots not yet displayed.

Service Cloud case ID: 01804139, 01845208, 01881927

You can select Reference ID as a Meta variable type from the Variable drop-down list.
Service Cloud case ID: 01861551

When you enter data in a password field in the initial form, the password field retains your
data after you submit the form without requiring you to re-enter the data.

Service Cloud case ID: 01846222
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When you use a file element to select multiple files, the file element functions properly
without having to reset the form.

Service Cloud case ID: 01840888

Buttons in forms work as expected. Previously, some users encountered an exception error
and were unable to click Confirm to submit their form.

Service Cloud case ID: 01846856

When you run a bot in Automation Co-Pilot, you can edit the auto-populated fields after
you select an option from the drop-down menu.

Service Cloud case ID: 01853623

When you use a number element and enable the Use comma to separate thousands
format option, the bot will run without issues. Previously, some users encountered an
exception error.

Service Cloud case ID: 01869566

When you use the File modified trigger option to modify the contents or files, the trigger
works properly.

Service Cloud case ID: 01812596

When you use a document element in your form to upload PDF files, the PDF files that are
uploaded renders the contents properly.

Service Cloud case ID: 01802898, 01833266

Known Limitations

Image files uploaded to forms for access in the Process Composer are limited to 150 kb.
Example of uploading and downloading file for web on page 2977
Service Cloud case 1D 01922815

Updates to the interface
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Automation Co-Pilot

The form builder now automatically adjusts the size for each form element you drag into
the canvas. The sizes can also be manually adjusted.
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Powered by Automation Anywhere

Build forms easily by dragging elements to form builder
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Automation Co-Pilot

The Tags field in the Edit Process page now has a drop-down menu for you to create new
or select from existing tags.

Edit Process: 35 - Returns

General Teams Deployment

Process name

Returns

Maximum 235 Characters

Description ( Optional )

Maximum 1024 Charactars

Frocess key @

Enter 1-5 alphabetical characters. Once saved, the Process Key cannot be changed.

Tags

Account x| Workspace x| [electizgs oo

[] Support

Account
[] Salesforce

Workspace
kd Dy user

[] bybot

Define tags in process configuration
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Automation Co-Pilot

The Filter automations field in the Add Widget page has a drop-down menu for you to
select existing tags.

Add Widget oo ) R

Widget name
MNew Widget

Maximum 235 Characters

Filter automations

(]
1

Account x| Workspace x| felect tags

[ ] Support

Account
[ ] Salesforce

Workspace

Select tags in widget setup

Related reference
Automation 360 v.27 Release Notes on page 117

Automation Workspace v.27 release on page 120
Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.27 release.

Process Discovery v.27 release on page 172
Review what's new in Process Discovery for the v.27 release.

IQ Bot and Document Automation v.27 release on page 182
Review what's new and changed, and the fixes and limitations in IQ Bot and Document
Automation for the v.27 release.

Bot Insight v.27 release on page 189
Review the fixes in Bot Insight for the v.27 release.

Packages updated in v.27 on page 149
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Review updates to the packages in Automation 360 v.27, including the compatible Control Room
and Bot Agent versions.

IQ Bot and Document Automation v.27 release

Review what's new and changed, and the fixes and limitations in 1Q Bot and Document
Automation for the v.27 release.

Document Automation

What's new

Standard forms integrated with Document Automation

You can create and manage learning instances entirely within Document Automation.
Previously, you had to create standard form learning instances in IQ Bot and then process
them through the Connect Learning Instance feature in Document Automation. With
standard forms integrated with Document Automation, you benefit by having an entire
workflow consolidated into a single system.

Using Document Automation for Standard Forms on page 3191.

Support for Microsoft Form Recognizer v3.0 models in Document Automation

Microsoft Form Recognizer v3.0 provides additional capabilities to the existing model
creation, including options to select Template and Neural. While training a model, you can
select either 2.1 or 3.0 version.

New Document Automation product licenses

Document Automation now offers the following licenses to enable users to process
documents and track metrics for learning instances in production:

* Document Automation Standard Forms (Number of pages): Required to create a model
and process documents in a Standard form in Document Automation.

*  Document Automation 360 Extraction (Number of pages): Required to process
documents in an Automation Anywhere (Pre-trained) model, including the User-defined
document type.

Also, there are updates to license consumption tracking.

License tracking release note

Extract data with Google Vision OCR

If you are a user with a Cloud Control Room, you can process documents using Google
Vision OCR technology by creating or updating a learning instance.
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What's new

Improved table extraction in Automation Anywhere models

You can use validation feedback to train a learning instance to extract data from a cell that
contains more than one field.

For example, if a product description column also includes item number, you can outline
the item number in the Validation interface. When the learning instance processes
subsequent documents, it will extract the item number and ignore the product description.

Using validation feedback to extract specific values in a table on page 3163

Visualize performance metrics with a new Document Automation widget

You can view data visualizations on Validator user performance. This new widget is a
horizontal bar chart that shows the weighted average time each Validator user spent
performing manual validation per document.

Document Workspace dashboard on page 3392

Document Automation supports regular expression pattern-based extraction

When configuring fields that the learning instance will extract, you can specify a regular
expression (regex) pattern to help the extraction engine find the field. After entering the
regex pattern you can test the expression using sample content within the Create Learning
instance window. You can use regex pattern extraction for values that follow a specific
pattern, such as a VAT number or a PO number.

Validation interface support for shortcut keys

Zoom in and out on documents in the Validation interface by holding the Alt key and
scrolling with your mouse wheel.

What's changed

The following updates impact how the Control Room tracks license consumption:

* The Control Room checks enough product licenses prior to deploying the bot.

* The IQ Bot Pages license and the Standard Forms Pages license track documents
that are processed through learning instances created in Automation 360 1Q Bot. This
includes documents processed in the learning instance in Automation 360 1Q Bot and
learning instances connected to Document Automation.

* Inthe Licenses page, the Document Al license is called the Google Document Al
(number of documents)

« The Control Room also tracks documents processed in Google Document Al for
users who brought their own license. Previously, the Control Room only tracked such
documents for users who bought their licenses through Automation Anywhere.

You can now configure Oracle Database with on-premises and Linux installations of
Document Automation.

When you import a learning instance created in previous versions of Document
Automation, the check box to send validation feedback to the system is now not selected
by default. You must edit the learning instance to select the check box.
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Fixes

Build 16694: This build includes the following fixes (along with fixes from the previous
builds):

Now users with either the Standard Forms for Document Automation or the Standard
Forms (for 1Q Bot) licenses can create a Standard Forms model in Document Automation.

Build 16685: This build includes the following fixes:

The Bot Agent now clears out the resources folder after running actions from the
Document Extraction package.

When you import a learning instance created in a previous version of Document
Automation, the Improve accuracy using validation check box is now unselected by
default.

Document Automation now correctly tracks license consumption in all On-Premises
installations, irrespective of the port number.

You can now add formula validation to learning instances with the user-defined document
type.

Standard forms in Document Automation is now supported in a fresh installation or
upgraded multi-tenant Control Room. Previously, Standard forms in Document Automation
was only supported on a fresh installation of a multi-tenant Control Room.

When you refresh the Validator page, the Validator displays the last document you worked
on. Previously after a page refresh, the Validator sometimes displayed the first document
you had validated.

Bot Runner devices configured with a proxy can successfully run actions from the
Document Extraction package.

Service Cloud case |ID: 01856276, 01862174, 01911425

Limitations

Standard forms only support unigue field extraction for any document. If there are fields
with the same name on multiple pages, then the document must be trained with different
tag names in the model creation tool.

For example, if there is a field named date on two different pages, then you must use
datel and date?2 to make the tag names unique in the model creation tool for training.

You cannot use spaces in model names when you create models for Standard forms
v3.0. If the model name contains any spaces, then an InvalidParameter error message is
generated.

There is no average accuracy for standard forms v.3.0 from the Microsoft Azure Form
Recognizer service. As a result, the standard forms training displays the average accuracy as
0.00% for the v.3.0 service.

When fetching a Standard Forms model, an incorrect error message displays when no
configurations are available in Document Automation.
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Limitations

The resizing functionality is not working properly for the model list table. As a result, you
cannot resize the table header or column in Standard Forms.

The run analysis result does not display in standard forms when creating a v.3.0 model with
multipages.

There is a default character limit of 100 characters for the table name, and 155 characters
for the field name of the table. However, if you reconfigure the table, you can add more
characters than the default limit.

The System-Identified Regions (SIRs) for checkboxes or radio buttons are not generated for
the standard forms v.3.0 model.

Standard forms is not supported on Linux.

Any re-mapping or re-drawing in the System-Identified Regions (SIRs) in the Validator
results in detection of an incorrect check box. However, you can enter the check box value
as checked or unchecked after changing the auto-generated mapping.

When migrating a learning instance from one Control Room to another, the same user
must export and import the .dw file.

If the learning instance extracts data from a multi-line field and transfers it to a CSV file, an
extra space is added at the end of each line.

When you mouse over data points in the "Average validation time" and "Validator
performance by number of documents” widgets, the correct values do not immediately
display in the pop-up window.

Document Automation prevents you from creating a learning instance if you create
a custom table field without providing a field name and field label, even if you have
unselected the field.

If you click Test regular expression and replace the value in the Regular expression field,
the field now has a limit of 50 characters.

Workaround: Click Cancel to leave the Test reqular expression window and make the
revisions in the Regular expression field.

The Table icon is not generated on the Form OCR Testing Tool (FOTT) for the Standard
form v3.0 Model.

If a field name contains more than 100 characters, the scroll bar does not appear and you
cannot see the value of the form field.

If a table name contains more than 50 characters, you cannot expand the table size.
Additionally, the field name in the table does not display when you hover over it.

If you test an invalid Python script when configuring custom logic, the system returns an
error message that contains the Python execution path.
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Limitations

Sometimes document extraction fails and one of the following error messages appear in
the Automation Co-Pilot request status: Extraction bot failed. Please check
activity/audit logs for more detail or Download bot failed. Please
check activity/audit logs for more detail with this message in the audit log:
Existing deployment in progress for this user session.

If this happens, restart the Bot Agent on the impacted device.

The Document Workspace dashboard sometimes shows incorrect page consumption
metrics if the Control Room is installed On-Premises.

Documents cannot be processed with Google Vision OCR if your proxy is configured with
a Proxy Auto-Configuration (PAC) file.

When you create or edit a Learning Instance, if a field name starts with a numerical value,
then the formula validation for that field fails. This issue applies to form fields and table
fields.

If you import a learning instance with the validation feedback option disabled, the validation
feedback option becomes enabled and you must manually edit the learning instance to
disable the option.

For Standard Forms, when a document with multiple pages is processed and enters into
validation, one page is being duplicated in the Validatoreven when the System-ldentified
Regions (SIRs) in the Validator are correct.

IQ Bot

What's changed

If you are using an older version of Microsoft SQL Server that does not support TLS 1.2,
then you must keep an IQ Bot database backup and update to a Microsoft SQL Server
version that supports TLS 1.2.

IQ Bot now uses the latest version of Python (3.11.0) for custom logic validation. To use the
latest version, you must upgrade from cx_Oracle 8.3 to python-oracledb. See Upgrading
from cx_Oracle 8.3 to python-oracledb

Fixes

IQ Bot now performs post-processing on fields with Python custom logic that contain
single quotation marks, such as print ('Test").

In 1Q Bot, when a document is either corrupted, deleted, or is not loading in Validator or
Designer, a placeholder image is displayed. The applications will not be consistent until you
upload new documents.

Service Cloud case |D: 00792976, 00835371
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Fixes

During the production process, you must not move the learning instances or bots from
Staging to Production, or vice-versa.

Service Cloud case ID: 01808931, 00821541, 01253373, 00836954, 01271722

When you upload any invalid document in manual or custom groups, then the document
gets processed. However, the System Identified Region (SIR) will not be generated for the
unsupported pages.

Previously, when an invalid document was uploaded with a valid document and processed
for extraction, the See extraction page kept loading.

Service Cloud case ID: 01786098

In Healthcheck API, the output shows the proper branch name convention, for example:
RC-A360.27. Previously, improper health information was displayed when the branch
name convention was heads/RC-A360.27.

If an error or exception is encountered during document validation, the error or exception
is processed, and the files are displayed consistent in the output.

Service Cloud case ID: 00827940

In 1Q Bot, if the RabbitMQ v3.8.17 and v3.8.18 is not working, then the log directory
location can now be changed by updating the system environment variable as
RABBITMQ LOG_BASE. If this variable is provided manually with the required directory
location, then the logs are created and updated in a new location. Previously, the
configuration given for the 1og.dir variable in rabbitmg.conf file did not support
RabbitMQ v3.8.17 and v3.8.18.

Service Cloud case ID: 01844995

The system-identified regions (SIRs) are now generated for manual groups when the
PDFBox is enabled. Previously, when the PDFBox was enabled, during Learning Instance
creation the SIRs for some vector PDFs were not generated for manual groups.

Service Cloud case |D: 01844223, 01849638

You cannot import an 1Q Bot archive (IQBA) file when the designer for the same Learning
Instance is open in another window. Previously, the import was failing because the
LockedTimestamp field in the visiobotDetails table had a value at the time of IQBA export.
This caused an error because the LockedTimestamp field was expecting a null value.

Service Cloud case ID: 01818474

Limitations

During the express installation upgrade of |IQ Bot, an error message is shown in the
installation steps. You must click OK to proceed further.

The maximum upload file size limit is set to 5 GB when importing and exporting files in
the 1Q Bot archive (IQBA) file. If the file size is greater than 5 GB, then you must delete
unwanted groups to decrease the file size and migrate successfully.
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Limitations

If the 1Q Bot archive (IQBA) file size is above 2,147,483,647 bits, then the File Storage does
not upload the exported file from output folder to the desired location.

before you upload it to 1Q Bot.

Sometimes, the PDFBox is unable to detect PDF (Portable Document Format) documents
accurately. We recommend that you use Adobe Acrobat to convert the documents to PDF

Updates to the interface

1Q Bot and Document Automation

provider.
.

The Create learning instance window now contains a drop-down menu to select an OCR

Create Learning Instance

& Name

~

|

Description (optional)

Document Type

| nvoices

Language

| English

Provider

‘ Automation Anywhere (Pre-trained)

OCR Provider

‘ Google Vision

28— et ——n e,
Fre-ay ECaia=iiin =i

ABBYY
Google Vision

Extract data with Google Vision OCR

Related reference

Automation 360 v.27 Release Notes on page 117

Automation Workspace v.27 release on page 120
Review what's new and changed, and the fixes and limitations in Automation Workspace for the

v.27 release.

Process Discovery v.27 release on page 172

Review what's new in Process Discovery for the v.27 release.

Automation Co-Pilot v.27 release on page 173
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Review what's new and changed, and the fixes and limitations in Automation Co-Pilot for the v.27
release.

Bot Insight v.27 release on page 189
Review the fixes in Bot Insight for the v.27 release.

Packages updated in v.27 on page 149
Review updates to the packages in Automation 360 v.27, including the compatible Control Room
and Bot Agent versions.

Bot Insight v.27 release

Review the fixes in Bot Insight for the v.27 release.

Fixes

In the Bot Insight Operations > Bots Dashboard, the bot duration shows the correct data.

Previously, there was a mismatch between the bot duration data and the manual
calculation of the bot duration from the historical menu because of a start time mismatch.

Service Cloud case ID: 01796106

When you upgrade to Automation 360 v.27 and launch the Control Room, no kernel
bootup failure occurs due to a failed Elasticsearch initialization. Thus, it does not show the
Bad Gateway error. As a result, the Control Room service is available and you can access
the Control Room URL.

Previously, Elasticsearch initialization failed during startup which was causing the kernel
bootup failure. As a result, the Control Room service was showing the Bad Gateway error.

Service Cloud case ID: 01908667, 01919727, 01919309, 01911464, 01921747, 01926887,
01925309, 01924168, 01929814, 01930226, 01931125, 01925270, 01934212

You can check out and republish the dashboard with a new name for a specific bot after
import it into the public workspace.

Note: In case of public import, you must run the bot at least one time before you export it.

Previously, you could not publish the dashboard for a specific bot even if it was checked in.
Service Cloud case ID: 01763067
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Updates to the interface

Bot Insight

The Bot Insight user interface is changed as per Common Frontend Component (CFC)
standards. Only the look and feel of the components (such as colors, fonts, icons,
paddings, borders, buttons, and so on) is changed, while the underlying functionality
remains the same. You can view these changes from the following user interface elements:

* All Bot Insight pages

« Table pagination position at the center of the page

« The Create widget dialog back drop with the Close button

* Add Widget title in the Create widget dialog

» The Switch Widget button position in the Add widget window for all charts

Related reference
Automation 360 v.27 Release Notes on page 117
Automation Workspace v.27 release on page 120

Review what's new and changed, and the fixes and limitations in Automation Workspace for the
v.27 release.

Process Discovery v.27 release on page 172
Review what's new in Process Discovery for the v.27 release.

Automation Co-Pilot v.27 release on page 173
Review what's new and changed, and the fixes and limitations in Automation Co-Pilot for the v.27
release.

IQ Bot and Document Automation v.27 release on page 182
Review what's new and changed, and the fixes and limitations in 1Q Bot and Document
Automation for the v.27 release.

Packages updated in v.27 on page 149
Review updates to the packages in Automation 360 v.27, including the compatible Control Room
and Bot Agent versions.

Automation 360 v.26 Release Notes

Release date: 6 October 2022

Review the top 5 features as well as other new features, enhancements, fixes, and limitations in
the Automation 360 v.26 release. Automation 360 and 1Q Bot are on Build 15459 (for On-Premises
and Cloud).

We have released updated builds for fixes after the Automation 360 v.26 GA build, which was Build
15436. For information about the fixes in these updated builds, see Updated release builds on page
193.

Note: The release builds include Manifest V3 browser extensions for Google Chrome and
Microsoft Edge browsers. For more information, see:

e Chrome and Edge Manifest V3 extensions on page 997
o Support for Manifest V3 extensions
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» Browser extensions for Automation 360 on page 852

Highlights of this release

Here are the top 5 features in the v.26 release:

Embedded automation with OAuth 2.0

Coding standards through code analysis

Business users can directly access authorized
automation from within their favorite business
applications, without having to open a new
interface or learn a new app. OAuth 2.0 enables
seamless authentication across systems,
reducing complexities of system-specific sign-
ins.

=

Embed automation
[ eb

application

Attended,
u

process automations

Lightweight and
esponsive
interface

N
Seamless

authentication with
OAuth 2.0 or SAML

Chrome Extension Widget
for web apps not

supporting customization

Learn more: Embed automations in your
application using Automation Co-Pilot on page
2862.

Administrators can establish coding best
practices by setting a code analysis policy
and improve their team'’s code to quickly find
and correct rule violations. They can select
which rules to check for and enable summary
reports for a snapshot of all bots within a
project.

Bot builders can quickly check the status of
their bots and receive feedback on what to fix,
speeding up bot development and deployment
and promoting coding best practices.

= Code
<] analysis

Q29

Administrator Bot Developer/
Citizen Developer

/Oj@ /@ EE— : e m%-

Configure code Run code analysis
analysis Fix violations

Learn more: Code analysis on page 1939.
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Package role-based access (RBAC) Administrators can tailor package access to the
business needs and expertise of bot developers
and enforce access policies for custom groups.
They can maintain policy control and ensure
confidence and ease-of-use for developers by
providing group-based package access with
clear policies.

Citizen developers can access simpler
packages and build easy-to-complete
automation, and professional developers can
access a broader set of complex packages.

@y PGoN e\l Recorder
ANYWHERE

Configure package availa

Please choose appropriate package settings
@ Atusers

All the users will be able to use it while creat

Users with selected roles
Packages
Users with selected roles, will have access tc

Learn more: RBAC on packages on page
1720.

Salesforce integration with command package RPA developers can build robust integrations
with Salesforce through direct APl interaction.
They can automate repetitive processes
involving access and updates to Salesforce
data, enabling business users to focus on high-
value business tasks such as strategic planning
and optimization. Commands available include
authentication, database querying, record
updates, and file processing.

Authentication

(Cliert I, Client Secret. Salesfarce Username and Passwaord)

OK (AuthToken)

Command Actions

Salesforce CRUD (Inserl, Gel, Updale, Upserl, and Delele) Records
/" [\ Automaton Object name & Record ID salesforce
‘\ ANYWHERE )|
F ACK

Upload/ Download File attachment

Record ID & Souce/Destination folder

ACK
Execute SOQL

Guery

Response with Query results
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Automation 360 integration with Google Cloud
Apigee

Updated release builds

We have released the following updated builds:

Learn more: Salesforce package on page
2606.

RPA developers can fast-track end-to-end
automation development by combining API
components from Apigee and RPA bots from
Automation 360 to access any data in the
enterprise. Our prebuilt integration packages
make the integration seamless, enabling you to
drive more value from reusing existing assets
created by your organization's automation
teams.

Two Way Integration

Automation 360 to Apigee

Connect

Google Cloud
>

Apigee

Apigee to Automation 360

Integrations
Authenticate (Control Room API)
m Credentias)

Pre-packaged + Ready made

uthToken)

Deploy Bot B (Control Room API)

Bot Inputs)

Learn more: Apigee integration.

e Build 15459 Service Cloud case ID: 01941769, 01945068

This build is updated to include a critical security fix for the issue related to Multi-Factor
Authentication (MFA) when used with database authentication. This vulnerability is not
applicable when using SAML or AD authentication. For more information on this security fix,
see Unexpected behavior observed with Two Factor Authentication post A360.26 upgrade,
where a valid authenticator code alone is sufficient to login to CR, in spite of an incorrect

password.

Note: This issue exists only in Automation 360 v.26 release. For v.26 On-Premises customers
using or planning to use MFA with database authentication, we recommend that you install
this update at your earliest convenience. No action is required from customers on other

Automation 360 releases.

» Build 15450 with fixes for the following issues:

»  When you import a bot or file that is a manual dependency of other bots using the
overwrite option, the import process no longer removes the dependencies from the other
bots (Service Cloud case ID: 01911410, 01920508).

» When you have large and complex bots with many dependencies and if the size of the
deployment messages that are sent from the Control Room to the Bot Agent is more than 2
MB, the bots run successfully. (Service Cloud case ID: 01882630).

» The following 1Q Bot issues were fixed:
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» |Q Bot can now perform post-processing on a field if the custom logic uses Python
script containing single quotes, such as print ('Test"').

« If your IQ Bot custom logic uses the Pandas library, the script no longer needs to have
the import Pandas statement.

« 1Q Bot can now perform post-processing on a field if the custom logic uses Python
script containing characters from non-Latin languages (Unicode characters), such as
aounmn.

« Security fixes for Cross-Site Scripting (XSS) vulnerabilities (Service Cloud case ID: 01843148).

Build 15443 (for US-East and US-West regions only) Service Cloud case I1D: 01911410,
01920508

This build is updated to include a fix for the issue related to the manual dependency file that
is shared between multiple parent bots upon export and import. If one of the child bot files is
exported and imported into the Control Room with overwrite options in the import process,
then links to the manual dependency are unlinked from other parent bots. Use Bot Agent
version 21.222 for this issue.

Build 15439 (Japan region only) Service Cloud case ID: 01911093, 01911209, 01911190,
01911116, 01911259

This build is updated to include a fix for the following issue: Cannot retrieve values
assigned to global values having Japanese characters after upgrading
Automation 360. Build 15439 is available for download for On-Premises customers who

need this fix.

What's new and changed in each product

Go to the following pages for details on all the updates (what's new, changed, fixed, and
limitations) in each product:

Automation Workspace

* Updating to this release
¢ Migration updates

AARI

|Q Bot and Document Automation

Bot Insight

Related concepts

Packages available in Automation 360 on page 2042

Actions are grouped into version-specific packages. Bot Creators can select which package
version to use for a specific bot.

Related reference

Automation Workspace v.26 release on page 195

Review what's new and changed, fixes and limitations, and the feature deprecations in Automation
Workspace for the v.26 release.

Automation Co-Pilot v.26 release on page 222
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Review what's new and changed and the fixes in Automation Co-Pilot for the v.26 release.

IQ Bot and Document Automation v.26 release on page 224
Review what's new and changed, and the fixes and limitations in 1Q Bot and Document
Automation for the v.26 release.

Bot Insight v.26 release on page 232
Review what's changed and the limitations in Bot Insight for the v.26 release.

Automation Workspace v.26 release

Review what's new and changed, fixes and limitations, and the feature deprecations in Automation
Workspace for the v.26 release.

What's new

Control Room, devices and Bot Agent

Microsoft Windows 11 Enterprise now supported (Service Cloud case ID: 01252605,
1252605, 1253745, 01255134, 01379865, 01801610, 01810148)

We now support Microsoft Windows 11 Enterprise, so you can now install and update the
Bot Agent and run bots on the Windows 11 Enterprise operating system.

Bot Agent compatibility on page 1181

Support for Manifest V3 extensions

Automations that use Google Chrome Manifest V2 based extensions will stop working
sometime after June 2023. The deprecation timelines of Manifest V2 based extensions are
currently under review and subject to change by Google.

» For Google Chrome Manifest V2 extensions timelines, see Manifest V2 support timeline.

» For Microsoft Edge Manifest V2 extensions timelines, see Overview and timelines for
migrating to Manifest V3.

This might impact your existing automations that use Manifest V2 based extensions for
Google Chrome and Microsoft Edge browsers. Automation 360 v.26 and later includes
Manifest V3 extensions by default to support features that use Google Chrome and
Microsoft Edge browsers.

You can automatically enable Manifest V3 based extensions for Google Chrome and
Microsoft Edge on all the Bot Runner devices by enabling the Browser extensions option
from the Control Room. Enabling this option applies the browser extension settings on all
the registered Bot Agent devices.

Note: We will continue to support Manifest V2 based extensions for Google Chrome until
June 2023. To know about Microsoft Edge Manifest V2 based extensions timelines, see
Overview and timelines for migrating to Manifest V3.

Note: Manifest V3 extension is supported on Google Chrome and Microsoft Edge
browsers version 91 and later only.

Configure browser extensions on page 1636 | Chrome and Edge Manifest V3 extensions
on page 997
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Control Room, devices and Bot Agent

Bot Agent updates by using installation file from local drive

You can now download the Bot Agent installation file to your local drive as a one-time
activity and then update the Bot Agent on several devices by providing the local drive path
to the installation file. This way, you can avoid downloading the installation file multiple
times from the Control Room for several devices.

Important: This functionality is implemented in v.26 and can be used from v.27. That is,
after you update your Bot Agent to v.26, future updates can be performed from the local
drive.

Automatically update the Bot Agent on page 1207 | Update the Bot Agent from a local
drive on page 1208

Oracle Database now supported (Service Cloud case ID: 00726728)

We now support Oracle Database, so you can now choose to install the Control Room on
Oracle Database.

Note: Oracle database for Control Room installation is supported only in Custom mode
and not in Express mode. Oracle Database support on the Control Room starts with the
v.26 release.

Installing Control Room using custom mode for Oracle installation on page 1119 |
Configure Oracle database type and server on page 1109 | Database requirements on
page 1042

Active Directory mappings filters stored in the database

When you update to a newer version of the Control Room, you no longer have to define
the Active Directory mapping filters again after installation. This is because the Active
Directory mapping filters defined in the um.properties file are now stored in and can be
referenced from the database. However, if you define new filters in the um.properties
file, the Control Room references the filters defined in the um.properties file and
overwrites the ones stored in the database.
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Packages, actions, and Bot editor

RBAC on packages

Based on your business requirements, you can now control the access that Bot Creators
have to packages in the Control Room. As an administrator or user with the Manage
package permission, you can restrict access to packages to either all the users or users
with specific roles.

Depending on the access that is configured by the admin, Bot Creators and Citizen
Developers can view and use specific packages:

» Bot Creators can access a broad set of complex packages and create bots, which can
be reused.

« Citizen Developers can access simpler and easy-to-use packages and build automations
quickly.

RBAC on packages on page 1720 | Configure RBAC for packages on page 1722

Salesforce command package

You can now authenticate from Automation 360 to access Salesforce and run several
command actions by using the new Salesforce command package.

Salesforce package on page 2606

SAP GUI 770 version now supported (Service Cloud case ID: 01793132, 01792775, 1776805,
01792623, 787725, 01805482, 01805479,01792623, 01810356, 01822839, 01851451,
01853577, 01860050)

SAP GUI 770 (patch 6) is now certified and supported with Recorder and SAP package.

Recorder actions supported in various SAP versions on page 2590

Configure and use custom proxy configuration in REST Web Service package (Service
Cloud case ID: 01271527, 01765084, 01839282)

REST Web Service package is now enhanced to support custom proxy configuration
for each Delete, Get, Patch, Post, and Put action. This provides you more flexibility in
calling REST APIs with different proxy configuration and allow you to create hybrid API
automation.

REST Web Service package on page 2596

Keyboard shortcuts to reduce scrolling

When developing large bots, you can now use keyboard shortcuts to expand and collapse
individual or all sections and move through the lines of code quickly instead of scrolling
and minimizing sections individually.

Keyboard shortcuts to expand or collapse elements in bot logic on page 1976

Set value in any editable control field to be blank in SAP application (Service Cloud case ID:
00821861, 01807129)

When you use the Set text action of the SAP package, you can now set the value in any
editable control field in the SAP application to be blank. For example, you can set the value
in the text field or the date field to be blank.
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Packages, actions, and Bot editor

Loop through emails and move them one at a time (Service Cloud case I1D: 00749763,
01807189, 01840743)

You can now loop through all the emails in a mailbox and move one email at a time to a
destination folder by using the Move action in the Email package.

Move action on page 2249

Configure pl2 certificate for SOAP-based automations (Service Cloud case ID: 00757213)

In the SOAP Web Service action, you can now select the p12 certificate file and provide
a password for user authentication. With this enhancement, you can now access web
services that use the pl2 certificate-based authentication (a more secure type of SSL
certificate).

Example of using the SOAP web service action on page 2826

Improved accessibility, usability of content on Terminal Emulator window (Service Cloud
case ID: 01609467)

You can now have improved accessibility and usability of the content displayed on the
Terminal Emulator window. When you use the enhanced Get text action of the Terminal
Emulator package, you can now view and extract all the lines and text present in the
Terminal Emulator window and perform an operation based on your requirement.

Using Get text action for Terminal Emulator on page 2743

Run bots with or without window title matching in letter case

You can now run bots even when the title of a captured window does not match the
letter case. For a bot to identify a static window or browser titles and titles with a wildcard
character, you can opt for a case-sensitive match if you want the letter case to be
matched, or a case-insensitive match otherwise, by using the Case sensitive option.

Control image preview and storage in Control Room during secure recording

You can now choose whether or not the object images are available for preview and
stored in the Control Room during secure recording by enabling the Recorder preview
image setting. When you enable the setting, the image is previewed in the Bot editor and
stored in the Control Room for 60 minutes. If you choose not to preview, images are not
captured.

Secure recording on page 913 | Secure recording mode on page 1997 | Settings on
page 1629

Automate Microsoft Excel spreadsheets from SharePoint

You can now automate Microsoft Excel spreadsheets that are uploaded and shared on
SharePoint. Use Excel advanced > Open action to open the Microsoft Excel spreadsheets
from SharePoint location.

Using the Open action for Excel advanced on page 2285

Automate Citrix Virtual Apps in Edge with I[E mode

When using the Recorder, you can now automate Citrix Virtual Apps running on Microsoft
Edge Chromium with IE mode.
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Packages, actions, and Bot editor

Automate controls using Microsoft Ul Automation (COM) technology

For automation, you can now use the Microsoft Ul Automation (COM) technology in the
following scenarios:

« Capturing controls with secure recording mode
» Capturing and automating combo box and list view controls

« Using Object exists and Object does not exist Recorder conditions in If, Loop, and Wait
packages

Capture using specific technology on page 2587 | Actions performed on objects captured
with Universal Recorder on page 2568

Seamless automation of Citrix Virtual Apps and other Citrix applications

With the new Automation 360 remote agent for Citrix, you can now seamlessly automate
all types of Citrix Virtual Apps and other Citrix applications that are supported on desktop
applications using the Recorder.

The new Automation 360 remote agent for Citrix supports the following browsers and
technologies:

e Google Chrome

¢ Internet Explorer

* Microsoft Edge

* Microsoft Edge with IE mode

*  Mozilla Firefox

« Java

* Electron apps

* Microsoft Active Accessibility (MSAA)
*  Microsoft Ul automation

Installing Automation Anywhere remote agent on Citrix servers on page 1079 | Using the
Recorder on Citrix Virtual Apps servers on page 1075

Important: For information about the supported packages, see Automation 360 previous release
versions.

Building and running bots

Implement coding standards with code analysis

You can now implement best coding practices by configuring coding rules in the Control
Room. This feature helps you prevent potential errors, improve bot reliability, and makes
the code more uniform, accessible, reliable, and efficient.

* As an administrator or a user with View policies and Manage policies permission, you
can configure the code analysis policy for all users.

* As a Citizen Developer, you can run code analysis to analyze your bots against
readability, maintenance, security, and compliance best practices.

Code analysis on page 1939
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Building and running bots

Choose specific version of child bot to check out with parent bot (Service Cloud case ID:
01771388)

When you check out a parent bot, you can now choose the version of the child bot

to check out. Every version of a parent bot can have different versions of child bot
dependencies. With this feature, you can roll back the dependencies while rolling back the
parent bot. You can make changes to a specific version of the dependent bot.

Easily move bots and files between folders in the private workspace (Service Cloud case ID:
00733125)

You can now move bots and files effortlessly and without requiring any permissions from
one folder to another in the private workspace. With this feature, if a bot is placed in an
incorrect folder, you no longer have to clone it in the correct folder and then delete it from
the incorrect folder.

Move a bot on page 2028

Better organization with bulk checkin of related bots and files

You can now select multiple bots or dependent files from different folders that belong to
the same process and check them in, in bulk, from private to the public workspace with the
same check-in message. You can check in a maximum of 10 parent bots, but there is no
limitation on the number of dependent child bots.

Email notifications for failed checkins (Service Cloud case ID: 01598642)

As an administrator, you can now configure sending email notifications to bot developers
whenever their checkins fail. Without such email notifications, bot developers will be
unaware of their failed checkins because although the checkin status is always logged

in the audit log, they cannot access the audit log access without permission. With email
notifications, bot developers can know about their failed checkins and retry immediately.

Export work items for offline records (Service Cloud case ID: 01769378, 01798514)

You can now export work items to a CSV file for offline audits and records. With this
feature, you can export selected, filtered, or all work items to a CSV file.

Export work items to CSV file on page 1846

Export and import queues for efficient and flexible usage

You can now export and import queues across development, testing, and production
environments. This way, you can create a queue in the development environment, testitin
the testing environment, and then promote it to the production environment to efficiently
execute business process workload. You can also include work items when importing a
queue.

Export queues on page 1840| Import queues on page 1841
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APIs and integrations

Connect Bot Agent to Control Room through vl/registration/auto AP

You can now use the V1/registration/auto API to register and connect your device
to a Control Room automatically. You must specify the Control Room URL and the
userName properties in the APl Request.

Bot Agent API: Auto registration on page 3444

Fetch execution details for specific execution IDs with new Control Room API

You can now fetch the execution details, such as botOutVariables and CallbackInfo,
for a specific execution ID by using the new APl endpoint, V3/activity/execution/
<id> API.

Authorization with bearer token

Automation 360 supports the Authorization header with a Bearer token for API requests to
the Control Room. This header was previously unsupported and ignored on API requests.
Obtain the Bearer token from our OAuth services. All API calls must contain either an
authentication token from Authentication API (generates JSON Web token) or a bearer
token from OAuth services. You cannot use both together in an API.

What's changed

Control Room, devices, and Bot Agent

Missed schedules redeployed automatically

You can now ensure that schedules missed because of Control Room shut down (Control
Room maintenance or upgrade) are automatically redeployed.

When you use the Redeploy the schedule again option, an audit log entry identifies the
event type as Schedule misfired, and the botis automatically redeployed after the
Control Room is restarted.

Low disk space issues resolved with automatic deletion of temp files

Automation 360 now supports automatic clearing of the files in the temp folder, thereby
resolving low disk space issues.

During bot import operations, temporary files were written to the following path, leading

to increased usage of disk space and resultant low disk space issues: C:\Users\<aa cr
admin account>\AppDatal\Local\Temp. As a result, the bots failed, and the temp files

had to be cleared manually.

Enhanced Active Directory role mappings page
The Active Directory role mappings page no longer has default validation of mappings.

Validating all the role mappings can take a longer time on slow networks and with a higher
number of mappings because it requires communication between the Control Room
database and the Active Directory server. Also, changes in security groups and roles are
infrequent and do not require frequent validation on this page. The Active Directory role
mappings page now displays only the list of mappings which loads at a faster speed as
validation of mappings is not done.
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Control Room, devices, and Bot Agent

Enhanced autologin functionality for Bot Agent (Service Cloud case ID: 01788805)

Bot Agent autologin now works successfully even if the Interactive logon: Do not require
CTRL+ALT+DEL group policy is disabled.

Previously, for the Bot Agent to autologin successfully, you had to enable this group policy,
which was not possible due to the security policy. As a result, Bot Agent autologin failed.

Improved administration for WLM automations

You can now view all the queues with the AAE_Admin role. Also, you can pause, resume,
and stop all WLM automations.

Note: If you are not an owner, participant, or consumer of that queue, you can view only
queue names and not the queue details.

Packages, actions, and Bot editor

Run DLL file without namespace (Service Cloud case ID: 01765712)

You can now run a DLL function even if the namespace is not specified because the Enter
the namespace field in the Run Function action of the DLL package is now optional.

Casing and format changes in Technology and Control types

When you use the Recorder to capture objects, you can now read and identify the names
of technology types and control types easily because the names of the properties now
use a more user-friendly casing and format. For example, MS_ACTIVE_ACCESSIBILITY is
renamed Microsoft Active Accessibility.

Loop condition evaluated with every iteration

When you run a sequence of actions repeatedly for a specific number of times within a
loop, the end condition within the loop is now evaluated in every iteration.

For example, when you loop through a Data Table that has 10 columns, enter dynamic
values of column count for the end condition in the loop, use the Data Table > Delete
column action to delete the column of index O inside the loop body, and then run the bot,
the bot deletes a column in every iteration. Hence it reduces the iteration count because
the loop end condition is evaluated in each iteration.

Fixes

Build 15459: This build includes the following fixes (along with fixes from the previous builds):
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A critical security fix for the issue related to Multi-Factor Authentication (MFA) when
used with database authentication. This vulnerability is not applicable when using

SAML or AD authentication. For more information on this security fix, see Unexpected
behavior observed with Two Factor Authentication post A360.26 upgrade, where a valid
authenticator code alone is sufficient to login to CR, in spite of an incorrect password.

Service Cloud case |D: 01941769, 01945068

Build 15450: This build includes the following fixes (along with fixes from the previous builds):

If you have large and complex bots with many dependencies and if the size of the
deployment messages that were sent from the Control Room to the Bot Agentis up to 5
MB, then the bots will run without failure.

Previously, bots were failing to execute when the size of the deployment messages that
were sent from the Control Room to the Bot Agent was more than 2 MB.

Service Cloud case ID: 01882630

When you import a bot or file that is a manual dependency of other bots using the
overwrite option, the import process no longer removes the dependencies from the other
bots.

Previously, manual dependencies were removed for the overwrite option from the other
bots during bot import.

Service Cloud case ID: 01911410, 01920508

You can select a path containing a dollar sign (S) in a folder trigger for a file and folder,
and the bot will execute successfully. Previously, the bot failed when you selected a path
containing a S in a folder trigger for a file and folder.

Service Cloud case ID: 01829534

Build 15443 (for US-East and US-West regions only): This build includes the following fixes (along
with fixes from the previous builds):

When you import a bot or file that is a manual dependency of other bots using the
overwrite option, the import process no longer removes the dependencies from the other
bots.

Previously, manual dependencies were removed for the overwrite option from the other
bots during bot import.

Service Cloud case ID: 01911410, 01920508

Build 15439 (Japan region only): This build includes the following fixes (along with fixes from the
previous builds):

You can now successfully retrieve values assigned to Global values with Japanese
characters after upgrading the Control Room to the Automation 360 v.26 release.

Service Cloud case ID: 01911093, 01911209, 01911190, 01911116, 01911259
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Build 15436: This build includes the following fixes:

You can now successfully delete a device from the device pool without any error.

Previously, when you deleted a device from the device pool, it was deleted from the
Control Room but remained in the DEPLOYMENT_ALLOCATION_QUEUE table. Hence,
the device could not be deleted and an error was shown.

Service Cloud case ID: 01791502, 1840575

If you run a bot from the Bot editor workspace for debugging using the Run from here
option and if the bot contains packages that use the session (Local or Global session), the
following compiler error no longer occurs: Unable to find any open session

Service Cloud case |D: 01080318, 01759454, 01785168, 01790014, 01786670

In a multi-user environment, for simultaneous bot deployments, bot launcher logs are now
generated for all the users.

Previously, in such cases, bot launcher logs were not generated for all the users.
Service Cloud case ID: 01759506

You can now successfully list a scheduled task, and the following error no longer occurs:
Unknown timezone ID:US-Pacific-New

Previously, an unsupported time zone could be selected, which resulted in this error.

Service Cloud case ID: 01759074

If a device is shared between a Bot Creator and a Bot Runner, when you try to

edit a schedule, the following updated message is now displayed: UNKNOWN: All
runAsUser (s) should have default device as no pool is provided.
RunAsUser (s): [dprunner] does not have a default device or that
device is shared with a bot creator

Previously, if a device was shared between a Bot Creator and a Bot Runner, when you tried
to edit a schedule, the following incorrect message was displayed: Automation failure
due to deploy failure

When you update the Bot Agent from user level to system level, you can now capture
objects using the Recorder actions or from a window list in a Google Chrome browser.
You no longer have to manually delete the registry entry in Windows from the current user
level (HKEY_CURRENT_ USER).

Service Cloud case ID: 00731155, 00778022

After connecting to a device, when you set the global cache location to an invalid path, an
audit log entry is generated against the device, and the default global cache path is now
used.

Note: Depending on the device used and the path you specified on your drive, validation
of the default cache path might not be supported.

When you want to edit a DataTable variable in debug mode, you can now scroll
horizontally to view all the columns in the DataTable variable.

Service Cloud case ID: 01818834
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In the FTP / SFTP package, you can now create bots using actions such as Delete files, Put
files, and Get files even if the file name contains characters such as the comma (,) and the
colon (2).

Previously, characters such as the comma (,) and the colon (:) were not supported in file
names.

Service Cloud case ID: 01772186

You can now run an Enterprise 11.3.3 bot from Automation 360 in the Enterprise 11 Control
Room by using the Run action.

Previously, the Run action did not work for v.11.3.3 because the device V1 APl was not
working with an empty filter for release 11.3.3.

Service Cloud case ID: 00825696, 01747999

You can now successfully connect to the Excel or Access (Microsoft Office 2016 or later)
engines with ODBC drivers.

Previously, if you tried to connect frequently to the Excel or Access (Microsoft Office 2016
or later) engines with ODBC drivers, bot execution failed intermittently.

Service Cloud case ID: 01762290, 01755335, 01778149, 01778899, 01793064, 01788154,
01810754, 01806851, 01811703, 1815437, 01807133, 01799364, 01755642, 01749480,
01767869, 01807133, 01818989, 01815300, 01826839, 01804882, 01842384, 01846477,
01762300, 01331003

When you send an email with multiple file attachments and if attachment size exceeds 24
MB, the bot now waits for 120 seconds before encountering a timeout error.

Previously, when you sent emails with a large file attachment, bot execution failed after 30
seconds if the attached file exceeded the file size.

Service Cloud case ID: 01763214

When you use the Connect action to connect with the EWS protocol, the Send email
action and read email now print the email message body in a new line character in the
following scenarios:

»  When you create a bot and connect with the EWS server, then use the Loop action to
read email as a plain text messages, and then use the Log to file action to log text into a
file.

*  When you use the Send email action and connect with the EWS server with OAuth
authentication to send email.

Service Cloud case |ID: 01770645, 01780628

In the Email package, when you use the Move all action and establish a connection with
the EWS server, if the destination folder contains any of the following special characters in
the folder name, then use a backslash (\) as escape character before the special character:
4 + 4 * 4 ? 4 ~ 4 $ 4 ( 4 ) 4 [ 4 J 4 { 4 } 4 | 4 \

For example, if the destination folder name is "4) folder name", enteritas "4\)
folder name".

Service Cloud case ID: 01803958
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If your bot contains an error, Bot error now shows the correct line number of the error
within the Finally block in the following scenario: When you add the Try/Finally block
around the corresponding action, then insert more actions in the Finally block, and then
save and run the bot.

You can now successfully upload files whose file names are in the Japanese language by
using the Rest web service action with multipart form data.

Previously, file upload did not work for files whose file names were in the Japanese
language.

Service Cloud case ID: 01801767

You can now use the Terminal Emulator package to perform tasks associated with
the terminal without any issues. We now provide support for the Start PC Command
(STRPCCMD), so when you run the bot, the terminal now successfully opens the
application with the STRPCCMD command.

Previously, when you passed the appropriate key on the Terminal Emulator, the bot did not
open the expected application because the STRPCCMD command was not supported in
the Terminal Emulator.

Service Cloud case ID: 01816577

In the Terminal Emulator package, you can now use the Connect action to connect with a
host machine on which you want to automate a task.

Previously, when you used the Connect action, a black screen was displayed for a few
terminal hosts.

Service Cloud case |D: 01823081, 01841800

After migration, when you open a Load Add-ins-enabled Excel file using the Excel
advanced > Open action and run a bot, the bot now runs successfully without any error.

Previously, the bot failed because some Excel files with the Load Add-ins option enabled
stopped functioning and the workbook was closed unexpectedly.

Service Cloud case ID: 00950745, 01835066

When you use the PDF > Merge documents action and select All pages option in the
Pages field to merge all pages of multiple PDF documents into a single PDF document,
the output PDF now retains and merges all the attributes such as bookmarks, links, layers,
attachments, and signatures from the individual source documents.

Service Cloud case ID: 01792105

When the Recorder fails on a computer where the operating system language is not
English, the error message for the bot runtime failure is now shown in the same language
as that of the operating system.

Previously, the error message was shown in English even on computers where the
operating system language was not English.

Service Cloud case ID: 01813050

You can now successfully extract text from within the captured area of a window using the
App Integration package even if the screen resolution is more than 100 percent.
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Automate and capture window authentication dialog boxes in the Google Chrome browser
using a specific technology with the Recorder.

Bots are no longer stuck when you work with Microsoft Access database queries.
Service Cloud case ID: 01756390

You can now open local files by using the New window option in the Browser > Open
action even if Microsoft Edge is your default browser.

Service Cloud case ID: 01799784

At bot runtime, when you assign a new window title to a window variable, the window
variable now detects the correct window.

Service Cloud case |D: 01788466, 01791773

You no longer encounter a compilation error in the Ul in the following scenario:

1. Use the Datetime package released with Automation 360 v.23 or earlier to create a bot
that uses the Datetime > Assign action.

Then, select the Variable option to add the variable value.

Then run the bot with the package released with Automation 360 v.24 or later.

You can now successfully capture objects from applications that are launched from a Citrix
machine.

Note: This fix is available only with the new Automation 360 remote agent, which you can
use with the upgraded Recorder package (version 2.8.6-20220823-160834).

Service Cloud case ID: 00831939

When you assign a window title to a window variable, if the variable field has an empty
reqular expression value, the bot no longer passes it without scrutiny. Instead, the following
error message is now displayed: Unable to find the window '<window name>'.
The provided regular expression ‘<regular expression>' is invalid.
Please provide a valid regular expression for the wvariable
'<variable value>'.

When you merge multiple PDF documents by using the PDF > Merge documents action,
all the form field attributes in Adobe Acrobat are merged and the output PDF document is
now rendered properly.

Service Cloud case ID: 01760279, 01792301

When you use the If > Folder does not exist condition to determine whether a folder does
not exist, if the specified folder exists, the bot now successfully recognizes the folder and
does not attempt to create it again.

Previously, because of the presence of leading and trailing spaces in the input folder path,
the bot failed to recognize an existing folder and hence attempted to create the folder,
leading to an error.

Service Cloud case I1D: 01466067
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If you migrate a bot and select the HTML Tag, HTML InnerText, and HTML type properties
and then select HTML-type properties in Search Criteria, the bot now successfully locates
and identifies the object and performs the selected action.

Service Cloud case ID: 00829817, 01757049, 01761452, 01822711

When you use the Recorder package for the Get property action, the correct values are
now displayed for the top, left, height, and width properties.

Note: The Get property action does not display correct values for cross-domain iFrames
elements.

Service Cloud case ID: 01251758

The AlSense Recorder package now works as expected when you use the Windows 10
operating system in the Japanese language. Because UTF-8 is now enabled, you no longer
need to use any workaround.

Service Cloud case ID: 01821267, 01822433

When you use 2.8.0-20220601-034227 and later versions of the Recorder package, the
automated bot now returns the correct value for the HTML InnerText property in Google
Chrome and Microsoft Edge browsers.

Service Cloud case |D: 01257098 , 01754795, 01791073, 01787461, 01813080, 01846403

For WLM queues, the date is now displayed in the correct format as YYYY-MM-DD.

Previously, this date was shown in the years ago format, which did not match the date
format in the CSV file and was confusing.

In a multitenant environment, when you upload a work item file to a queue in one of
the tenants, the In progress tab now displays the correct file upload status only in the
corresponding tenant.

Previously, the In progress tab displayed the upload status for all the tenants.

When a WLM automation is in progress, an administrator can no longer delete the user
who created that automation.

Previously, the user who created an automation could be deleted, after which that
automation could not be paused or resumed by another user.

When you stop a WLM automation, work items are no longer stuck in the ready-to-run
state and are now moved to the New state.

Previously, when you stopped a WLM automation, a few work items were stuck in the
ready-to-run state and could not be deleted.

After you change any configuration field in the Administration > Settings > Devices
> Advanced options settings in versions prior to v.25, if the Control Room is updated
to v.25, the Global Cache Location is now set to the default C: /ProgramData/
AutomationAnywhere/GlobalCache value.

Previously, in such cases, no value was shown for the Global Cache Location field, which
was confusing.

Service Cloud case ID: 01869048
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When you use the Run bot option to run a bot in the Activity > Historical > View page for
any activity, the bot now runs successfully.

Previously, in such cases, bot execution failed with an error.

When you import a bot that contains manual dependencies, for the overwrite option, the
import process now removes the manual dependencies.

Previously, during bot import, the manual dependencies were not removed for the
overwrite option.

Service Cloud case ID: 01813452

When you import a bot into a folder, if a folder with the same name but different letter case
already exists in the repository, bot import now fails with an error.

Previously, in such cases, bot import was successful, but the imported bot failed at the time
of execution because of the wrong folder path.

Service Cloud case ID: 01270324, 01816507

You can now successfully access all the folders in the public workspace without any issues.

Previously, when you imported and cloned a bot under a folder in the public workspace
and then tried to access that folder, sometimes an error occurred, and the folder could not
be accessed. This occurred some times when there were more than 2100 folders under
the bots directory.

Service Cloud case ID: 01852748

When you update from Enterprise 11 to Automation 360 or upgrade from an earlier version
of Automation 360 to a later version, the earlier defined group mappings are retained are
retained, even when the Distinguished Name (DN) column of the mapping entries are
empty in the database.

Previously, some of the earlier-defined group mappings were deleted due to the empty
value for the DN column.

After you update to Automation 360 v.22 or later, the Repository Management (v2/
repository/file/list) APl now returns the correct file size as response output.

Previously, the Repository Management (v2/repository/file/list) API returned the file size as
zero in the response output.

Service Cloud case ID: 01151460

The Azul Zulu JDK is now updated to version 11.0.15+10. The previous version, 11.0.14+9,
contained some vulnerabilities.

Common Vulnerabilities and Exposures (CVEs) for this version are as follows:
CVE-2022-34169, CVE-2022-21540, CVE-2022-21541, CVE-2022-21549, and
CVE-2022-34169

Service Cloud case ID: 01854652, 01868897, 01857973, 01854652, 01887083
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Limitations

When you connect to the Microsoft Access Database with JDBC and specify the database
path, and if you use the following specific aggregation functions in the query, an error
occurs when you run the bot.

ASC, ATN, SQR, CBOOL, CCUR, CDATE,

CDBL, CDEC, CDATE, CDBL, CINT, CLONG, CLNG,

CSIGN, CSTR, CVAR, DATEADD, DATEDIFF, DATEPART,
DATESERIAL, DATEVALUE, FORMAT, IIF, INSTR, INSTRREV,
ISDATE, IsNull, ISNUMERIC, LEFT, LEFTS, LEN, MID,
MONTHNAME, DATE, NOW, NZ, SIGN, SPACE, STR, TIME, VAL,
WEEKDAYNAME, WEEKDAY, STRING, TIMESERIAL, CONCAT

Workaround:

1. Go to Administration > Settings > Devices > Advanced options
> Bot launcher JVM options and set the value as follows: -
Dhsgldb.method class names=net.ucanaccess.converters¥*

2. Restart the Automation Anywhere Bot Agent service.

External key vault integrations are not supported on Oracle Database.

Not all missed recurring schedules are redeployed with the Redeploy the schedule again
option. Also, only one entry is shown for the missed recurring schedules in the In progress
tab.

As an 1Q Bot user, you can check out only the latest version of a process. You cannot
check out previous versions of a process because version check is performed based on the
Automation Anywhere file version and not the Git version.

The OAuth?2 configuration settings in the Control Room will not enable you to connect
to the OAuth2 service at this time. Customers planning an OAuth?2 integration with our
partner application should expect the service to be available by November.

In the Oracle Database environment, you cannot view a checked-in bot in the Public folder
because version check is performed based on the Automation Anywhere file version and
not the Git version.

Workaround: To view a checked-in bot in the Public folder, you must refresh the
Automation page manually by using the Refresh button.

In an Oracle Database environment, when you select the number format and sort order
for the work items in a queue, and then run bot using the Run bot with queue option, the
queues are not deployed. Also, no errors are shown in the Audit log or Activity page.
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For regular or scheduled automations using the unattended Bot Runners, bot deployments
remain in the queued state and accumulate on the In progress page for these following
scenarios:

« |f the devices are down or not available.
» If arun-as user is busy executing the bot.

For devices not in the deployment state, if the number of queued bots reaches 500, it
blocks the bot deployments for all devices or for all run-as users.

Workaround: To run the blocked deployments, perform one of the following actions:

» Select the queued jobs on the In progress page and move it to the Historical page
* Reconnect the Bot Runner devices.

When you set the default package version using the Update bots to default package
version option for bots in the public workspace that are using the Excel Advanced > Open
action, the Task Bots do not display the session name and file path values.

Workaround: Perform one of the following workarounds:

* Update the Excel Advanced package manually to use the latest version of the package.
See Select the package version used in your bot on page 2048

» Check out the bot and revert to the previous version of the Excel Advanced package.
Then, check in the bot to use the latest version of the package. See Update bots to
default package version on page 1730

Service Cloud case |D: 01905290, 01882083, 00712719, 00728499, 00737694, 00803673,
01255722, 00838604, 00772147, 01760236, 01762679, 01771416, 01761859, 01782588,
01778220, 01784255, 01789551, 01809167, 01818690, 01831969, 01813413, 01287311,
01923711, 01927867

You will encounter an error when you run a standard workflow in the SAP BAPI package

Workaround: To execute SAP BAPI, use the Run Function call (RFC) with a combination of
Create function, Set or Get field value, Set or Get structure, and Set or Get table actions.

When you use 2.6.1-20220428-010714 or later versions of the Recorder package to
automate a web page on Microsoft Edge browser, the Recorder might not be able to
perform Click or Left click actions on the JavaScript alert, prompt, and confirmation pop-
up windows.

Workaround: For performing the click actions successfully, downgrade the Recorder
package to 2.5.4-20220309-151830 version or earlier.

When you use the Browser > Close action to close a tab or a window opened in the
Microsoft Edge browser, if only one Microsoft Edge browser window is open, the bot
encounters the following error: Error occurred while closing the tab

Workaround: See Configure Microsoft Edge browser settings when Close action of
Browser package encounters an error (A-people login required)
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When you run a bot in the Google Chrome or Microsoft Edge browser, use the If, Loop,
or Wait action, select the webpage from the list of active tabs in the Browser tab, close
the browser window, and then run the bot, the bot might take two minutes to open the
webpage in the browser irrespective of the timeout value mentioned.

Workaround: Move the If, Loop, or Wait action inside the If block and use the Application
is running condition with same browser application to check whether the browser is
running.

When you run a stored procedure in Oracle and it returns SYS_REFCURSOR, the Run
stored procedure action is not closing the cursors. As a result, after the maximum cursor
limit is reached, this action results in an error.

When you migrate a bot that contains XML command > Get single node, after migration,
the bot encounters the following error: No node found at XPath while executing
the Get Single node command

Workaround: If the XPath expression is not starting with (/) , apply XPath starting with »/»
so that at the time of execution, the modification can be skipped or the XPath expression
can be designed to get the desired result.

While running a bot in debug mode, the bot will fail if the variable size gets greater than 3
MB. An error message appears showing that a variable has exceeded the 3 MB limit.

When you use the Browser > Open action to automate a browser window running on
Google Chrome and Microsoft Edge browsers, then from the browser window, select
More tools > Name window option to update the title of this window during bot run and
then when you try to run the bot with the updated window title, the bot might fail.

When you use the actions in the App Integration package to extract text from a window,
the bot might not be able to detect the new Ul of the Windows 11 operating system and
capture the text.

Workaround: Enable the old classical Ul in Windows 11 operating system. See Restore Old
Classic Notepad in Windows 11

When you use the /v2/repository/file/1list, the response lists bots restricted
by user role. If you use this APl as an AAE_Admin, you can view bots from the private
repository in the response. Whereas if you use this APl as a bot creator, you can view
system bots (recorder) in the response.

Workaround: Use the /v2/repository/workspaces/{workspaceType}/files/
list.

Command prompt APl allows you to switch the device registration even if the Allow
devices (single user) to be switched to another Control Room without reinstalling bot
agent option is disabled.

When you upgrade from Automation 360 v.25 to a later version, although you enabled
code analysis in the Control Room, the rules set in the policy are not retained after the
upgrade.

Workaround: Before upgrading, we recommend that you keep a note of the rules enabled
in Automation 360 v.25 and then re-enable them after upgrading to a later version.
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Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation.

Automation Anywhere Mobile app deprecated

The Automation Anywhere Mobile app is deprecated as of July 2022 and will not be
updated to subsequent versions of iOS and Android. The mobile app is no longer available
and no further support will be offered. A replacement product is currently not available.

Tesseract OCR v3 deprecated

Tesseract OCR version 3 is deprecated as of September 2022. If you have created learning
instances using Tesseract OCR version 3, we recommend that you plan to train your
learning instances with alternative OCRs (including Tesseract4 OCR) before you update to
Automation 360 v.26.

Deprecation of Tesseract OCR v3 on page 1011

Deprecation of IQ Bot Extraction package

The 1Q Bot Extraction package has been deprecated as of September 2022. As part of
Automation 360 v.26, 1Q Bot will no longer support pretrained machine learning models
for invoice data extraction.

To move your bots from the |Q Bot Extraction package to Document Automation, see 1Q
Bot Extraction package on page 2423.

Automation Anywhere for Excel deprecated

Automation Anywhere for Excel has been deprecated as of January 2022. The plug-in is
no longer available to download as a product. However, support will be offered to current
customers already using the product.

A replacement product as a plug-in for Microsoft Excel is not available. In Automation
Anywhere for Excel, this action was triggered from within the Excel application. However,
as an alternative, new customers can develop bots for Excel within Automation 360
Automation Workspace and use input variables to allow specifying file names, worksheets,
and ranges for bots to operate on. In Automation Anywhere for Excel, this action was
triggered from within the Excel application, whereas now this action is taken from the
Automation Anywhere Control Room.
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G-Suite Apps package deprecated

The G-Suite Apps package has been deprecated as of September 2022 and it no longer
supports using the Connect and Disconnect actions to establish a connection with the
Google server and automate tasks.

Recommended: For specific G-Suite applications, the functionality of the G-Suite Apps
package is available in the following G-Suite packages:

e Google Drive
* Google Calendar
« Google Sheets

To automate tasks, in the appropriate G-suite package, use the corresponding Connect
and Disconnect actions.

Related concepts

Packages available in Automation 360 on page 2042

Actions are grouped into version-specific packages. Bot Creators can select which package
version to use for a specific bot.

Related reference
Automation 360 v.26 Release Notes on page 190

Updating to v.26 release on page 214
Review requirements and support information about updating your Control Room and Bot Agent
for the v.26 release.

Migration updates for v.26 release on page 216
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10
versions to Automation 360 v.26.

Automation Co-Pilot v.26 release on page 222
Review what's new and changed and the fixes in Automation Co-Pilot for the v.26 release.

IQ Bot and Document Automation v.26 release on page 224
Review what's new and changed, and the fixes and limitations in IQ Bot and Document
Automation for the v.26 release.

Bot Insight v.26 release on page 232
Review what's changed and the limitations in Bot Insight for the v.26 release.

Updating to v.26 release

Review requirements and support information about updating your Control Room and Bot Agent
for the v.26 release.

Control Room update

If you are updating to this release, ensure that the Server audit is not enabled on SQL Server
Database. If the server audit is enabled, use SQL administrator user account to turn off the SQL
Server audit before initiating the update.
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Bot Agent updates

Important: This release includes an optional Bot Agent update. You can continue to run your
existing bots without updating the Bot Agent. However, if you want to use the new features in
Automation 360 v.26, you must update the Bot Agent available with this release.

For more information on updating to this release, see these resources:

« Automatically update the Bot Agent on page 1207 | Manually update the Bot Agent on page
1209

« Compatibility with release builds on page 1182

Supported Control Room builds for direct update

You can update to the latest version of Automation 360 from the previous three releases (that is,
from n—3 releases, where n refers to the latest release).

The following previous releases are certified for update to Automation 360 v.26:

e v.25 (Build 15112, 15097)
e V.24R2 (Build 13343), and v.24 (Build 12350, 12342)
e V.23 (Build 11513)

If you are on one of these previous releases, for information about updating, see Update
Automation 360 to latest version on page 1266. If you are not on an n-3 release, update
Automation 360 to one of the n—-3 releases before updating to Automation 360 v.26.

For the latest updates to the Automation 360 extensions for Google Chrome, Microsoft Edge, and
Mozilla Firefox, see Browser extensions for Automation 360 on page 852.
Related reference

Automation Workspace v.26 release on page 195
Review what's new and changed, fixes and limitations, and the feature deprecations in Automation
Workspace for the v.26 release.

Migration updates for v.26 release on page 216
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Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10
versions to Automation 360 v.26.

Migration updates for v.26 release

Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10
versions to Automation 360 v.26.

What's new

Enterprise 11 and Enterprise 10

Migrate parent bots independently, avoiding overwrites and loss of updates (Service Cloud
case ID: 01258572, 01778107, 01275417, 01880168)

You can now migrate a parent bot independently even if it has associated child bots. You
now have a choice to select whether you want to migrate a parent bot independently or
along with its dependent child bots.

This helps in avoiding overwrites and loss of updates that might happen when child bots
that are migrated to Automation 360 are updated after migration.

Migrate Enterprise bots on page 1431

Migrate more bots with specific features
You can now successfully migrate bots in the following cases:

» Bots that use spreadsheets residing in SharePoint by using the Excel advanced > Open
action.

* You can now migrate bots with REST commands with custom proxy configuration at
the Action level. For custom proxy configuration support, in the Bot Migration Wizard,
select the Include web service settings option.

When you select this option, the REST commands are migrated with custom proxy
configurations that use the following global variables:

+ AAProxyHost for Hostname
e AAProxyPort for Port

Migrate Enterprise bots on page 1431

* Bots in which the user interface or window extends beyond the screen on the top-left
corner (truncated) for the following actions: Object Cloning, If, Loop, Web Recorder,
and Manage Web Control.

Now, migrated bots support windows with negative coordinates (truncated windows).
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Enterprise 11 only

Migrate bots independent of Bot Insight migration

Before migration of legacy bots, you can now declare whether these bots were using
the Bot Insight option in Enterprise 11 by selecting the Tag bots and variables for analytics
option in the Bot Migration Wizard. The Bot Insight Open and Close actions are created
only for such migrated bots where this option is selected.

Migrate Enterprise bots on page 1431

What's changed

Assess migration readiness of processes with Bot Scanner

The Bot Scanner scans your repository for processes that can be migrated to Automation
360 and provides information under the following categories:

Note: A process is a bot that is not used in any other bot and can include child bots.

e Al List of all the processes.

» Action required: List of processes that require action after migration to Automation
360. A process is flagged as Action Required even if one of its child bot requires action.

* Review required: List of processes that require review after migration to Automation
360. A process is flagged as Review Required even if one of its child bot requires
review.

* Noreview required: List of processes that can be migrated. All the bots in the process
can be migrated.

+ Non Migratable: List of processes that cannot be migrated. All the bots in the process
cannot be migrated.

Note: For generating processes summary report, the maximum repository size that is
supported is up to 10 GB.

Analyze Bot Scanner report for migration on page 1375

Direct link to upgrade launchpad and migration resource portal in Bot Scanner
Bot Scanner report now also contains direct links to:

» Upgrade Launchpad: Use the information provided on this page for a self-guided
experience that is customized for your migration requirements.

Upgrade Launchpad

« Enterprise Migration Resources: Use the information on this page to plan for migrating
to Automation 360.

Enterprise Migration Resources | Cloud RPA | Automation Anywhere

Analyze Bot Scanner report for migration on page 1375
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Direct link to corresponding migration messages

With a direct link to migration messages in Bot Assistant, you now have quicker access to
information about migrated bots that require action or review.

Validate letter case in window titles

You can now validate the letter case in window titles in window variables. By using the
Case sensitive option, you can now decide whether to match or not match the letter case
in window titles that have the same titles but differ in letter case.

With this option, you can ensure that the migrated bots produce the same output as that of
their corresponding Enterprise 11 bots.

Review bots more efficiently with exact line number in Bot Scanner report

The Bot Scanner report now displays the exact line number in the bots that need review
or action even in cases where some of the commands used in Enterprise 11 bots are not
available in Automation 360.

Fixes

When you migrate bots with the Select item by index action of the SAP package, the index
is now displayed correctly. The migrated bot selects items according to the correct index,
and no error is displayed.

MetaBots that were captured using the following configurations will now be migrated to
Legacy AlSense in Automation 360:

Linked object play mode Main object play mode
Text Text
None Text

Previously, bots that used such MetaBot configurations failed to migrate.
Service Cloud case ID: 01774261

You can now migrate Task Bots that use MetaBot Logic whose DLL file contains classes
without a namespace.

Previously, an error occurred when you ran such Task Bots.
Service Cloud case ID: 01765712
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When you migrate from Enterprise 11 to Automation 360, capturing MetaBot screen
commands is changed as follows:

Enterprise 11 Automation 360

« Main objects captured with the Object | Record capture actions with the Object
play mode play mode

» Linked objects captured with the
Coordinate play mode

You can now use commas in the filenames of bots that use FTP actions and use colons in
the filenames of bots that use Delete files and Delete folder FTP actions.

Previously, such bots encountered an error during bot run.
Service Cloud case I1D: 01772186

When you migrate bots that use the same window titles but have different letter case in
window variables, the bots now run successfully.

Previously, bots that used the same window titles but had different letter case in window
variables failed to run successfully after migration.

Service Cloud case ID: 00825181

You can now successfully run migrated bots that use the Email Received Date variable
twice in subactions inside the Email Loop action.

Previously, a parse error occurred in such cases.
Service Cloud case ID: 01275815

In migrated bots, when you use the Recorder package, you can now use the Click action
on Client Control in HTML technology without any issues.

Previously, the Click action button on Client Control did not work as expected.

Service Cloud case ID: 01713357

You can now successfully re-edit a migrated bot with the Record > Dataset variable.
Service Cloud case ID: 01807170

When you want to open web pages, in the Browser package, when you use the New
window option of the Open action, you can now specify a URL without the protocol
information, such as http, https, or file.

Previously, when protocol information was not provided in the URL, some web pages did
not open properly.

You can now successfully migrate Enterprise 11 bots with analytics flags.
Previously, migration failed when variables with analytics flags were checked.
Service Cloud case ID: 01768545
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When you click the Back button in the migration details page for a migration run, you are
now redirected to the Migration runs tab.

Previously, when you clicked the Back button, you were redirected to the Overview tab.
Service Cloud case ID: 01816558

When you migrate a bot that uses the Manage Window Controls action, the height value is
now set correctly after migration.

Previously, after migration, the last digit of the height value was not available.
Service Cloud case ID: 01756996

When you run a bot to automate spreadsheet data, all the requests are now processed
successfully in the following scenario:

When an Excel session is active in SAP and a corresponding Excel process starts in the
background, Automation 360 creates a separate Excel process other than the one that SAP
started, and the correct window is now activated for all the subsequent requests.

Previously, only the first request was processed successfully because the correct window
was not activated for automating the spreadsheet data for the subsequent requests.

Service Cloud case ID: 00815159

When you migrate bots from Enterprise 11, the automation priority of each bot is now
adjusted to match its equivalent priority level in Automation 360, as follows:

* In Enterprise 11, if the automation priority for a bot was set to low, after migration, the
automation priority for the bot is changed to medium.

* In Enterprise 11, if the automation priority was set to medium, the automation priority in
the migrated bot is set to high.

Note: There is no change in automation priority when it is set to high.

Previously, the automation priority of migrated bots remained the same as in Enterprise 11.

You can now migrate bots even if the properties value of the Manage Window Controls
action is set to 65536 or more.

Previously, when the properties value was set to 65536 or more, the bots encountered an
error during bot run.

Service Cloud case ID: 01768555, 01825071

After migration, you can now get all the lines of text from the Terminal Emulator by using
the Get text > All lines action.

Previously, you could get only 24 lines of text from the Terminal Emulator.
Service Cloud case ID: 01609467

In the Bot migration wizard, the Bot Scanner and the Bot migration report now display the
correct status for bots that are flagged for the R134 migration message.

Previously, in the Bot Scanner and the Bot migration report, the status of bots that required
review was incorrectly displayed as No review required.
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You can now successfully migrate bots whose queue category name contains a space.

Previously, migration of such bots failed because Enterprise 11 bots whose queue category
name contained a space went into an infinite loop until the loop timed out at 90 minutes.

Service Cloud case ID: 01850864

After you migrate a bot that uses the Terminal Emulator package, when you run the baot,
the terminal window is now activated and remains in the front. This is because the Show
terminal window in the front option in the Connect action is now enabled by default.

Previously, when you ran such a bot, the terminal window was not activated and remained
minimized because the Show terminal window in the front option was not present in the
Connect action.

When you run a bot with the Database package, the bot no longer becomes stuck at the
Insert or the Update command when run for a long duration.

Previously, in such cases, the bot became stuck intermittently.

Service Cloud case ID: 01836733

Limitations

In Enterprise 11, if bots were using the String > Replace action to find a carriage return
line feed (CRLF) character and replace it with another character, after migration, the output
might not be the same as the output seen in Enterprise 11.

Workaround: In the Find string option, instead of the Enter (LF) variable, use the Newline
(CRLF) variable.

Service Cloud case ID: 01808878

In Enterprise 11, if bots were using the If, IF/ELSE, or Loop While command in Windows
Control and if the Application window does not exist, after migration, the bots will
encounter an error during bot run.

Service Cloud case ID: 01846262

When the Select query is used inside a Loop command and its result set is further iterated,
if the query returns no record, the result set Loop reiterates the previous record.

Service Cloud case ID: 01799961

Related reference

Automation Workspace v.26 release on page 195
Review what's new and changed, fixes and limitations, and the feature deprecations in Automation
Workspace for the v.26 release.

Updating to v.26 release on page 214
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Review requirements and support information about updating your Control Room and Bot Agent
for the v.26 release.

Automation Co-Pilot v.26 release

Review what's new and changed and the fixes in Automation Co-Pilot for the v.26 release.

What's new

Embedded automation with OAuth 2.0
Embedded automation streamlines access to the automation experience.
Embed automations in your application using Automation Co-Pilot on page 2862

» Automation Co-Pilot Integrations embeds in web applications as a widget, so if you
are an end user, you can access automated processes and bots without leaving your
environment.

« Automation Co-Pilot Extensions offers further adaptability through Chrome browser
extensions, enabling automation directly in any web scenario. Business users can now
access automations through a widget, available through an extension in their web
browser.

« With an OAuth 2.0 connection, existing access to automations in the Control Room are
now shared with the Extensions to offer you a seamless user experience.

Automation Co-Pilot using embedded widget and Chrome extension on page 2865

Oracle Database support

We now support Automation Co-Pilot on Oracle Database. When you install or update to
this release, you can now choose Oracle Database to work with Automation Co-Pilot.

Delete files permanently from Automation Co-Pilot cloud storage

You can now delete files permanently from Automation Co-Pilot cloud storage. When you
delete a request, the associated file is also permanently deleted now and not just sent to
the recycle bin.

Cloud storage usage on page 2980

Append or overwrite operations in your form

Append or overwrite operations in your form by using the Assign form rules for the web,
with the Checkbox and Radio Button elements, which now support form rules.

Assign dynamic values with support for new elements in your forms

When you use the interactive forms package, you can now assign dynamic values with the
Assign action, which now supports Checkbox and Radio Button elements in your form.

You can also change the label of the selected form elements with the Change label action
for the Button element.

Interactive forms package on page 2405
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Run processes more seamlessly by setting expiration time for human tasks (Service Cloud
case ID: 00806522)

You can now run your process more seamlessly even when a human task takes longer to
run. You can achieve this by setting an expiration time for your tasks in Human Task in a
process.

When you set an expiration time, if a human task takes longer to address, the task times out
and the process moves to the next step to ensure there is no break to the flow.

You can set the expiration time by number of days, hours, and minutes, depending on your
requirement.

Create a process in Process Composer on page 2991

What's changed

Simplify your workflow by grouping multiple conditions in form rules

You can now group multiple conditions for your form rules by using the And logic with
the Or logic. Previously, you could group only the And logic or the Or logic. This change,
which is similar to the If-Then-Else logic, facilitates grouping multiple conditions and helps
simplify your workflow.

Fixes

You can now have greater security validation because it is no longer possible to upload files
that have double extensions, such as File.PDF.PDF, to your web application.

Previously, uploading files with double extensions was possible, which represented a
significant risk to applications.

Service Cloud case ID: 00828289

Clean up operations now include recursive request files to prevent spam in audit logs.
Previously, an Unsuccessful Request alert appeared repeatedly in the audit log, from root
error:

org.hibernate.exception.ConstraintViolationException: could not
execute statement

Service Cloud case ID: 01816489, 01839604

When you use the Has Errors rule to show the number of errors in your form, the error
message now shows the correct number of errors.

When you update from Automation 360 v.24R2 to Automation 360 v.25, the bot setup now
correctly shows the number of bots and assigned team:s.

Related reference
Automation 360 v.26 Release Notes on page 190
Automation Workspace v.26 release on page 195
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Review what's new and changed, fixes and limitations, and the feature deprecations in Automation
Workspace for the v.26 release.

IQ Bot and Document Automation v.26 release on page 224
Review what's new and changed, and the fixes and limitations in 1Q Bot and Document
Automation for the v.26 release.

Bot Insight v.26 release on page 232
Review what's changed and the limitations in Bot Insight for the v.26 release.

IQ Bot and Document Automation v.26 release

Review what's new and changed, and the fixes and limitations in 1Q Bot and Document
Automation for the v.26 release.

Document Automation

What's new

Improve extraction by providing changes to the Validator

You can now improve extraction by providing learning instances with validation feedback
for Automation Anywhere models. You can achieve this by enabling the Validation
feedback option in the Create learning instance and Edit learning instance windows.

Data extraction in Document Automation on page 3161

Search for form or table fields

When creating a learning instance, when you are configuring fields, you can now search
for fields by field name, field label, or data type.

Process invoice-like documents with user-defined document type

You can now process documents that are visually similar to invoices, such as purchase
orders and sales orders, which contain key-value pairs and a table structure. You can
achieve this by create learning instances with the user-defined document type, using which
you can also achieve the following results:

e Extract from English, Dutch, French, German, Italian, Portuguese (Brazilian), and Spanish
language documents.

« Define exactly which values to extract from a field, such as when a date of birth field
also contains the age.

» Use the Address data type for form fields, which identifies and extracts the structure of
an address.

Enhancements to the Validator

* The Validator now shows the group number for documents processed in a learning
instance connected from Automation 360 1Q Bot

e You can now configure a list of valid values when creating learning instance.

*« When you click a field that requires validation, a message now appears with the
confidence level determined by the system and the threshold set in the learning
instance.
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What's new

Monitor document processing metrics in Bot Insight dashboards

You can now visualize data, such as the number of documents uploaded per day,
extraction time per document by learning instance, and STP percentage by learning
instance, by using the customizable dashboards in the Document Workspace tab.

Document Workspace dashboard on page 3392

Document Automation now supports the bring your own key (BYOK) use case for the
Google Document Al product license

Users can now configure their Control Room environment with Google Document Al
licenses purchased from Google. This allows the learning instance to send documents to
Google Document Al for extraction and for the Control Room to track consumption in the
All licenses page.

Configure key for Google Document Al on page 3156 | Automation 360 licenses on page
1251

View Document Automation user activities in the audit log

With the AAE_Admin role or a custom role with the View audit log permission, you can
now view the status of events related to learning instances, domains, and documents.

Audit log on page 1906

Create and train standard forms within the Control Room

Users with the AAE_IQ Bot Admin or AAE_IQ Bot Services roles can now create new
standard forms in Document Automation. It is no longer necessary to leave the Control
Room and open a third-party service to create or modify a standard form. The interface to
configure the extraction model is launched from the Learning instances page.

Note: To process documents in a learning instance which uses the standard forms model
in Document Automation:

1. Create the standard form in Document Automation.
2. Create and train the learning instance in Automation 360 1Q Bot.

3. Connect the learning instance to Document Automation.

Create standard form in Document Automation on page 3196

What's changed

To connect a learning instance from Automation 360 IQ Bot, you must have one of the
following roles:

« AAE_IQ Bot Admin

» AAE_IQ Bot Services

» A custom role with the Connect learning instance permission

© 2023 Automation Anywhere. All rights reserved. 225



product-flagshipAutomation Anywhere - Release Notes

What's changed

Uploaded documents and extracted data are now removed after 90 days even if a
document has not completed processing, except in the following cases:

* |f data is downloaded and deleted, the source documents are immediately deleted.

* |f the document is manually validated, the document is stored for 90 days from the date
of extraction.

If a document is renamed to a new file extension and uploaded to a Google Document Al
pretrained model, the document will fail processing.

Workaround: Rename the document to the correct file extension.

Fixes

Beside the Validate documents link, the value that reflects the number of documents
awaiting validation is no longer hidden, and you can now view it without adjusting the
width of the Actions column.

Previously, you had to adjust the width of the Actions column to see the value.

You can now successfully draw a box, zoom in, fit the box to match the screen size, and
then redraw the box without any issue.

Previously, when you drew a box, zoomed in, clicked Fit to screen, and then tried to
redraw the box, the box appeared at a different location from where you clicked.

In the Validator, you can now adjust the system-identified region (SIR) by dragging the
corners of the SIR when you zoom in or zoom out.

Previously, you could drag the corners of the SIR but not when you zoomed in or zoomed
out.

When you connect to a learning instance from Automation 360 |Q Bot, if the learning
instance has an optional field with a set default value and some fields that are unmapped,
when you process documents in that learning instance in Document Automation, the
default value now appears only in the mapped fields.

Previously, the default value appeared incorrectly in the unmapped fields.

In Community Edition, when you try to delete a learning instance, the following, correct
message is now displayed and you can successfully delete the learning instance:
Community edition users are limited to 5 learning instances

Previously, although you could delete the learning instance, the following, incorrect
message was displayed: Community edition users are limited to 5 learning
instances and will not be able to delete.

Fixed an issue where Document Automation sometimes failed to extract data from tables
that span across multiple pages. Document Automation now supports data extraction from
tables that span across multiple pages for Automation Anywhere models.
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Fixes

You can now use the Document Extraction > Download action in a standalone bot that is
not part of an Automation Co-Pilot process.

Previously, this action could be used only in the Downloadbot within the Automation Co-
Pilot process that was automatically generated when a user created a learning instance.

After the Validator times out because of inactivity, when you refresh it, instead of showing
the most recent document that you validated, the Validator shows the first document that
you validated.

Limitations

Document Automation does not support Cloud-enabled (SDS) deployment.

Formula validation does not support numbers that contain delimiters. For example, 1, 000
and 2.0 are not supported.

In some cases, the Bot Agent does not clear out its resources folder. Until the disk space
is freed, the production documents in processing will be affected. This issue occurs
intermittently.

Workaround: Based on the issue, you must create a task scheduler to clean out the
resources folder every day or every week.

There is no notification when the product license is about to expire. When the product
license expires, the Learning Instances tab is removed from the Control Room.

Learning instances that use Google Document Al models do not reliably extract all the
fields in a table, if the table that spans multiple pages.

In On-Premises installation in Linux environments, document processing sometimes fails
because of a storage service error.

Workaround: In the command prompt, run the following script:

cd /opt/automationanywhere/automation360/appdata/Server Files/
sudo chown -R crstorage:controlroom storageservice

Document Automation does not support Oracle Database for On-Premises installations.

Document Automation supports only the following standard ports for On-Premises
installations:

e For HTTP: Port 80
e For HTTPS: Port 443

Sometimes, files uploaded to train a standard form appear corrupted although the data is
still usable.

Standard forms in Document Automation is not supported in a multi-tenant Cloud Control
Room that was upgraded from v.25. This limitation does not occur on a fresh installation of
a multi-tenant Cloud Control Room.

Learning instances with the user-defined document type do not support Dutch language
documents.
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Limitations

The first time you click a learning instance connected from Automation 360 1Q Bot,
you are redirected to the IQ Bot homepage instead of the details page for that learning
instance.

Formula validation is not supported for custom fields if the field name contains a space.

When you import a learning instance created in a previous version of Document
Automation, the check box to send validation feedback to the system is unselected by
default. You must edit the learning instance to select the check box.

Document Automation does not perform post-processing on connected learning instances
that contain Python custom logic with either of the following:

* Single quotes, such as print ('Test"'). Ensure the Python script uses only double
quotes.
» Characters from non-Latin languages (Unicode characters), such as asufin.

Formula validation is not supported in learning instances with the user-defined document
type.

When you process documents using the 1Q Bot Extraction package, the Python scripts
are not applied properly on the form fields for the classic learning instances connected on
Document Automation. This results in improper data extraction in the output CSV files and
the Validator.

When you click the Table icon on Form OCR Testing Tool (FOTT) editor, the text appearing
on the pop-up window is not readable.

If 1IQ Bot,Control Room, and Bot Agent are installed on the same Windows Server 2012,
then data extraction fails for any Classic learning instances connected in Document
Automation.

IQ Bot

What's new

When user logs out, lock released immediately on documents in Validator

When a user logs out of IQ Bot, the lock on the documents in validation is now released
immediately so that other users can view or validate the documents. Previously, when a
document was in the Validator queue, if the logged out, the lock on the document in the
validator was not released immediately, as a result of which other users could not view or
validate the document.

Use the 1Q Bot Validator on page 3265

IQ Bot Database Migration Assistant Tool now supports Windows Authentication

When you migrate from Enterprise 11 to Automation 360 by using the Database Migration
Assistant Tool, you can now use Windows Authentication for connecting to the |1Q Bot
database server.
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What's new

Choose classification type while creating learning instance

When you create a learning instance, you can now choose which aliases and fields are
considered for classification by using the Disable classification changes on domain
modification (fields, alias) check box.

* When this check box is selected, the classification process uses only the aliases or fields
that were present in the domain when the learning instance was created. Aliases and
fields added to the domain after the learning instance was created are not considered
for classification.

* When this check box is cleared, the classification process uses all the aliases or fields
that are part of your domain. Aliases and fields added to the domain after the learning
instance was created are also taken into consideration for classification.

This feature classifies the document to the same group even if there are any updates in the
domain.

What's changed

Upgraded machine learning models

IQ Bot now uses an upgraded machine learning model for detection of check boxes and
Advanced tables.

Python libraries upgraded to 64-bit

All the Python libraries provided in |Q Bot by Automation Anywhere for this release are
now upgraded to 64-bit from 32-bit. If you are using third-party libraries, ensure that you
upgrade to 64-bit libraries. After upgrading the third-party libraries, ensure that these
libraries work successfully.

Fixes

When you download an unclassified document, click Delete from the server, and then
toggle the learning instance from production to staging and back, the document no
longer appears in the untrained folder. Previously, when you downloaded an unclassified
document from the untrained groups, even after you deleted it, the document still
reappeared in the folder.

Service Cloud case ID: 01781935

When you upload documents, the Classifier no longer halts or becomes stuck. Documents
that are not classified are now cleared from the queue, allowing smoother processing

of subsequent documents. If these documents fail to be processed within the timeout
limit, they are now categorized as unclassified and you can download these unclassified
documents.

Service Cloud case ID: 01762844, 01272642, 01750753

You can now install IQ Bot by using Windows authentication and CyberArk Vault and
then rotate the key. Previously, when you tried to rotate the Vault key, the following
error message was displayed: Error occurred while setting up the new key.
Please check the logs
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Fixes

You can now select multiple learning instances for backup by using the Search drop-down
list. Previously, after you clicked the Create Backup option on the Migration Management
page, if you selected a learning instance and then used the Search drop-down list to select
another learning instance, the previously selected learning instance became deselected.

The value displayed in the My totals > Accuracy field now matches the value in My
learning instances > Field accuracy for the available learning instances.

You can now add documents to manually created groups and upload documents to
staging.

Previously, when you edited a manually created group or tried to upload a document,
you encountered an error and the following error message was displayed: Failed to
update manual group: Duplicate label found.

Service Cloud case ID: 01849616, 01845590

You can now use the migration utility to successfully migrate learning instances created for
a custom domain. When you import IQBA files with duplicate fields (even through an API),
the following message is displayed alerting you to the existence of duplicate fields: Error:

Duplicate field found Invoice number. Previously, the migration utility could
not be used to migrate learning instances created for a custom domain.

Service Cloud case ID: 00729627

During migration, you can now successfully import and export IQBA files. Previously, the
import and export of IQBA files failed because the content classification table contained
duplicate training fields.

Service Cloud case ID:; 00826891

When a document is successfully downloaded, it is now placed in the Success folder.
Previously, documents that were successfully processed were sent to the untrained folder,
causing inconsistencies in the download process.

Service Cloud case |D: 00780227,00842077

When there is an update in the domain, IQ Bot now classifies a document to the same
group.

Previously, whenever there was any update in the domain, IQ Bot created new groups for
the same document.

Service Cloud case ID:01622981

If a document without content is uploaded to a learning instance in production, the

following message is logged in the bot_launcher.log file: Unable to upload file
<filename> to the Learning Instance. No content in file, size 0"
whenever there is a 0 KB file is uploaded.
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Fixes

The security vulnerability related to Unquoted Service Path has been fixed. Previously,
the Windows host referred to an installed service that used an unquoted service path
containing whitespace Automation Anywhere Cognitive Console: D: \Program Files

(x86) \Automation Anywhere IQ Bot\Portal\node modules\winser\bin
\nssm64.exe, which resulted in the vulnerability.

Service Cloud case 1D:01880370

Limitations

You cannot create a bot in IQ Bot when an invalid document is uploaded to a custom or
manual group. Also, when an invalid document is uploaded along with a valid document
and processed for extraction, the See extraction page keeps loading.

IQ Bot does not support Oracle Database for on-premises installations.

During production processing, if a learning instance is switched from Production to Staging
or the other way around, for any documents processed during this switch, the production
document that appears in Validator is blurred and not in human-readable form.

IQ Bot does not perform post-processing on a field if the custom logic uses Python script
containing single quotes, such as print ('Test'). Ensure the Python script uses only
double quotes.

Custom Logic Python script challenges in A360.26 1QBot (A-people login required)

If your 1Q Bot custom logic uses the Pandas library, the script must have the import
Pandas statement.

IQ Bot does not perform post-processing on a field if the custom logic uses Python script
containing characters from non-Latin languages (Unicode characters), such as 61k

In 1Q Bot, when you run a script created on versions prior to Automation 360 v.26,
you might see a warning. However, this does not impact the script execution and the
functionality.

Related reference
Automation 360 v.26 Release Notes on page 190

Automation Workspace v.26 release on page 195
Review what's new and changed, fixes and limitations, and the feature deprecations in Automation
Workspace for the v.26 release.

Automation Co-Pilot v.26 release on page 222
Review what's new and changed and the fixes in Automation Co-Pilot for the v.26 release.

Bot Insight v.26 release on page 232
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Review what's changed and the limitations in Bot Insight for the v.26 release.

Bot Insight v.26 release

Review what's changed and the limitations in Bot Insight for the v.26 release.

What's changed

With the expanded user interface, you can now gain more insights into the Document
Workspace. A new dashboard is available that delivers insights to Document Automation
activity and trends, such as number of uploaded documents, pages and average extraction
time. See more information in the following topic.

Document Workspace dashboard on page 3392

Limitations

DataTable widgets for Bot Insight dashboards currently show a maximum of 100 records.
Service Cloud case I1D: 01820004, 01851999, 00760252, 00806950

To avoid errors from occurring during bot lifecycle management, the private workspace
dashboards will be imported only when the bot is imported directly to the private
workspace.

Importing a bot to the public workspace and checking the bot out to the private workspace
will not import the associated private workspace dashboards.

Service Cloud case |D: 00760022, 01803726, 01794757, 01777561, 01780407, 01842554,
01874606

Connectors for Bot Insight, such as Tableau or Power Bl, work only with the following
authentication mechanisms:

« Authentication based on Control Room database
« Authentication based on Active directory

Service Cloud case ID: 01863601, 01909212

Related reference
Automation 360 v.26 Release Notes on page 190

Automation Workspace v.26 release on page 195
Review what's new and changed, fixes and limitations, and the feature deprecations in Automation
Workspace for the v.26 release.

Automation Co-Pilot v.26 release on page 222
Review what's new and changed and the fixes in Automation Co-Pilot for the v.26 release.

IQ Bot and Document Automation v.26 release on page 224
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Review what's new and changed, and the fixes and limitations in IQ Bot and Document
Automation for the v.26 release.

Automation 360 v.25 Release Notes

Release date: 28 June 2022
Review what's new and changed, and the fixes and limitations in the Automation 360 v.25 release.

» Control Room: Cloud Build 14304 (replaces Build 14298) and On-Premises Build 15112
(replaces Build 15097)

« 1Q Bot: Cloud Build 14304 (replaces Build 14298) and On-Premises Build 15112 (replaces Build
15097)

Important: Manifest V3 based extensions - Google will deprecate Manifest V2 based extensions
for Google Chrome by January 2024. . To know about Microsoft Edge Manifest V2 based
extensions timelines, see Overview and timelines for migrating to Manifest V3. The deprecation
might impact your existing automation that use current Manifest V2 based extensions in Google
Chrome and Microsoft Edge browsers. Use the Automation 360 v.25 Build 15118 and Bot Agent
version 21.211 for the latest Manifest V3 based extensions updates to support features that use
Google Chrome and Microsoft Edge browsers. This build is available for download in the link
provided in the following article: Everything about the Chrome/Edge Manifest V2 Deprecation. See
Chrome and Edge Manifest V3 extensions on page 997 and Everything about the Chrome/Edge
Manifest V2 Deprecation.

If you want to continue using the earlier builds of Automation 360 v.25 (Build 15112 or 15097) but
want to upgrade to Manifest V3, you can manually upgrade to Manifest V3. See Manifest extension
manual upgrade.

Important: We have updated the Cloud Build 14304 and On-Premises Build 15112 to include fixes
for the following issues. Fixes specific to On-Premises or Cloud builds are indicated.

« When you created or deleted new users, multiple, duplicate audit log entries were generated
for a single user (Service Cloud case ID: 01836296).

 When you logged in to the Control Room with bot export permissions, when you exported a
task, no corresponding entry was immediately visible in historical activity (Service Cloud case
ID: 01834139, 01839933, 01841993, 01839817, 01834108, 01846407/, 01845706, 01843349,
01846220, 01846819, 01845547, 01847028, 01847024, 01847094, 01847114, 01847115,
01846998, 01847840, 01846757, 01848123,01846944, 01848104, 01848294, 01848905,
01846596, 01849748).

»  When you updated to Automation 360 v.25 and attempted to use the previous settings with
instance names, the previous settings were not allowing an update (Service Cloud case ID:
01838276, 01835897).

e (On-Premises only) When you deployed a task On-Premises without direct Internet access, the
compilation slowed down (Service Cloud case ID: 01841448, 1839118, 1844817, 01846153,
01846332, 01839254).

»  When the wait for condition package was used with any command package, the set timeout
value for the wait was not met (Service Cloud case ID: 01842547, 01846156, 01847338,
01846324, 1842368, 01847054, 01848080, 01848789, 01848151, 01848963, 01847054,
01847121, 01848236, 01848260, 01849016, 01848248, 01848572, 01847828, 01847055,
01848826, 01848191, 01848944, 01851181, 01849792, 01852057, 01846152).

© 2023 Automation Anywhere. All rights reserved. 233


https://docs.microsoft.com/en-us/microsoft-edge/extensions-chromium/developer-guide/manifest-v3
https://apeople.automationanywhere.com/s/article/Everything-about-the-Chrome-Edge-Manifest-V2-Deprecation
https://apeople.automationanywhere.com/s/article/Everything-about-the-Chrome-Edge-Manifest-V2-Deprecation
https://apeople.automationanywhere.com/s/article/Everything-about-the-Chrome-Edge-Manifest-V2-Deprecation
https://apeople.automationanywhere.com/s/article/Upgrade-Chrome-and-Edge-Manifest-v3-from-Manifest-v2
https://apeople.automationanywhere.com/s/article/Upgrade-Chrome-and-Edge-Manifest-v3-from-Manifest-v2

product-flagshipAutomation Anywhere - Release Notes

« When you update from any build to Automation 360 v.25, if changes were made to the If/Else
logic in nest and saved, a new Go to End point element was added, which created a process
error (Service Cloud case ID: 01848192).

e (On-Premises only) When an Automation Co-Pilot process was checked in and then checked
out, the mapped variables did not persist and were lost (Service Cloud case ID: 01847675).

This page includes the following sections:

« Migration
e 1lxand10.x
e llxonly

» Automation Workspace

«  What's new | What's changed | Summary of changes in packages on page 245
« Fixes | Limitations (this release) | Limitations (previous releases)

» Internet Explorer EOL updates

e Features

» Automation Co-Pilot

«  What's new | What's changed | Fixes | Limitations
» Discovery Bot

o Fix
»  Document Automation

« New capability | Limitations

+ 1Q Bot

+ What's new | What's changed | Fixes | Limitations

« Bot Insight
«  What's changed | Fixes

» Automation Anywhere for Genesys

o What's new

» Feature deprecations

e Summary list

Top 5 developer features in this release

View the following video on the top 5 developer features:
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Updating to this release

If you are on the previous build (Build 15097) of Automation 360 v.25, you must update to the
latest Build 15112.

You can update to the latest version of Automation 360 from the previous three releases (that is,
from n—3 releases, where n refers to the latest release).

The following previous releases are certified for update to Automation 360 v.25:

e V.24R2 (Build 13343), and v.24 (Build 12350, 12342)
e V.23 (Build 11513)
» Vv.22 (Build 10526)

See also A360 | Upgrading to A360.23, A360.24, A360.25 from A360.22 (A-People login
required).

When updating from previous releases to v.25 (Build 15097), ensure that you review the
information in the following article: Error parsing the SQL instance name while upgrading to
Automation 360 v.25 (A-People login required).

If you are on one of these previous releases, for information about updating, see Update
Automation 360 to latest version on page 1266. If you are not on an n-3 release, update
Automation 360 to one of the n—-3 releases before updating to Automation 360 v.25.

Important: This release includes an optional Bot Agent update. You can continue to run your
existing bots without updating the Bot Agent. However, if you want to use the new features in
Automation 360 v.25, you must update the Bot Agent available with this release.

For more information, see these resources:

» Automatically update the Bot Agent on page 1207 | Manually update the Bot Agent on page
1209

« Compatibility with release builds on page 1182

For the latest updates to the Automation 360 extensions for Google Chrome, Microsoft Edge, and
Mozilla Firefox, see Browser extensions for Automation 360 on page 852.
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Migration

Enterprise 11 and Enterprise 10 features

Migrate Task Bots when the referred MetaBot Logic is renamed

You can now successfully migrate Task Bots where referred MetaBot Logic name is
renamed or has changed the relative path after mapping.

If a MetaBot Logic is renamed or changed the path after being mapped in the Task Bot
then the Task Bot is now migrated with the new MetaBot Logic hame or path.

The command path in the Task Bot is updated with the renamed name or with the updated
path.

Changing the relative path is applicable in the following scenarios:

* Logic is moved from one folder to another.

* Logic is moved from a MetaBot root level folder to a sub folder.

« Logic is moved from a sub folder to a folder at MetaBot root level.
» The folder that has the Logic is renamed.

This enhancement applies to the following commands:

* Run Logic

If > Logic Successful

If > Logic Unsuccessful
e Error Handling

Enhanced Bot Scanner output report

In the Bot Scanner output report, when you click the name of a bot that requires corrective
action, you can now view the Line number of commands instead of the Total message
count (frequency).

Migration support for Send Email action with multiple attachments

You can now migrate bots that have the Send Email command with a filepath in a variable
for the following scenarios:

« Asingle file is sent as an attachment.
¢ Multiple attachments are sent in a single email.
o Files are attached from a network drive.
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Enterprise 11 and Enterprise 10 features

Migration support for Work Item variable (Service Cloud case ID: 01270496)

You can now migrate bots with the Work Item variable for scenarios in which the Work
Item variable includes the following:

e A number

* Both number and string, for example, a message box

« Adate

* A combination of Datetime and string, for example, a message box

Note: If the Work Item variable is a Datetime type, the action Record:Assign is added
automatically, which then gets converted to Datetime type string variable, before
applying the Work Item variable.

Variables created automatically after migration

In the Bot Scanner utility, bots that contain the following non-referenced variables are no
longer flagged as Action Required or Review Required:

o SFileName$

« SError Description$
o SError Line Number$
o SExtension$

SFolder Name$

After migration, the system automatically creates these variables according to the
Automation 360 naming convention, and the migrated bots run successfully.

Migration enhancement to packages and actions

» If the migrated bots use the PDF Extract Text > Structured Text action, the new
Reduce Data Loss option ensures that characters are retained in the extracted text and
the bots run successfully.

« If you have bots with a specific Xpath expression in the SOAP Web Service package,
ensure that the SOAP command output for Selected Response is returned accordingly
by selecting String Delimited or List of Strings. For migrated bots, the String delimited
by None option is selected by default.

» If migrated bots use the Terminal Emulator, the Set cursor position to the beginning
option now enables you to edit the Terminal Emulator screen manually, and the focus
is set to the beginning of the editable field. Note that this option is selected by default
only when the Show terminal option is selected for these bots. (Service Cloud case ID:
00812730, 01252363, 01804623)
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Enterprise 11 and Enterprise 10 features

Support for 7-Zip

We have certified 7-Zip, a third-party tool, to handle backing up the Control Room
repository with lengthy file names, bot names, and folder names. You can now back up
and restore the repository of bots even when the length of the filepath to the repository of
bots exceeds 256 characters. You can run either 7z.exe commands using the command
line interface or run the 7.Zip as an application.

The 7-Zip tool support is available on the following Automation Anywhere certified
Windows operating systems:

e Microsoft Windows Server 2016
e Microsoft Windows Server2019

You can download the 7-Zip tool from 7-zip Download page.

New Update window title action to update browser name in window title

When you are migrating Enterprise 10 or Enterprise 11 bots that use the Internet Explorer
browser, the Update window title action now converts the window titles of these bots to
Microsoft Edge with [E mode. The window titles are updated based on browser used by the
bots. For example, consider bots that use Internet Explorer and have Internet Explorer
in the window title. After migration, the new action updates the window title to reflect the
new browser, Microsoft Edge, and the format of the text as *Microsoft*Edge.

Using legacy Web actions on page 2443

Enterprise 11 only features

Automate objects that appear behind bot runtime window (Service Cloud case ID:
00710929)

For the following commands, when you run a bot, you can now automate objects that
appear behind the bot runtime window:

* Image Recognition > Find window in window

« If/Else > Image Recognition > Window is found in window or not
* Mouse > Click

« OCR > Capture area or window

Automation Workspace

What's new

Support for Azure Application Gateway

On Microsoft Azure cluster environment for On-premises, Azure Application Gateway is
now a supported load balancer..

Supported data center component versions on Microsoft Azure on page 1133
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What's new

Install Bot Agent on devices that have Enterprise 11 Enterprise Client

When you are creating a bot in Automation 360, you can now install the Bot Agent on a
device with an existing Enterprise 11 Enterprise Client. You can create or run bots from
both the Control Room instances.

Install Bot Agent and register device on page 1194

IE 11 EOL notification banner displayed in Control Room

Starting from the Automation 360 v.25 release, if you use the Microsoft Internet Explorer
browser to access the Control Room, you will be prompted to use an alternative supported
browser, such as Google Chrome or Microsoft Edge (Chromium). When you log in to

the Control Room, a notification banner is displayed indicating that support for Internet
Explorer 11 is ending.

Log in to Automation Anywhere Control Room on page 1331

Switch Bot Agent to another Control Room without reinstalling the Bot Agent

You can now enable a single-user device to be switched to another Control Room without
reinstalling the Bot Agent. Log in as an administrator and select Enabled and the Allow fast
switching check box from the device settings.

Switch device registration between Control Room instances on page 1643

Configure the VM instance to delay Bot Agent registration

You can now configure the VM instance (golden image) to delay the Bot Agent registration
until the user logs in to the Control Room from that instance. You can also configure up
to 20 Control Room URLs so that you can use the same golden image to connect to any
Control Room from that list.

Bulk install Bot Agent on devices on page 1201

Automation 360 support for Amazon Linux 2 on AWS EC2 environment

Automation 360 now supports the Amazon Linux 2 operating system for Automation
360 On-Premises Control Room installation on the AWS Elastic Compute Cloud (EC2)
environment.

Amazon Linux 2

Out-of-sync licenses and Control Room license expiry

When licenses are oversubscribed, the Control Room enters the fail-safe state and
continues to operate in fail-safe mode for 30 days, after which the Control Room becomes
locked.

When a Control Room license is within 30 days of expiration, a warning message is
displayed in a banner until the license either expires or is renewed.

Control Room fail-safe status on page 1244 | Control Room license expiry notifications on
page 1264

© 2023 Automation Anywhere. All rights reserved. 239



product-flagshipAutomation Anywhere - Release Notes

What's new

Support for integration with SIEM

The Automation 360 Cloud Control Room now supports integration with security
information and event management (SIEM) to forward the audit logs.

Configure integration with SIEM on page 1674

Enforce coding standards with code analysis

» Code analysis enables you to define and enforce coding standards to improve
automation coding practices. You can set different rules that will govern how you code.
With code analysis, you can implement coding best practices and make the code more
uniform, accessible, reliable, efficient, and secure.

« Two new permissions, View policies and Manage policies, are introduced in the
Control Room for code analysis policy.

Code analysis on page 1939

Two-factor authentication for Control Room users

If you are a Control Room administrator, you can now enable two-factor authentication
(2FA) for users logging in to the Control Room. 2FA provides an additional security layer
for all logins to the Control Room, which can be set either for all users or for users with
specific roles.

Two-factor authentication on page 1646

View version history of non-bot file dependencies (Service Cloud case ID: 01615105)

You can now view the version history of your non-bot file dependencies. This helps to
identify relevant changes made to your file by other users during a specific date and time
along with the check-in messages.

View version history of non-bot file dependencies on page 2087

Edit non-empty folder names in private workspace (Service Cloud case ID: 00535388,
00730075, 00786633, 00791528, 01615295, 01820406)

You can now edit your non-empty folder names in the private workspace. With this feature,
you can now manage folders more easily. Ensure the following when you rename a folder:

* |t does not contain checked-out or cloned bots even at subfolder levels.
» [t does not contain more than 100 items including subfolders and files.

Create and rename folders on page 2051

View dependency maps for bots

You can now view the dependency map for your bot in both the public and private
workspaces. The dependency map shows the immediate parent and child bots for any
selected bot. If you are an RPA developer, you can use the dependency map to better
understand where a bot is invoked and which child bots are invoked by the bot. With this
information, you can gauge the impact of the change in a bot, use the bot effectively,
maintain better bot code and reusability, and prevent conflicts.

View bot dependency map on page 2041
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What's new

Support to automate applications supported on Citrix Workspace app (Service Cloud case
ID: 01758063)

The Citrix Workspace app is now supported on Automation 360. You can now automate
applications that are accessed through the Citrix Workspace app by using the Recorder >
Capture action or the Start recording option.

AlSense Recorder: Support for Korean language and complex table operations

«  You can now use AlSense Recorder to automate applications that use Korean and a
combination of Korean and English interfaces.

AlSense for recording tasks from remote applications on page 1998

» With AlSense Recorder, you can now extract tabular data from complex tables. You can
capture and automate tables with wider columns and tables that have columns with
controls such as check boxes and options. You can also capture specific columns from
tables.

Note: If the table is not detected automatically, use the Define option to detect the
table.

Table data extraction through AlSense Recorder on page 2012

Enhancements to Recorder

«  When you run a bot, you can now automate objects that appear behind the bot runtime
window by using the Recorder > Capture action. (Service Cloud Case ID: 00684306,
00770636, 01146672)

e You can now use the Recorder to capture and automate objects with a specific
technology. The Capture object tab now has the option to select a specific technology
and capture using that technology. You can capture objects with the following
technologies:

« Microsoft Active Accessibility (MSAA)
o Ul automation
e Microsoft (MS) COM Ul Automation

Capture using specific technology on page 2587

(Service Cloud Case ID: 01760871, 01865823

e You can now use the Recorder to automate third-party plug-in window objects on
Google Chrome or Microsoft Edge browsers by using a specific technology.

Reduce Data Loss option in PDF package

In the PDF > Extract text action, for the Structured text type field, a new Reduce Data
Loss option is now available. When you use this option, you can extract the complete text
with minimal overlap of characters.

Using Extract text action from PDF on page 2534
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What's new

Enhancement to the String package (Service Cloud case ID: 00770822)

In the String > Extract text action, a new When extracting option is now available. You
can use this option to specify whether the case of the text in the extracted substring must
match that in the source string.

Using Extract text action of String package on page 2715

Download files from URLs that require NTLM authentication (Service Cloud case ID:
01189873)

With the enhanced Browser package, you can now download files from URLs that require
NTLM authentication by using the Browser > Download file action.

New option in Connect action of the Terminal Emulator package (Service Cloud case ID:
00812730, 01252363, 01804623)

You can now edit the screen of the Terminal Emulator session manually by selecting the
Set cursor position to the beginning check box. By selecting this option, you can now set
the focus to the first editable field. By default, this option is not selected.

Bulk update to default package version across bots (Service Cloud case 1D: 00712719,
00728499, 00737694, 00803673, 01255722, 00838604, 00772147, 01760236, 01762679,
01771416, 01761859, 01782588, 01778220, 01784255, 01789551, 01809167, 01818690)

Use Update bots to default package version to update bots to use the default version for
any package. User with the View Packages and the permission to edit the bots can now
update bots in bulk to use the default package version. This feature provides you with an
efficient way to securely update all the bots in the Control Room repository that you have
access to with the default package version in a few clicks.

Update bots to default package version on page 1730 | Example of updating default
package version across bots on page 2845

Advanced search feature in the Bot editor (Service Cloud case ID: 01615310, 01780115)

The Bot Assistant now provides Advanced search capabilities to enhance the overall
search experience in the Bot editor. This helps improve the productivity of the Bot Creator.
The Advanced search page allows you to enter a search text, select the search filter
criteria, and navigate through the search results. You can use the filter criteria to narrow
down the search results and quickly locate the search text. When you edit or view a

bot, you can use the advanced search feature to find the exact line of action and the
corresponding action details where the search text appears, that s, as a string, text value, or
a variable name.

Note: Find in this bot is now renamed to Search in this bot.

Advanced search option in Bot editor on page 2091
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What's new

Enhancement to multiple attachments option in Send email action (Service Cloud case ID:
00800976, 00817136, 00821405, 00936080, 01256523, 01256320, 01262069, 01259369,
00936080, 01801928)

When you send email from bots, you can now send multiple attachments as a list of files
or a variable that contains the list of file objects. With this feature, you can attach files

such as data files, spreadsheets, and word processor documents to your email. You can
attach multiple filepaths from a local drive or a network drive, or you can use a variable that
contains a filepath.

Using the Send action on page 2256

Enhancement to SOAP Web Service package

When you build a SOAP response for an Xpath expression in the SOAP Web Service
package, the result of the Xpath expression can be stored as a list of strings.

Example of using the SOAP web service action on page 2826

Common table expression supported in Export to data table action (Service Cloud case ID:
00655318)

You can now simplify complex joins and subqgueries by using common table expressions
(CTE) in SQL-compliant databases. Use CTEs in the Export to data table action of the
Database package by using the WITH keyword.

Enhancement to OCR package

When you use actions from the OCR package, such as Capture area or Capture window,
the bot now identifies the controls even if the controls are behind the bot runtime
window. It also extracts the text behind the Automation 360 bot runtime window from any
application window.

New package SDK version

You can now set up the default value for a global session by using default_session_value
in CommandPkg in the newly released package SDK version.

Configure packages for On-Premises

On-Premises administrators can now disable the latest package version from becoming
the default version automatically. Administrators can also enable a feature that fetches and
installs new package versions as and when they are released even without a Control Room
upgrade.

Automatic package updates for On-Premises Control Room on page 1726

Workload automations supported on PostgreSQL and Oracle databases

Workload automations are now supported on the PostgreSQL and Oracle databases, as
well. All the workload automations work well with both the databases.

Workload management on page 1816
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What's new

Trigger API

Map triggers to users or roles for an attended Bot Runner user by using the Trigger API.
With the Trigger API, you can also create and delete event triggers.

Trigger API

Enhancement to the Authentication using apikey

With .24 or previous versions, you must replace any escape character '\" with \\" in the API
key. With .25 or later versions, the API key will no longer have any escape characters('\).

Newly implemented Activity List API

With the newly implemented Activity List APl (v3/activity/1list) you can return the
job executions without call back and bot output information. The old Activity List API (v2/
activity/list)is now deprecated.

v3/activity/list Bot Execution Orchestrator API

Definition: Deprecation refers to features or capabilities available in the current (latest)
release that will be removed or unsupported from a future release.

You can use the specified alternatives or updated versions when they are made available.

Migrate from Enterprise 11 Control Room version 11.3.4.7 to Automation 360 On-Premises

We now support migrating from Enterprise 11 Control Room version 11.3.4.7 to Automation
360 On-Premises v.25 and later releases.

Supported Control Room versions for migration on page 1347

What's changed

Enhancement to the String package (Service Cloud case ID: 00770822)

After migrating bots, when you are extracting a text string based on a source string, the
default option is set to not match the case of the source string. For new bots, the default
option is set to match the case of the source string.

Enhancement to the Browser package

In Enterprise 11, if a bot is using the Launch Website action to open a URL in Internet
Explorer and when migrating the bot to Automation 360, if you select the Convert bots
built using Internet Explorer to Edge with Internet Explorer mode option in the Settings
panel of the Bot Migration Wizard, the URL is automatically set to open in Microsoft Edge
after migration.

Option to change the global cache location (Service Cloud case ID: 00745395,
00781135,00831182, 01124360, 01764952)

As an administrator, you can now change the default location for global cache according
to your requirements by going to Administration > Settings > Devices > Advanced
options.

Manage device settings on page 1635
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What's changed

Enhancement to database server for Control Room instance

To set up the connection and authentication for your database server, use the port number
of your database server instance (default port number, 1433) instead of the instance name.

Configure Microsoft database type and server on page 1106

For user credential changes, add new configuration for LDAP settings without causing in-
progress authentication to fail

When a user's credential is changed or updated, an LDAP settings page is now provided so
that the Control Room administrator can add the new configuration for the LDAP settings
without causing the in-progress authentication to fail.

Support for exact match in the subject field for email triggers (Service Cloud case ID:
00953823)

When you connect the Control Room to one of the email services on your system and
trigger a bot when you receive a new email, the email trigger is now executed depending
on the following subject conditions:

*  When the subject line is provided within double quotation marks ("), for example, "ABC
spreadsheet", the trigger is executed only when the email subject has an exact
match for the string provided within quotation marks.

*»  When multiple subject lines are separated by semicolons, for example, ABC
spreadsheet; ABC project logs, the trigger is executed when the email subject
matches any of the subject lines mentioned.

Import Enterprise 11 bots with or without MetaBots (Service Cloud case ID: 01261325)

You can now import the Enterprise 11 bots (.aapkg file) with or without the dependent
MetaBots into the public workspace. If you are importing the .aapkg file into the private
workspace, ensure that the dependent MetaBots are included.

Summary of changes in packages

The following table summarizes the new and updated features in the Control Room packages:

Name of package or New or changed Version number Bot agent version
action feature

AlSense Recorder Support for Korean 2.7.3-20220527-0046081.210 or later
language and
complex table
operations

Korean language
and complex table
support
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Name of package or New or changed Version number Bot agent version
action feature

Browser package Support to download  3.5.1-20220527-17203121.210 or later
files from URLs
that require NTLM
authentication

NTLM authentication

Database package Support for common 4.8.0-20220504-1302021.88 or later
table expression in
Export to data table
action

CTE support in
Export to data table

Email package Support for sending  3.12.3-20220516-1148521.210 or later
mail with multiple
attachments through
bots

Send email with
multiple attachments

OCR package Support to identify 2.10.0-20220502-2043P8.118 or later
and capture controls
behind bot runtime
window

Support to capture
controls that appear
behind the runtime
window

PDF package Support to extract 3.5.2-20220414-1018441.31 or later
complete text with
minimal overlap of
characters

Extract text
accurately
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Name of package or
action

New or changed
feature

Version number Bot agent version

Recorder « Support to

automate objects
that appear
behind bot
runtime window

Automate objects
behind bot
runtime window
e Support to
automate objects
with specific
technology

Automate objects
with a specific
technology

» Support to
automate
applications
accessed through
Citrix Workspace

app

Automate
applications on
Citrix Workspace

app

2.7.3-20220527-0046081.210 or later

SOAP Web Service
package

Support to store
output of Xpath
expression as list of
strings

Store Xpath
expression output as
a list of strings

3.11.3-20220426-064423.90 or later

String package Support to match

case of textin

that in source string

Match case of
substring to that of
source string

extracted substring to

5.4.2-20220412-13472420.18 or later

Important: For information about the packages supported with this release, see also Packages

available in Automation 360 on page 2042.
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Fixes
Build Service Cloud case  Description
ID
15112 01838276, When you update to Automation 360 v.25, an
01835897 error no longer occurs when the database server
includes the instance name.
Builds 14304 and 01834139, When you successfully export a bot, the latest bot
15112 01839933, export activity is now displayed on the Historical
01841993, activity page. Previously, the latest export event
01839817, was not displayed as the Ended on column was
01834108, displaying the value as N/A.
01846407,
01845706,
01843349,
01846220,
01846819,
01845547,
01847028,
01847024,
01847094,
01847114,
01847115,
01846998,
01847840,
01846757,
01848123,
01846944,
01848104,
01848294,
01848905,
01846596,
01849748
Builds 14304 and 01836296 When you delete a user or a role, only one entry
15112 is now generated for each action in the audit log.
Previously, multiple duplicate audit log entries
were generated for a single action, affecting the
user management workflows.
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Fixes
Build Service Cloud case  Description
ID
Build 14304 and 01842547, When you use the Wait > Wait for condition
15112 01846156, action with conditions that have specific timeout
01847338, values set, the bot now waits only for the
01846324, specified waiting time then runs the subsequent
1842368, action. Previously, even when you specified a
01847054, timeout value, the bot waited indefinitely.
01848080,
01848789,
01848151,
01848963,
01847054,
01847121,
01848236,
01848260,
018490186,
01848248,
01848572,
01847828,
01847055,01848826,
01848191,
01848944,01851181,
01849792,
01852057
15097 01274643, If you have a function in a DLL that uses a
01812436 credential variable as an input parameter and
if the credential variable is not available in
Automation 360, you will see the A108 migration
message. Previously, you used to see the E153
migration message.
Migration messages on page 1519

15097 -- You can now migrate bots even if the date and
month are in single-digit or double-digit format
and the year is in single-digit, double-digit, or
quadruple-digit format for the Modified before
and Modified between dates in the File and
Folder action. Previously, you had to specify the
dates in the MM/DD/YY format before migrating
the bots.

15097 01260742 After migration, when the system passes a
Credential Value (CV) type variable from a parent
bot to a MetaBot Logic's non-CV variable, the
temporary string-type variable that is created to
hold the CV now does not exceed 50 characters
or include an invalid space character.
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Fixes
Build Service Cloud case  Description
ID
15097 00796546 The Bot Insight pre-migration utility can now
resolve corrupted dashboard IDs that are present
in the Bl tables and generate the dashboards.zip
file for the migration. Previously, when corrupted
dashboard IDs were detected in the Bl tables, the
Bot Insight pre-migration utility encountered an
error and closed.
15097 01758427, In the SAP application, when you use the Click
01805913 action control, the tabs are now selected
precisely.
Note: The Type value in Enterprise 11 is renamed
as Role in Automation 360.
When you migrate from Enterprise 11 to
Automation 360, the Role value is automatically
set to the value that was the SAP Control
Type value under SubType if the Type value in
Enterprise 11 was set to GuiShell. For example,
in Enterprise 11, if the Type value was set to
GuiShell and the SubType value was set to
Gridview, in Automation 360, the Role value is
automatically set to GridView.
15097 01376353, When you update your Control Room from
01449535, Automation 360 v.21 or v.22 to Automation 360
01713118, v.25, the installation now completes successfully
01627144, without any issues. Previously, the installation
01762404 failed when users who created migration
schedules lost the permissions after migration.
15097 01257547, You can now edit or delete a schedule because
01722892, you can no longer delete an .atmx file that is
01291187, associated with a schedule from the Automation
01770716, 360 Control Room. Previously, the .atmx file
01777450 could be deleted, which resulted in an error
that prevented you from editing or deleting a
schedule.
15097 01255723, When you migrate Enterprise 11 bots with the
01252824, Comment command enabled, the command
01260677, now remains enabled after migration.
01608653
Note: If the Comment command contains a
variable or a $ symbol, the command is disabled
after migration.
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Fixes
Build Service Cloud case  Description
ID

15097 01755175 You can now migrate bots with system variables
(such as date, month, or year) as an Export Data
to CSV option without encountering an error.
Previously, a preprocessing error was displayed in
such cases.

15097 01261863 You can now migrate bots with system variables

or expressions that include array variables without
an error. Previously, a preprocessing error
occurred in such cases.

15097 01758814 You can now migrate bots when the MetaBots
Logic call each other and another, third Logic
calls one of these in recursion. Previously, in
such cases, bot migration failed with an "An
unexpected error occurred” message.

15097 01255810 When you perform the Send Text action two
times for the same value in the Terminal Emulator
and the first field is protected, when the Terminal
Emulator screen is loaded for the second time, it
now works properly after the migration.

Previously, when the Terminal Emulator screen
was loaded for the second time, an incorrect
behavior was observed.

15097 01770547 In Automation 360 commands, expressions in
which a variable is included within parentheses
and is preceded by a $ character are now
migrated properly, with the variable inside
parentheses prefixed and suffixed with the $
character.

15097 01258964 After migration, the Capture action can now
identify popup windows that use the same title as
that of a main window in the SAP GUI. Previously,
the Capture action could not identify popup
windows that used the same title as that of a main

window.
15097 00745395, If the path for global cache exceeds 256
00781135, characters, Automation 360 automatically
00831182, changes the path to the default location although
01124360, the path in the Ul displays the path configured
01764952 by the user. Previously, when the path for global

cache exceeded 256 characters, Automation 360
displayed an error when downloading packages.

© 2023 Automation Anywhere. All rights reserved. 251



product-flagshipAutomation Anywhere - Release Notes

Fixes

Build Service Cloud case  Description
ID

15097 01767018, If a user does not have access permission for a
01755092, trigger or a folder with trigger under the public
01765551, tab, no error message is now displayed on the
01764245, event triggers page. Previously, if a user did not
01778477, have access permission, the event trigger page for
01782790, the user displayed an error under the public tab.
01795043

15097 01765445,01759831,When you log in to the Control Room as an
01779960, administrator, you can no longer delete users that
01799422 have active schedules.

15097 01255678 In the Manage > Devices page, the Modified by
column now correctly displays the username of
the latest user to modify the details. For example,
if userl registers a device and later user2 modifies
the device details, such as Deployment type, the
username of user?, instead of the username of
userl, is displayed in the Modified by column.

15097 -- When you are installing the Control Room
(On-Premises), even if an external key vault is
configured, you can now manually enter the
database credentials and configure them for
database authentication in the Windows installer
Database Server page.

15097 01753671 When you update to this release, in the View
history Task Bot page, the Checked In and
Checked In By columns now display the correct
information.

15097 - Now when you run bots that have the Get Total
Rows command in the SAP GUI, the values are
returned as Integer data type. Previously, such
commands returned values as a Float string type.

15097 01212822 During workload automation, you can now view
and use queues even if the name of a work item
template contains leading or trailing spaces.
Although the spaces are displayed in the queue
name, they are automatically removed when
the work item template is created. Also, leading
or trailing spaces in queue names are ignored
during execution. Previously, queue names and
template names with leading or trailing spaces
were not displayed and hence were unavailable
for selection.
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Fixes
Build Service Cloud case  Description
ID
15097 01772061 When you update to this release, Automation 360

does not allow multiple license-sync jobs to run
concurrently. Previously, when multiple license-
sync jobs were running, the audit logs displayed
Licenses synced errors.

15097 01754415 When you update from Automation 360 v.21 or
later, the Bot Agent devices are no longer shown
as disconnected in the Control Room Manage
> Devices page. When you try to update Bot
Agent in versions prior to Automation 360 v.21,

a message now indicates that the device is not
compatible.

15097 01780460 When you update to this release, the Control
Room Advanced options for devices
(Administration > Settings > Devices), such as
Autologin timeout, Maximum simultaneous
downloads, and Bot response wait time, no
longer revert to default values.

For example, if you set the Autologin timeout
to 70, after updating to this release, the value
remains at 70 and does not change back to the
default value.

Previously, when you upgraded the Control
Room, for example, from Automation 360 v.22 to
Automation 360 v.23, the Advanced options for
devices reverted to default values.

15097 01762582, The Control Room Activity page now displays
01808698, the total number of scheduled activities correctly.
01815446 Previously, when you had more than 200

scheduled activities, the Control Room Activity
page displayed only 200, and you had to sort

by the Activity name, Automation priority, or
Modified by columns to view the correct number
of scheduled activities.

15097 01764492 When you install Automation 360 Control Room,
the installer-generated log file no longer displays
the password in clear text.
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Fixes

Build Service Cloud case  Description
ID

15097 - In the Administration > Settings > Email page, if
the Require verification option is not selected,
you no longer receive a verification link in the
email notification to verify you as a user. You can
now log in to the Control Room without verifying
the email ID and setting the login credentials.
Previously, an email notification with verification
link was sent to verify the email address even
if you did not select the Require verification
option.

15097 01783110 When you launch a bot, if the bot fails during the
run, the Activity > Historical page in the Control
Room now shows the correct Started on time,
that is, the time when the bot started running.
Previously, when a bot run failed, the Started on
time incorrectly showed the time when the bot
failed. As a result, the Started on and Ended on
columns displayed the same time, which was
incorrect and confusing.

15097 01826944, When you log in to the Control Room,
01828683 the Activity > Historical page now loads

without error. For the historical data in the
JOBEXECUTION table, a new Cloud data
retention policy of 90 days is implemented,
whereby the Cloud historical data is deleted along
with the rollout of Automation 360 v.25 to the
different regions. Previously, when you logged in
to the Control Room, the Activity > Historical
page did not load because of a large number of
records, and the following error message was
displayed: An unexpected problem has
occurred

« View completed activity on page 1893
» Automation 360 Cloud FAQ on page 926

15097 01753337, On the Activity > In progress page, when you
01785865 use the sort function to list the items in the
Started on column in ascending or descending
order, the items are listed correctly now.
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Fixes

Build Service Cloud case  Description
ID

15097 - You can now successfully establish a secure
SQL connection in the Linux environment by
choosing the Enable option in the Database
Configuration > Secure Configuration >
Secure Connection field. The Linux installer now
successfully imports the SSL certificate, and the
connection is established. Previously, the Linux
installer failed to import the SSL certificate and the
connection was not established.

15097 00781974 In the Linux environment, you will no longer
encounter issues with services stopping due
to disk storage issue. Previously, some of the
Control Room log messages were stored in the /
var/log/messages file instead of the /var/log/
automationanywhere directory, leading to low
disk space.

15097 01260701 When you run bots on user devices, bots no
longer become stuck in queues. Also, the
following messages are no longer displayed:

e Waiting for user username
e Picked at runtime

15097 01760032 Domain names are no longer case-sensitive, and
you can now create users by using the Active
Directory group mapping and map a role to a
user in the Control Room. Previously, because
some Active Directory servers were returning
domain names in uppercase whereas others were
in lowercase, domain names could not be found
and there was an issue with the group mapping
feature.

15097 00828289 The Global Value fields are now validated and
have a maximum length of 4000 characters.

15097 00828289 When you navigate to My settings >
My Profile > Edit in the Control Room
and provide a link, for example, <a
href="www.google.com">LinkInjection</
a>, the email sent contains a link, and the email
text sent is validated against HTML injection and
you will no longer see a functional link.
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Fixes

Build Service Cloud case  Description
ID

15097 01754431, When you use the Recorder to capture an object,

01773662, set the waiting time for detecting the object to

01789555, fewer than 30 seconds in the Keep trying for

01791065, (seconds) field, and run the bot, the Recorder

01784255, now waits for the specified time to detect the

01785653, object and waits for the page to load completely.

01780070 Previously, the Recorder waited for a minimum of
30 seconds to detect the object regardless of the
time specified.

Note: This fix is applicable only to Google
Chrome and Microsoft Edge Chromium browsers.

15097 01614810 You can now use a blank space as the delimiter
in the Specify delimiter (optional) field. In the
Open action of the CSV/TXT package, when you
browse the filepath to open a file, add a blank
space as the delimiter in the Specify delimiter
(optional) field, and run the bot, the blank space
is now treated correctly as a delimiter and the bot
no longer fails.

15097 01387738 When you use the Browser > Open action to
open a new window in Google Chrome, the new
window is now activated and displayed in front of
the other open windows. Previously, when you
ran a bot, the window remained in the minimized
state.

15097 01273095 When you enter a decimal value with 16 or more
decimal points in a cell of a Microsoft Excel
spreadsheet and when you use the Read cell
value option in the Excel advanced > Get single
cell, Get multiple cells, or Get worksheet as data
table actions to retrieve the decimal value from
the cell, the format of the cell value no longer
changes from General to Scientific.

15097 01144509, When you connect to an SAP session, use the If
01767881 > Object exists Recorder condition to identify

and capture objects on the SAP application,
disconnect the SAP session, and then run these
actions in a loop, the bot now detects the objects
correctly in every iteration of the loop. Previously,
when the bot was run in a loop, it captured the
objects correctly only during the first iteration and
failed during subsequent iterations.
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Fixes
Build Service Cloud case  Description
ID

15097 01769573 If you use the App integration > Capture text of
window action to capture the text in a command
prompt window, when you run the bot, the bot
now captures all the characters in each line
correctly. Previously, the bot failed to capture the
last characters in each line.

15097 01628448, The Excel advanced package now works as

01766957, expected and without any issues. Previously,

01788709, the package threw a generic exception error

01788801, intermittently.

01789538,

01803156,

01781597,

01810230,

01811694,

01802054,

01815687,

01823526,01814962,

01833962,

01835418,

01835382,

01837832,01830790

15097 00824995, In the PDF > Extract field action, when you

01451063, select the Open PDF viewer option, select a PDF

01274854 file from the Control Room or Desktop, click
Load, and open the PDF viewer, you can now
view the PDF document. Previously, when you
selected the Open PDF viewer option to view
the selected PDF document, a blank page was
shown, and you could see the value in the PDF
document only when you selected a specific
rectangular area in the blank field.

15097 00957308 In the File > Copy Desktop file action, when
you specify a source filepath where the folder
name contains a number sign (#) character or the
filename contains a wildcard character, specify
a destination filepath to copy the file, and run
the bot, the bot now detects the source filepath
and copies the file to the specified destination
location successfully. Previously, when you
ran the bot, the bot failed to detect the source
filepath and hence did not copy the file to the
destination folder.
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Fixes

Build Service Cloud case  Description
ID

15097 01685239 You can now use the Recorder to capture
objects on the Citrix Xenapp application, use the
If > Object does not exist condition to verify
whether a specific object exists in the application,
and successfully run a bot from a parent bot.
Previously, when you tried to do this, an error
occurred.

15097 01260387 A password-protected Microsoft Excel file is
no longer corrupted when you open the file
manually after successfully running a bot using
the Excel basic package. Previously, when you
used the actions in the Excel basic package to
open a password-protected Excel file, made some
updates to the file, and closed the file by selecting
Save changes when closing file in the Excel
basic > Close action, the password-protected
Excel file became corrupted when you opened it
manually from its location.

15097 00920617 When you connect to your mailbox through the
IMAP protocol, use For each mail in mail box as
email loop iterator to retrieve all email message
received before date filter, and run the bot, the
bot now retrieves all the email messages received
before the specified date, including the email
messages received on the specified date before
the specified time.

15097 -- In Google Chrome, Microsoft Edge, and Mozilla
Firefox browsers, you can now successfully open
network URLs that start with two backslash (\)
characters by using the Browser > Open action.

15097 01015001 When you specify the total number of packages
that you want to view per page under the
Manage > Package section in the Control Room,
the page now displays the correct number of
packages specified. Previously, all the packages
were displayed on a single page even if you chose
to view only a specific number of packages.

15097 01711629 In the Recorder > Capture action, when you
select a specific browser window whose title
matches another browser window from the
Browser tab and run the bot, the bot now
accurately opens the selected browser window.
Previously, when the title of two browser
windows matched, the bot randomly opened a
browser window with a matching title.
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Build Service Cloud case  Description
ID

15097 - You can now use the Browser > Run JavaScript
action to successfully run JavaScript on web
pages that have iFrames.

15097 01075660, The Excel advanced > Open and Create
01273111 workbook actions now display the Default
session value under the Local session field.

15097 01252773, An error no longer occurs when you use the
01278029, Excel advanced > Open action to open a
01772301, worksheet that is a type of hidden chart or a
01765017 macro. You can specify the sheet name to open
the worksheet of type macro.

Note: When you open the default sheet, ensure
that the active sheet is an Excel Worksheet. If the
active sheet is of type chart, the following error
message is now displayed: The Excel file
does not contain an active sheet to
open. Please make sure the Excel file
you want to open has at least one
active sheet.

15097 - After migration, when you run the bots that use
File and Folder packages, the year under the Date
option now accepts the value 00 as input, which
is considered as year 2000.

15097 01257829 In the REST Web Services package actions, you
can now add a Custom content type, using which
you can add content that does not fall under a
standard content type.

15097 - In the REST Web Services package actions, you
can now perform Add Substitution, using which
you can enter variables in the REST request body.

15097 01784553, In the SOAP Web Service package actions, the
01794924 ampersand character (&) is now automatically
escaped. Previously, the ampersand character (&)
which is a reserved control character, was not
automatically escaped, which resulted in invalid
XML files.

15097 01767571 In the REST Web Services package actions, new
lines in the request body are no longer altered
at runtime. For example, when the request body
contains a new line, it is no longer replaced by a
space at runtime. Previously, when a request body
contained a new line, it was replaced by a space.
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ID
15097 00773353, In the REST Web Services package actions, you
00787270 can now use the user token option to access
the Control Room APIs. When you log in to the
Control Room, a token is generated, which is
used by the bot to access the endpoints of the
Control Room API used within the bot.
15097 01372460 You can now run bots by using the RunScript

action of the Legacy Automation package. When
you pass multiple arguments to replace values
from a Microsoft Word document, the bot now
runs the function and replaces and displays

the text on a new line. Previously, the text was
displayed on the same line.

15097 01758458 When you use the Connect action to establish
a connection with an email server, use the
Disconnect action to close the connection
with the same session name. You will then not
encounter any issue when you establish a new
connection again with the same or different
credentials.

15097 01273357 You can create a bot to run a standard workflow
in SAP BAPI, and the output is now generated
correctly as a .CSV file. Previously, when you ran
a standard workflow in SAP BAPI, the generated
output was varied.

15097 01342887 When you run a process by using the Terminal
Emulator package, the terminal window is now
activated and remains in the front. Previously,
when you ran a process, the terminal window was
not activated and stayed minimized.

15097 01251933 In the Terminal Emulator package, when you use
the Connect action to establish a connection
with TN3270E, an error no longer occurs.
Previously, an error occurred, and the following
error message was displayed on the mainframe
screen: ISPP904 Panel ISR@PRIM error
- Xx'0E' or x'OF' is invalid as an
attribute character

15097 01432885 When you run a bot, the Task bots run metric on
the Home dashboard page of the Control Room
now displays the correct count. Previously, the
metric displayed an incorrect count. For example,
on the Home dashboard page, if the Task bots
run count showed 39, when you ran the bot, the
count displayed was 42 instead of 40.
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15097 00742840 When you use actions such as Open and Run
function from the DLL package, you no longer
encounter any issues. The bot now opens the DLL
file even if the DLL filepath length is fewer than
256 characters.

15097 01261786, When you edit a bot and disable any action
01615115 within it, you can now use the Ctrl+Z keyboard
shortcut to undo an action. Previously, the Ctrl+Z
keyboard shortcut did not work as expected.

15097 01080067 In the Active Directory package, when you use
usernames with special characters, the bot now
runs successfully. Previously, when you added
a user to a group, if the username had special
characters, when you tried to remove the user
from the group, the bot failed.

15097 00962414 You no longer encounter an issue when you
connect to a pulTY application through Terminal
Emulator. Previously, when the terminal was
connected to the host, the host prompted for
a password. Subsequently, the terminal screen
went blank, and the bot displayed the following
error: Unable to connect to a terminal.
Please check connection details

15097 00829259 In Active Directory, you can now successfully
create a user with one of the following options:
Require password change at next login or Do
not require password change at next login.
Previously, when you used the Connect action
to establish a connection, if the LDAP connection
path contained the OU attribute with a space value
such as OU=aa unit, an error occurred when
you ran the bot.

15097 00961069 When you are using the Send text action from
the Terminal Emulator package, you can now
send numeric keyboard minus (-) keys using
Simulate keystrokes action [ALT DOWN] - [ALT
UP] keys to the mainframe application.

For more information, see A360 : How to send
hyphen(-) in Terminal Emulator TN5250E (A-
people login required).
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Fixes

Build Service Cloud case  Description
ID

15097 00825675 When you delete the variables mapping from
parent and child bots and then run the parent bot,
the bot no longer encounters an error. Previously,
when you deleted the variables mapping from
parent and child bots and then ran the parent bot,
the bot failed.

15097 00798604 When you use the Run Function action from the
VBScript package, the bot no longer encounters
an error. You can now specify the function name
to run and pass arguments that contain brackets
(I). Previously, the Run Function action failed to
run if an open or close bracket was included in
any position in a string parameter.

15097 - When you use a DLL file that is available in the
Control Room, and if the DLL filepath is fewer
than 260 characters, the bot now retrieves the
DLL file successfully.

15097 01149730 You can now connect to an email server, select
the IMAP protocol, use Loop > For each mail
in mail box iterator, and successfully download
attachments from an email message and save
them to a specified folder. Previously, if the
attachments had a bin file, the attachments were
not downloaded or saved to a folder.

15097 00919896 When you use actions such as Send text or Send
key from the Terminal Emulator package, the bot
launcher no longer stops working. Previously,
bots created using actions from the Terminal
Emulator package sometimes stopped working at
random when a double-byte character set (DBCS)
was enabled and the host screen had a wrapped
field.

15097 00950682 You can now use the Open spreadsheet action
in the Google Sheets package without any issue,
even if you use a Proxy Auto-Configuration (PAC)
file or a proxy-enabled environment.

15097 01257464 When you connect to an email server with the
IMAP configuration and use the Move all action
with a filter for all mail received before a certain
date, all email messages that meet the criterion
can now be moved from one folder to another
without any issue.
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Fixes

Build Service Cloud case  Description
ID

15097 01753270 In the Google Drive package, you can now use
the Create file permission action with the File
ID option. Previously, when you used Create file
permission, if no other Google Drive action was
placed before it, an error occurred.

15097 01276141 In the email package, when you use the Move
all action or the Loop > For each mail in mail
box iterator, you can now add any number of
email addresses in the From specific sender field.
Previously, the email loop did not work if the
From specific sender field had more than two
email addresses.

15097 01689348 You can no longer import bots with incomplete
package files from one Control Room to another
because the system now disallows and rejects the
import of incomplete package files.

15097 01763262, You can now create a bot and run stored

01762153 procedures successfully. Previously, if you had
two stored procedures in different databases,
for example, Database A.dbo.SP_A and
Database B.dbo.SP B, inthe SQL Server, if
you were connected to Database A and wanted
to run the stored procedure in Database B, the
execution failed because the fully qualified stored
procedure name was not supported in the Run
stored procedure action.

15097 - You can now successfully download exported
bots by navigating to Activity > Historical >
Bot Export: Export.<date_name > Download
exported zip file.

15097 01762348 Bots that are deployed from the Control Room
on user devices are no longer stuck in a queue
after the unattended Bot Runners are added from
a device pool.

15097 01151181 If you have the required permissions, you can
now successfully delete an inactive schedule from
the Manage > Scheduled > Scheduled activity
page. Previously, even if you had the required
schedule permissions, when you tried to delete
an inactive schedule, you encountered an error
message about permissions.
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Fixes

Build Service Cloud case  Description
ID

15097 00917927, The Modified by field in the Manage >
01255618 Scheduled page now displays the correct
username for recurring schedules. Previously,
when schedules were imported from one
environment to another, the Modified by field
showed the username of the original Bot Creator
or administrator.

15097 01778350, When you create a schedule in the Control
01803570 Room, the Manage > Scheduled > View activity
> Schedule page now displays the correct end
time for the End date field. Previously, when an
end date was selected for a schedule, the end
time shown for the End date field was incorrect.

15097 - In the Kubernetes environment, when you try
to create a queue, you no longer encounter an
error.

15097 00716776, If you check out an item at certain time T1
00778659, and then cancel the checkout later at time T2,
01820190, the canceled checkout is not considered as a
01856732 modification to the item. Also, the last modified

time is rolled back to time T1 that is when the bot
was checked-out last time from the Public folder.
Previously, the canceled checkout at certain time
T2 was incorrectly considered as a modification
to the item. Also, the last modification time

was incorrectly shown as time T2 that is when
checkout was canceled. Thus, it was difficult to
keep track of actual modification dates of items.

15097 - In the Kubernetes environment, you can now
delete work items even after pausing a queue.
Previously, when you paused a gueue and tried to
delete a work item, an error sometimes prevented
you from deleting the work item.

15097 01255617 The WLM filters in the Queue > Work items page
now return accurate results. Previously, filters
were not working accurately when you combined
them.

15097 01806221, After you update to Automation 360 v.24, WLM
01805371, tasks no longer fail. Previously, after an update,
01818356, bot execution processes or actual bot execution
01828330 sometimes failed, resulting in the failure of WLM
tasks as well.
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Fixes

Build Service Cloud case  Description
ID

15097 01769740 Bot descriptions are now displayed even after you
check in or check out bot. Previously, after you
checked in or checked out a bot for the first time,
the bot descriptions stopped being displayed.

15097 01764336 An appropriate error message is now displayed
when you try to change the work item status
from Ready to run to On hold or Complete. The
error message now informs you that because the
queue is already in use, you must either pause or
stop a queue automation to change the status
of the work item. Previously, the error message
displayed did not help with rectifying the issue.

15097 01273374 The gettasklogdata APl now shows real-time
data, whereby local time values are converted to
UTC values for that APl request.

The following table lists the limitations identified in the current release:

Limitations

Bots whose queue category name contains a space (for example, Input — Emails) cannot
be migrated because during migration, such bots enter and remain in an infinite loop until
the loop times out at 90 minutes. (Service Cloud case ID: 01850864)

Workaround: You can migrate to Automation 360 v.26 release where this issue is fixed or
remove the space in the queue category name and then migrate the bots.

After you migrate your bots, an error occurs in the following situations:

«  When you use FTP actions on bots with commas in filenames
*«  When you use the Delete files and Delete folder FTP actions on bots with colons in
filenames

Workaround:

» For bots that use FTP actions, ensure that you remove commeas from the filenames.
» For bots that use the Delete files and Delete folder FTP actions, ensure that you
remove colons from the filenames.

When you try to migrate bots in which the If condition is used for more than 95 times in
a single line, migration fails with the following error message: Unexpected response
status: 500 (Service Cloud case ID: 01830793)

Workaround: Divide the bot into multiple logical sub-bots.

(Service Cloud case ID: 01773164) If the number of cells in a table object exceeds 300,000,
the Control Room might become unresponsive.

Workaround: Ensure that the number of cells in a table object does not exceed 300,000.
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Limitations

Even if the Control Room path is invalid or does not exist, the invalid path is still displayed
instead of the default path: C:\ProgramData\AutomationAnywhere\GlobalCache\

When you run a migrated bot with the Recorder package, the Click Action on Client
Control might not work. This issue occurs because some Microsoft Windows operating
systems might not be activated properly on a few Windows applications.

Workaround: Use the Left Click action.

When you try to re-edit a migrated bot with the Record > Dataset variable, an error occurs,
and the following error message is displayed: An unexpected problem occurred. If
the problem persists, please contact your system administrator.

Workaround: Refresh the Bot editor page to reload the details.

A parse error occurs when you run a migrated bot with the Email Received Date variable
used twice in subactions inside the Email loop action.

When you create a bot by using the Send email action, if the attachment includes the
less-than symbol (<) as a special character in the filepath, the special character will be
removed after bot execution. The Windows operating system does not support this special
character.

In a bot, when you create a List variable with the File subtype, select the value as a Control
Room file, and add the List package, the bot execution fails when you run the bot.

If your bot has an error, you add the Try/Finally block around the corresponding actions,
and insert more actions in the Finally block, when you save and run the bot, the Bot error
dialog shows the wrong error line number within the Finally block.

Workaround: If you are using Try and Finally without using the Catch action, the Bot error
dialog does not show the correct line number. Instead, use Try/Catch. The Try action
handles the error and sends execution to Catch with line number and description. This
gives the correct line number within the Finally block.

When you frequently connect to the Excel or Access (Microsoft Office 2016 or later)
engines with ODBC drivers, bot execution fails intermittently.

When you use the Connect action to connect with the EWS protocol, read email skips

the newline characters and prints the email message body on a single line. This issue is
also observed in the Send email action. Following are the scenarios where these issues are
observed:

« Create a bot and connect with the EWS server. Use the Loop action to read emails as a
plain text message and use the Log to file action to log text into a file.

« Use the Send email action and connect with the EWS server with OAuth authentication
to send the email.

In a device pool, when you select the Run bot now option for a WLM bot, the WLM bot
run is triggered and an error message is also displayed.

Workaround: To run a WLM bot in a device pool, ensure that you select the Run bot with
queue option.
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Limitations

In a multitenant environment, when you upload a work item file to queue in one of the
tenants, the In progress tab displays the same work item file for all the other tenants, as
well.

In a device pool, when you stop a WLM automation, a few work items are still in the ready-
to-run state. As a result, these work items cannot be deleted.

Workaround: To delete work items that are in the ready-to-run state, perform one of the
following actions:

* Pause and stop the automation.
« Rerun, pause, and then stop the automation.

After migration, when you use the Excel advanced > Open action to open a file with the
Load Add-ins option enabled and the system has COM add-ins enabled, when you run the
bot, the bot might fail with an error.

Workaround: Disable the Load Add-ins option to run the bots successfully.

When you use the If > Folder does not exist condition to determine that a folder does not
exist, even if the folder exists, the bot might fail to identify it due to the leading and trailing
spaces in the input folder path. As a result, the bot might throw an error.

When you update the Control Room to the latest version, you might see some packages
with two default versions.

Recommendation: Sometimes, you might notice the duplicate packages a few weeks after
the Control Room is updated. Hence, we recommend that you compress and save the
Control Room logs dir that contains all the WebCR*.log files 30 minutes after the Control
Room is updated. This way, if you discover the issue later, these logs from the time of
update will be available and help in investigating this issue.

In the Data Table > Assign action, when you select the Table with values option, select
the Edit table (1 X 1) option to edit a table, enter variables in the rows and columns and
then run the bot, the output still shows the input Svariable$ instead of the evaluated value
of the variable.

When you try to upload packages to the Control Room manually, the system does not
check for the minimum required version of the Control Room that is compatible with the
packages before they are uploaded. It allows the packages to be uploaded in the Control
Room even if the version of the packages is not compatible with the currently installed
version of the Control Room.

When you use the Run bot option to run a bot in the Activity > Historical > View page for
any activity, the bot execution fails with an error.

(Service Cloud case ID: 01784401) To ensure that multiple Git processes are not modifying
the same repository at the same time in the Control Room, Git lock is implemented

for a short interval. After the lock is released, repository-related operations are resumed
without any issues. However, in some instances, the Git lock is not released, and new Git
operations cannot be processed. As a result, repository-related operations, such as edit,
save, import, and check-in, are delayed and eventually time out.

Workaround: Contact Automation Anywhere Support.
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Limitations

When you use the If package, add a specific condition with a variable, then add specific
conditions within a group, save the bot, and if you rename the variable that was used, the
name of the variable might not update for the Group conditions but is only updated for the
conditions in the Condition tab.

When you use AlSense Recorder to automate applications on a Windows 10 Japanese
operating system, the bot might encounter an error.

Workaround: Enable UTF-8 encoding and restart the Bot Agent machine.

Limitations from previous releases

When you migrate a bot that was using the Manage Window Controls action, the last
digit of the height value is not available after migration. However, the bot will execute
successfully. (Service Cloud Case ID: 01756996)

When an Excel session is active in SAP, a corresponding Excel process starts in the
background. In such a scenario, Automation 360 uses the same Excel process that SAP
started. When you run a bot to automate spreadsheet data, Automation 360 processes
the first request successfully. However, during execution, if the Excel is closed and a
subsequent request is sent for automating the spreadsheet data, Automation 360 does not
process the request because the Excel process is still being accessed by SAP. Therefore,
the correct window is not activated for automating the spreadsheet data. (Service Cloud
Case ID: 00815159)

» If you are updating from Automation 360 On-Premises v.21, remove the following Bot
Agent files and folders:

e C:\Windows\System32\config\systemprofile\AppData\Local
\AutomationAnywhere\AA-DB.mv.db

e C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-
resources

» Before you update from Automation 360 On-Premises v.22, refer to the upgrade
considerations in Update Automation 360 to latest version on page 1266.

(Service Cloud case ID: 00837271) If you are migrating from Enterprise 11 with a database
that has a large amount of repository data, the installation might fail. This issue occurs
because Liquibase update for a few SQL queries is not completed during migration.

Workaround: Contact Automation Anywhere Support.

When you try to automate any process in a Java application that uses version 11.0.8
of AdoptOpendDK, the Recorder might not capture the drop-down elements on the
application.

When you use the Recorder to capture an object, select HTML Tag, HTML InnerText, and
HTML type properties in Search Criteria, or migrate a bot with similar properties selected
in Search Criteria, the bot fails to identify or locate the object and perform the selected
action.

Workaround: Modify the DomXpath according to the controls you capture, or add more
properties in Search Criteria.
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Limitations from previous releases

When you use the Browser > Close action to close a tab or a window opened in the
Microsoft Edge browser, if only one Microsoft Edge browser window is open, the bot
encounters the following error: Error occurred while closing the tab

Workaround: See Configure Microsoft Edge browser settings when Close action of
Browser package encounters an error (A-people login required)

Internet Explorer EOL updates

Note: This release (Automation 360 v.25) includes features from Automation 360 v.24R2 (Build
13331). For information about what's available in the v.24R2 release, see Automation 360 v.24R2
Release Notes for Internet Explorer 11 EOL on page 283.

Features

Packages and actions

You can now migrate Internet Explorer bots from Enterprise 11 and Enterprise 10 to
Automation 360 and convert the bots to Microsoft Edge with IE mode for the following
actions and commands in the Web Recorder package:

« Navigate URL, Go Back, and Search by Caption actions.

« Open Browser and Close Browser commands. These commands are mapped to the
Legacy Automation > Open Page and Close Page actions in Microsoft Edge with IE
mode.

To launch Internet Explorer bots, in the Legacy Automation package, select the Launch
Internet Explorer in Edge compatibility mode option.

To migrate and convert Internet Explorer bots, in the Control Room, from Administration
> Migration > Migrate bots, select the Convert bots built using Internet Explorer to Edge
with Internet Explorer mode option.

Automation Co-Pilot (Automation Co-Pilot)

Note: For Automation 360 v.25, Automation Co-Pilot does not support an Oracle Database. You
can continue to use Automation Co-Pilot with Microsoft SQL Server.

What's new

Use Bot Task labels to identify bot version to run

In Bot Task, you can now select the version of a bot for deployment by choosing between
the Latest version and Production label options. When you deploy the bot, the version of
the bot that you selected is run.

Create a process in Process Composer on page 2991
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What's new

Bot priority reference

In Bot Task, you can now refer to the priority level of your bots. For bots that were set to
a priority level, the Bot priority section now displays a Low, Medium, or High read-only
label.

Create a process in Process Composer on page 2991

Create request in new tab

You can now open and run your new requests in a separate tab when you select the Open
request in New Tab option in the initial form. With this option, you can create requests
concurrently without changing your current page navigation.

Create a request and complete a task on page 3017

Invalid scheduler

An invalid scheduler is when a scheduler user has their role removed or when they

cannot access a file because of missing permissions. Users who are notified of the

invalid scheduler are the Control Room admin, the Automation Co-Pilot admin, and the
Automation Co-Pilot user. Now, the Control Room admin will see an audit log change, the
Automation Co-Pilot admin will see an error message to reassign a new scheduler user,
and the Automation Co-Pilot user will see an error message in their process.

Assign a scheduler user to a process on page 2968

Duplicate rows for Table element

In the web interface, when you are adding rows to your form by using the Table element,
you can now save time by duplicating a row in the table with the new Duplicate row
option. The duplicated row will now be placed under the highlighted row that you had
selected.

Interface triggers support more technologies
You can now use interface triggers with the following technologies:

*  Windows native
e SAP Desktop
*  Google Chrome and Edge Chromium browsers

Add an interface trigger on page 2950
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What's new

Enhancements to form rules
e Use custom formatting

When you are adding a rule, if you use the If menu to set the rule conditions on certain
elements such as Text Box or Text Area, you can now select Is from the drop-down
menu to enable additional options. Select the Custom option and click Add regular
expression to apply custom formatting requirements on the selected element.

Consider a scenario where the user IDs of all your employees have AV as prefix. For
example, for an employee whose name is Adam, the user ID is AVAdam. Use the Add
regular expression option to set the value in the Regular expression field as "AV. If a
user enters Adam in the user ID field, an alert is displayed.

« Set custom value or append element value

When you are adding a rule, use the Then menu to select a form element. For this form
element, you can set one of the corresponding actions using Set Value or Append
value:

« Value: Data entered in the Enter value field is applied to the selected element.
« Form element: Data from the form element selected in the Select element drop-
down menu is appended.

Consider a scenario where a user registration form has 'First name’ and 'Employee 1D’
fields. You can set one of the following rules for the value in the Employee ID field:
» Select Value and enter Emp1013 as preset value.

This value is displayed in the 'Employee ID’ field when the bot runs.
« Select Form element and set 'First name’ element in the Select element drop-down
menu.

The value from the 'First name’ field is appended to the 'Employee ID’ field when the
bot runs.

You can use elements in the same way that variables are used in the Bot editor. You can
enter $ to view a list of elements.

Add rules to form elements on page 2939

What's changed

Request reference for AARI web package

The Automation Co-Pilot web package now supports reference I1Ds. A reference ID
is a combination of a prefix and a number that is created from a process key and

is incremented every time a request is created. Request ID is replaced by Request
Reference, and Team ID is replaced by Team Reference.

Process Composer package on page 2545
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What's changed

Process and package version changes in Get Storage file action

The Get Storage file action now requires the matching of versions between the version of
the process and the version of the package. Processes created before Automation 360 v.25
must be used with package versions from before Automation 360 v.25. Similarly, processes
created after Automation 360 v.25 must be used with package versions after Automation
360 v.25.

Process Composer package on page 2545

Fixes

Build Service Cloud case  Description
ID

15112 01841448, When you download a series of packages from
1839118, 184481/,  tne pot compilation, the download is now faster.
01846153,
01846332,
01839254

15112 01847675 After you update to Automation 360 v.25, when

you modify a process in a private workspace, you
can now save your changes successfully, without
encountering an error. Previously you will get a
process error when you attempt to modify and
save your process, or when you open the same
process again.

15112 01848192 After you update to Automation 360 v.25, you
can now insert or modify conditions, such as
the If/Else logic, to your process without any
issues. Previously when you made changes or
add the If/Else element to the process logic, a Go
to element would be added to the logic which
caused a process error.

15097 01807181, Cloud users: You can now successfully upload
01809192, a file for your requests. This applies to some
01816444 scenarios when you upload a file and the request
creation fails.
15097 01771877 In the process editor, at the end of your process,
you can now drag Go To and add it to your End
Point.
15097 01774331 When you use the Row before scrolling option

from the Table element and specify a number of
rows, the web interface now renders the correct
number of rows that you specified.

15097 - When you use the Document element and click
the Fit option to fit your document in request
view, the document is now scaled to fit the frame
entirely.
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Fixes
Build Service Cloud case  Description
ID

15097 - If you design a form with a drop-drown rule
applied to it, when you view the drop-down in
read-only mode in the web interface, you can
now view the changed data.

15097 - After you are disconnected, when you log back
in to the web interface, the next= parameter is
no longer shown in the URL and you are now
redirected to the page that you were on before
you were disconnected.

15097 - For the Text Box element, the Does not contain
form rule now works correctly.

15097 -- For the Rich Text Editor element, the Contains
form rule is now working correctly.

15097 - When you create a form with the Document and
Dropdown elements, you can now submit your
form without issues.

15097 -- You can now use Request Reference as a
parameter in the AARI web package.

15097 01803846 You can now use Request Reference in the AARI
web package, for example, as an output for the
Create a Request action. Request ID is now
replaced by Request Reference.

15097 - You can now successfully submit an initial form
that has a table with no content, data, or rows.

15097 01803019 When you open and view a task, the task
assignment now correctly shows the user
assigned to that task.

Limitations

When you attempt to delete a request that is associated with more than one file, the

deletion fails.

After you create a request from a private process, when you attempt to open and run the

request in a new tab, a new tab is generated but it fails to run the request and the URL is

not correct.
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Discovery Bot

Fix

Service Cloud case ID Description

00971940, 01018262, You can now successfully record a process without
01255326, 01829662 encountering an error because when you log in to the Control
Room, the proxy settings now support the following scenarios:

« No proxy is enabled.
« Proxy is entered with username and password.
« Proxy is entered without username and password.

Previously, when you recorded a process, if there was no
proxy and if you entered a username and password with proxy
enabled, an error occurred.

Document Automation

New capability: Document Automation is the new Cloud-native intelligent document processing
solution that business users can set up to automatically read and process documents quickly using
pretrained models and validation feedback.

Document Automation is fully integrated into Automation 360: Document Automation is installed
as part of the Control Room, RPA bots are used to extract semi-structured data to automate
document-centric business processes, and Automation Co-Pilot manages the end-to-end
extraction process and validation tasks.

Document Automation on page 3142

Limitations

Although the v.26 Document Extraction package appears in the .v25 On-Premises Control
Room, features will not work as expected.

Workaround if the package version is auto-synced: Manually change the Document
Extraction package version to v.25. See Update bots to default package version on page
1730.

Document Automation does not support SDS deployment.

Google Document Al pretrained models are available only for Cloud customers who
purchased licenses through Automation Anywhere.

Customers who install Document Automation on Linux must separately download the
Document Extraction package.

Document Automation supports a device username of 21 characters or fewer.

The value beside the Validate documents link, which indicates the number of documents
awaiting validation for a learning instance, sometimes does not appear.

Learning instances that use Google Document Al models do not reliably extract tables that
span multiple pages.
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Limitations

When you are validating a document in public mode, if you zoom in or out, you cannot
drag the corners of the system-identified region (SIR) selection.

When you are validating a document, if you draw a box, zoom in, and then click Fit to
screen, the box appears at a different location from where you clicked.

If you connect to a learning instance from Automation 360 |Q Bot with an optional

field that has a set default value and some fields that are unmapped, when you process
documents in that learning instance in Document Automation, the default value appears in
the unmapped fields.

There is no notification if the product license is about to expire. When the product license
expires, the Learning Instances tab is removed from the Control Room.

You might encounter extraction issues when you process documents with tables that span
multiple pages.

Workaround: Contact your Customer Success Manager to download a patch for the
Document Extraction package.

When a bot runs an action from the Document Extraction package, the Activity > In
progress page shows the item name as IQBotAutoExtract.

The Bot Agent does not verify whether the Document Extraction package version is
compatible with the Control Room version prior to running a bot.

Document Automation cannot process documents in Automation Anywhere pretrained
models if the Bot Agent runs through a proxy.

Workaround:

» With authentication: Create a Windows environment variable HTTP_PROXY with a value
of http://<username>:<password>@<proxyhost>:<proxyport>.

» Without authentication: Create a Windows environment variable HTTP_PROXY with a
value of http://<proxyhost>:<proxyport>.

If a document is renamed to a new file extension and uploaded to a Google Document Al
pretrained model, the document will fail processing.

Workaround: Rename the document to the correct file extension.

Bots containing actions from the Document Extraction package must be deployed as part
of an Automation Co-Pilot process. Standalone bots are not supported.

In some cases, the Bot Agent does not clear out its resources folder. Until the disk space
is freed, the production documents in processing will be affected. This issue occurs
intermittently.

Workaround: Based on the issue, you must create a task scheduler to clean out the
resources folder every day or every week.
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1Q Bot

Note: For Automation 360 v.25, IQ Bot does not support an Oracle Database. You can continue
to use 1Q Bot with Microsoft SQL Server.

What's new

Migrate the roles associated with a learning instance

You can now retrieve a list of custom roles with access to a learning instance in a source
environment and grant users in a destination environment access to the learning instance
by using the Roles migration API.

IQ Bot roles migration APIs (A-People login required)

Track the number of pages processed in standard forms separately from 1Q Bot

The Control Room Licenses page now shows the number of pages processed in standard
forms, the Classifier, and through 1Q Bot. If the licenses are added to the Control Room
from the Cloud, the Licenses page also shows the number of pages processed in other
Control Room instances.

Automation 360 licenses on page 1251

What's changed

Reinstall IQ Bot services using a new script

You can now reinstall all the 1Q Bot services together in a batch or choose to reinstall them
individually by using the reinstall-allservices.bat script.

Postinstallation checklist on page 1292

Fixes

Service Cloud case ID Description

00780662 A round-off error no longer causes documents to fail formula
validation. Previously, these documents were manually validated.

01763658 For the Concatenate Images action in the IQ Bot Pre-processor
package, if a filename does not exceed 256 characters, the
output is now successfully generated.

01795651 When you export the IQBA file from a learning instance of a
custom domain type with manual groups to another learning
instance, the manual Group Label is now exported successfully.
Previously, without a manual Group Label, it was difficult to
distinguish between system-generated groups and manual
groups for new learning instances.

00780712 When you import IQBA files using VisionBot data, among the

learning instances, you can now see new groups created.
Previously, new groups were not created when documents were
uploaded.
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Fixes

Service Cloud case ID Description

- An error message is no longer displayed when you change the
display language of any learning instance that has a document
in Validator. Previously, even if the selected display language was
applied successfully to a learning instance, the system showed
an error.

- When you use the Overwrite option to import a learning
instance, the Default validations group is now successfully
overwritten. Previously, the Default validations group was
not overwritten, and you needed to manually edit the learning
instance after importing the IQBA file and then change the
default group.

- When you use the 1Q Bot Extraction package, you can now
view your document count on the Details page of the learning
instance. Previously, if you processed documents that did not
belong to any created groups, they were not displayed on the
Details page of the learning instance.

-- You can now sort the PagesUpload column in the Learning
instance > Document Group tab. Previously, the following error
message was displayed: System error, please try again
after some time

- On the Designer, when you resize the system identified region
(SIR) of an automapped field, the values from the resized
selection are now captured accurately in the corresponding
value field.

- Database Migration Assistant Tool now notifies with an error
if there are any environmental issues (such as missing DLL).
Previously, the tools and logs indicated that migration was
complete, even if a unified database was not created.

- When a non-English filename is uploaded using the Invoice
domain and processed using the AutoExtract command, system
identified regions are now generated. Previously, to process the
documents successfully, you had to convert the non-English
filename to English characters.

- If you import a learning instance with a set default validation
group to an environment where the learning instance was
previously deleted, the default validation group setting stays
intact. Previously, the imported learning instance appeared
without the default validation group.

- The column header name for the Default validations group
now appears in the Projectdetails.csv file obtained from
exporting a learning instance.

- For a standard forms learning instance, if you try to process a
large number of documents (more than 10,000) by using the
Process documents action from the |Q Bot Extraction package,
some of the documents might not be processed.
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Fixes

Service Cloud case ID Description

- During 1Q Bot Extraction package updates, even when you
use the Tesseract4 OCR, there is no delay in the document
processing time and throughput results.

- In standard forms learning instances, you can now set a default
value for optional fields. If extraction fails for an optional field,
the system uses the default value you set.

- You can now access standard forms learning instances created
in earlier |Q Bot versions that were installed with the CyberArk
vault key.

Limitations

IQ Bot Cloud: If you do not access 1Q Bot within the configured Ideal time out value set
on the 1Q Bot server, the following things happen:

A message to restart IQ Bot is displayed.
« Bots that use 1Q Bot APIs fail when the server is restarted.

Refresh the IQ Bot web page after some time (more than 5 minutes) to log in to 1Q Bot.

On the Validator screen, if incorrect values are used to update a field on which you have
applied validations, an alert is not displayed when the focus is lost from that field.

If you use the Process documents action from the 1Q Bot Extraction package to extract
content from a large number of documents (more than 1 million), an error message is
displayed and 1Q Bot might stop responding.

When you access the 1Q Bot application on Internet Explorerll, the following functions do
not work as expected:

« Export option on the dashboard

e |consin the menu list

* Actions list on the Bots page

« Action icon for learning instance

» Validator functionality, such as the following:

e Add rows

o Delete rows

» Search functionality

« Hideicon

» Data type for form fields
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Limitations

In the 1Q Bot Community Edition, when you use a Cloud OCR to create a learning
instance, if you use the IQ Bot Process document action from the 1Q Bot Extraction
package, the values from the uploaded invoices or documents are not processed
successfully.

Workaround: If you use the Cloud OCR to create a learning instance, use the 1Q Bot
Upload Document action from the 1Q Bot package.

When you click the Create Backup option on the Migration Management page and
select the learning instances to be backed up by using the Search drop-down list, the
learning instances selected become deselected. As a result, you cannot take a backup of
the learning instances.

Workaround: Instead of using the Search drop-down list, select learning instances from the
list on the Backup Learning Instance page.

In a Native Validator learning instance, when you try to enter data into or modify the data
in a child table that does not exist in the parent table, no error is prompted, which leads to
documents being saved with incorrect values.

When you use the 1Q Bot Extraction package along with other OCR-based commands
(such as 1Q Bot Pre-processor, |IQ Bot Classifier, AISense Recorder, and OCR) in a single
bot, the bot fails.

Workaround: Ensure that you create separate bots for |Q Bot Extraction, and do not run 1Q
Bot Extraction in conjunction with other packages that include the 12.2 Abbyy OCR.

When you install IQ Bot with Windows authentication and CyberArk Vault, it is not possible
to rotate the key, and the following error message is displayed: Error occurred while
setting up the new key. Please check the logs

In some cases, the Bot Agent does not clear out its resources folder. Until the disk space
is freed, the production documents in processing will be affected. This issue occurs
intermittently.

Workaround: Based on the issue, you must create a task scheduler to clean out the
resources folder every day or every week.

If you have a document with more than 100 pages, an error message is displayed
intermittently when you click See extraction results for an existing learning instance.

If you use the ABBYY FineReader Engine version 12.4 instead of version 12.2, the MICR
feature does not support data extraction from documents in Japanese language.

When you download an unclassified document, click Delete from the server, and then
toggle the learning instance from production to staging, and vice versa, as a consequence,
the same document starts reappearing in the untrained output folder, and when you
download the document from untrained groups, the same document reappears even
though it has been deleted.

When you upload documents to production using 1Q Bot Upload > Run the command,
toggle the learning instance from production to staging, and then toggle back to
production, all unprocessed documents appear blurred.

Workaround: Upload documents to Staging using an APl. Upload document to Staging API
(A-People login required)
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Limitations

As a result of upgrading Control Room and 1Q Bot from A360.21 to A360.25, you are
unable to edit groups in the learning instances, and move groups from Staging to
Production.

Workaround:

1. Restore the latest IQ Bot database backup.
2. Run the delete query.

3. Delete from EncryptionKey.

4

Run the following query: NSERT INTO EncryptionKey ([Keyl,
[Typel) VALUES ('xDxQoAhlc/ROnF+bFXHuo6/UGnnm6Hgs/
uBVxYpzlldUBUAEUUVYf5vnFIJUB6agkBcnCAvdQOUjdwrJWwWW4LAKA==""data’)

Start the A360.25 installer.Post upgrade checklist:

g

Ensure that following logs details are not available in installion-helper.log file: [ INFOI:
main/

com.automationanywhere.cognitive.installationhelper.infrastructure.datarotation.DataRdtationServicelm;
- Rotation starts.

7. Runthe API, and ensure that the filename has proper value (it should not
be "fileName" : "THIS STRING IS NOT ENCRYPTED",). http://localhost:9996/
organizations/1/projects/%/BlLearninglinstancelD%7/D/categories/%/BgroupNumber
%/D/files

Note: Replace the value of {LearninglnstancelD} and {groupNumber} properly. Also,
GroupNumber should belong to same learning instance.

There is no notification if the product license is about to expire. When the product license
expires, the Learning Instances tab is removed from the Control Room.

Bot Insight

What's changed

Dashboards now require the use of the Analyze package version 2.3.0-20210922-121532 or
later. This version of the package is available from Automation 360 v.23.

Bot Insight dashboards on page 3384

Fixes
Service Cloud case ID Description
01755186 When you use a filter on an individual widget, the filter is now

correctly applied only to that filter, as expected. Previously, a
filter meant for a specific widget was sometimes applied to other
widgets, as well.
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Automation Anywhere for Genesys

What's new

Automate tasks for Genesys platform with Genesys package for Automation 360

Use the actions in this package for onboarding and updating records in the repository.
Each action palette offers single and bulk record creation and delete/remove actions for
records. You can list or search records for referencing the IDs required for updating other
records. You can also organize the records for communication purposes and contextual
insight. The action palettes in this package include the following:

* Record creation: User, Division, Phone, External contacts
* Organize records: Group, Queue, External organization
« Record attributes: Language, Role, Skill

Genesys package on page 2336

Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation. For more
information, see also this page: Feature deprecations affecting Automation Anywhere products on
page 947.

Human-Bot Collaboration 11.3.x deprecated

The Human-Bot Collaboration (HBC) 11.3.x was deprecated from August 2020 with the
release of Enterprise A2019.15, after which the product has not been actively developed or
maintained. Customers that are using HBC 11.3.x are required to migrate to the Automation
360 platform to use Automation Co-Pilot (Automation Co-Pilot), Web or Desktop. For this
migration, there is no automated migration path because of an absence of parity between
the two products (including sets of features). Any path that you take to migrate from HBC
11.3.x to the Automation 360 platform will involve significant manual steps to convert and
map bots and other assets (such as forms, teams, and tasks) to Automation Co-Pilot assets
(such as bots, forms, processes, teams).

Feature deprecations affecting Automation Anywhere products on page 947

Basic authentication in Exchange online

Microsoft has announced that starting October 1, 2022 Basic authentication will be
permanently disabled in Exchange Online. This change will impact bots used for email
automation that connect to Exchange Online with Basic authentication using IMAP,
POP3, or EWS protocols. Hence, Microsoft recommends customers to switch from Basic
authentication to OAuth 2.0.

To maintain business continuity of the impacted bots, Automation 360 customers and
partners can leverage the OAuth 2.0 feature support in Email package and Email trigger
that will be delivered in the week of Aug 29th, 2022.

Deprecation of Basic authentication in Exchange Online on page 982 | Everything about
Basic Authentication deprecation in Microsoft Exchange online (A-People login required)
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Manifest V2 extensions for Google Chrome and Microsoft Edge

As Google will deprecate Manifest V2 extensions by June 2023, this might impact your
existing automations that use our current MV2 extensions in Google Chrome and Microsoft
Edge browsers. You can choose to use the enterprise group policy to continue to use
Manifest V2 extensions until June 2023(Manifest V3 transition timeline). However, post this
date, you have to switch to Manifest V3 extensions for your automations to work.

We plan to provide Manifest V3 extensions for Google Chrome and Microsoft Edge with
our next release Automation 360 v.26. We recommend that you now start planning to
switch to Manifest V3 extensions.

Chrome and Edge Manifest V3 extensions on page 997

Tesseract v3 OCR planned change from October 2022

Tesseract is an open source OCR engine leveraged by Automation 360 1Q Bot as part

of document processing and extraction. Tesseract v3 has not been updated since 2018,
and it will no longer be packaged with Automation 360 1Q Bot from the next release v.26
(planned for October 2022).

Tesseract 3 OCR was removed as an option from the |Q Bot learning instance creation
user interface about 2 years back (in our v.13 release). However, we continued to package
this older OCR version, which ensured that learning instances previously created on
Tesseract 3 can function.

Starting from our next release Automation 360 v.26, Automation 360 |Q Bot will no longer
package Tesseract 3. From v.26 release, document processing against learning instances
with Tesseract 3 will result in an error, indicating that this OCR version is not available.
However, the learning instances will remain in the system, allowing customers to view their
details and train with alternative OCR options (including Tesseract v4 OCR).

For all existing learning instances trained using Tesseract v3 OCR, we recommend that you
plan to train them with alternative OCRs (including Tesseract v4), before you update to
v.26. Note that Automation 360 1Q Bot Cloud customers will receive v.26 release by default
from October.

IQ Bot Extraction package deprecation from October 2022

As part of Automation 360 v.25, 1Q Bot Extraction package will no longer support pre-
trained machine learning model for invoice data extraction, but will continue to support
learning instance group based-training extraction.

We have released a new set of capabilities on pre-trained models with Document
Automation as part of v.25 release, including a new command package called Document
Extraction . 1Q Bot Extraction package will be deprecated starting from the next release
Automation 360 v.26, so we recommend our customers to start leveraging this new
Document Extraction package.

For more information about Document Extraction package and instructions on how to
move learning instances to Document Automation, see Move from |Q Bot Extraction
package to Document Automation on page 2426.

Previous Automation 360 Release Notes

Review the release notes for previous Automation 360 releases.

© 2023 Automation Anywhere. All rights reserved. 282


https://developer.chrome.com/blog/more-mv2-transition/

product-flagshipAutomation Anywhere - Release Notes

Automation 360 v.24R2 Release Notes for Internet Explorer 11 EOL

Release date: 17 May 2022

This release notes applies to the Automation 360 v.24R2 patch release for Cloud, On-Premises
, Sandbox, and Community Edition users impacted by the Internet Explorer end-of-life (IE EOL)
and who have therefore chosen to convert |E bots.

Cloud, On-Premises, 1Q Bot, Sandbox, and Community Edition are on Build 13343.

Note: The IQ Bot build does not include any specific updates and is available to match the
Control Room build.

Why this release

Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and
recommends Microsoft Edge or Microsoft Edge in IE mode. This release contains packages
certified on Edge in IE mode and an IE Update Bot wizard to help you update bots in bulk to
work with Edge in IE mode. The upcoming IE EOL might affect your deployments based on the
operating system you are currently using where the bots are run.

See the following table for details:

Microsoft operating system Automation 360 bots
Windows 10 Semi-Annual Channel Upgrade the bots to use a compatible
browser.

For a list of supported browsers, see Browser
requirements for Automation Workspace on
page 1063.

All other supported operating systems No immediate impact

Starting from the upcoming Automation 360 v.25 release, you will be prompted to access the
Control Room through an alternative supported browser, such as Google Chrome or Microsoft
Edge (Chromium) instead of Internet Explorer. Your Control Room will no longer be accessible
on Internet Explorer. By aligning with Microsoft's strategy for browser support, we can provide
you with enhanced functionality that latest browsers such as Google Chrome and Microsoft Edge
make technologically possible.

Updating to this release

You can update to Automation 360 v.24R2 On-Premises from the following previous releases that
are certified for update:

e V.24 (Build 12350)
e V.23 (Build 11513)
e V.22 (Build 10526)
e V.21 (Build 9664, 9642, 9595)
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As Community Edition and Sandbox are Cloud deployments, no manual upgrade is required.
These environments are automatically updated to Automation 360 v.24R2 Build 13343.

If you are not on any of the above certified releases, update Automation 360 to one of the
certified releases (listed previously) before updating to this release.

For information on updating to this release, see these resources:

+ Update Automation 360 to latest version on page 1266

« Automatically update the Bot Agent on page 1207 | Manually update the Bot Agent on page
1209

» Compatibility with release builds on page 1182

For the latest updates to the Automation 360 extensions for Google Chrome, Microsoft Edge, and
Mozilla Firefox, see Browser extensions for Automation 360 on page 852.

Bot Agent updates

This release includes an optional Bot Agent update. To use the features in Automation 360 v.24R2
patch, update the Bot Agent available with the following builds:

» Bot Agent version 21.200 for Build 13343
» Bot Agent version 21.1000.14009 for Build 13331 (On-Premises pre-GA)

Note that if you want to run your existing bots, you do not have to update your Bot Agent to this
release.

If you have installed the Automation 360 v.24R2 pre-GA patch (Build 13331) with Bot Agent version
21.1000.14009, perform the following steps.

1. Uninstall the pre-GA Bot Agent version 21.1000.14009.
2. Install Bot Agent version 21.200 for Automation 360 v.24R2 (Build 13343).

Important: If you have moved your bots from the user acceptance testing (UAT) environment
and deployed them in a production (PROD) environment with Bot Agent version 21.1000.14009,
you must update the packages with the latest Bot Agent version 21.200.
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Community Edition features

Packages

Microsoft Edge browser support for Browser package and window variables

* The following actions of the Browser package now support Chromium-based Microsoft
Edge browser:

+ Close

» Get source code
« Go back

« Open

« Run JavaScript

* In the Browser option, you can now select the Microsoft Edge tabs from the list of
active tabs.

Support for last used browser tab in Browser > Open action for Microsoft Edge and
Google Chrome

You can now open a web page on a new tab or an existing tab using the Last used
browser tab preset in the following browsers:

« Microsoft Edge
* Microsoft Edge with IE mode
* Google Chrome

Automate Java web applications

You can now automate Java web applications that run on Microsoft Edge Chromium with
IE mode by using the Recorder > Capture or the Start recording option.

Default wait time for loading page in Microsoft Edge browser with IE mode

When you automate any web applications in Microsoft Edge browser with IE mode, the
Recorder now waits for 30 seconds by default to allow the web page to load completely
before recording any objects on the page, thereby making object detection more reliable.
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Cloud, On-Premises, and Sandbox features

Control Room and Packages

New Update Bot wizard for Internet Explorer

» Use the new Update Bot wizard in the Control Room to convert your existing Internet
Explorer bots to Microsoft Edge with IE mode to ensure that these converted bots
continue to run after IE EOL.

Update Bot wizard for converting IE bots on page 977

* As an administrator, you can enable a user to use the Update Bot wizard by assigning
the new Bot update feature permissions to access and convert a bot from Internet
Explorer to Microsoft Edge with IE mode.

Feature permissions for a role on page 1590

« Use the View Bot update action in a bot conversion instance to view the summary
and status of each bot conversion. You can review action details at the individual line
numbers and take action if required for the bots that are in failed status, or in completed
with action or review required status.

View conversion details for IE bots

Automate Java web applications

You can now automate Java web applications that run on Microsoft Edge Chromium with
IE mode by using the Recorder > Capture or the Start recording option.
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Control Room and Packages

Convert Automation 360 bots with browser-specific packages using Internet Explorer to
Microsoft Edge with IE mode

You can convert bots that use Internet Explorer to Microsoft Edge Chromium with IE mode
for the following packages:

* Recorder

* Browser

«  Application

» Simulate keystrokes
e Screen

« Mouse

e Window

« OCR

* App Integration
* Image Recognition

o If
e Loop
*  Wait

To convert these bots, use the Update Bot wizard in the Administration > Bot update tab
in the Control Room.

Update Bot wizard for converting IE bots on page 977

The following properties of browser-based packages and actions are updated from Internet
Explorer to Microsoft Edge browser with IE mode:

» Bots created using the browser or application-based window, window title, and
application path

«  Window variable's default value, window title, and window application path

* Browser variables and browser title

Microsoft Edge browser support for Browser package and window variables

* The following actions of the Browser package now support Chromium-based Microsoft
Edge browser:

« Close

» Get source code
« Go back

« Open

e Run JavaScript

* In the Browser option, you can now select the Microsoft Edge tabs from the list of
active tabs.
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Control Room and Packages

Support for last used browser tab in Browser > Open action for Microsoft Edge and
Google Chrome

You can now open a web page on a new tab or an existing tab using the Last used
browser tab preset in the following browsers:

* Microsoft Edge
* Microsoft Edge with IE mode
e Google Chrome

Default wait time for loading page in Microsoft Edge browser with IE mode

When you automate any web applications in Microsoft Edge browser with IE mode, the
Recorder now waits for 30 seconds by default to allow the web page to load completely
before recording any objects on the page, thereby making object detection more reliable.

Migration features

Scan bots that use Microsoft Internet Explorer

You can now use the Bot Scanner to scan and identify Internet Explorer bots. You can
also analyze the report generated by the Bot Scanner to get usage statistics about Internet
Explorer used in your bots.

Scanning bots that use Internet Explorer on page 1372 | Analyze report for Internet
Explorer bots on page 974 | Internet Explorer conversion or scanning messages on page
1556
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Migration features

Packages and actions

You can now migrate and convert Internet Explorer bots from Enterprise 11 or Enterprise
10 to Automation 360 with Microsoft Edge with IE mode for the following packages and
actions:

* App Integration

e Delay

» |F/ELSE and Loop

¢ Image Recognition

e Launch Website

* Manage Window Controls
+ MetaBot Screen

« Mouse

»  Object Cloning

Image Play mode and Coordinates Play mode are supported. Coordinates Play mode
supports the mouse click action with keystrokes after it.

« OCR

»  Open Program/File
e Screen

* Simulate keystrokes
o Wait

Support for Wait for condition, Wait for screen change, and Wait for window actions
*» Web Recorder
«  Windows Actions

For more information, see Package mapping for migration on page 1461.

To migrate and convert bots, go to Administration > Migration > Migrate bots and
select the Convert bots built using Internet Explorer to Edge with Internet Explorer
mode option in the Control Room.

The following properties of browser-based commands and actions are updated from
Internet Explorer to Microsoft Edge with IE mode:

» Bots created using the browser or application-based window, window title, and
application path
*  Window variable's default value, window title, and window application path

Note: Bots that use value type variables are not updated to Microsoft Edge. You must
first enable the configure settings in the Legacy Automation package to open bots built
using Internet Explorer to Microsoft Edge compatibility mode.

« Browser variables and browser title
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Migration features

Convert |E bots to Microsoft Edge with IE mode

When you migrate your bots from Enterprise 10 or Enterprise 11, you can use the new
Convert bots built using Internet Explorer to Edge with Internet Explorer mode option
in the Bot Migration Wizard to convert your bots from Internet Explorer to Microsoft Edge
with I[E mode.

Migrate Enterprise bots on page 1431

History and version updated for migrated bots

In the Bot Migration Wizard, when you migrate your Enterprise 10 or Enterprise 11 bots, the
version history is now updated to show that it is a migrated bot (the check-in comment
shows that the bot is migrated from Enterprise 10 or Enterprise 11 version). You can use this
check-in comment to identify which version of the bot is migrated.

Bot Migration Wizard on page 1428

Fixes

The following fixes are available for Cloud, On-Premises, and Sandbox:

Service Cloud case ID Description

01784593 You can now run migrated bots successfully even when a $
(dollar sign) is present as a value in the User Variables field.
The Bot Scanner no longer displays a preprocessing error.

- When you automate web applications running on Microsoft
Edge Chromium with IE mode or Internet Explorer, the
Recorder now captures the object from the currently
selected browser tab. Previously, the Recorder captured the
object from the last used tab.

01189873 After migration, when you use the Browser > Open action
to open a URL that has a space character, use the Browser
> Download files action to download the file from the
specified URL, and then run the bot, the bot now opens the
URL in a single tab and downloads the file from the specified
URL.

Previously, when the specified URL had a space character,
the bot split the URL and opened it in two separate tabs.

Known behavior and limitations

The following limitations apply to Cloud , On-Premises , and Sandbox:

» When you execute a stored procedure with name parameter arguments that resides in another
database in the SQL Server, the bot displays an error because of the JDBC driver issue with
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executing a stored procedures with name parameters of another database in the same SQL
instance.

Workaround: When you add parameters to provide an input parameter or configure an output
parameter, ensure you do not enter any value in the Parameter name field. The bot will not
encounter any error when executing the stored procedure because the Database package
considers blank values as indexing.

» Note that even when the number of schedules listed on the Control Room Schedules page is
less (for example, five or six schedules), you might see the following error because of a query
timeout: An unexpected problem occurred. Thisis an existing Control Room database
performance related issue.

» There are other limitations and behavior that apply to bots migrated from Enterprise 11 to
Automation 360 and to Automation 360 bots that run on Internet Explorer and are converted
to Microsoft Edge with IE mode. For more information, see Known behavior and limitations on
page 967.

« When you use the Browser > Close action to close a tab or a window opened in the Microsoft
Edge browser, if only one Microsoft Edge browser window is open, the bot encounters the
following error: Error occurred while closing the tab

Workaround: See Configure Microsoft Edge browser settings when Close action of Browser
package encounters an error (A-people login required)

« When you use the Browser > Open action to open network URLs that start with two backslash
(\\) characters in the Google Chrome, Microsoft Edge, or Mozilla Firefox browser, the URLs
might not open properly.

Workaround: Replace the two backslash (\\) characters with file:// protocol.

» When you use the Browser > Open action, select New tab or Existing tab option to open a
specific webpage in Microsoft Edge with IE mode, the bot might throw an error after opening
the webpage.

Workaround: Use any of the following workarounds based on specific scenarios:

« Option 1. Add Try/Catch block around the Open action and ignore the exception as the
website opens.

« Option 2: In the Browser > Open action, select the New window option instead for such
websites.

* When you use the New window option in the Browser > Open action with the 3.4 x version
of the Browser package to open a URL with arguments, the bot might not perform the specific
action as the 3.4.x version of the Browser package does not support argument flags.

Workaround: Use any version other than the 3.4.x version of the Browser package to automate.

See also these resources:

« Microsoft Internet Explorer EOL overview on page 956
» Microsoft Internet Explorer 11 EOL FAQ on page 960

Related concepts

Microsoft Internet Explorer 11 EOL FAQ on page 960

Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and
recommends using Microsoft Edge or Microsoft Edge in Internet Explorer (IE) mode. This will
impact automations (bots) based on the operating system currently in use where the bots are run.

Microsoft Internet Explorer EOL overview on page 956
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Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating
systems and recommends impacted users to move their apps or websites running on IE to
Microsoft Edge with |[E mode.

Related information
Enterprise 11 and upcoming Internet Explorer 11 EOL FAQ

Automation 360 v.24 Release Notes

Release date: 08 April 2022

Review what's new and changed, and the fixes and limitations in the Automation 360 v.24 (Build
12350) release.

Important: We have updated the Automation 360 v.24 (Build 12350) to include fixes for the
following issues:

e After migration, when you ran the migrated bots, they displayed an error for variables within
double quotation marks (" ") (Service Cloud case ID: 01802575, 01803323, 01803800,
01804121, 01804820).

» When you clicked the Automation Co-Pilot icon, the Control Room was displayed instead of
the Automation Co-Pilot Desktop Assistant sign-in screen (Service Cloud case I1D: 01803979).

» Migration
11.x and 10.x | 11.x only | 10.x only
» Automation Workspace

What's new | What's changed | Fixes| Limitations
« Automation Co-Pilot

What's new | What's changed | Fixes| Limitations
» Discovery Bot

What's new | Fixes| Limitations | Feature Deprecation
« |Q Bot

What's new | Fixes| Limitations
« Bot Insight

What's changed | Fixes | Limitations

Updating to this release

You can update to Automation 360 v.24 from the previous three releases (that is, from n—3
releases, where n refers to the latest release). The following previous releases are certified for
update to this release:

e V.23 (Build 11513)
» V.22 (Build 10526)
o V.21 (Builds 9664, 9642, 9595)
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You can directly update to v.24 from any of these builds (see Update Automation 360 to latest
version on page 1266). If you are not on an n-3 release, update Automation 360 to one of the
three certified releases (listed previously) before updating to this release.

» If you are directly updating to this release from Automation 360 On-Premises v.21, remove the
following Bot Agent files and folders:

e C:\Windows\System32\config\systemprofile\AppData\Local
\AutomationAnywhere\AA-DB.mv.db

e C:\ProgrambData\AutomationAnywhere\GlobalCache\embedded-resources

« Before you update to this release from Automation 360 On-Premises v.22, refer to the upgrade
considerations in Update Automation 360 to latest version on page 1266.

Important: This release includes an optional Bot Agent update. To use the new features in v.24
(including updates to Bot Migration, Browser, DLL, Process Discovery, and Recorder packages),
update the Bot Agent available with this release. However, note that if you want to run your
existing bots, you do not have to update your Bot Agent to this release.

For information on updating to this release, see these resources:

« Automatically update the Bot Agent on page 1207 | Manually update the Bot Agent on page
1209

« Compatibility with release builds on page 1182

For the latest updates to the Automation 360 extensions for Google Chrome, Microsoft Edge, and
Mozilla Firefox, see Browser extensions for Automation 360 on page 852.

Important: This release includes new command packages in which the Apache log4j2 library is

no longer bundled. However, older command packages, from Automation 360 v.23 and earlier,

might continue to have the log4j2 library bundled within. If you want to use command packages
without the log4j2 bundled within, we recommend that you use the newer Automation 360 v.24
packages in your tasks.

Migration

Enterprise 11 and Enterprise 10 features

Self-service Control Room migration

You can now manage the migration provisioning process with self migration capabilities.
You can also choose between manual and automated migration.

Self-service Control Room Migration on page 1261

Enhancement to migration of Credential Vault variables

Migration is now supported when Credential Vault variables are passed from one MetaBot
Logic to another MetaBot Logic for the following commands:

* |F > Logic Successful
» |IF > Logic Unsuccessful
* Begin Error Handling > Run Logic
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Enterprise 11 and Enterprise 10 features

You can now successfully migrate Enterprise 11 bots that use the 32-bit wscript.exe
to the 64-bit architecture, without exception errors. This enhancement helps you to
successfully execute VBScript.

Migrate MetaBot with parent and child Logic with renamed Logic

You can now migrate a MetaBot with a Logic (parent) that includes a renamed Logic (child).
If a child Logic is renamed after it is mapped to the parent Logic, this parent Logic mapping
is now migrated with the new name.

This enhancement applies to the following commands:

« |F > Logic Successful

* IF > Logic Unsuccessful

» Else If > Logic Successful

» Else If > Logic Unsuccessful
* Error Handling > Run Logic
* Run Logic

Migrate when MetaBot and Logic have the same name

You can now successfully migrate your Enterprise 11 bots when the name of the MetaBot
and the assets folder or the Logic name inside that MetaBot are the same. The Logic name
is suffixed with -bot. The name is appended only when the Logic or the folder is on the
same hierarchy as the MetaBot.

« |f an existing bot has the renamed Logic or assets folder, the Logic is then renamed
with the next available number. For example, -botn, where n indicates the next available
number. Additionally, an action required message is displayed.

» If a MetaBot or a Logic calls a renamed Logic or Task Bots, the command path is
updated to include the new name.

e If a Logic, MetaBot, or a folder name exists with a new name, the existing bot is
overwritten.

Migration messages on page 1519

Consolidated view of migrated bots and their status

Use the Overview tab in the Control Room to get a consolidated view of the status of the
migrated bots. View the overall status of bot migration for all the bots that are successfully
migrated, those that failed to migrate, and those that require review or action. You also
have the option to rerun migration on selected bots and view the history of each bot that
has gone through multiple migrations.

Bot Migration Wizard on page 1428
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Enterprise 11 only features

Update to AAApplicationPath, CurrentDirectory, and AAlnstallationPath variables

If your migrated bot contains SAAApplicationPathS, SCurrentDirectory$, or
SAAlnstallationPath$ variables in any file or folder path, a validation check for the absolute
path is no longer performed during migration. Also, a temporary variable (Sm-string-
start-in-path$) is not created and assigned to the migrated bot for validation. As a
result, the size of a migrated bot is now reduced and the bot performance is enhanced.

Enhancement to migrate bots with Email Connect command

When you migrate Enterprise 11 bots that contain the Email > Connect and Email > Send
commands configured for EWS server, the Azure Cloud field is set to Azure Global and the
Authentication type is set to OAuth2-Silent which was previously called OAuth?2.

Note that OAuth2 now supports two modes: Silent and Interactive.

Using Connect action for Email on page 2240

Migrate bots with timeout configured to send REST and SOAP request

The timeout value configured in Enterprise 11 to send REST and SOAP requests is

now migrated to Automation 360 as part of the global values (AARestTimeOut and
AASoapTimeOut). The default timeout value is set as 60000 ms in Automation 360. You
can update this value if the REST Web Service takes more time to receive a response.

REST Web Service package on page 2596 | Example of using the SOAP web service action
on page 2826

Enterprise 10 only features

Migrate new or modified Enterprise 10 bots to Automation 360 (Service Cloud case ID
00719524)

You can now migrate new or modified Enterprise 10 bots to Automation 360 after an
earlier migration. A new export utility is now available that enables you to export such new
and modified bots from the Enterprise 10 Control Room repository. You can then import
the exported bots later to Automation 360 using Bot Lifecycle Management (BLM) and then
finally migrate them using the Bot Migration Wizard.

Migrate new or updated Enterprise 10 bots to Automation 360 on page 1425
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Automation Workspace

What's new

Bot Agent updates and early availability of packages

Starting from this release, you can choose or skip some Bot Agent updates and start using
packages as soon as new package versions become generally available regardless of your
region.

Bot Agent updates that support new packages or updates to packages will be made
available quarterly, with updates alternating between mandatory and optional.

Previously, Bot Agent updates were available automatically across user device pools
without affecting bot execution. In some large and complex deployment scenarios, these
updates were cumbersome but could not be skipped. (Examples include deployments
where the device pools were deployed using standard device Amazon Machine Image
(AMI) on separate schedules requiring greater coordination, change management
processes, and approvals in the user environment for the Bot Agent update.) Now, you can
skip an optional update and update to the next mandatory Bot Agent update as Automation
360 will start providing reverse compatibility with Bot Agent for a release every six months.

Also, with every release, you can start using the latest packages as soon as new package
versions are released. For Automation 360 Cloud users, package updates are now available
asynchronously across all regions, so you can start using the latest packages on the current
Control Room version even before the Control Room update is made available for your
region.

Compatibility with release builds on page 1182

Create multi-login users

You can now create a multi-login user. A multi-login user is allowed multiple sessions to
the Control Room through the API.

Multi-login user on page 1587 |

Do more with Microsoft Edge Chromium
You can now use the Microsoft Edge Chromium browser extension for the following:

« Bot Agent proxy configuration
« Automatic population of device credentials

Browser requirements for Automation Workspace on page 1063

Reduce turnaround time

You can now reduce the turnaround time for collecting information on issues by capturing
log files from the Bot Runner device. You can save the log files by using the new -
collectlogs command with the Bot Agent diagnostic utility.

Perform Bot Agent diagnostic checks on page 1210
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What's new

Google Chrome policy change impact on Bot Agent

From Google Chrome version 101, Google Chrome is deprecating direct access to private
network endpoints from public websites as part of the Private Network Access (PNA)
specification for URLs using https. To mitigate its impact, starting from this release,
response headers are added to the Bot Agent that enable the Bot Agent to communicate
with Control Room on Google Chrome browsers. This will ensure that operations such

as device registration, bot recording, playback, and deployment are not adversely affected
because of this change.

Enhancement to AlSense Recorder

You can now use AlSense Recorder to automate applications that use Japanese and a
combination of Japanese and English interfaces.

AlSense for recording tasks from remote applications on page 1998

Wait time option in SOAP Web Service and REST Web Service packages (Service Cloud
case ID: 00756730, 00792793, 01255869, 01753287)

When you create a bot, you can now set a time-out value for actions in REST and SOAP
requests. To indicate how long a bot should wait for a response from the server before
timing out, you can set a wait time (in milliseconds) in the Wait for actions to complete
field. You can enter a number or a variable or provide a global value.

Format text with new HTML editor in Email package

In the Email package, when you use the Send, Reply, and Forward actions, you can now
create and customize your email layout and body by using the new HTML design editor.
Use the editor toolbar to make various changes to your text, such as applying bold, italic,
and other formatting effects, inserting links, and changing the font and size of the text. You
can copy the content from the design editor and paste it to other windows.

Task Bot package now supports passing Window variable to child bot (Service Cloud case
ID: 00691890, 00804359, 01258948, 01764292)

In the Run action of the Task Bot package, when you select Input values fields and enter
the values or variables to pass to the child bot, you can now choose the Window type
variable and pass it from parent bot to child bot.

New option in Content type field of REST Web Service package (Service Cloud case ID:
00666852, 00789910, 00771194, 00785116, 00825945, 01762199)

You can now use the multipart/form-data option to upload files and data through REST
Web Service. The content type multipart/form-data can be used to submit form elements
containing files, non-ASCII data, and binary data. This option is available for actions such as
POST, PUT, and PATCH.

Custom delimiter option in SOAP Web Service package

For responses specific to XPath, you can now use the custom delimiter option to delimit
the return content from the SOAP response. In the Custom Delimiter field, you can
provide a character or a variable, and the output of the delimited response will be a
complete string.
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What's new

New option in Run function action of DLL package (Service Cloud case ID: 00830568,
01063654, 01259336, 01767965)

In the Run function action of the DLL package, when the C# DLL interacts with the
Windows API to perform system-related operations, such as keystroke, mouse click, or
window switching, an intermediate window (AAZeroSizeForm) is displayed occasionally and
interrupts the user's operation when the bot is running. In some cases, the DLL function
does not interact with the Windows API to perform actions, such as keystroke, mouse

click, or window switching, on the operating system Ul through the DLL function. In such
cases, you can now select the Run function in background check box to bypass the
intermediate window (AAZeroSizeForm) and run the C# DLL in the console application
without the form. This feature also helps to improve the performance of the DLL execution
if the Run function in background check box is selected.

Autoscroll supported in Bot editor (Service Cloud case ID: 00730747)

When you are creating or editing bots with a large number of lines of code and when
you drag actions up or down the page, the page now automatically scrolls up or down
accordingly. This feature is supported in both Flow and List views.

Configure session timeout in Control Room settings (Service Cloud case ID: 00765320)

You can now ensure that your web session does not time out, such as when you are
creating a bot, by configuring a suitable session timeout duration in the Control Room
settings. Depending on the timeout duration configured, you will be timed out only after
the specified number of minutes of inactivity, which prevents loss of work due to early
timeout.

New JSON package

Use the JSON package to automate JSON data. You can now extract the required
information from JSON text or file and directly use the values in the bot.

Json package on page 2436

New option in Catch action of Error handler package (Service Cloud case ID: 00766117)

In the Error handler package, you can now ignore errors from actions inside the Catch
block by using the Catch > On error, continue with next action option. When you select
the On error, continue with next action check box, even if there is an error from an action
in the Catch block, no exception is thrown and the bot ignores the error and continues to
the next action.

Note: This enhancement applies to all nested actions in the Catch block. For example, if
you have a Try/Catch action inside a main Catch action, if the check box is selected on
the main Catch action, any error from actions within the nested block will also be ignored.

Enhancements to the Connect action of the Email package (Service Cloud case ID:
00830611, 01264796, 00788467)

*  You can now connect to an EWS server hosted on Azure US GCC high cloud.

« The action now enables Federated Azure users to connect to an EWS server in Attended
Automation mode.

Using Connect action for Email on page 2240
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What's new

Enhancement to String package

In the Extract text action of the String package, when you use the After or Before and/or
after option, you can now extract a substring from a specified source string that occurs in
the range of 1 through 999999 times in a file.

Search for files by specific date

You can now search for files created or modified on a specific date by using the new On a
date option available in the File Date condition of various packages.

You can use this feature with the following packages and actions:
¢ File package

» Copy Desktop files action
» Delete action

e Print action

« Print multiple files action
* Rename action

* Folder package

« Copy action
o Delete action
« Rename action

» If > File date condition
e Loop > While > File date condition

New action in Excel advanced package (Service Cloud Case ID: 01263892, 01782290)

When you perform actions in a Microsoft Excel worksheet, you can now disable or enable
real-time screen update by using the new Disable or enable real-time screen update
action of the Excel advanced package. This action is useful to improve the performance of
Excel-based automations at run time when dealing with large data sets.

Worksheet operations in Excel advanced on page 2288

Support for copying metadata from one bot to another

You can now copy image and metadata files from one bot to another by using the Copy to
shared clipboard option.

Add document extraction capabilities to bots

You can now make bots connect to your Google Cloud service account, send documents
to a specific processor, and retrieve the extracted data in JSON format by using the actions
in the Google Document Al package.

Google Document Al package on page 2373
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What's new

Use Recorder conditions in Chromium-based Microsoft Edge with Internet Explorer (IE)
mode

You can now use the Object exists and Object does not exist Recorder conditions in
Chromium-based Microsoft Edge with IE mode for the following packages:

e Loop > While condition
*  Wait > Wait for condition
« |f package

Use custom datetime formats

Use the following conventions to specify custom datetime formats and convert a datetime
value:

* D: Specify a day in a year as D or DD.
* a: Specify an AM/PM marker for the 12-hour time format.

Datetime formats on page 2215

Internet Explorer browser support for Browser package and window variables

* The following actions of the Browser package now support the Internet Explorer
browser:

« Open
o Close
o Go back

» Get source code

* In the Browser option, you can now select the Internet Explorer tabs from the list of
active tabs.

Browser package on page 2162

Enhancement to Datetime package

The Variable option in the Datetime > Assign action is now enhanced and divided into
two options:

» Datetime: Enables you to select the date and time along with the time zone manually
and assign it to a Datetime variable.

« Variable: Enables you to select the Datetime variable or other variables that can have
Datetime as a subtype, such as the Dictionary, Record, and list variables.

Using the Assign action on page 2212
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What's new

Enhancement to Recorder package

You can now capture and automate objects inside a cross-domain IFrame that has multiple
I[Frames with the same frame source and IFrames that are loaded at run time in Google
Chrome and Microsoft Edge Chromium browsers. You can do this by using the Recorder
> Capture or the Start recording option. This support is also available for offline Google
Chrome extensions.

Recorder package on page 2564

Support for pop-up windows and dialog boxes in Google Chrome, Microsoft Edge
Chromium, and Mozilla Firefox browsers (Service Cloud Case ID: 00762207, 00769773,
00781196, 00786646, 00777907, 00795677, 00785995,00808600, 00811044, 00767486,
01282172, 01286665, 01256750, 01762040)

When you are automating a web page on the supported browsers, you can now capture
the pop-up windows, alert dialog boxes, confirmation dialog boxes, and prompt dialog
boxes that appear. You can do this by using the Recorder > Capture or Start recording
option.

Recorder package on page 2564

Retrieve source code of an iframe in Google Chrome browser

You can now retrieve the source code of an iFrame in the Google Chrome browser by
using the Browser > Get source code action. You can use the new Capture object option
to capture these iFrames.

Note: The Capture object feature is optional and is only used to retrieve the source code
of an iFrame.

Run JavaScript inside an iFrame in Google Chrome browser

You can now run JavaScript in a page that contains iFrames in the Google Chrome
browser by using the Browser > Run JavaScript action. You can use the new Capture
object option to capture iFrames on which you want to run JavaScript.

Note: The Capture object feature is optional and is only used to run JavaScript inside an
iFrame.

Global session support for Excel basic package

» The Global session option is now supported for the Excel basic package. Use the Global
session option to share a Microsoft Excel session across multiple bots so that you can
use the same Excel worksheet across these bots.

¢ The Session name field is now renamed Create Excel session.

Using the Open action for Excel basic on page 2277
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What's new

Default variable to hold number type data

When you are building or testing a bot, you can now use the default number variable
SampleNumber, which is included in the Variables palette.

Note: The default number variable is only available in new bots.

Export and import password-protected files

To improve security by providing protection against unauthorized access and malicious
editing and also to protect privacy, the export and import features are now enhanced to
include the password option. With this feature you can now perform the following:

» Set a password for the files that you want to export from your Control Room.
* Import the password-protected exported file into your Control Room.

Export bots on page 1850 | Import bots on page 1852

New options in Git configuration (Service Cloud case ID: 00782957, 00837059, 00687394,
00783715, 00714059, 00659476, 00749755, 00786233, 00748166, 00776417)

You can now perform the following actions for Git configuration:

» Choose either the HTTPS or SSH authentication method to set up the Git configuration.
The SSH authentication method is more secure as the authentication is based on a
public and private key pair.

« Specify the branch to which you want to push your Git commits. This helps with team
coordination and workflow management.

« Connect to your Git repository by using a proxy server.

Configure a remote Git repository in Control Room on page 1660 | Restore bots from Git
repository on page 1668

Force push now a configuration setting for Git Integration in the Control Room (Service
Cloud case ID: 00683762)

You can now configure the Git push to be with or without the force push flag. Previously,
updating a remote Git from the Control Room exclusively functioned as a force push. This
force push is the recommended and optimal setting.

Support for Azure DevOps (On-Premises or Cloud) Git for SSH authentication (Service
Cloud case ID: 00652012, 00690526)

You can now use either the SSH or the HTTPS authentication method to connect to Azure
DevOps (On-Premises or Cloud) Git through the Control Room to check in a bot and its
dependent files to the remote Azure DevOps Git repository.

Connect to Azure DevOps Git from Control Room on page 1664

Spring core vulnerability - CVE-2022-22965 (01793279, 01793398,
01793497,01793679,01794189)

Updated to the Spring Framework which has the patch for CVE - CVE-2022-22965
vulnerability.
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What's changed

Migration validation checks for default device settings

The prerequisites validation for migration now validates whether Bot Runners selected for
bot migration have the default device set. If the default device is not set, then bot migration
cannot proceed and the validation report lists a validation error. The report also shows the
specific Bot Runner devices that do not have a default device.

Note that bot migration cannot use devices that are selected at runtime.

Bot migration report shows migrated bot with action and review required

The bot migration report now separately lists bots that might require an action or review
after migration. This feature enables you to view the list of bots that will require action or
review and to plan post-migration steps accordingly.

Migrate 11.x bots with forward slash in file and folder path (Service Cloud case ID
00808534)

You can now migrate Enterprise 11 bots that include a forward slash in the path used within
the File and folder action. Previously, only the backslash was supported in the path and so
the user could not create a folder on SharePoint.

You can now manually migrate Enterprise 11 bots even when the My MetaBots folder
is not present in the Control Room because this folder is no longer validated during
migration.

Enhanced user management

You can now view the activity of bots started by other users from the folders for which you
have run and scheduling permissions.

Enhancement to API key validity setting (Service Cloud case ID: 00543590, 00719480,
01373359)

You can now increase the duration of validity for APl keys to 9999 days from the Control
Room settings for authentication. Previously, the duration of validity for APl keys was 45
days. With this enhancement, a Control Room admin need not regenerate the API key
every 45 days to authenticate Automation 360 APIs.

Enhanced security in Image Recognition package

You now have enhanced security when you use any of the Image Recognition actions
from the Image Recognition package. Image logging is now disabled to ensure that if a bot
fails while running one of the Image Recognition actions, the captured source and target
images are no longer stored in the log folder.

Enhancement to subject filter in Email package (Service Cloud case ID: 00776374,
00953823, 975605)

When you connect to an Exchange Web Services (EWS) server, to repeat a set of actions
on all the email messages that meet a set of criteria, use the Move all action from the
Email package or use Loop > Iterator > For each mail in mailbox. The When subject
contains field is now case sensitive. When you enter text inside a pair of double quotation
marks (") in the When subject contains field, the bot retrieves all the email messages
whose subject exactly matches the text and the case that you entered inside a pair of
double quotation marks.
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What's changed

Change to default variable name

The name of the default string-type variable is now changed from prompt-assignment
to SampleString.

Note: This change only impacts new bots.

Change in activity information on Historical page

The information about bot execution activity is retrieved for 90 days in the Control Room
Historical activity page. Information older than 90 days can be viewed in the audit logs.

View completed activity on page 1893

Enhanced Secure Recording mode control

If you are an administrator, you can now enable or disable the Secure Recording mode
based on assigned user roles (permissions) for more granular control of the Control Room.

Secure recording on page 913

The following table lists fixes alongside the build in which each issue was fixed. Build 12350 is the
latest build and includes fixes from the previous builds.

Fixes
Build Service Cloud case  Description
ID
12350 01768021, After the upgrade, the Control Room is no longer
01803781 unresponsive and behaves normally. Previously,
the Control Room was unresponsive after the
upgrade due to Java deadlocks.
12350 01802575, After you update from a previous release to this
01803323, release, when you run the bots, the migrated
01803800, bots no longer show an error for variables within
01804121, double quotation marks (" *). You do not have
01804820 to remove the double quotation marks as a
workaround to run the bots.
For example, after you update from Automation
360 v.23, you can run a bot with the Excel
advanced package that contains the following
variable: "SHeaderCounterS”
12342 00827504, With the required permissions, you can now
00788652, view the correct information in the Historical
00827730, Activity page. Previously, a "Do not have sufficient
01259452 permissions” error sometimes prevented even
users with administrative permissions from
viewing some of the entries in the Historical
Activity page.
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Fixes

Build Service Cloud case  Description
ID

12342 00823799, When you migrate Enterprise 11 MetaBots with
01623586 Input, Output, and None variable parameter
types, these are now correctly mapped to the
respective parameter type in Automation 360
after migration.

Previously, the Enterprise 11 Input, Output, or
None variable types were mapped to Input/
Output type after migration.

12342 00819756 After migration, when you run a bot that
contains Switch to sheet action and the action
is performed, the worksheet is now visible and is
activated for further operations.

12342 01773270, The Cloud Migration Utility can now connect
01781001 successfully to the database even when the
database credentials contain the following special
characters:

S#Q%S

12342 00988580, After you migrate from Enterprise 11 to
01200161 Automation 360, you can now Check out bots
and dependent files to the Control Room Public
workspace.

Previously, the dependent files were not available
for Check out in the Control Room Public
workspace. The parent bots had to be checked
out first so that the dependent files could be
automatically cloned and available for Check out.

12342 00788046 When you run a bot with the Wait, File, Folder
as Actions or If/Loop as Conditions and if the
Start Date and End Date options are set to the
same date, these bots now execute the respective
action or conditions based on the end date that is
set.

12342 01598462 The Run Logic command now works correctly
when MetaBots contain Logic with different
parameters assigned to each Logic. If you disable
one Logic in a MetaBot, the other Logic and its
command will work correctly.

Previously, if one Logic in a MetaBot was disabled,
commands related to another Logic were
disabled.
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12342 01251985, In the SAP BAPI package, the Get Table
01264753, command for the Table subtype now successfully
01272804 retrieves results for the Import, Export and Table
parameters.

Previously, if you ran the Get Table command
for the Table subtype for Import or Export
parameters, the command failed.

12342 01262390 When you migrate Enterprise 11 bots that use the
IF > File exists condition with a wildcard in the file
name, they now run successfully irrespective of
whether the parent folder is available in the path.

Previously, if the parent folder was not present in
the condition path, the bot stopped running and
encountered an error.

If you are on this release or an earlier one,

you can use IF > File exists condition with the
parent folder, along with current IF > File exists
condition with wildcard.

12342 - A migrated that includes the File and folder
command has the Include start and end dates
check box enabled by default. As a result,
Enterprise 11 bots no longer fail in Automation
360 when the file rename operation is performed,
even if the start and end dates specified are
the same for comparison using the Is between
condition.

12342 01751462 When the Run Task command with a variable
path is disabled and the variable used in the path
is deleted, the Task Bot can now be migrated,
without any error. Previously, migration failed and
a preprocessing error was displayed.

12342 00824337 The migration result no longer shows an error
message when you migrate a bot with the
credential name in Japanese.

12342 00783883 The HTML technology-based action (for example,
GetProperty) now supports the retry mechanism,
which enables you to migrate bots that include
the recorder command with an inner text.

12342 - You can now successfully migrate Enterprise
11 bots that have negative values for x and y
coordinates for top and left fields.
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12342 00827997 Bot Scanner now allows the migration of bots
with multiple expression conditions that include
a disabled line of code and no longer shows an
error.

12342 00834597 Bot Scanner now successfully analyzes a MetaBot
screen and no longer shows an error for the
preprocessing of the source file.

12342 01213241 All plug-ins now successfully load when you open
an Excel sheet using the Excel > Open action.

12342 01504682 Bot Scanner no longer shows an internal error
even if a bot contains any of these special
characters: &#26.

12342 - You can now successfully migrate Enterprise
10 bots that have roles with folder permissions.
Previously, such permissions were not migrated.

Note: The Run and Schedule role is not migrated.

12342 01632298 You can now successfully migrate bots with the
Analytics variable through the Bot Migration
Wizard, and after migration the status is displayed
as successful. Previously, these bots were stuck in
the In Progress state and therefore the bots did
not run.

12342 00828781, Bots now complete their execution faster than
01258567, previously when a proxy is enabled through a PAC
01273170, file in Cloud deployments.
01469879

12342 01385567, The Control Room now correctly shows
01749465 the information for Display intranet sites in
Compatibility View in Compatibility View
Settings. Previously, in Automation 360 v.23, a
blank page was displayed because of an internal
issue.

12342 00807226, If an IP subnet address contains the numeral 80
01148097 (for example, 192.30.80.25), you can now
configure the Control Room port to 80 in the
installer.

Previously, if the subnet address contained the
numeral 80, the Control Room port could not be
configured to 80. A different port number that did
not contain 80 had to be configured for the IP.
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12342 00836549 When you copy a role by using Create Role
within a Control Room, user and bot permissions
are now correctly retained. Previously, editing
the associated role caused all associated bot
permissions to be lost.

12342 01434341, You can now successfully search for Japanese
01755003, characters within bots by using the Find in this bot
01755713, search box. Previously, the Japanese characters
01756244, typed through the keyboard were not entered
01757083, correctly and you had to use a workaround to
01756871, search for Japanese characters.

01758346
Japanese language search support

12342 - If you Check in a bot to the Control Room Public
workspace after filtering any dependency data,
when you export the bot, only the filtered data is
displayed now. Previously, even after filtering the
dependency data, all data was displayed.

12342 00819477 You can now view dependent files when you
open a bot in the bot editor. Previously, the
dependent files were listed only in view mode.

12342 - When a device pool name includes the
underscore character (_), the MSI Installer now
completes autoregistration of device pool
properties, resulting in device pool names with
underscores to populate. Previously, the MSI
Installer did not complete autoregistration of a
device if the device pool included an underscore
character.

12342 01758029, You can now use Azure AD authentication to
017596611 connect to Azure database server when you
install the Control Room using Windows installer
and installation script. Previously, if Azure AD
authentication was selected on the Database
server window, Control Room installation failed.

12342 -- After you install or upgrade Automation 360
from a previous release, the Control Room
Installation summary page now displays the
correct version number. Previously, the page
displayed an incorrect version number.
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12342 00796190, When you deploy a bot, the run-time window
00827493, now displays the correct line number and
01251725 package name for the capture desktop action
of the Error Handling package. You can find the
exact line number that caused the error by using a
variable in the Error handler: Catch > Assign line
number to option.

12342 00800990 You can now rename a bot by changing the text
from uppercase to lowercase or from half-width
to full-width characters. For example, you can
rename a bot from Automate to automate.

Previously, the text in the bot name could not
be changed. When the text was changed, the
following error message was displayed:

Unable to create a file with

the name <filename>. That name
is already in use. To continue,
please rename your file. Code:
repository.exception.file.exists

12342 01258242 When you run a bot that contains multiple
conditions and a missing operator in one of
the conditions through the Bot editor, an error
message is now displayed about the missing
operator. When you update an action and save
the changes and if there is a missing operator, an
AND operator is now added by default. Previously,
bots with multiple conditions failed intermittently
with a preprocessor error.

12342 00805738 An error message is now displayed and you can
no longer check in or check out files whose
filepaths are identical except for differences in
case. Previously, when the filepath had different
cases and was checked in or checked out, there
were issues during bot deployment.

12342 01753711 You no longer encounter any issue when you
check out a folder that contains tasks with
dependencies. Previously, casing-related issues
occurred in string comparison operations,
which caused errors in check-in and check-out
operations.

12342 01271474, When you assign a production label to a child bot
01761856 that has more than one version, the production
version is now displayed during bot operations.
Previously, instead of the production version, the
latest version of the child bot was displayed.
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12342 01270601, When you connect with Microsoft Outlook,
01260628, IMAP, or POP3, you can now create a bot and
01255632, save all emails to a folder even if the email subject
01758499, line contains slash (/) or backslash (\) characters.
01775489,01773778 When you save the emails, the slash (/) and
backslash (\) characters in the subject line are
now replaced by an underscore (_) character.

12342 01755993, In the Email package when you connect to
01782945, Microsoft Outlook to automate an email-related
01775161, task, you can now use the Move all action
01792954 followed by Loop action to move unread emails
from one folder to another folder. Previously,
when you ran the bot, the bot failed to move the
unread emails because of an error.

12342 01264563 You can now create a bot using the Global
session option in the Open action of the DLL
package and choose DLL session does not
exist for the If condition. Previously, an error
was encountered when the Open action of the
DLL package and the If (DLL session does not
exist) condition were called multiple times in a
sequence.

12342 01258059 In the XML package, when you create a bot to
retrieve the data by using the Get single node
action and if the XML file has some lines that are
commented out, the output no longer shows
those lines. Previously, the output displayed the
lines that were commented out.

12342 - In SOAP Web Service, when you select Raw data
parameter and use the Build Xpath option, you
can now successfully extract values from the
SOAP response and store the XML output in a
variable. Previously, you could not extract values
from the SOAP response because the Build Xpath
option did not work as expected.

12342 01071731, When you open a CSV or TXT file, read data from
01762875 that file, and write data from a Table type variable
to the file, the bot no longer fails if the CSV or TXT
file contains large data sets. The bot now runs
successfully even when the Create folders/files if
it doesn't exist and Override existing file check
boxes are selected in the Write to file action.
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12342 00968574 An error no longer occurs when you create a bot
by using the Open action of the VBScript package
and select a VBScript file from the desktop with
the file extension in uppercase. Previously, if the
file extension was in uppercase, the bot failed
because the file was considered an invalid script
file.

12342 00831463 Using the Email package, you can now send
emails with the email subject containing a
combination of Japanese half-width characters
and katakana characters. Previously, if email
subject contained a combination of Japanese
half-width characters and katakana characters, the
output displayed was garbled in the mail received.

12342 00822222 When you connect to the EWS server to
automate an email-related task, you can now
send multiple emails without providing any value
in the subject field when you use the Send email
action in a loop. Previously, when there was an
empty value in the subject field, the bot failed to
read such mails.

12342 00823283 In the FTP / SFTP package, you no longer
encounter an error when you provide the folder
name as a dot () in the Get folders action. When
you run the bot, it downloads all the folders from
the current directory to the local folder path
provided in the action.

12342 00824379 In the Google Sheets package, when you open
a spreadsheet and use the Go to cell with the
cell option as Specific cell and if the spreadsheet
has more than 40000 rows and you select the
One cell below option, the bot now executes
successfully. Previously, an error occurred on bot
execution.

12342 00788970 The bot name is now translated correctly in
Chinese (Simple Chinese) in the Bot running
window. Previously, the bot name was displayed
as garbled in the Bot running window.

12342 01270344, When you use the Google Sheets package and
01767148 open a Google spreadsheet, you can now use
the Get all sheet names action to successfully
retrieve the names of all the sheets. Previously,
if the Google spreadsheet had more than five
sheets in it, the bot encountered an error.
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12342

01709026,
01755897,
01768689,
01761434,
01554474

An error no longer occurs when you establish

a connection by using the OBDC driver in the
Database package. For Microsoft SQL Server, the
blank value is now inserted as O in the database
table for the int column.

12342

01602081

When you use actions from the REST Web Service
package to send requests and receive responses
from a REST APl and to store the response status
of the APl in a dictionary variable, REST now
returns headers and empty body content in
response even if the APl does not have response
body.

12342

01758733

When you migrate from Enterprise 11 to
Automation 360, after you edit or add some
actions to a bot that does not exist in a parent
bot, when you save the bot, it is now saved
without any delay. Previously, it took some time
to save the bot.

12342

01254323

An error no longer occurs when you use the
Create workbook action of the Excel advanced
package to create a workbook inside a folder in a
network drive path.

12342

01036851

When you open a file with . x1sx extension by
using the Open action of the Excel advanced
package, the bot no longer fails even if an
intermediate parent folder does not have access
privileges. For example, the Open action can
open the file from \\share\a\b\c\file.xlsx
if the \\share\a\b\c folder has access
privileges even if the \\share\a or \\share\a
\b folder does not have access privileges.

12342

00827204

On computers that use the Japanese and Chinese
versions of operating systems, an error no longer
occurs when you try to return a tab to the first
web page it opened by using the Go back action
of the Browser package and deselect the Throw
an error if step exceeds history option.

12342

00777283,
00829912

When you use the Open action of the Excel
advanced package to open a Microsoft Excel
worksheet, use the Replace action of the Excel
advanced package to replace a string in the
worksheet, and then run the bot, the bot now
runs as expected and is not stuck even if the
string to be replaced is not present in the Excel
worksheet.
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12342 00835312 An error no longer occurs when you create a
shortcut to a folder by using the Open program/
file action of the Application package to open a
file and then using the Create shortcut action of
the Folder package.
12342 00757943, You can now use the Al Sense action in a parent
00787404, bot and the OCR action in a child bot, or both
00788421, actions together, to successfully run your bot.
00807528, Previously, this caused an ABBYY FineReader
00822941, Engine 12 error.
01018972
12342 01212753, When the current session of an application on
01470071 Citrix is closed and the application is restarted,
the Recorder now identifies the object and
successfully performs the correct action.
Previously, the Recorder failed to identify the
object.
12342 00742936, You can now convert a datetime value by
00808117 specifying custom datetime formats (for example,

hh:mm: ss). Previously, an error occurred when
you used the hh convention to specify a custom
datetime format.

12342 01266752 When you use the 6.2.0-20210903-141520
version of the Excel advanced package to run a
macro on a Microsoft Excel worksheet, the values
in the referenced cells in the Excel worksheet are
now updated correctly.

12342 01755439 An error no longer occurs when you use the
2.5.3-20220304-010651 version of the Recorder
package to capture an object. Previously, when
you used the 2.4.0-20211118-080716 version
of the Recorder package, the bot failed with
the following error message: The bot could
not be executed due to an error in
setting up the execution environment

12342 01276429 After migration, you can now call a reusable bot
with the new package version from the same
parent bot with which it shared a session. You can
do this by inserting a session variable initialized
with a value to a key in the dictionary with the
Dictionary > Put action.

12342 00805417, You can now use the Recorder to successfully
00815023, run keystrokes and capture objects on a new tab
01049408 opened in the Google Chrome browser.
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12342 - In the Browser > Open action, when you select
the Last used browser tab preset for the Internet
Explorer window under the Existing tab option,
the corresponding tab and window are now
activated.

12342 01755590 In Automation Workspace, when you navigate to
Automation > Bot Store and log in, you can now
access the Bot Store without issues.

12342 - When you add or remove a consumer role from
the locker, role values are no longer changed
when you sort the table. Previously, the values in
the Modified By and Last Modified columns were
inadvertently modified.

12342 01272058, You can now pause or stop your in-progress
01752731 workload automations and the Internal
server error NO lONger OCCurs.

Previously, the workload automation could not be
paused or stopped after the user who created the
automation was deleted from the Control Room.

12342 01181402, When you run your workload automations, you
01260706 no longer have to pause and then resume to run
the gueued bots that are stuck in the In progress
state.

12342 00790086 The incorrect Japanese translation for schedule
description of the daily and monthly frequency
fields for the Run repeatedly option (Manage >
Schedules > Schedule a bot) is now fixed. The
correct Japanese description is now available on
the Schedule a bot page.

12342 00852637 When you edit a bot schedule in the Control
Room, the schedule column on the Scheduled
page now displays the correct schedule date
instead of the previous day. Previously, for
example, if a bot was scheduled for 01-Oct-2021,
the Scheduled page displayed the schedule date
incorrectly as 30-Sep-2021.

12342 00821057, If a file is exported after the bot name and folder
01188160 path are changed, the bot name now reflects the
new name. Previously, the bot was exported with

the old name.

12342 01252294 You can now successfully import the zip files
in the zip64 format from the development
environment to the production environment.
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12342 - You can now run multiple queues without any
delay in between queues. Previously, when you
ran multiple queues, a delay of 5 to 15 minutes
sometimes occurred between queues.
12342 00800831, When you use the Export checked items to csv
00815411, option, the schedule data in a .csv file is now
00826054, saved correctly. Previously, when you exported
00826058 the schedule data to a csv file from the Control
Room Scheduled activity page, the file data was
saved incorrectly. For example, the schedule type
was saved as Recurring in the csv file instead of
One time.
12342 01754721, If the system locale setting is changed, the weekly
01753460, scheduled bots now run as scheduled from the
01767806 Control Room. Previously, when the system
01759361, locale setting was changed, the bots did not run
01763327, according to schedule.
01764201,
01767827, 1770574
12342 00714546, The Control Room can now integrate a Git
00759029, repository that rejects force push. Previously,
01257992 some security protocols rejected all force push
updates making the git integration incompatible
without a configuration for the force push flag.
You can now change the configuration of the Git
push from the Control Room to disable the force
push flag.

The following table lists the limitations identified in the current release:

Limitations

(Service Cloud case ID: 01765712) If a MetaBot Logic was using a DLL file that used classes
without namespaces, after migration, any Task Bot that uses the MetaBot Logic does not
work.

Workaround: Manually update the DLL file to include namespaces for classes.

If you created the Active Directory role mapping in previous releases, when you update to
Automation 360 v.24, some previously defined group mappings are deleted because the
Distinguished Name (DN) column of the mapping entries in the database contains empty
rows, with no values. Before you update to Automation 360 v.24, run a script to populate
the DN column. (Service Cloud case ID: 00751756)

For support on this issue, contact the support team: Open a support case (A-People login
required)
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The Bot Insight premigration utility encounters an error and closes when it detects
corrupted dashboard IDs in Bl tables. (Service Cloud case ID: 00796546)

Workaround: Download and install the latest Bot Insight premigration utility from the
Automation Anywhere Support site.

When you build bots by using drag actions from the Actions palette, the bot workflow
shifts to the right side in the Flow view.

Workaround:

*  When you create or edit a bot in the Bot editor, add new actions from the Actions
palette by double-clicking the action that you want to use.

For example, if you are editing a bot and you want to add an action after line 7, place
the insertion point after line 7, and then, from the Actions palette, double-click the
action that you want to add.

* |If you want to use the drag option, ensure that when you drag the actions, you move
them a little faster on the canvas.

(Service Cloud case ID: 01798098) When you update Automation 360 from a previous
release to this release on a Windows machine, you might see the following error message
about an invalid digital signature:

Error 1330: A file that is required cannot be installed because the
cabinet file
E:\AA\....\Datal.cab has an invalid digital signature.

Workaround: A360.24 Installation Failure "Error 1330 Invalid Digital Signature” (A-People
login required)

If the Automatically update all bot agents option is selected and if you update to this
release, some Bot Agent might fail to automatically update to the latest version.

Workaround:
1. Manually uninstall the existing version of the Bot Agent.

2. Install the latest version of the Bot Agent.

When you migrate Enterprise 11 bots with the Comment command enabled, the command
is disabled after migration. (Service Cloud case ID 01255723, 01252824, 01260677,
01608653)

When you log in as an administrator after migration and then start a bot migration, the
Audit Logs pane intermittently displays an unsuccessful message with a Bot Launcher
has crashed error.

When you migrate bots with system variables (such as date, month, or year) as an Export
Data to CSV option, a preprocessing error is displayed. (Service Cloud case ID 01755175)

When you update your Control Room from Automation 360 v.21 or v.22 to Automation
360 v.23 or v.24, the installation might fail because of schedule migration issues. (Service
Cloud case ID: 01376353, 01449535, 01713118, 01627144, 01762404)

Workaround: Open a support case (A-People login required).
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Administrators can export data, up to 100,000 entries, to a CSV file. Downloaded audit .csv
files are stored in the C: \Windows\TEMP\ folder in the On-Premises environment
temporarily. Files in this folder with names starting with cr-audit should not be deleted
for at least 90 days and can be downloaded from the Control Room.

See .Export audit data to CSV on page 1937

When you autoupdate the Bot Agent simultaneously on 500 to 1000 devices in the Control
Room (On-Premises), the autoupdate fails.

Workaround: Manually update the Bot Agent on a few devices at a time from the Control
Room Devices page.

In browsers such as Microsoft Edge (Chromium) and Mozilla Firefox, when the Bot Agent
installer file is downloaded, the download information is shown at the top-right corner
although the download arrow points to the bottom-left corner of the browser's taskbar.

The download arrow points to the correct direction only for the Google Chrome browser,
in which the download information is shown at the bottom-left corner of the browser's
taskbar.

For a Control Room installed on Linux operating system, the
AutomationAnywhereBotAgent.msi file is not available for download with the
Download installer option from the Control Room > Administration > Settings page.

Workaround: To install the Bot Agent, use the AutomationAnywhereBotAgent .msi

file from the <application filepath>\cruilasset folder of a Control Room (On-
Premises) installed on Windows operating system. For more information, see Sample steps
to create Bot Agent golden image (A-People login required).

In the Email package, when you use the HTML design option to create and customize
your email layout and body and then paste content copied from another source, such as
Outlook or Notepad++, the font style, size, and color are currently not retained for the
following actions:

« Send
e Reply
« Forward

When you create a bot using actions such as Send, Reply, or Forward from the Email
package, choose an option from Plain text, HTML design, or HTML code to format your
email body. When you switch between these tabs (Plain text, HTML design, or HTML
code), the previously set value in the message body is not retained, and the message body
is blank.
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* Nested IFrames are not supported in the Google Chrome and Microsoft Edge
Chromium browsers.

» Support to capture window authentication pop-ups is not available when automating
Google Chrome browser.

« After performing an action in an application or page, if a frame is added at run time to
the application or page, and if any pop-up windows, alert dialog boxes, confirmation
dialog boxes, or prompt dialog boxes appear on that frame, then the pop-up windows
and dialog boxes are not captured.

Workaround: Use the actions in the Image recognition package or the Mouse > Click
action instead to run the bot.

On computers where SystemLocale is set to a non-English language, when you open
multiple tabs in a browser, try to execute any action on a new tab that is currently inactive,
and run the bot, the inactive new tab does not become activated.

In Internet Explorer, to activate one among multiple web pages with no titles, only the fully
qualified domain names (FQDN) are compared. If pages that have no titles but have the
same FQDN are opened in Internet Explorer, any tab that matches the FQDN is activated.

In Internet Explorer, when you use the Close action to close a tab or a window, it is closed
only if it does not have an alert dialog box.

Note: An Internet Explorer tab or window with an alert dialog box is closed only when the
alert dialog box is closed manually.

When you use the Open action of the Excel advanced package to open files with .x1sm
extension that have charts, the bot fails with an error.

Workaround: Provide the Excel sheet name in the Specific sheet name field and then run
the bot. If there are any hidden sheets, unhide the specific sheet and make it as the active
sheet.

When you automate web applications running on Microsoft Edge Chromium with IE mode
or Internet Explorer, the Recorder sometimes fails to capture the object from the currently
selected browser tab and captures from the last used tab instead.

Workaround: Refresh the Bot editor and then start recording again.

When you use the Recorder to capture an object, select HTML Tag, HTML InnerText,
and HTML type properties in Search Criteria, or migrate a bot with similar properties
selected in Search Criteria, the bot might fail to identify or locate the object and perform
the selected action.

Workaround: Modify the DomXpath according to the controls you capture or add more
properties in Search Criteria.

When you use the Datetime package released with Automation 360 v.23 or earlier to
create a bot that uses the Datetime Assign action, then select the variable option to add
the variable value and try to run the bot with package released with Automation 360 v.24 or
later, the Ul shows a compilation error, and the user must select the variable value again.
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In the Recorder package, the Run in background option that enables an automation to run
in the background is not supported for applications running on Google Chrome, Microsoft
Edge, and Mozilla Firefox browsers for any of the Recorder actions.

The following table lists limitations from previous releases that are also applicable to this release:

Limitations from previous releases

When you migrate a bot that was using the Manage Window Controls action, the last
digit of the height value is not available after migration. However, the bot will execute
successfully. (Service Cloud Case ID: 01756996)

When an Excel session is active in SAP, a corresponding Excel process starts in the
background. In such a scenario, Automation 360 uses the same Excel process that SAP
started. When you run a bot to automate spreadsheet data, Automation 360 processes
the first request successfully. However, during execution, if the Excel is closed and a
subsequent request is sent for automating the spreadsheet data, Automation 360 does not
process the request because the Excel process is still being accessed by SAP. Therefore,
the correct window is not activated for automating the spreadsheet data. (Service Cloud
Case ID: 00815159)

If you are directly updating from Automation 360 On-Premises v.21 to this release, you
might face issues updating your Bot Agent on some Bot Runner machines in the following
scenarios:

« After a Control Room update, the device status keeps changing and the Bot Agent fails
to update automatically.

e |f the embedded resources file is missing, the Recorder does not recognize the user
interface elements or does not capture a single object in the Google Chrome browser.

Workaround: Before updating to this release, remove the following Bot Agent files and
folders:

e C:\Windows\System32\config\systemprofile\AppData\Local
\AutomationAnywhere\AA-DB.mv.db

e C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

For more information, see Bot agent auto update fails post the Control Room Upgrade
with ‘device.connection.lost’ (A-People login required) | The recorder is not able to
recognize the GUI elements in Google Chrome browser (A-People login required)

When you use the Terminal Emulator command with the Send Text action that contains
the LF key (Enter), the command might fail if the LF key is not supported by theTerminal
Emulator.

Workaround: Ensure that you replace the LF key with supported characters such as the
space character.

After migration, a user is able to delete an .atmx file even when the file is associated with a
schedule from the Automation 360 Control Room.
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Limitations from previous releases

If you configure an external key vault in External Key Vault Integration and select the
SQL authentication mode for database authentication in the Windows installer Database
Server page to install Control Room (On-Premises), the installation fails, and the following
error message is shown: Control Room database tables fail to create.

Workaround: Add the database credentials in the external key vault and use those
credentials for database configuration.

Newly created Control Room users on Windows for On-Premises Google Cloud Platform
VMs cannot change their password. The security questions option is not available on the
Change password screen and as a result the Control Room displays an error when they try
to save the password.

Workaround: Refresh the page and change the password again.

(Service Cloud case I1D: 01768545) Update status stuck as IN_PROGRESS during migration
from Enterprise 11 to Automation 360

When you migrate from Enterprise 11 to Automation 360, even if bot migration is
successful, Bot Insight does not update the status to the Control Room. Until version
11.3.2, the analytical flag was historically enabled by default, so all created bots are
identified as analytical bots. Some bots identified as analytical bots have no processed data
available to the Bot Insight dashboard. As a result, the migration status becomes stuck as
IN PROGRESS even if bot migration is successful.

When you try to automate any process in a Java application that uses version 11.0.8 of
AdoptOpendDK, the Recorder sometimes does not capture the drop-down elements on
the application.

Automation Co-Pilot (Automation Co-Pilot)

What's new

Microsoft Edge Chromium and Safari supported for Automation Co-Pilot

You can now create forms and processes in the Automation Workspace and run your
requests, tasks, and bots in the web interface on Microsoft Edge Chromium and Safari
browsers.

Browser requirements for Automation Workspace on page 1063

Create password fields and hide sensitive information (Service Cloud case ID: 00714159,
01063512)

In the Automation Workspace, you can now create password fields by using the Password
element in your form builder. You can use the Password element in the web interface to
add masked text to your password fields in the initial forms to hide sensitive information.

Configure processes in Process Composer on page 2971 | Password element properties
on page 2990
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What's new

Configure a scheduler user for each team

You can now access the Process page in the web interface to edit a process and assign a
scheduler user for each team. This ensures that the bots in the process are deployed on
the devices assigned to a team and that these devices are not used by another team. The
Team scheduler user is set by default, but if a scheduler user is undefined, then the Process
scheduler user is selected. The Global scheduler user will be selected only if the Team or
Process scheduler users are not selected.

Assign a scheduler user to a process on page 2968

Configure scheduler deployment type (Service Cloud case ID: 00814885, 01276257)

You can now configure the scheduler deployment type for bot tasks in your process setup
and determine how the bots in the process will be deployed. You can define the mapping

between run-as user and the device that helps take care of constraints, such as credential

constraints that require one-to-one mapping between the run-as user and the device.

Configure deployment type for bots on page 2970

Reference ID enhancement to requests

You can now view the reference ID associated with your process in the Reference
column of the Requests page. The reference ID is a combination of a prefix and a number
that is created from a Process Key that you can enter when you edit your process for

the first time. This reference ID is incremented whenever a request is created from the
corresponding process.

Reference ID properties on page 3013 | Configure a process on page 3031

Reqguest retention settings

When you edit a process, you now have the option to set when your completed requests
are moved from the Requests page to the Recycle bin. With this feature, you can avoid
manually moving completed requests individually to the Recycle bin. You can choose to
disable the settings to move completed requests to the Recycle bin. You can also set the
number of days after which requests are deleted from the Recycle bin.

Configure a process on page 3031

Default team assigned to process

You can now edit a process to display the default team that the process is assigned to in
the Default team field. The first team that a process is assigned to is automatically set as
the default team. With this feature, you can view the default team that a process is assigned
to without viewing each individual team.

Configure a process on page 3031

View status of queued bots

You can now view the status of your bots that are queued and are not actively running. The
request view page now shows the In Queued label next to your queued bots that are not
active.
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What's new

Cancelled status for tasks

You can now filter tasks by the Cancelled status in the Tasks page. This status will show a
Cancelled label next to the filtered results to inform you of the tasks that were cancelled by
a user. You can filter by this status from the drop-down menu in the status bar.

Filter and search for a task on page 3026

Fill initial form elements by URL parameters

When you create a request, you can now fill initial form elements by creating query scripts
that enter specific parameters in the initial form URL. These parameters are applicable only
for Date, Number, Text Box, and Time elements.

URL parameters on page 2989

Storage service enhancement (Service Cloud case ID: 00768394)

As a tenant admin, you can now set a configuration option to block upload of executable
files to prevent a security breach. You can block the upload of files with the following
extensions: .acm, .ax, .cpl, .dll, .drv, .efi, .exe, .mui, .ocx, .scr, .sys, and .tsp.

Run virtual window in bot configuration

If you are an Automation Co-Pilot Admin, you can configure bots in the Bots page and
enable the Run your bot in virtual window option. With this option, an attended user in
Automation Co-Pilot Desktop Assistant can run bots in a virtual window without losing their
user experience.

Configure a bot on page 3030

Add rules to Button element
You can now add rules to the Button element.

Using the Button element on page 2925

Customize text in forms using updates to Label element

You can now customize the text in your forms in various ways, such as applying bold, italic,
underline, and other formatting effects, changing the font size and color, and so on, by
using the Label element. With these options, you can highlight specific messages or texts,
such as next steps, warnings, or errors, when they are rendered in the initial form in the
web interface.

The Label element now provides the following formatting options:

*  Emphasis

« Font color

* Fontsize

+ Text alignment

Using the Label element on page 2930
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What's new

Search and filter columns in a table

On the form builder screen, if you select the Enable column filtering check box for the
Table element, users can search and filter the content for all the available columns when
the bot is running.

When you use the Table element to render a table in your initial forms, you now have the
enhanced ability to search each column of your table by value.

Using the Table element on page 2936

Additional options for rules

With additional options included for rules in the form builder, you can now perform the
following:

» Find a rule but using the search bar. In the search bar, enter the name of the rule or the
element label that is associated with any condition or action in the rule.

« Create a copy of a rule by using the Duplicate rule option.
* For multiple rules, you can use the following options to rearrange the order in which
these rules are executed at bot run time:

« Move up

« Move down

« Move to top

+ Move to bottom

Add rules to form elements on page 2939

Apply an action to multiple elements

If you are adding or editing a rule, when you are adding an action, you can now apply an
action to more than one element by selecting multiple elements in the Then menu.

Additional If conditions for some elements

When you are creating or editing a rule, you can now select additional If conditions for the
following elements:

« Dropdown

e Checkbox

* Radio Button
« Date

e Time

« Hyperlink

Use Assign for updating the value of the Dropdown element

When you are adding a rule, if you select the Dropdown element as an action item from
the Then menu, you can now use the Assign drop-down menu to append or overwrite
values when the bot is running.

Add rules to form elements on page 2939
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What's new

Elements in If condition are available in Then action

All the elements that are used as part of the If condition are now available as part of Then
action.

Multiple lines supported for Text Area and Rich Text Editor

Text across multiple lines is now supported for Text Area and Rich Text Editor elements
within If and Then options.

Add rules to form elements on page 2939

What's changed

Enhancements to importing process to public folder

When you import your process to a public folder, the process is now automatically
published in Automation Co-Pilot. Previously, you were required to check in the imported
processes in the private repository and then check in the process again for it to be
published in Automation Co-Pilot.

Import a process on page 2985 | Import process dependencies on page 2986

Process page layout updated

The layout of the Process page has now been updated to be consistent with the Bot and
Team pages. The changes include columns for reference ID, key, name, description, tags,
and teams. You can now filter your results in the search bar for faster sort and quickly
reference the current global scheduler user on the page.

Active bot status

In the request view page, you can now view the exact status of your bots by referring to
the In Progress label next to your active bots that are currently running. Previously, the In
Progress label showed both active bots and queued bots that were not running.

Reference to replace Request ID in Automation Co-Pilot on the web

» You can now filter or query your requests in the Requests and Recycle bin tabs and
tasks in the Tasks tab (Table View and Detail View) using the new Reference instead of
the Request ID.

* The Requests, Team, Process, and Bots URL is now changed to entity/ref/:ref
fromentity/:1id. If you open any request using Request ID, the URL now redirects
using Reference. For example, consider the Request ID as 896 and Reference as 2-34
for a request. If you view the request using the Request ID (/aari/#/requests/
all#/requests/896), the URL will redirect using the Reference (/aari/#/
requests/all#/requests/ref/2-34).

Reference is a unique key that helps you identify your related processes and requests in the
Requests, Team, Process, and Bot pages. Reference is easier to use and more meaningful
than Request ID as it provides a logical sequence of referential number incremented per
tenant. Reference is unique within a tenant, but it can be the same for two tenants.

Reference ID properties on page 3013
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The following table lists fixes alongside the build in which each issue was fixed. Build 12350 is the
latest build and includes fixes from the previous builds.

Fixes
Build Service Cloud case  Description
ID
12350 01788376 You can now launch AARI using the Bot Agent
(version 21.133) connection without errors.
12350 01803979 If you have Control Room configured with

SAML and you click the AARI icon on the
Windows Desktop, you are now redirected to the
Automation Co-Pilot Desktop Assistant web page
instead of the Control Room home page.

12342 01759135 When you use the Date element and select
the Use the local system date when this form
is loaded option, the date is now correctly
displayed, with the local system date.

12342 01766579 If you are a Bot Creator, after creating a request
using your Automation Co-Pilot process, you can
now submit the initial form and complete tasks
without being stuck on the request view page.

12342 - For Automation Workspace with SDS setup, when
you enter data or upload files in your initial forms
after selecting a process to run the request, you
no longer encounter an exception error message.

12342 - When you use the Checkbox element to create a
CheckBoxGroup in your form and set form rules
and conditions for each box in this group (C1,
C2, C3, and so on), the selections now function
properly in the initial form as defined your form
rules.

12342 - If you are a Bot Creator and an Automation Co-
Pilot manager, you no longer encounter an error
when you run a bot by using the Team Members
action from the AARI Web package to access
teams.

12342 - If you are a member of a team by role (that is,
if you were first added to a role in the Control
Room and the role was then synced to a team),
you will now be able to view updated information
for your requests and tasks. The page now
automatically refreshes the latest request and task
details.
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Fixes

Build Service Cloud case  Description
ID

12342 - In the web interface, when tasks are completed
in the request view, and you confirm by clicking
Finish, Cancel, or any other primary or secondary
option, these types of events are now captured in
the Audit log history in Automation Workspace,
as an Automation Co-Pilot Human Task type of
event.

12342 - In Linux environment, you can now use the file
upload functionality of Automation Co-Pilot on
the web without any issues. Previously, the file
upload functionality failed with an access denied
error because the filestorage directory was
not automatically created to store the files.

12342 - The Edit button no longer appears enabled for
processes that are checked in, checked out, or
cloned. Previously, you could edit the names of
processes that were checked in, checked out, or
cloned although the changes were not saved.

12342 -- For any element in a form, if you use the Mark
field uneditable option on the form builder or
disable it when you run the associated bot, form
validations applied to that element are overruled.

Limitations

In some scenarios, when you launch a bot that was configured to run in a virtual window,
the virtual window starts and you are prompted to log into the window with your
credentials.

Workaround: Reboot your system and launch the bot again.

When you a design a form, you can create references for hidden elements by using the
Hidden elements option from the form properties. However, after you have designed the
form, you cannot view or change the variables among hidden elements.

After you design a form with a drop-down rule assigned to your form, if you view the drop-
down in read-only mode, you will not be able to view the changed data in read-only mode.

If you have Select file element in the form, then you cannot upload a file that has special
characters (such as, () & ; - =) in the filename when you run the bot.

In the web interface, when you are on a page other than the main page and your login
session disconnects and returns you to the login page again, the next= parameter is shown
in the URL indefinitely. This can be an issue as the next= parameter is used to redirect the
URL to a previous page but is currently not supported.

For the Text Box element, the Does not contain form rule is not working.

For the Rich Text Editor element, the Contains form rule is not working.
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Limitations

For the Table element, the Rows before scrolling option can support only up to four rows.
If you specify five or more rows, this option is not supported and you must scroll instead.

If you create a form with the Document and Dropdown elements, when you attempt to
submit this form, an error occurs. This error is due to the dynamic form schema, such as a
drop-down field filled by a process that is present in the form with the document field and
causes an error.

Discovery Bot

What's new

Save the recording with a name

After recording a process, you can now save the recording with a name. The name of the
recording is displayed on the Recordings page for that process.

Record a Discovery Bot business process on page 3365

Share a description of the recording

You can now provide a description for a recording of a process by using the Recordings
page for that process. In the Recordings page, use the Description field to share the
context and the purpose of the recording with the analyst. The description provided is also
displayed in the PDD.

Record a Discovery Bot business process on page 3365

Delete a recording

After you record a process, if you do not want to submit the recording data to an analyst
for review, you can delete the recording by using the Recordings page for that process. In
the Recordings page, use the Delete option to delete the recording.

Record a Discovery Bot business process on page 3365

Record business processes using Automation Co-Pilot Desktop Assistant

You can now use Automation Co-Pilot Desktop Assistant to record business processes
without signing in to the Control Room. To record a business process, start Automation
Co-Pilot Desktop Assistant by double-clicking the Automation Co-Pilot icon on your
desktop.

Record a Discovery Bot process using Automation Co-Pilot Desktop Assistant on page
3369

Enhancements to custom opportunities

You can now update the potential cost and savings for custom opportunities and save your
changes to the process diagram. The potential cost and potential savings can be updated
at any time as you review the steps from various recordings and make changes within the
process diagram.

Review opportunities, convert to bot, and generate PDD on page 3371
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What's new

Enhancement to PDD

You can now view the entire process diagram from within Discovery Bot by clicking the

URL link provided in the PDD. The PDD does not display the process diagram if more than

100 steps are selected.

Review opportunities, convert to bot, and generate PDD on page 3371

What's changed

The process discovery document (PDD) now displays Chinese Unicode characters in both

Word format and PDF.

Fixes

Service Cloud case ID Description

- Cloud users: When you capture more than 250 steps, you
can now create a customized opportunity for automation and
generate a PDD.

- You can now download a PDD for custom opportunities and
recordings without any issue. Previously, an error occurred
intermittently and the following error message was displayed:
Error generating PDD

- An error message is now displayed when you cannot connect
to the Control Room. For example, this occurs when a signed
or wildcard certificate is used for the Control Room setup
for On-Premises deployments and you have not pre-installed
the certificate. The Processes page fails to load. Follow the
instructions in the message to connect to the Control Room.

00829246 Cloud users: You can now download a PDD for an automation
opportunity with 200 or more steps. Previously, when you
created an opportunity with 200 or more steps, clicking
Download PDD returned an error.

- For autogenerated and custom opportunities, the Recordings
table now works as expected. Previously, it encountered an error
intermittently.

00827381 When you search for the Recorder package in the Japanese Ul,
you can now view the correct package name for the Recorder.

The following table lists the limitations identified in the current release:
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Limitations

In rare situations when a device CPU is busy, the recording screenshot might not be
captured from the Recordings page for a process. However, user actions, such as text
selection, are displayed on the Recordings page.

The following table lists limitations from previous releases that are also applicable to this release:

Limitations from previous releases

When you add branches to the left and right sides of a main branch, the Recording flow
chart section of the PDD might not capture the entire process workflow, including all the
branches.

Feature deprecation for Discovery Bot

Review the deprecated feature to understand how it can impact your automation.

Discovery Bot red highlight

In the recording session, the red outline that highlights when you move the mouse over
the area to capture the action has been deprecated as of June 2021. The red outline

is displayed in the screenshot images when you review your captured steps from the
Recordings page.

IQ Bot

What's new

Document Automation limited availability release

A select group of early adopters can now use Document Automation to automate
processing business documents in the new Automation Anywhere Cloud-native intelligent
document processing solution.

Document Automation is integrated into the Control Room. When you create a learning
instance, 1Q Bot automatically creates RPA bots to extract and download the data and
an Automation Co-Pilot process to manage the entire process. Learning instances do
not require training. Instead, Document Automation uses pre-trained models to process
invoices and receipts.

Document Automation on page 3142 | Intelligent Document Processing solutions feature
comparison matrix on page 3150

Total number of pages uploaded for Process Documents action

In Automation 360 IQ Bot, when you use the Process documents action from the IQ Bot
Extraction package to process documents, you can now view the total number of pages
uploaded displayed under Dashboards > My totals

Using 1Q Bot Process documents action on page 2431
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What's new

Role-based access control (RBAC) available

Automation 360 1Q Bot now offers role-based access control (RBAC). You can use RBAC to
handle the following user permissions:

« Edit learning instance

e Delete learning instance

« Send learning instance to production
e |mport domain

Defining a custom role for IQ Bot on page 3213

Rotate encryption key as AAE_IQ Bot Admin

With the AAE_IQ Bot Admin role, you can now rotate the encryption key by changing the
object name in the new Administration > Key rotation page.

Rotate the external key on page 3265

New model for Cognitive MLWeb Service

In On-Premises installations of Automation 360 |Q Bot, you can now achieve improved
check box and table detection when you use the new model of the Cognitive MLWeb
Service.

What's changed

For on-premises installations of 1Q Bot, the MLScheduler Service in the Microsoft Windows
services window is now disabled, by default, to free up system resources.

Fixes

Service Cloud case ID Description

00764550, 00765854 When you migrate from Enterprise 11 to Automation 360,
any learning instance with custom domain that has Chinese
language fields is now displayed correctly. Previously, these
fields were populated with incorrect values in place of Chinese
characters.

00758208, 00632965,  The MLScheduler service is now disabled on 1Q Bot On-

00727063, 00715124, Premises, and the system no longer slows down or stops

00828988, 01251514 responding. Previously, the autocorrection and autosuggestion
features, which are part of the MLScheduler service, used
system resources extensively and caused the system to slow
down or stop responding.

01757917 Documents are now successfully classified using Microsoft
Azure 3.2 OCR. Previously, due to deprecation of the Microsoft
Azure preview OCR v3.2-preview.2, the documents remained
unclassified.
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Fixes

Service Cloud case ID

Description

Documents extracted using the Auto Extract command are
now successfully processed. Previously, when documents were
extracted using the Auto Extract command, validations from the
default validation group were not applied to them.

01261531

When you create a learning instance and use the 1Q Bot

upload command, the display is now stable, without any issues.
Previously, this caused resizing and toggling between larger and
smaller fonts, making the display flicker.

To manually create a group, you require only the IQBot_admin
role now. Previously, to manually create a group, you required
both the aae_basic and IQBot_admin roles.

In the 1Q Bot Ul, for groups that were created manually, you can
now see the Group label in its entirety. Previously, you could see
only a part of the Group label.

Documents whose file names begin with a special character,
such as a hyphen (-), are now properly classified and processed.
Previously, such documents were held up in the classification
queue or remained unprocessed.

01063054

You can now import a learning instance that has a lengthy name,
with more than 50 characters, without any errors because the
Label field now supports more than 50 characters.

For a standard forms learning instance, if you upload a
document that contains a table with an empty cell, the
document is now sent to 1Q Bot Validator. Previously,
documents with empty table cells were sent to the Failed folder.

An error no longer occurs when you run a bot that contains
actions from 1Q Bot Pre-processor, |Q Bot Classifier and OCR
packages. Previously, in such cases, an ‘Assertion failed’ error
occurred.

01777853

You can now create standard forms learning instances using
pretrained models that have long field names (up to 250
characters). Previously, pretrained models that had lengthy field
names caused an error.

Limitations

When you upload vector PDF documents to a new learning instance, a few documents are
identified as unclassified. Alternatively, if you convert the documents from PDF to TIFF and
upload them, the documents are processed successfully.

When you are running |Q Bot using service account credentials, if the password contains a
space, |Q Bot logs will not be updated.
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Limitations

In some cases, even if the correct number or amount is accurately reflected, some
documents still fail the validation rule because of a round-off error and are sent for manual
validation.

In formulas, if you use delimiters, such as commas or periods as thousand separators,
formula validation fails.

Workaround

« For English language: Remove all delimiters, such as commas used as thousand
separator.

« For other European languages: Remove all delimiters, such as periods used as thousand
separator. Use the English number convention for formula validations.

If you use the ABBYY FineReader Engine version 12.4 instead of version 12.2, the MICR
feature does not support data extraction from documents in Japanese language.

After you back up the databases and run the DB Migration Assistant tool, the tool and the
logs indicate that migration is successfully completed even if the unified database is not
created.

Workaround: Ensure that you install both the x86 and x64 versions of the Microsoft Visual
C++ 2015-2019 Redistributable package.

Bot Insight

What's changed

startDateTime data now in standard format

When you export data to Microsoft Excel, the date format will be exported based on the
date format of the widget.

Fixes

Service Cloud case ID Description

- Now when you are using a proxy network, when you click
Analyze, the network dashboard generates an analysis.
Previously, this dashboard did not generate an analysis.

- When you run a bot that was checked in to a public folder and
then checked out into a private folder, the last refreshed date is
now displayed accurately. Previously, the last refreshed date was
displayed as invalid.

01252869, 01259449 The Business Dashboard is now visible to users assigned the Bl
Admin Role and Bl User License. Previously, users with this role
and license were not able to access this dashboard.
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Limitations

Cannot drill down for data used in group by duration

When Group By is selected as duration (time/date) in the widget, the drill down is
applicable only to a single level. If you try to drill down for data at the second level or
further, you might encounter the following error: No data found.

(Service Cloud case ID: 00777595) When you attempt to refresh the data in a Microsoft
Excel worksheet, an authentication error can occur from multiple simultaneous attempts
through open windows and tabs.

Workaround

1. Inthe Power Bl desktop application, navigate to File > Options and settings >
Options.

2. From the Current File section, select Data Load.

Note: Do not select Data Load from the Global section.

3. Disable the check box Enable parallel loading of tables.

Automation 360 v.23 Release Notes

Release date: 30 December 2021

Review what's new and changed, and the fixes and limitations in the Automation 360 v.23 (Build
11513) release. Build 11513 replaces Builds 11499 and 11486.

Important:

This build includes the Apache Log4j2 library version 2.17.1 to address the exposure to
CVE-2021-44832, CVE-2021-45105, CVE-2021-44228, and CVE-2021-45046 vulnerabilities.

Though the command packages are not upgraded to Apache Log4j2 library version 2.17.1, the
Bot Agent is upgraded to Apache Log4j2 library version 2.17.1. At runtime, the packages will use
Apache Log4j2 library version 2.17.1 through the Bot Agent and hence will not be exposed. As
an additional security measure, the Automation 360 v.23 Bot Agent installer also disables the
Apache Log4j2 library look-up feature by default.

Third-party security scans might find traces of earlier versions of the Apache Log4j2 library.
However, with the upgrade to Automation 360 v.23 and the mitigation in place, there will

be no exposure to vulnerabilities. For more information, see FAQs related to Automation
Anywhere Releases regarding zero-day vulnerabilities (CVE-2021-44228, CVE-2021-45046) (A-
People login required).

This build also includes fixes for the following issues:

*  When you update from Automation 360 v.22 to v.23, background jobs related to cloud
license server sync-ups were deleted because of incorrect license job name.

e When you install or update to Automation 360 v.23 for On-Premises deployments, log files
were not updated for a few additional services.
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« If you did not have the View Package permission, bot deployments failed when you
scheduled or ran a bot.

« Migration

11xand 10.x | 11.x only
» Automation Workspace

What's new | What's changed | Fixes | Security fixes | Limitations
» Automation Co-Pilot

What's new | What's changed | Fixes| Limitations
» Discovery Bot

What's new | Fixes | Limitations | Feature Deprecation

+ 1Q Bot
What's new | What's changed | Fixes| Limitations
« Bot Insight

What's changed | Fixes | Limitations

Updating to this release

The updated Build 11513 for Automation 360 v.23 includes Log4j2 library version 2.17.1 and fixes.
If you are on the previous v.23 Build 11499 (with Log4j2 library version 2.17.0) or Build 11486 (with
Log4j2 library version 2.16.0), update to Build 11513 for the updated Log4j2 library version and the
fixes.

You can also update to Automation 360 v.23 from the previous three releases (that is, from n-3
releases, where n refers to the latest release). The following previous releases are certified for
update to this release:

» Vv.22 (Build 10526)
e v.21 (Builds 9664, 9642, 9595)
e v.20 (Build 8815)

You can directly update to v.23 from any of these builds (see Update Automation 360 to latest
version on page 1266). If you are not on an n—-3 release, update Automation 360 to one of the
three certified releases (listed previously) before updating to this release.

If you are directly updating to this release from Automation 360 On-Premises v.20 or v.21, remove
the following Bot Agent files and folders:

e C:\Windows\System32\config\systemprofile\AppData\Local
\AutomationAnywhere\AA-DB.mv.db

e C:\ProgrambData\AutomationAnywhere\GlobalCache\embedded-resources

Important: To use the new features in v.23 (including updates to Recorder packages) and for the
Log4j2 vulnerability fix, update the Bot Agent for this release. Note that the Bot Agent update from
the previous release is not required if you want to run your existing bots as Bot Runners.

For information on updating to this release, see these resources:
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« Automatically update the Bot Agent on page 1207 | Manually update the Bot Agent on page
1209
« Compatibility with release builds on page 1182

For the latest updates to the Automation 360 extensions for Google Chrome, Microsoft Edge, and
Mozilla Firefox, see Browser extensions for Automation 360 on page 852.

Migration features

Enterprise 11 and Enterprise 10 features

MetaBots containing linked objects

Migrate MetaBots that contain a text play type linked object that is linked with the object
play mode object, an image play type linked object linked with the image play type object,
and a coordinate play type linked object linked with the coordinate play type object.

Migrate bots with the following attributes:

» Bots with variables that contain data larger than 64 KB ( Service Cloud case ID:
00716311,00756449,00819149)

The migration process stores the data in a text file. The text file is uploaded to the Cloud
Control Room and is used in the migrated bot.

« MetaBots with DLLs that return list and array type values with any delimiters
combination and store these values in the clipboard

e You can now migrate MetaBots with image play mode that use the action GetVisibility

e You can now migrate bots with the GetSelectedindex and GetSelectedText actions
for the Ul Automation technology used in the Object Cloning command and MetaBot
screens.

* You can now migrate bots which automate applications with Java technology Type
using the Object Cloning command with the action GetDataofAllchildren.

Bots with different variable casing

When you migrate a bot that has passed a variable from a Task Bot to a MetaBot Logic or
from a MetaBot Logic to a Task Bot and if the casing of the variable name is modified in the
MetaBot Logic, the migration process updates the variable name with the same casing as
that of the bot corresponding to the migrated MetaBot Logic in the parent Task Bot.

Migrate bots with locator image (Service Cloud case ID: 00754508, 00776192)

You can now migrate bots that contain images that are captured using the Object Cloning
command.

MetaBots as dependencies are not downloaded

The migration process does not download MetaBots that are available as dependencies.
This restriction is to avoid downloading MetaBots and creating multiple copies of the same
MetaBots because they are already available in the Control Room repository.
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Enterprise 11 and Enterprise 10 features

New action in Legacy Automation package for migration (Service Cloud case ID:
00797140, 00849161)

Use the Get keystrokes delay action to match the duration of delay defined in Enterprise
11 bots for the Insert keystrokes command and simulate the same value in Automation
360 for the Simulate keystrokes action.

Notification about bots with issues in Bot Scanner report

The Bot Scanner report now flags Enterprise 11 or Enterprise 10 bots that have issues and
therefore require action or review. For example, bots that have security issues or bots that
refer to non-existent variables are flagged with an icon in the action or review message.

Improved validation of migrated bots

« Additional compile time validations are now available to validate a bot at run-time. For
example, if a parent bot calls a child bot and the child bot has compilation errors, these
errors are displayed when you try to run the parent bot. This ensures that an error does
not occur in the middle of an automation or make it an incomplete automation.

This feature enables you to proactively identify all migrated bots that have compilation
errors. Migrated bots with compilation errors are shown in Successful with Review
section of the Migration Report and ensures that you can get a list of bots that require
your attention.

To enable the bot validation feature, navigate to Administration > Settings > Bots >
Bot validation and set it to On. See Settings on page 1629.

» The Bot Migration Wizard now displays validation error details for each bot in the bot
migration results. Details about the errors help you to review and take action on the
migrated bots, thereby saving time.

Migrate Enterprise bots on page 1431

Enhanced bot migration assistant

The migration assistant is now merged with the error assistant to provide a comprehensive
view of all the lines in a bot that require review or action by you, or which have errors in
these and therefore require you to address them. This feature helps you to quickly identify
the areas of bots that require your attention.

Support for 32-bit driver to connect database (Service Cloud case ID: 00757466)

To enable migration of Enterprise 11 bots with VBScript, 32-bit drivers are now supported in
Automation 360 to connect the database.
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Enterprise 11 only features

Migrate bots with the following attributes:

* Bots that include images that are captured using the Object Cloning command, OCR >
Capture area command, App Integration > Capture area command, and Mouse click
action.

« Bots that contain an HTML email body with local image references if the referenced
images are available on the Bot Runner machine (Service cloud case ID: 00780065,
00790657, 00827527, 00822092, 00928116, 01181845)

» Bots that contain Microsoft Excel commands with file extensions such as .ods, .htm,
.html, .mht, .mhtml, .slk, and .pdf to open an Excel file (Service Cloud case ID:
00799071)

* MetaBots that use the credential variable of non-string type to pass a numeric value as
an input to a DLL function

Automation Workspace

What's new

Enhanced administrator capabilitiesProperly licensed Automation Anywhere Control Room
administrators can now create valid RPA users based on authentication with username
and password and select not to require live authentication via email response. This feature
enables administrators to resend "Welcome" authentication emails without having to reset
the credentials assigned to RPA users.

Microsoft Edge (Chromium) supported for Control Room and Bot Agent

You can now perform Control Room operations, and install and register your Bot Agent
device using the Microsoft Edge based on Chromium browser.

Browser requirements for Automation Workspace on page 1063

Support for Azure Key Vault

Automation 360 now supports Azure Key Vault, and you can now retrieve the following
from the external key vault:

» Active Directory (AD), services account, and SMTP credentials
» Auto-login credentials
« Credentials by automations

Bot Validation

Bot validation check happens for new bots and when you run a bot. Control Room
administrators can now turn the Bot Validation feature on or off. By default, this feature is
turned off for every Control Room.

Migrate Enterprise bots on page 1431
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What's new

Credential Vault variable supported in Run function action of the DLL package

As a Bot Creator, you can now use the Credential Vault variable or credential type variable
for the Number data type and pass it as an input parameter in the DLL function.

Using the Run function action on page 2229

File ID supported in Check permission action of Google Drive package (Service Cloud case
ID: 00777716)

The Check permission action of the Google Drive package now supports the File ID
option to refer to files available in the Shared with me folder of Google Drive. By
providing the File ID, you can now verify the Read, Write, or Delete access granted to you
in the Shared with me folder of the Google Drive files.

Google Drive package on page 2364

New Credential package

You can now use the Assign action in the Credential package to assign an insecure string
or a variable directly to the credential variable.

Credential package on page 2174

Web Services security supported in SOAP Web Service package (Service Cloud case ID:
00481836)

As a Bot Creator, you can now provide credential variables in the raw data of the SOAP
Web service action. You can create a credential variable, map the credential with a
reference name in the credential mapper, and use the reference name in the raw data.
Because this ensures that all security-related data can be defined in the Credential Vault
and the credentials can be used in bots, you can safely deploy tasks without compromising
security.

Example of using the SOAP web service action on page 2826

New option in SOAP Web Service package

Use the Build Xpath option in the SOAP Web Service package to extract values from the
SOAP response. You can now specify the Xpath expression or select the appropriate node
from the response body and store the output in a variable.

Outlook server supported in Change status, Save email, and Delete actions (Service Cloud
case ID: 00544534, 00557623, 00642506, 00659724, 00763565, 00680801, 00803975,
00818304, 00819362)

In the Email package, to automate a task you can now establish a connection with the
Outlook server for the Change status, Save email, and Delete actions.

Read email from shared mailbox in Microsoft Outlook (Service Cloud case ID: 00728579,
00831622)

To automate email-related tasks, you can now select a shared account in Microsoft
Outlook so that email messages can be read from the shared mailbox.
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What's new

New encoding types supported in the Write to file action of Data Table package (Service
Cloud case ID: 00767158)

When you use the Write to file action to write data from a Table type variable to a CSV or
TXT file, you can now use the following encoding types from the encoding list:

e UTF-8: Works as UTF-8 without BOM

e UTF-8 with BOM (called UTF-8 previously)
« UTF-16LE

Shift-JIS (Japanese encoding)

Auto-save functionality in Bot editor

In the Bot editor, when you use actions to build an automation, when a bot is not manually
saved, an auto-save is performed and the bot now automatically saves the changes for
specific events.

Note: The auto-save functionality is currently available only for specific events.

Some of the events that support auto-save functionality are as follows:

* Recorder: When you create a bot with certain actions and click Recorder, the event is
saved, and when the recording is complete, the event is automatically saved.

* Variable manager: When you create or edit a variable to insert it in an action, the
changes are saved.

Note: The auto-save functionality is not supported when you delete a variable or insert
it by pressing F2 to open the variable list.

» Actions menu (vertical ellipsis): When you select any action from this menu, for
example Packages, the event is saved automatically. When you make any change to the
Packages page and return to the Bot editor, the event is saved.

* Find a file: When you click the Find a file icon, the bot is saved if it is not manually
saved. Also, after you click the Add option, the bot is automatically saved.

» Dialog boxes: When a dialog box is opened, it is automatically saved if any changes are
made.

Note: Auto-save is triggered only for top-level dialog boxes and not for nested dialog
boxes.

e Deleting variables: When you delete unused variables, the event is saved.
* Bot name change: If you edit the name of a bot, the event is saved.

New option in FTP / SFTP package (Service Cloud case ID: 00792346)

Use the Credential option when you connect with the Secure FTP server type to automate
a task. You can now use username and password for authentication.

Connect action on page 2331
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What's new

Enhancement to AlSense Recorder

AlSense Recorder now supports automation of applications that use Brazilian-Portuguese
and a combination of Brazilian-Portuguese and English interfaces.

AlSense for recording tasks from remote applications on page 1998

Support for Capture anchor in AlSense Recorder

The AlSense Recorder now supports the Capture Anchor option. When you run a bot to
search for an object in an application in which the anchor changes frequently, you can use
Capture anchor to override the default anchor and manually select an anchor to detect
the object.

Edit a task recorded using AlSense on page 2001

Enhanced support when selecting Object property in Recorder package

After you capture an object using the Recorder > Capture action, you can now select a
particular object property name from the list of available properties in order to retrieve the
value of the object property using the Get property action. The list includes suggested
property names from the search criteria in the Object Properties table.

Recorder package on page 2564

Enhancements to Number package

¢ In the Random action of the Number package, you can now specify and limit the
number of decimal digits required in the random number generated in the output.

» The existing Save the outcome to a number variable field is now renamed as Save the
outcome to a variable.

Number package on page 2472

Enhancements to Wait package

Use the new Capture region feature in the Wait for screen change action of the Wait
package to capture a specific region on an application by drawing a rectangle around it
so that the bot automatically captures the coordinates of this region. You can perform the
following actions:

» Capture a specific region on a Windows application.
e Preview the captured image in the Preview window.
» Recapture a region if the image in the Preview window is not per user requirement.

The coordinates are renamed as follows:

e Leftisnow X

e TopisnowY

* Rightis now Width

* Bottom is now Height

Using Wait for screen change action on page 2762
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What's new

Enhancement to String package

In the Extract text action of the String package, you can now extract a substring from a
specified source string that occurs more than 1000 times in a file and up to a maximum
limit of 999999.

Enhancement to File conditions in If package

You can now use the new File extension condition from the Condition list in the If
package to check the extensions of files and then execute actions based on the results.

Support for cross-domain IFrames in Google Chrome and Microsoft Edge Chromium
browsers (Service Cloud case ID: 00825656)

You can now capture and automate objects inside a cross-domain IFrame in Google
Chrome and Microsoft Edge Chromium browsers by using Recorder > Capture or the
Start recording option. After you capture an object inside a cross-domain IFrame, the path
to the frame is stored in the FrameDOMXPath property, by default.

The new FrameDOMXPath property identifies the path to the frame in which the object is
located. You must select this property to run the bot successfully to capture objects on a
cross-domain IFrame.

Note: This feature is available for the bots you create using the 2.4.0-20211016-070100
version of the Recorder package starting from this release.

Recorder package on page 2564

Support to automate Microsoft Edge Chromium with Internet Explorer compatibility mode
(Service Cloud case ID: 00767502, 00787186)

You can now automate web applications running on Microsoft Edge Chromium, by
enabling the Internet Explorer compatibility mode, using the Universal Recorder where the
objects are captured using HTML technology.

Record a task with the Universal Recorder on page 1982

Global session support for loop iterator based on Excel advanced

You can now use the Global session option when you loop through each row in an Excel
advanced worksheet. Use the Global session option to share a Microsoft Excel session
across multiple bots so that you can use the same Excel worksheet across these bots.

Using the Open action for Excel advanced on page 2285

Enhancement to Excel advanced package (Service Cloud case ID: 00799071)

Use the Open action of the Excel advanced package to open files with .ods, .htm, .html,
.mht, .mhtml, .slk, and .pdf extensions.

Excel advanced package on page 2279
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What's new

Check out a specific version of a bot

To edit a bot in the Control Room Automation page, when you check out a bot from the
Public to a Private workspace, you can now choose a specific version of the bot along
with its dependencies by using the new Advanced options.

Check out a single bot on page 2031

New APIs for devices

You can now allocate default devices by using the new APIs introduced in the v1/
Devices section. Choose to set or not set a specific device as the default deployment
device for a specified user by using the following APIs respectively:

e /runasusers/default
e /runasusers/default/unset

Configurable API-key validity (Service Cloud case ID: 00763420)

You can now configure the validity of the API-key using the API-Key Duration feature
available in the Administration > Setting > Security Configuration in Automation 360. You
can set validity minimum of 1 minute or maximum of 45 days.

Bot version comparison

You can now compare various versions of the bots in your public workspace. You can

use the Compare versions option to select two versions of a bot and compare them for
differences, and any modifications in your work flow are highlighted for your reference.
You can also view the differences in the actions, packages, triggers, and variables between
the versions.

Compare bot versions on page 2039

Production label support in bot development work flow

You can now assign a Production label to a particular version of a bot. After you assign
a label, you can run or export bots with a bot version of your choice. You can select
the version associated with a production label to schedule, run, queue, and trigger bot
development work flows.

Assign label to a bot on page 2038

Access to Automation Anywhere RPA Training & Certification

A direct link to Automation Anywhere RPA Training & Certification is now added in the
Automation 360 Help Center.

Automation Anywhere University: RPA Training and Certification (A-People login required)

What's changed

Bot Scanner recommendation

The Bot Scanner now recommends to proceed with migration (with or without review or
action) when 95% or more than 95% of your bots can be migrated.
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What's changed

Assign credential variable to non-credential type variables for migrated bots

For migrated bots, Automation 360 no longer restricts you from assigning the credential
variable to a non-credential type variable in an insecure (non-secure) way. SO you can now
successfully run migrated bots that use the Run Logic command to pass the credential
variable to a non-credential type variable in an insecure manner.

Enhancement to Recorder package

The search algorithm for the Recorder package is now enhanced so that when you run

a bot an object is captured only if its properties match the exact search criterion that you
selected in the Object properties table. If the properties of the object do not match the
search criterion exactly, then the bot fails with an error message. However, if the search
criterion includes a wildcard character, then the bot captures the first object that matches
the criterion.

For example, to capture a text box from an application that has three text boxes named
firstnamel, firstname2, and firstname3, if you select HTML name as the search criterion,
enter the value firstname in the HTML name field, and run the bot, then the bot fails with
an error message because a text box with the HTML name firstname does not exist.
However, in the HTML name field, if you enter £irstname*, and run the bot, then the bot
captures the first text box that matches the criterion.

Previously, if there were no objects whose properties matched the search criterion exactly,
instead of failing, the bot captured the first object whose properties matched the search
criterion partially. For instance, in the previous example, if you selected HTML name as
the search criterion, entered the value firstname in the HTML name field, and ran the
bot, then instead of failing, the bot captured the first text box that matched the criterion
partially.

Note: This enhancement is available for the bots you create using the
2.4.0-20211016-070100 version of the Recorder package starting from this release. To use
this functionality in the bots created using a previous version of the package, you must
recapture the objects.
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What's changed

Enhancement to File package (Service Cloud case ID: 00755631, 00780237)

» In the Copy Control Room file action of the File package, the new Dynamic file path
option in the Control Room file field now enables you to use variables in the file path to
copy a file from the Control Room repository where the file path is dynamic.

«  Some actions and properties in the File package are now updated, as follows:

« The Copy action is now renamed Copy Desktop file.
« The Download CR file action is now renamed Copy Control Room file.
« In the Copy Control Room file action, the following fields are renamed:

e The Select a Control Room file field is now renamed Control Room file.
« The Save CR file to location field is now renamed Target file path.

« In the Copy Control Room file action, the Control Room file field now has two new
options: Static file path and Dynamic file path.

The Static file path option is an existing feature in the Control Room file field that
enables you to browse the Control Room repository and select the file. When you
browse the repository using Static file path, files with .bot extension are no longer
displayed.

Note: The renaming of actions within the File package does not impact existing bots
that use these actions.

File package on page 2312

Changes to Connect action in FTP / SFTP package (Service Cloud Case ID: 00792346)
The following changes are made to the Connect action:

e SSH FTP server type is now renamed Secure FTP.

* When you select the server type FTP Secure, the User credentials authentication type is
now renamed Username & Password.

Note: From this release, if you use the Secure FTP credentials in FTP Secure, the bot
will fail. Instead, we recommend you to use the Credential option available in Secure
FTP to connect with the Secure FTP server.

» Change in Connect action: If you created bots using the Connect action using
Automation 360 v.22 and earlier releases and you update to v.23, the bots display some
of the Connect action settings as deprecated due to changes in the interface. However,
your existing bots will continue to run successfully. For new bots, we recommend that
you create them using the Connect action available from this release.

Support for copying one or more variables (Service Cloud case ID: 00549368, 00751052,
01260498)

You can now copy one or more variables from one bot and then paste them in another
bot. Previously, the copy operation also copied the actions along with the variables.
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What's changed

Support for reserved characters in Distinguished Names (DN) for Active Directory Control
Room (Service Cloud case ID: 01133364, 00952301)

You can now use reserved characters, such as the comma (,), in the DN or the username
of a Control Room configured for Active Directory users.

The following table lists the fixes and the builds in which they were fixed. Build 11513 is the latest
build and includes fixes from the previous builds.

Fixes

Build Service Cloud case Description
ID

11513 00797196, Updates to the Private workspace API
00818347 ( /v2/repository/workspaces/
{workspaceType}/files/list):

»  Only private workspace authorized users can
list the bots from the private workspace.

* Admin cannot list the private workspace bots.

« Only public workspace authorized users
cannot list the private bots.

» One private workspace authorized user
cannot list another user private workspace
files.

11513 00808478, If you are a Control Room administrator, when
00814198, you change the viewing permissions of some
01260666 bot folders so that they can be viewed only
by specific users, the change is now correctly
applied. Previously, changes made to the viewing
permissions of bot folders were not applied
correctly.

11513 When you update from Automation 360 v.22 to
v.23, background jobs related to cloud license
server sync-ups are no longer deleted because
of incorrect license job name.

11513 01753484, You can now deploy (both schedule and run)
01754939 bots from the Control Room without any issue if
you have the View Package permission.

Note: The View Package permission is required
to deploy (both schedule and run) bots from the
Control Room.
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Fixes

Build Service Cloud case Description
ID

11513 - When you install or update to Automation 360
v.23 for On-Premises deployments, the log files
are now updated for all the services without any
issue. Previously, the log files for a few additional
services were not updated with any information
or time stamp of the activities.

11486 00793800 When you migrate to this release, issues related
to JRE while installing the Control Room on
machines using Microsoft Hyper-V servers
are now fixed. The following error no longer
occurs: Unknown Failure. Please check

the database login credentials and
check if this machine has a network
connection to the database server.

11486 00815340 User folder names given similar leading portions
or naming conventions no longer display folders
that share naming conventions but not the
assigned or specific user permissions.

11486 00836898, The Cloud Migration Utility now includes
01259938 enhanced logic to enable you to successfully
upload data even when the network is
connected through a proxy server.

11486 00817173 You can now perform a Run DLL function
when both the input and output parameters
are set to a String value, and the Date and
Time value is now passed as a String parameter
successfully. Previously, the Date and Time value
was converted and not displayed as expected.

11486 00754305, The configuration tagging works properly
00769128 now, based on the settings configured in the

nodemanager-logging.xml file. Previously,
the node manager and bot launcher logs
were purged either after two days or if
the log count was increased by specific
amounts due to tagging issues with tags such
as the following: "IfLastModified age” and
"DirectWriteRolloverStrategy”

11486 When you decide to select or deselect all the
bots and dependencies, you can now select
or clear the Select All check box without any
issues. Previously, after selecting the Select All
check box, when you cleared the check box,
it did not work as expected, and you had to
deselect the bots and dependencies individually.
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Fixes

Build Service Cloud case Description
ID

11486 00798037, The Manage and Administration labels in the
00814184 navigation pane are now updated to ensure
that roles and permissions are distinct in the
following languages: Simplified Chinese,
Traditional Chinese, Japanese, and Korean.

11486 01218053 You can now import parent and child bots
with dependencies even if you do not have
permissions to all folders.

Previously, if a user with no folder permissions
imported parent and child bots with
dependencies, the dependency between them
was lost.

11486 01046249 When you migrate from Enterprise 11 to
Automation 360, duplicate entries are no longer
created for any of the existing commands.

11486 - You can now migrate an Enterprise 11 bot that
uses the Run Task command successfully even
if the Upon error, continue with next repeat
option is not selected.

Previously, the parent bot stopped running if the
child bot encountered an error. Now, when this
option is not selected, an error handler ensures
migration is successful even if the child bot
encounters an error.

11486 - If you used the Go to cell action from the Excel
advanced package in an Enterprise 11 bot, the
setting is now retained when you migrate it to
Automation 360.

11486 00779016 You can now use the XML package to open any
xml files without any issue after migrating to
Automation 360.

11486 00794202 You can now migrate Enterprise 11 bots with
If command to Automation 360 without any
issues.

11486 00790245 You can now use the SOAP Web Service action
of the SOAP Web Service package without any
issues after migrating to Automation 360.

11486 00795518, If you used the Delete cells action from the
00832462 Excel advanced package in an Enterprise 11 bot,
correct cell addresses are now displayed when
you migrate it to Automation 360.
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11486 00808601 Migrated bots that include Extract and Substring
actions of the String Operation no longer
encounter an error if the input string is empty.

11486 00807945, When you migrate Enterprise 11 bots using the
01258127 Error Handling command, an error no longer
occurs if the file path value in the variable is
missing the file extension from the Snapshot
and the Log to file. After migration, the Snapshot
file now saves files with .png extension and Log
to file with . txt extension.

11486 00777395, The migration process now adds the Window >
00807705, Set title action for all the Elself-window exists
00814087 conditions. This setting enables you to make
the window title dynamic, eliminating the need
for you to recapture the window title when it
changes.

11486 00820094, After you migrate to Automation 360 from
01019195 Enterprise 11 or Enterprise 10, the Error Handler
snapshot error is now logged to the Snapshot
image path. If the snapshot image path is
provided as a variable, then the snapshot error is
logged to the default application path.

11486 00810389 You can now migrate bots with variables whose
names start with or contain arrayRows. You no
longer encounter a stack overflow error and the
bots are successfully migrated.

11486 00795347 The DLL Run action now successfully copies
your data from one Excel sheet to another even
if the .Net DLL uses the OLE mechanism (for
example, clipboard) to copy data. Previously,
when data was copied from one Excel sheet to
another, a threading-related exception occurred.

11486 00787562 After migration to Automation 360, an Enterprise
11 large bot (with 2000 or more commands) no
longer encounters the Code too Large for

try statement preprocessing error when
the bot is used in Automation 360. However, if
the migrated bot includes a Loop or Trigger
Loop command with Continue or Break as a
child command, a preprocessing error might still
occur when the bot is run.
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11486

00782594,
00786968

When you migrate to Automation 360, an
Enterprise 11 bot with large array sizes no longer
encounters Java heap errors. If the total size

of the arrays in one bot exceeds the threshold
value of the array size, then the arrays variables
are migrated as is till it breaches the threshold
value. However, the remaining array variables are
migrated as table variables with no default value
using the Database > table action.

11486

00792346

If your Enterprise 11 bot was configured with
Secure FTP without Key File Authentication, the
migration process now appropriately configures
the bot with the Secure FTP server type in
Automation 360. Previously, the migration
process incorrectly configured the bot with the
FTP secure server type.

11486

Users with the AAE_Bot Migration Admin role
no longer encounter an issue when they migrate
bots using the Bot Migration Wizard.

11486

The Bot Migration Wizard now displays the
correct number of MetaBots on the Select bots
to migrate screen.

11486

Enterprise 11 bots that are migrated no longer
encounter an error when a variable that is
mapped between the parent bot and a child bot
is not available in either of the bots.

11486

00729719,
00959356

You can now add or update SAP automation
using the Capture action of the Recorder
package when the SAP scripting is disabled in the
Enterprise 11 bot.

11486

00639940,

00770561

If the migration process fails, the All migration
screen now shows the status as unsuccessful.
Previously, when the migration process failed
because of invalid device credentials, the screen
showed that the migration process is in progress
but the Audit log displayed the correct status.

11486

00840456

The migration process no longer encounters an
error when you migrate a MetaBot that contains
a logic that has an extra space character at the
end of its name.

11486

00786646,

00808600,

00822029

Migrated bot no longer encounter an error when
they contain commands that perform an action
on a pop-up window of a browser.
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11486 00777467 Migrated bots no longer encounter an error
when they are checked out in Automation 360
and they contain an invalid expression that is
added by the migration process.

11486 00786002 You can now delete .atmx and .mbot files from
the Control Room if you have all the required
permissions.

11486 00796725 The Bot Scanner no longer encounters an error
when it scans a bot in which the window title is
specified using a variable within brackets.

11486 00790861, Migrated Enterprise 11 or Enterprise 10 bots
00836849 no longer encounter an error when they use

the Run Logic command to run a MetaBot
logic and the location of the logic is specified
up to the folder that contains that logic. For
example, consider that you have a MetaBot
named Financel and you want to run Logicl
that is available in the MetaBot at the Metabots
\Logics\Finance location. Previously if you
specified only Metabots\Logics\Finance
instead of the complete path (Metabots
\Logics\Finance\Logicl) of the logic, an
error occurred.

11486 00804550 You can now import bots from an Enterprise 11
production environment to an Automation 360
development environment even if these bots
include the user ID of the user who had checked
out the bot in Enterprise 11.

11486 - When you search for bots with the following
characters, the bots are now displayed in the
search results:

rS@LE#KIWL)(H, 1~ $AE()_~+=1]

11486 00729393 After you migrate from Enterprise 11 to this
release, you can now view the bot subfolders in
your Control Room Public workspace on the
Automation page.

11486 - After you migrate from Enterprise 11 to this
release, you can now check in bots to the
Control Room Public workspace from a folder
for which you have the Check in permission
using the Repository Manager API. The API
response code no longer shows the following:
"upload": false.

© 2023 Automation Anywhere. All rights reserved. 350



product-flagshipAutomation Anywhere - Release Notes

Fixes
Build Service Cloud case Description
ID
11486 01032367, An issue with the bot deployment progress
01066099 window is now fixed. Previously, even after
the bot completed the run, the window was
displayed for a long time (for example, for more
than 10 seconds in some cases).

11486 00826923, After you migrate from Enterprise 11 to this

01081380, release, you can now add work items to queues

01259907 using the Workload API through AWS Lambda.
A StackOverflow error no longer occurs in the
Control Room logs.

11486 00801810 When you update Automation 360 On-Premises
to this release, Bot Agent devices now remain
in connected state. WebSocket errors are no
longer generated in the C:\ProgramData
\AutomationAnywhere\BotRunner\Logs
\Node manager.log file.

Previously, when you updated from Automation
360 v.19 (Build 8147) to Automation 360 v.21
(Build 9664), some issues were reported where
the Bot Agent devices remained in disconnected
state and WebSocket errors were generated
even without any proxy configuration changes.

11486 00831028, When you update your Control Room that is

00830336, configured with Active Directory to this release,
00827031, you can now use the log in with Windows
00832413, option and the following error no longer occurs:
00833089, java.lang.NoSuchMethodError.
00833436,

00832850,

00839997,

00849904,

00857296,

00831062,

00833436,

01140913,

01145306,

01252819,

01127960,

01256324,

01257414,

01258281,

01263606
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11486 00719407 For On-Premises deployments, when you
configure multiple IP addresses for Control
Room nodes in a cluster, the primary IP address
is now automatically configured. You no longer
have to manually configure the primary IP
addresses in the cluster.properties file.

11486 When you are installing the Bot Agent, if you run
out of disk space and click OK on the Out of
disk space window, the wizard returns you to
the previous Setup type window so that you can
cancel the Bot Agent installation.

Previously, when you clicked OK on the Out
of disk space window, the wizard displayed
multiple windows.

11486 - When the Bot Agent is updated automatically
from a previous release to this release, you can
perform various operations simultaneously, such
as running bots, configuring device settings in
the Control Room, and updating the Control
Room. You no longer have to restart the Bot
Agent service from the Task Manager.

11486 00781135 After you install the Bot Agent on a user
device, when you restart the Bot Agent,
the global cache folder (C: \ProgramData
\AutomationAnywhere\GlobalCache\)is no
longer deleted.

11486 00709309, You can now upgrade the Control Room
00766163 installed on Linux to this release and the

Elasticsearch service now starts successfully.
Previously, the upgrade failed because the
service did not start and the following message
was displayed: Elasticsearch service
fail to start during certificate
retrieval process.

11486 00742074 License allocation for users configured to
use multi-user devices is now honored for
concurrent bot deployments on unattended Bot
Runners.

11486 00822176 On multi-user devices, you can now create an
RDP session that uses a custom port. Previously,
if you configured a multi-user device to use a
custom port for RDP-based deployments, the
deployments failed.
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11486 00806583, When you perform RDP-based deployments
00805381 on a device, FreeRDP no longer fails when
connecting to a Windows server for per-device
RDS licensing.

11486 - If you deploy bots using event triggers and install
the Bot Agent on a device as a non-admin user
for yourself or a local admin user, the Bot Agent
is now updated automatically. The device is no
longer shown as disconnected in the Control
Room.

11486 00803434 Issues with the change in Jetty HTTP client
behavior on load balancers with custom rule
for host headers to route a request are now
resolved. Device registration now does not fail
and the port numbers are added to the host
when default ports are used.

11486 00815334 Performance issues related to logging in to the
Control Room and editing and running bots in
the Cloud Control Room are now fixed.

11486 00543141, With Splunk integration and enhancements
00674098, to syslog, you can now forward audit logs to
00714238, remote Splunk servers and view audit logs on
00744991, Splunk dashboards.
00750325

11486 00776569 When a bot you run encounters an error,
an appropriate preprocessing or runtime
error message is now shown. Previously, a
preprocessing or runtime error message was
shown even if the bot did not contain an error or
if the bot was empty.

11486 00781638, Issues with a checked-out bot and its clone
00805371, are now resolved. When one user checks out a
00804784 bot, makes changes to it, and checks in the bot,
the clone of the bot in another user's Private
workspace is now updated with the changes.

11486 00784252 If you do not have Control Room admin
privileges and you check in bots to the Cloud
Control Room Public workspace in subfolders,
the bot folders no longer take time to load in the
Control Room.
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11486 00786716, An error no longer occurs when you use the
00801631, Download action in the Browser package to
01189873 download a file from a web URL. Previously, if
a web URL had a backslash at the end or space
characters at the beginning or end, the bot failed
to download the file.

11486 00783197, When you use the Assign action of the Number
00818698, package to assign decimals to an existing
00820666 number variable, an error no longer occurs
irrespective of the device locale settings on the
machine.

11486 00778496 You can now successfully import the bot archive
into the public workspace even if the archive
creates a folder named System in the Bots
folder.

11486 00774026 You no longer encounter an issue when you use
the CSV/TXT > Open action and the Task Bot
> Run action to search for a file or a bot with a
name that contains Japanese characters.

11486 00761035, You can now use the Recorder > Capture

00786113 action to capture an object on a window that
has a tree view and also retrieve the ltem
name property of that object by using the Get
property action. Previously, when you ran a bot,
the recorder captured the object on the window
successfully but failed to retrieve the item name
of that object in the output.

11486 00763925 An error no longer occurs when you use the
Split action of the String package to split a
source string that has any combination of
Unicode characters.

11486 00767074 In Internet Explorer, when you use the Browser
> Open action to open a new window or tab,
the new window or tab is now displayed in front
of the other, non-admin open windows.

11486 00819664 You can now create bots using the SOAP Web
Service action. XML calls no longer return
corrupted data when the SOAP response has an
XML document as an inner element.
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11486 00748494, You no longer encounter any issues when you
00829735, deploy a bot containing email triggers. Now,
01018622 each time an email message is sent, the bot is
triggered and runs successfully. Previously, the
email trigger worked only for the first time an
email message was sent, and for subsequent
email messages, the bot was not triggered and
did not run.

11486 - The Task bots runs metric on the Home
dashboard page of the Control Room now
displays the correct count. Previously, the Task
bots runs metric displayed the count as zero
even if you have run bots from the same Control
Room.

11486 00824309 In the Run stored procedure action of the
Database package, when you click Add
parameter to provide an input or output
parameter, the label for the parameter type field
now displays as Parameter type. Previously,
the label for the parameter type field was not
displayed correctly.

11486 00810212 When you use the Run action of the Task Bot
package and select the Multiple variables
option in the Save outcome to a variable field,
the variable name is now displayed in the correct
case. Previously, the variable name was displayed
in lowercase even if the variable name was
created using uppercase.

11486 00796913, You can now use the Move all action from the
00836389 Email package to move multiple email messages
from Inbox to another folder. Previously, the
Move all action was not able to process a large
number of email messages because disk storage
ran out of space.

11486 00798673, An error no longer occurs when you use the
00815700 Database Connect action, enter the connection

string that uses Windows authentication, and
run the Run stored procedure action that
has an input parameter value of more than 36
characters. Previously, an error was displayed
when the length of the input parameter value
exceeded 36 characters.
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11486 00799450 When an excel spreadsheet is opened in the SAP
editor and simultaneously you use Open action
of the Excel advanced package to open an excel
file, any error no longer occurs when the bot
is run and the Excel file is opened successfully.
Previously, an Excel file opened in the SAP
editor was considered the default window and
therefore when you ran the bot, an error was
displayed stating that the Excel file could not be
opened.

11486 00794102 In the REST Web Service package, the
description below the Assign the output to a
variable field is now translated correctly for the
following languages.

» Japanese

e French

« ltalian

» Portuguese (Brazil)
» Simplified Chinese

Previously, the description was not correctly
translated for these languages.

11486 00788920, In the Email package, when you use Connect
00796452 action to connect to the Outlook or IMAP
server, you can now successfully download the
email attachment in .eml file format. Previously,
if you had email attachments in xlsx and .eml file
formats, only xlsx files were downloaded.

11486 - If you create a Dictionary variable with the Any
subtype and select Datetime as the default
value, when you click the time icon, you can
now see the time values displayed in the drop-
down list. Previously, when you clicked the time
icon to select the time from the drop-down list,
the values were not displayed.

11486 00746630 You can now create a new task using Excel
advanced with Loop and you select the For each
row in worksheet (Office 365 Excel) option
from the lterator list, create a Record type
variable, and run the bot. An error no longer
occurs when you edit the same bot and select
the For each row in worksheet (Excel basic or
Excel advanced) option from the Iterator list.
Previously, a preprocessing error was displayed
on bot execution.
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11486 00762978 If you use the Windows > Close action and
select Currently active as the window title to
close active windows, when you run the bot,
the Shut Down Windows pop-up is no longer
activated even if there are no active windows on
the machine.

11486 00805654 The Split action of the String package now
allows you to select the Any variable type to hold
the output values. Previously, you could select
only the list variable.

11486 00761189, Performance issues related to the Run macro

00764563, action in the Excel advanced package are now
00785751, fixed.

00794273,

00835194

11486 00796120 When you use the Data table > Sort action to
sort a column, if the column does not contain
any value, the bot now runs as expected and
does not get stuck. Previously, you had to stop
the bot manually.

11486 00830011 In the Excel advanced package, when you
perform the Go to next empty cell action on an
Excel sheet, the system no longer runs out of
memory.

11486 00765210, An error no longer occurs when you use the

00790641 Excel advanced > Open action to open an
Excel file that contains a pivot table.

11486 00776021 When you use the Open action of the Excel
advanced package to open an Excel workbook,
even if the workbook has invalid links, the bots
now run as expected.

11486 00692220, Performance issues related to the Write from

00785965, data table action of the Excel advanced package

00798035 are now fixed, and the action now performs
better on Excel sheets with large amounts of
data.
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11486 00808137 The format of Start date and End date under the
Date condition is now updated to MM/dd/YY
for the following actions of the File and Folder
packages, where dd now correctly shows the
date:

» File package

» Copy Desktop files action
» Delete action

e Print action

» Print multiple files action
» Rename action

» Folder package

» Copy action
« Delete action
« Rename action

Previously, the format of Start date and End
date was MM/DD/YY, where DD gave the day
count of the year instead of date.

11486 - When you run a bot with the following sequence
of actions, the file is now successfully deleted at
the end of the sequence:

1. CSV/TXT > Open action to open a .csv file

2. Aloop action within another loop action to
retrieve values from the .csv file

3. CSV/TXT > Close action to close the file

Here, all the actions are using the same,
default session.

4. File > Delete action to delete the file

Previously, the file was not deleted because the
bot failed to close the default session.
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11486 01164436, An error no longer occurs when you use
01209626, the 2.4.0-20211118-080716 version of the
00975390, Recorder package to capture a control using
01080879, HTML technology in the Google Chrome
01254846, or Microsoft Edge Chromium browser and
01256132, run the bot. Previously, when you used the
01255004, 2.3.0-20210806-215200 version of the Recorder

01263774,01253240 package, the bot failed with the following
error message:Unable to find control.
Search Criteria did not match

11486 00818990 The capture anchor option in the Recorder
package is now supported for the Citrix XenApp
application. You can now select an anchor to
search for an object in a user interface during
bot run and execute actions based on it.

11486 00782962 An error no longer occurs when you loop
through multiple Excel sheets and use keystrokes
inside the loop to copy and paste the retrieved
values into another Excel sheet. Previously, when
you opened and closed multiple Excel sheets
within a loop, the bot did not identify the correct
Excel sheet for performing the keystroke action.

11486 - You can now use the String > Import string
from text file action to read values from a text
file when a bot runs if the text file encoding was
set to any of the following encodings:

« UTF-16BE
« UTF-8
* ANSI
e  Window-1251
o UTF-16LE
e Shift-JIS
11486 - When you update the Control Room on Linux

from any earlier version to Automation 360

v.21, the Control Room now displays the
updated interface. Previously, when you updated
to Automation 360 v.21, the Control Room
continued to display the old interface from the
previous version.
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11486 00816941 You can now run bots with a queue based
on the sorting order that was selected for the
work item column in the work item template.
Previously, the bots were deployed based on the
seguence in which work items were inserted into
the queue.

11486 00804330, After a bot is deployed on a user device, the

00822092 Run History page (Manage > Scheduled) now
shows the correct details about the run history
of the bot.

11486 - When you pause and resume a workload
automation after using the run bot with queue
in the Control Room, the audit entries are now
captured on the Audit logs page.

11486 00803717 In the Control Room Historical activity page,
the Modified by column now shows the name
of the user (Bot Creator or Bot Runner) who
scheduled a bot on a user device. Previously, the
column displayed the username of the latest bot
user.

11486 - When you deploy workload bots from the
Control Room, you can now run workload
automation with elevated privileges by using the
Run as administrator option.

11486 00780635, When you update from a previous release,

00791587, schedules no longer disappear from a Control
00795559, Room configured on a single-node or multi-
00795632, node environment. Also, previously deactivated
00797130, schedules no longer disappear and become
00797113, reactivated automatically after the update.
00791783,

00765770,

00826805,

01859661

11486 00974353 You can now deploy workload bots on Bot
Runner devices because the bots associated with
a gqueue cannot be deleted. Previously, user had
permission to delete the workload bots while
running with queue.

11486 00830546, When work items are inserted for workload

01181402 automations, an Apache Ignite StackOverflow
error no longer occurs, and the Control Room
server no longer stops running.
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11486 01021889 When you schedule or deploy a bot from the

Control Room, if a bot fails to run, an email
notification is now sent. Previously, even if
the Control Room administrator enabled

the A Task Bot stops running because it is
unsuccessful setting in the Control Room, an
email notification was not sent.

11486 00949288 Scheduled bots are no longer stuck in the
pending execution status intermittently on the
Activity page, and subsequent bots scheduled
for execution are not stuck in queue.

11486 01253045, Each scheduled bot is now deployed on Bot
01256337 Runner device one time in a day. Previously,
some scheduled bots were deployed twice on
Bot Runner device.

11486 00750399 You can now capture objects from Microsoft
Internet Explorer running as XenApp on a Citrix
Server that has multiple Citrix applications
installed.

The following table lists the limitations identified in the current release:

Limitations in this release

In Enterprise 11, if bots were using windows variable where the window title value did not
use the exact case as that of the application window title, after migration, the bots will fail
to execute.

Workaround: You can migrate to Automation 360 v.26 release where this issue is fixed or
ensure that you change the case of the window titles in windows variables to match the
case of the window titles and then migrate the bots.

When you migrate a bot that was using the Manage Window Controls action, the last
digit of the height value is not available after migration. However, the bot will execute
successfully. (Service Cloud Case ID: 01756996)

When an Excel session is active in SAP, a corresponding Excel process starts in the
background. In such a scenario, Automation 360 uses the same Excel process that SAP
started. When you run a bot to automate spreadsheet data, Automation 360 processes
the first request successfully. However, during execution, if the Excel is closed and a
subsequent request is sent for automating the spreadsheet data, Automation 360 does not
process the request because the Excel process is still being accessed by SAP. Therefore,
the correct window is not activated for automating the spreadsheet data. (Service Cloud
Case ID: 00815159)

When you run the bot, the Task bots run metric on the Home dashboard page of the
Control Room does not display the correct count. For example, the task bot run count
shows 39 on the Home dashboard page, but when you run the bot, the count is displayed
as 42 instead of 40.
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(Service Cloud case ID: 01753337 ) In the "In progress” table, the column sort function
cannot be used to list items in ascending or descending order.

After migration, when you run a parent-child bot that share a session and use different DLL
package versions, the bot fails with a run-time error message.

* Nested IFrames are not supported in Google Chrome and Microsoft Edge Chromium
browsers.

e After performing an action in an application or page, if a frame is added during run time
to the application or page, and the frame is populated and page is not refreshed or
reloaded, elements in the application frame or page cannot be captured or played until
you manually refresh that page.

(Service Cloud case ID: 00988580, 01200161) After you migrate from Enterprise 11 to
Automation 360, you might not be able to Check out some bots and dependencies to the
Control Room Public workspace.

Workaround: Check out the parent bots to the Control Room Public workspace. The
dependencies are then automatically cloned.

For more information, see Cannot Check Out With Child Dependencies Due To No
Versions (A-People login required).

If you are directly updating from Automation 360 On-Premises v.20 or v.21 to this release,
you might face issues updating your Bot Agent on some Bot Runner machines in the
following scenarios:

» After a Control Room update, the device status keeps changing and the Bot Agent fails
to update automatically.

¢ |If the embedded resources file is missing, the Recorder does not recognize the user
interface elements or does not capture a single object in the Google Chrome browser.

Workaround: Before updating to this release, remove the following Bot Agent files and
folders:

¢ C:\Windows\System32\config\systemprofile\AppData\Local
\AutomationAnywhere\AA-DB.mv.db
e C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

For more information, see Bot agent auto update fails post the Control Room Upgrade
with 'device.connection.lost’ (A-People login required) | The recorder is not able to
recognize the GUI elements in Google Chrome browser (A-People login required)

In some cases, if you Check in a bot to the Control Room Public workspace after filtering
any dependency, when you export the bot, all the dependencies are displayed instead of
the filtered data.

(Service Cloud case ID: 00773700) The migration process fails to migrate bots that contain
more than 96 conditions in a single If command.

Workaround: Split the If command into two If commands in Enterprise 11 and then migrate
the updated bot.
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Limitations in this release

If you create a bot that has invalid JSON tags with an Error Handling action (Try/Catch) in
it, and if the Bot validation service is enabled (ON) in the Settings > Bots page, when you
run the bot, the bot fails because of a preprocessing error.

Workaround: In the Bot editor, open the bot that displays the error. Select and click any
line of code, edit it, and save it. For example, if you have created a bot using the Comment
action, select and click the Comment action, edit it by entering a space in the comment
box, and then click Save. When you run the bot now, it no longer displays a preprocessing
error.

In SOAP Web Service, selecting the Raw data parameter and using the Build Xpath option
to extract values from SOAP response to store the XML output in a variable does not work.

Workaround: Enter the Xpath expression manually instead of using the Build Xpath option
in the selected response.

When you try to establish a secure SQL connection in the Linux environment by choosing
the Enable option in the Database Configuration > Secure Connection field, the Linux
installer fails to import the SSL certificate, and the connection fails.

Workaround: Select the Disable option in the Database Configuration > Secure
Connection field. The Linux installer successfully establishes a secure SQL database
connection.

In Linux environment, the file upload functionality of Automation Co-Pilot on the web fails
with an access denied error. This error occurs because the filestorage directory is not
automatically created to store the files.

Workaround: Create the filestorage directory in the Automation 360 repository path and
assign the appropriate permissions as outlined in the following steps:

1. Navigate to the Automation 360repository path: /opt/automationanywhere/
automation360/appdata/Server Files

2. Enter the following commands in the Linux console:
a) sudo mkdir storageservice
b) sudo chown -R crkernel:controlroom storageservice

c) sudo chmod -R 775 storageservice

When you upgrade the Control Room from the previous version, the Task bots runs metric
on the Home dashboard page does not display the historical count of tasks bot that ran

in the earlier version. It shows only the count of task bot runs from the upgraded Control
Room.
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Limitations in this release

When you use the Recorder to capture objects on applications running on Microsoft Edge
Chromium with Internet Explorer mode, use Recorder conditions in the bot to check
whether the element exists in the application, try to capture Ul elements in the application
based on the result of the condition, and run the bot, then the bot always goes to the
next action because the Recorder condition is unable to locate the Ul element in the
application.

Workaround: Use the Image Recognition condition instead to locate a Ul element in an
application.

Copying Form variables across bots by using the Copy to shared clipboard option is not
supported.

The following table lists limitations from previous releases that are also applicable to this release:

Limitations from previous releases

If you configure an external key vault in External Key Vault Integration and select the

SQL authentication mode for database authentication in the Windows installer Database
Server page to install Control Room (On-Premises), the installation fails, and following error
message is shown: Control Room database tables fail to create.

Workaround: Add the database credentials in the external key vault and use those
credentials for database configuration.

Newly created Control Room users on Windows for On-Premises Google Cloud Platform
VMs cannot change their password. The security questions option is not available on the
Change password screen and as a result the Control Room displays an error when they try
to save the password.

Workaround: Refresh the page and change the password again.

(Service Cloud case ID: 00837271) If you are migrating from Enterprise 11 with a database
that has a large amount of repository data, the installation might fail. This issue occurs
because Liquibase update for a few SQL queries is not completed during migration.

Workaround: Contact Automation Anywhere Support.

Security fixes

Service Cloud case ID Description
00836486, 00942844, Disabled the module for caching that was using credential
01264029 authentication.
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Automation Co-Pilot (Automation Co-Pilot)

What's new

New query filter in Query Requests and Query Tasks actions

Use the new filter now available in the Query Requests and Query Tasks actions of the
AARI Web package to filter query requests and tasks by team name in the Automation Co-
Pilot web interface.

Team name filter

You can filter your tasks and requests by team name in the Task and Request pages in the
web interface, respectively. Select the Team label from the filter and search by team name
to view the teams assigned to a task or request.

Filter and search for a request on page 3024 | Filter and search for a task on page 3026

Support for audit logs (Service Cloud case ID: 00801166)

You can now view the audit logs and refer to events relating to requests, teams, scheduler,
process setups, bot setups, human tasks, and bot tasks that you have created, deleted,
updated, submitted, or recovered.

Audit log on page 1906

Enhancement to user task assignment in Human Task

In the process editor, the Auto-assign this task option in Human Task provides the
following alternatives:

* The user who created the request: The task is automatically assigned to the user
creating the request in the web interface.

* The user who opens this task: The task is automatically assigned to the user who opens
the task in the web interface.

This feature helps to reduce conflicts in assigning a task to oneself, particularly in case of
specialized users such as Validator for whom the action of opening a task is equivalent to
assigning the task to oneself.
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What's new

Enhancement to team setup

You can now simultaneously add multiple users with similar roles (custom role) to the
Automation Co-Pilot team in the web interface. The custom role in the Control Room
is now aligned with a team in the Automation Co-Pilot web interface, and the enhanced
team setup works as follows:

* The users added with the role are assigned a Member role in the team. The role cannot
be changed to Owner or Admin.

* You cannot view these users in the Users tab of the Team page.

e If auseris both part of a role and added manually to the team, their role in the team will
be the same as the role assigned to them manually. For example, if a user is a member,
they will continue to have the Member role whereas if the user is an owner, they will be
assigned the Owner role in the team.

» If the user is no longer part of a role, the user will also not be a part of the team.

Also, the Team page is now enhanced with navigation options at the top so that you can
navigate through the various tabs (General, Users, Roles, Processes, and Bots). Use the
General, Users, and Roles tabs to create teams and add users to them. The Processes and
Bots tabs display the processes and bots assigned to teams, respectively.

Team management on page 3010 | Create a team and assign team roles to members on
page 3020

Bot setup support

The Automation Co-Pilot Admin can use the Bot Setup page to view the bots that are
assigned to a team, assign teams to a bot, and edit bots to remove or reassign teams.
Attended Bot Runners who can view all the bots that are checked in to the Public
workspace can now view the bots that are assigned to teams in Automation Co-Pilot
Desktop Assistant.

Bot setup on page 2959

Enhancement to the form logo

You can now use the Logos in footer field to select up to two separate logos that are
displayed in the footer of the form during bot runtime.
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What's new

Add rules to various form elements

When you are creating or editing a form in the form builder, you can now add rules to the
following form elements by using the Form rules tab:

e Checkbox

« Date

« Document

« Dropdown

* Label

« Number

« Password

« Radio Button
* Rich Text Editor
e Text Area

* Text Box

e Time

For the Checkbox and Radio Button elements, the rules are triggered only if the
corresponding presets are selected. For example, if a form has two mutually exclusive
options, such as Yes and No, the rules associated with these options are triggered only
when you select one of the two options.

Add rules to form elements on page 2939
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What's new

Updates to triggers
The following triggers are now available to run a bot:

» Process trigger: Starts a bot when the status of the specified process in Microsoft
Windows meets one of the following preset conditions:

« Starts
+ Stops

Add a process trigger on page 2951
» Service trigger: Starts a bot when the status of the specified service in Microsoft
Windows meets one of the following preset conditions:

« Starts

» Stops
 Resumes
« Pauses

e Isrunning
+ Has stopped
« |s paused

Add a service trigger on page 2952
*  Window trigger: Starts a bot when the specified application window meets one of the
following preset conditions:

« Opens
+ Closes

Add a window trigger on page 2952

What's changed

Enhancement to Create a Request package

In the Create a Request package, you can now browse and choose the public process for
which you want to create a request. With this enhancement, you can choose the public
process without having to contact the Automation Co-Pilot admin for the URI of the public
process and enter the URI manually. This feature also simplifies mapping process inputs for
initial form fields.

Process Composer package on page 2545

Fixes

Service Cloud case ID Description

00800192 You can now use an email trigger to start a bot without any
issues, even when the email server is POP3.

00801428 You can now add an email trigger to a Gmail account to start a

bot for new email messages.

© 2023 Automation Anywhere. All rights reserved. 368



product-flagshipAutomation Anywhere - Release Notes

Fixes

Service Cloud case ID

Description

00736309, 00765069,

For documents that are in the .csv, .xlsx, or .x1ls format,

00784362 you can now use a file trigger to start a bot when a document is
modified.

00796697 When you check in a bot, the associated private event trigger is
now retained.

00802427 With the Bot Creator license, you can now view all the requests
and tasks regardless of your role or other licenses assigned to
you.

00829282 When you create a request in the web interface, your bot now

runs properly and does not encounter any processing issues,
such as an idle status that prevents progress on your bot.

When more than four text box elements of a form are
populated in a process, the document is now displayed
correctly on the document viewer irrespective of the state
of the text box elements. Previously, the document was not
displayed.

When you delete a request from the Request tab and it is sent
to the recycle bin, the related task from the Task tab is now
removed.

When you use the Date and Boolean type If/Else conditions,
there is now parity in validating conditions between a bot and a
process. Also, the String type If/Else condition now allows the
target values to be empty. Previously, validation for Date and
Boolean type conditions were not supported when used in a
process and the target values could not be empty.

Issues with the Hyperlink element in the Human Task are now
fixed. The Hyperlink element now works correctly with the
following behaviors:

« If the hyperlink URL is empty, either at design time or when
passed from the process, the hyperlink is now unavailable.
Previously, the hyperlink was set to the Control Room
domain.

e If the Hyperlink element is used in a Human Task that is
read-only, data is now passed from the process editor to
the form. Previously, the data from the process editor was
ignored.

For Time element in forms, when the Use the local time when
form is first displayed and Make field required options are
selected, the time element now treats the system time as the
default value and can be maodified in the initial form.

The following table lists the limitations identified in the current release:
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Limitations in this release

The web interface lacks the Set Warning action and the Set Error action for the
Checkbox, Dropdown, Radio Button, and Rich Text Editor elements.

For the Date and Time elements, when the date and time are included in a rule, changes
made to the rule format are not reflected in the rules section. As a result, when you try to
process a rule that contains that date and time, bot execution fails.

Workaround: Open the rules editor, expand the corresponding rules, and select a
respective data value from the calendar before saving. Do not change the format after the
date and time element are included as part of any rule. You can also delete older date and
time elements.

When you use the Select File element in your forms and select the Make field uneditable
option, the element can still be edited.

When you run a bot using the Team Members command from the AARI Web package,
you will be prompted with an exception error.

In Automation Co-Pilot on the web interface, if you create a variable by using the Form
type in a bot, you cannot copy that variable to another bot even when you select the Keep
or Overwrite option.

When a user is a member of a team by role (the user was added to a role in the Control
Room then the role was synced to the team), the user will not be able to view updated
information on the user interface of the request or task details. This is due to the Request
page not automatically refreshing.

Workaround: Refresh the Request page to view the updated request or task details.

The following table lists limitations from previous releases that are also applicable to this release:

Limitations from previous releases

In an SDS setup, when you create a request to upload a file, the upload fails and a
SecurityTokenInvalidException error message is displayed.

Discovery Bot

What's new

Install Bot Agent seamlessly

If you have not already installed the Bot Agent, you are now prompted to install the Bot
Agent from the Processes tab. Follow the screen instructions to install the Bot Agent. After
the installation, you are prompted to enable a Chrome plug-in in order to proceed with
your recording tasks.

Prerequisites for Discovery Bot on page 3351
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What's new

Enhancement to auto-generated opportunities

You can now begin reviewing an auto-generated opportunity from the Opportunities

tab when at least one process recording is submitted for review. Review the auto-
generated opportunity and choose to create a custom opportunity from an auto-generated
opportunity, as required.

Review opportunities, convert to bot, and generate PDD on page 3371

New recordings for review for custom opportunity

You can now review new recordings submitted by a Discovery Bot user for a custom
opportunity. You can choose to accept or dismiss the recording updates as part of the
custom opportunity work flow. This option allows you to quickly and easily review new
recordings in real time as the recordings are submitted by the user for that process.

Review opportunities, convert to bot, and generate PDD on page 3371

Enhancements to Opportunities page

The opportunities page is now updated to include an opportunities evolution map, along
with other graphs, to help you review and analyze data for a potential opportunity for
automation. Use the opportunities evolution map to help guide you on which opportunities
to automate first.

Analyzing opportunities for automation on page 3370

Download PDD document from the Recordings page

You can now download and export a PDD document from the Recordings page. After you
submit a recording for an analyst to review, the PDD begins processing in the background
automatically. When the PDD is generated, the field changes from Processing PDD to
Download. You can now choose to download the document in Word format, PDF, or
both. An email notification to the business user is also sent to the email address on file. The
Download PDD for Word or PDF document is also available for a custom opportunity from
the Opportunities list table.

Review opportunities, convert to bot, and generate PDD on page 3371

Fixes

Service Cloud case ID Description

You will now receive one email notification for a PDD
generated in Automation 360 v.21. Previously, when you
upgraded to Automation 360 v.22, you might have received
multiple email notifications about the PDD generated in
Automation 360 v.21.

The following table lists the limitations identified in the current release:
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Limitations in this release

During upgrade the PDD documents are not getting generated intermittently, for both
recordings and opportunities.

Workaround: Edit the flowchart for the custom opportunity that displayed an error, and
save. Or alternatively, create a new opportunity from the existing opportunity.

Depending on the memory available in your system, the PDD (in PDF or Microsoft Word
format) can support up to 250 recorded steps captured in the document. If a process is
recorded with more than 250 steps, the PDD generation periodically stops functioning.

Workaround: Regenerate the PDD and click Download.

The PDD PDF document for business users and analysts does not display Unicode
characters when entered in the opportunity name and step description fields.

Cloud users: For an auto-generated or custom opportunity, an error is displayed from the
Recordings table intermittently.

Workaround: Refresh the page to update the Recordings table.

After you save your changes, if you update a process workflow by adding or removing
steps, the values from the Overview pane might not be updated to include the recent
changes.

Workaround: Refresh the page to update and include the recent changes made to the
opportunity values in the Overview pane.

Cloud users: Creating a custom opportunity with more than 250 steps is not supported.

Linux users: The recording flowchart section is not displayed in the PDD.

For On-Premises deployments, when a self-signed or wildcard certificate is used for the
Control Room setup, the Processes page fails to load.

Workaround: Update or add the Control Room certificate to the Java Credential Store on
all your Bot Runner machines for the Processes page to load.

Add Control Room certificate to Windows certificate stores on page 1233

For custom opportunities and recordings, there is an intermittent issue and error generating
PDD message. You will not be able to access and download a PDD and instead see an
Error generating PDD error message.

Workaround: Only for custom opportunities, you can either create a new opportunity in
your workflow using the Save As option OR edit the your workflow chart with any small
change and save it. After doing this, the PDD generation will work properly.

Discovery Bot supports bot conversion to template only. To generate the automation task,
you must manually update or enhance the template generated by Discovery Bot in the RPA
workspace. (Service Cloud case ID: 01840856, 01822803, 01860950)
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Feature deprecation for Discovery Bot

Review the deprecated feature to understand how it can impact your automation.

Discovery Bot Aggregated and Comparison options

The Discovery Bot Aggregated and Comparison tabs from the Processes page has been
deprecated as of June 2021. You can use the Opportunities tab to view processes in an
aggregated workflow.

IQ Bot

What's new

Document Automation released in Community Edition

Community Edition now offers limited features from the Document Automation version.
This version is integrated with the Community Control Room. When you create a learning
instance, 1Q Bot automatically creates RPA bots to extract and download the data and an
Automation Co-Pilot process to manage the end-to-end process. Validation now takes
place in Automation Co-Pilot tasks.

Use 1Q Bot Community Edition to extract data from invoices in English.

Community Edition on page 3202

IQ Bot standard forms enhancements
IQ Bot now provides the following enhancements related to standard forms:

* You can now extract data from tables.
¢ You can now use container deployment.

Using 1Q Bot for standard forms on page 3274

CyberArk support

The On-Premises installation process now enables users to connect to CyberArk to store
their custom keys for encrypting and decrypting 1Q Bot data.

Note: This feature is only available for new installations.

Installing 1Q Bot in Custom mode on page 1283

Classifier enhancements

You can now create custom document groups in a learning instance. This reduces the
possibility of an OCR failing to detect fields in a document, which will cause the Classifier
to create a document group unnecessarily or send the document to a wrong group.

About the Classifier on page 3219
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What's new

View the number of pages purchased and uploaded

The 1Q Bot dashboard now shows the number of pages purchased and uploaded in the
current license period.

Review the dashboard on page 3269

What's changed

(Service Cloud case ID: 00656822) Credential Vault integration is now available for
passwords in 1Q Bot.

Fixes
Service Cloud case ID Description
00727633 When you import or export learning instances, duplicate

classification entries no longer occur.

00768600, 00783773, When you import an existing IQ Bot archive (IQBA) file, you can
00815546, 00795424 , now use the Overwrite option without any issues.
00788180

00770638, 00746545, When you import the 1Q Bot archive (IQBA) file, you will no
00827208, 00746545, longer see duplicate group entries.
00827208

00773631 (On-Premises) After you install, restart the |IQ Bot services using
a different Windows user. Prior to this release, IQ Bot services
could not be run with a different account post-installation,
resulting in an incompatible FilePath for Liquibase changesets.

- You can now access 1Q Bot > Explore 1Q Bot with a refined
user experience. Previously, a user could not navigate back to
the Control Room landing page. Users can now access the
landing page by clicking the back button.

00766454 The Manage your IQ Bots no longer displays the incorrect Ul
for trained bots currently in production. Previously, it displayed a
link to create a bot.

00804476 When you update the classification report, you can now
successfully classify the documents in IQ Bot. Previously,
because the classification report field name was longer than 75
characters, document classification failed.

- On the Learning Instance summary page, the number
of unclassified documents and the number of documents
uploaded are now accurately displayed.

00695159 An internal exception in the Removelines module that caused
documents to remain unprocessed has now been fixed, and
documents no longer remain unprocessed due to this error.
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Fixes

Service Cloud case ID

Description

00806557

You can now successfully assign a group to a bot, and move
the bot to production. Previously, in a few instances, the IQBA
contained multiple bots for the same group, making the state of
the bot inconsistent.

You can now download output files without any issues even
if APl requests are sent frequently to the database during
download for any standard forms learning instance.

You can now use the 1Q Bot Extraction action without any
issues even if you selected the Only for me option when you
installed the Bot Agent.

For bots associated with standard forms learning instances, you
can now successfully upload a large number of documents.

00776423, 00829915,

00949561

You can now use a custom port (apart from port 1433) to run
the Migration Assistant tool on the database server.

When documents with lengthy non-English (for example,
Japanese) file names fail, the issue is now logged in the
bot_launcher.log file.

00814577, 00812300,

00823120

An unexpected error that occurred due to large unnamed
RabbitMQ message queues has been fixed and the user can
now navigate to the Learning instances page.

The MLScheduler service is now disabled on 1Q Bot Cloud,
and the system no longer slows down or stops responding.
Previously, the auto-correction and auto-suggestion features,
which are part of the MLScheduler service, used extensive
system resources and caused the system to slow down or stop
responding.

The Process Document action in 1Q Bot Extraction package
now fetches the ABBYY pre-processing settings from the 1Q
Bot server and applies these settings to the classic side of
processing during bot runtime.

The following table lists the limitations identified in the current release:

Limitations in this release

When a bot is moved to production, documents become unavailable in the validator
output folder or the following error is displayed: Project not found/No documents

found.

Workaround: Ensure that the length of the filename does not exceed 100 characters.

In a cluster setup, sometimes, a specific document in production becomes unavailable.
Also, an incorrect learning instance summary is displayed.

Workaround: Upload again and reprocess documents that are not successfully processed.
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Limitations in this release

In the Designer, some documents for the user-created group and their extraction results
do not load.

Workaround:
1. Reload the Designer.

2. To obtain extraction details on On-Premises, go to the Settings.txt file and
increase the value for See extraction timeout.

On the learning instance details page, because of the 150-character limit, the group labels
for user-created groups are not displayed completely.

When you create an 1Q Bot administrator user, if you do not include the AAE_Basic role
along with the AAE_IQ Bot Admin role, that administrator user cannot add a new group to
a learning instance.

Workaround: Ensure that you include the AAE_Basic role along with AAE_IQ Bot Admin
role in the Control Room.

For a standard forms learning instance, if you upload a document that contains a table with
an invalid field, that document is sent to the Failed folder.

For the Concatenate Images action in the IQ Bot Pre-processor package, no output is
generated if a filename contains more than 256 characters.

Workaround: Use English language characters and number convention.

When you use the 1Q Bot Extraction package along with other OCR-based commands
(such as 1Q Bot Pre-processor, IQ Bot Classifier, AlSense Recorder, and OCR) in a single
bot, the bot fails.

Workaround: Ensure that you create separate bots for IQ Bot Extraction, and do not run 1Q
Bot Extraction in conjunction with other packages that include the 12.2 Abbyy OCR.

From a learning instance of custom domain type with manual groups, when you export the
IQBA file to another instance, the manual Group Label is not exported. Without a manual
group label, it is difficult to differentiate between system-generated groups and manual
groups in new learning instances.

The following table lists limitations from previous releases that are also applicable to this release:

Limitations from the previous releases

If you have a document with a large number of pages (> 100), an error message is
displayed intermittently when you click See extraction results for an existing learning
instance.
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Bot Insight

What's changed

To change the language in Bot Insight, you must apply the language settings from either
your browser or operating system that is configured to the language of your choice.

Internationalization, localization, and language support on page 1067

Fixes

Service Cloud case ID Description

00799262, 00826862 An error no longer occurs when you run a bot that includes
special characters in the name and the analyze command.
Previously, bots with an ampersand (&) in the name and the
analyze command included encountered an error.

The calculation in the device dashboard is now corrected to
show an accurate maximum of 100 percent for daily utilization.
Previously, a calculation error caused the device dashboard to
display over 100 percent.

The following table lists the limitations identified in the current release:

Limitations in this release

Bot Insight is not compatible with Microsoft Internet Explorer 11. For a list of alternative
browsers, see Browser requirements for Automation Workspace on page 1063.

Important: For information about the packages supported with this release, see Packages
available in Automation 360 on page 2042.

Automation 360 v.22 Release Notes

Release date: 21 September 2021

Review what's new and changed, and the fixes and limitations in the Automation 360 v.22 release.
Build 10535 is for Cloud and Build 10526 is for On-Premises. For Automation 360 |Q Bot, Cloud is
on Build 10535 and On-Premises is on Build 10520.

Important: We have updated the Automation 360 Cloud build to include additional fixes for the
Apache Log4j2 component vulnerability. The build includes the new Log4j2 library version 2.16.0.

» Migration

11.x and 10.x | 11.x only
« Automation Workspace

What's new | What's changed | Fixes | Limitations
» Automation Co-Pilot
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What's new | What's changed | Fixes | Limitations
» Discovery Bot

What's new | Fixes | Limitations
« |1Q Bot

What's new | What's changed | What's deprecated | Fixes | Limitations
« Bot Insight

Fixes | Limitations

Updating to this release

You can update the Automation 360 v.22 release from the previous three releases (that is, from n
-3 releases, where n refers to the latest release).

The following previous releases are certified for update to this release:

e v.21 (Builds 9664, 9642, 9595)
e v.20 (Build 8815)
« V.19 (Builds 8147/, 8145, 8122, 8098)

You can directly update to v.22 from any of these builds. For details on how to update, see Update
Automation 360 to latest version on page 1266.

Recommendation: If you are not on an n—3 release, update Automation 360 to one of the three
certified releases before updating to this release.

Important: This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this
release.

Automatically update the Bot Agent on page 1207 | Manually update the Bot Agent on page
1209

To verify which version is compatible with this release, see Compatibility with release builds on
page 1182.

For information about the latest updates to the Automation 360 extensions for Google Chrome,
Microsoft Edge, and Mozilla Firefox, see Browser extensions for Automation 360 on page 852.

Migration features

Enterprise 11 and Enterprise 10 features

Migrate bots that use Credential variables (Service Cloud case ID: 00705937, 00761271,
00776189)

You can now migrate bots that use Credential variables that are not available in the Cloud
Control Room. However, you must create the required credentials after migration in the
Credential Vault and use them in the migrated bots to run these bots successfully.
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Enterprise 11 and Enterprise 10 features

Migration support for Browser, Java, and Java Applet applications for App Integration
command

You can now migrate bots that contain the App Integration command with application
types such as Browser, Java Applet, and Java applications.

New Action Required tab in Bot Scanner report

In the Bot Scanner report, we have introduced the Action Required tab within the Bots
that can be migrated now section to provide advance notification about bots that require
manual intervention after migration so that they can run successfully in Automation 360.
View messages associated with the bot that requires action to understand the cause and
the specific action you must perform in Automation 360.

Analyze Bot Scanner report for migration on page 1375

Action required, Review required, and Error messages for migration

Migration messages are now classified into the following categories: Action required,
Review required, and Error messages:

« Action required and Review required messages are displayed for bots that contain
unsupported commands but which you can still migrate and run after migration by
performing specific actions. The messages provide specific actions you have to perform
or information that you have to review to ensure that these bots run successfully after
migration to Automation 360.

» Error messages are displayed when a specific bot is not migrated successfully. The
messages also include the cause for the failure.

Migration messages on page 1519

Enterprise 11 only features

Migrate bots with the following attributes:

« Bots with timeout specified in their property

» Bots that contain the GUI Automation command with the Restore Window or the
Execute Script option selected

« Bots that open a session for Terminal Emulator and Microsoft Excel in the parent bot
and close that session in the child bot

* Bots that automate email-related tasks on Microsoft Exchange 2013

* Bots that use SAP BAPI standard and custom workflows to automate tasks on SAP
applications

» Bots that contain the Window command with the Close All Open Windows selected to
close all multiple active windows (Service cloud case ID: 00773227)
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Automation Workspace

What's new

Save bandwidth on devices through preloaded offline bot packages

Customized or most commonly used bot packages in a bot are now saved offline on a
user device to the following new folder: AAPreloadedPackages. When a bot is deployed
on a user's device, the packages are used from this AAPreloadedPackages folder instead
of downloading them from the Control Room.

When a specific version of the package is available, you can download it from the Control
Room repository to save the time required to download the package during bot execution.

Preload packages on page 2036 | Devices on page 1703

Introducing Text file package

A new Text file package is now available and includes the Get text action. Use this action
to extract text from files that have Japanese characters with Shift-JIS encoding and then
save the content in the files to a string variable.

Text file package on page 2751

New actions in Window package

* Use the Close all action to close all windows or programs running on the system,
except the windows added in the Add window field.

» Use the Restore action to restore the size of a maximized or a minimized window or
application running on the system.

Window package on page 2779

Share session across bots

Share a DLL, Excel, and Terminal Emulator session across multiple bots using the Global
session option. You can also share a session with specific child bots using the Variable
option and share a session with only the current bot using the Local session option.

Sharing sessions across bots on page 2227

Enhancements to Excel advanced package

*  Open files with .xml and . txt extensions using the Open action.

e Use the wildcard character (*) in the Open action for file names to search based on the
wildcard pattern.

*  When you use the Run macro action and specify an argument that has a blank value,
this blank value can now be passed to the macro.

New option in Database: Disconnect action

In the Database: Disconnect action, you can now use the Keep database schema in
cache until bot finishes running option to enable the Loop action to iterate the dataset by
using cached schema after disconnecting from the database.
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What's new

TNS name supported for Oracle Database connection

TNS (Transparent Network Substrate) name is now supported in the Oracle Database.
You can connect to the Oracle Database by specifying the TNS name and path of the
tnsnames.ora configuration file.

New Exchange version supported in Email package

In the Email package, when you choose an EWS server to establish a connection, you can
now use the Exchange2013 option in the Exchange Version field.

Enhancement to AlSense Recorder

AlSense Recorder now enables automation of applications that use Russian and a
combination of Russian and English interfaces.

AlSense for recording tasks from remote applications on page 1998

Enhancements to recorder conditions for packages

» Use the new Object does not exist condition from the Condition list of any package to
verify whether a specific object in a window exists and then execute actions based on
the result.

This condition works with SAP technology as well.
» The existing Object condition is now renamed as Object exists.

Loop package on page 2455

Enhanced support for SOAP Web Service URI (Service Cloud case ID: 00759811)

In the SOAP Web Service package, if the input to the Address location field is empty, the
bot now retrieves the address location from the WSDL file.

New option in SOAP Web Service package

Use the Build SOAP request option in the SOAP Web Service package to retrieve SOAP
request details from the SOAP URI or the WSDL file. You can now select any operations
from the list of services and ports available in the SOAP Request to automatically populate
data in the fields of the SOAP Web Service action.

Example of using the SOAP web service action on page 2826

New option in REST Web Service (Service Cloud case ID: 00764198, 00800287)

In the REST Web Service package, you can now use the Allow insecure connection when
using https option to skip SSL certificate validation and to allow non-secure connections.
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What's new

Relative click and occurrence supported in packages (Service Cloud case ID:
0055643,00754173)

When you capture a target image using the Image Recognition package, you can now
use the Preview option to select a specific captured occurrence and position your click
location relative to the image.

The feature is supported in the following packages and actions:

* Image Recognition > Find image in window

* Image Recognition > Find window in window

« |f > Image Recognition condition

e Loop > While > Image Recognition condition

« Wait for condition action > Image Recognition condition

Using Find image in window action on page 2399|Using the Find window in window
action on page 2402

Wait time option in Google Sheets package (Service Cloud case ID: 00738249, 00817449,
00814775)

When you use the Connect in the action in the Google Sheets package to establish a
connection with the Google server, you can now set a wait time in the Wait for actions to
complete field when performing actions such as Get, Set, or Delete. For example, if you
have a large file that takes a long time to open, you can now set the wait time for the file to
open before the system executes the next set of actions.

New option for Put action in Dictionary package

You can now assign a static value to a key for a dictionary variable by using the Static value
option in the Put action in the Dictionary package.

Dictionary package on page 2218

Java applications supported in App integration package

The App integration package now supports Java applications that are based on the
Standard Widget Toolkit and Abstract Window Toolkit, which can draw text using Windows
text-drawing APIs.

Use regular expressions in File > Open action (Service Cloud case ID: 00737614)

Use regular expressions (regex) in the Open action of the File package to support pattern-
based search.

Specify timeout for bots (Service Cloud case ID: 00667049, 00690892, 00699158,
00706491, 00739420, 00739415, 00741590, 00769795)

You can now specify the amount of time by which the execution of a bot must be
completed. The system stops the bot execution if it is not completed within the time you
specified.

Configure timeout for bot execution on page 2050
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What's new

New option to search text within bot content in Bot editor (Service Cloud case
ID: 00735685, 00736201, 00739122, 00740481, 00733885, 00748970, 00746459,
00738181,00756441,00759037,00761453,00764478)

In the Bot editor, use the search box in the Flow, List, or Dual view to search for text,
variables, or actions in the entire bot content such as package name, action name, string
name, or variable name. This feature helps you to view or edit a bot with long code lines
to determine where the searched text, such as variables, strings, or actions, is used and in
which line.

Actions to build bots on page 2088

Enhancements to the bot structure

We have enhanced the overall readability of the bot structure and updated the node labels
of the bot to show selected properties and parameters of each action in detail in the Flow,
List, and Dual views. You no longer have to expand each action to view these details.

The Flow, List, and Dual views display the following properties of actions:

» The value you enter for actions such as Set text for all supported technologies

* Names of objects on which actions such as Set text, Click, Left click, Get property,
and Select item by index are performed

« Name of the object property mentioned in the action

«  Name of the return variable if some value is assigned to a variable

» List of properties for the Get property action

Enhanced network security control

As a Control Room administrator, you can now configure and audit specific, permitted
URLs for more granular control of the network access points.

Set callback URLs on page 1646

Enhanced proxy support

Connections to the internet are often run through proxy servers. Automation 360 provides
enhanced support for proxy configuration for packages, such as REST and SOAP packages,
for building and running bots.

Connect Bot Agent to a device with a proxy on page 1198

Connect to Azure DevOps (Cloud) Git from Control Room

You can now connect to Azure DevOps (Cloud) Git through the Control Room to check in
a bot and its dependent files to the remote Azure DevOps (Cloud) Git repository.

Connect to Azure DevOps Git from Control Room on page 1664

Work item ID and time filters for workload automations

Combine the work item ID and start time of a queue to search for specific work items and
monitor the progress of these work items. The start time filters the list of all work items that
start between specified start date and start time.

Actions allowed on view queue page on page 1835
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What's new

Enhancements to execution type key in AATaskExecutor variable

* When you schedule a bot to run, the Execution Type key in the AATaskExecutor
variable now returns information about the execution type with schedule type
(frequency) such as Run as schedule Daily, Run as schedule Weekly, Or Run

as schedule Monthly.

* When you use a trigger in a bot, the Execution Type key can be accessed through
the trigger data. The Execution Type key returns the Run through Trigger asa
string for triggers.

Language support for variable names

Variable names now support Greek and Japanese languages. You can now create variable
names using the following characters:

* Greek uppercase and lowercase characters
« Japanese Katakana full-width and half-width characters.

ML services support in Linux package installer

The python package in the Linux installer package is now updated to support ML services.
When you download and install Control Room on Linux, ML services are up and running as
part of the installation process.

Installing Control Room on Linux on page 1145 | Stop and start Control Room services on
Linux on page 1157

Direct download support in Bot Store

Users who cannot connect their Control Room to the internet can now directly download
Automation 360 bots and packages locally from Bot Store and then import them to their
Control Room.

Download locally and import bots and packages from Bot Store to Control Room on page
3135

MS-SQL database management enhancement

Administrators are no longer required to re-install Automation 360 to have the ability to
change MS-SQL configuration related settings. The editable settings include username,
password, database server name, database server |IP and port numbers.

What's changed

Changes to Runtime Window

The title on the Runtime Window is now changed to Bot running from the previous
Automation Anywhere.

If any issue occurs in your automation due to this title change, see this article on how to
resolve it: A360.22 | Runtime Window: Minimize Command Fails Due to Title Change (A-
People login required)
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What's changed

Changes to Run DLL package

* The Run function (Legacy) action is no longer available in the Run DLL package. We
recommend that you use the Run Function action from the Run DLL package because
this action is an improved version of the Run function (Legacy) action.

Note that existing bots that use the Run function (Legacy) will continue to run
successfully without any issues.

* The Set session variable action is no longer available in the Run DLL package. Instead,
we recommend that you create a new DLL session using the Variable option in the
Open action of the Run DLL package.

Note that existing bots that use the Set session variable action will continue to run
successfully without any issues.

Messages for migrated bots for which referenced MetaBot logic is not available

Bot Scanner and Migration Assistant now display action required messages for Enterprise 11
or Enterprise 10 bots for which the referenced MetaBot logic is not available.

Migration of bots with missing variable is blocked

The migration process does not migrate Enterprise 11 bots that use a variable which is no
longer available and that variable is used in the If, Loop, Variable Operation, or Clipboard
command. Previously, these bots were successfully migrated but an error occurred when
the bots were run.

Update to MetaBots that use same DLL in multiple logic (Service Cloud case ID: 00684185,
00730248, 00742840, 00742840, 00779629, 00779788, 00727977, 00743986, 00764872)

Migrated bots that use the same DLL in multiple MetaBot logic now work as expected
without any modification. Previously, you had to update the migrated bots to run them
successfully.

Migrated bots run successfully when mapped variables are not available (Service Cloud
case ID: 00746651, 00785703)

Migrated bots now run successfully when mapped variables are not available in the child
bot or the parent bot.

Enhancements to Bot Agent device settings

To easily access local and remote devices, a user can now change the Bot Agent device
settings from the My Settings page in the Control Room pane below your username. You
can perform the following actions:

« Update device credentials
» Change the default Bot Runner device
* View local device name, status, and Bot Agent version

Set user device credentials on page 1200 | View and update Bot Agent device settings on
page 1200
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What's changed

Enhancement to auto discovery for multiple domains

You can now configure the maximum number of sites that can be discovered across the
domain in the um.properties file for a Control Room set up for auto discovery across
multiple domains in different locations.

Configure Control Room for Active Directory: auto mode on page 1222

Enhancement to OpenDistro for Elasticsearch

As part of enhanced security, OpenDistro (cron-utils) is now upgraded to v.1.13.2 for
Elasticsearch v.7.10.2

Update to Printer package

In the Remove and Set default actions of the Printer package, you can now select a
specific printer from the list of available printers.

Printer package on page 2543

Insert recorded actions in the middle of a bot

You can now insert any recorded actions that are newly captured at a specified location in
an existing bot. Previously, recorded actions were added to the existing bot at the end by
default and users had to drag the action to the specified location.

Universal Recorder for object-based automation on page 1981

Migration: system variable behavior outside a loop (Service Cloud case ID: 00761281)

When you migrate bots that use system variables outside a Loop package, the variables
are now converted to record type or string type user-defined variables as applicable and
assigned to a record action. As a result, when bots that contain these variables are run, data
from the last row is displayed. Previously, an empty value was displayed after migration.

The following system variables are converted to record type variables:

SFiledata Column$
SExcel Column$
SDataset Column$
STable Column$

L]

The system variable SXML Data NodeS is converted to a string type variable.

Variable mapping for migration on page 1495

Support removed for Redirect URI attribute in Google Sheets package (Service Cloud case
ID: 00777287)

The Redirect URI attribute in the Connect action of the Google Sheets package is now
removed. After updating to this release from previous Automation 360 releases, you can
continue to successfully execute your bots by entering the fixed redirect URL in Google
Cloud Platform: http://localhost:8888/Callback
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What's changed

Updates to device credentials recorded in audit log (Service Cloud case ID: 00691511)

You can now view audit log entries if your device credential is updated either manually
through the Bot Agent device or through the Control Room API. Activity details such as the
user name updating the device credentials and the time of the update are logged.

Enhancement to Image Recognition package

When secure recording is enabled, the target image that is captured using the actions in
the Image Recognition package is now hidden after the initial capture to enhance security.
Previously, the user was able to view the target image even when secure recording was
enabled.

Image Recognition package on page 2398

Enhancement to File and Folder package

Users with a valid role permission can now create a shortcut to a selected source file at a
specified location using the Create shortcut action in the File and Folder package.

Support for HTTP method HEAD (Service Cloud case ID: 00754096)

The HTTP method HEAD is now supported as an API call to connect to the load balancer of
a Control Room configured for high availability.

Update to Linux installation and log path
» Installation files

« If you are on a version earlier than Automation 360 v.22 or if you have updated from
an earlier version to v.22, the installation files are now stored in this path /opt/
automationanywhere/enterprise

« If you perform a new installation of v.22, the files are stored in this path: /opt/
automationanywhere/automation360

* Log files

« If you are on a version earlier to v.22 or if have updated to v.22 from an earlier
version, the log files are stored in this path: /var/log/automationanywhere/
enterprise

« If you perform a new installation of v.22, the log files are stored in this path: /var/
log/automationanywhere/automation360

Check out a Task Bot with specific version

If a bot has multiple versions, you can now select and check out the specific version of the
bot. As a Bot Creator, this enables you to roll back to an earlier version of the bot.
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What's changed

Signed DLLs for bots and packages

Automation 360 now signs all DLLs, including third-party DLLs, for bots and packages.

The following are exceptions:

» The IQ Bot Pre-processor package does not have a new version in this Automation 360
v.22 release. The v.21 package version is copied to v.22 without modification, including

a few unsigned DLLs.

* The Process Discovery package in this v.22 release does not have the signing applied.

* Automation Anywhere

e Azul Systems (Java JRE in Bot Agent)
» TeamDev Ltd. (third-party library)

Fixes

Service Cloud case ID

Description

00712808, 00765752

In previous releases, Automation Anywhere related files were
sometimes generated in C: \Windows\Temp. This issue is now
fixed.

00800392 An error no longer occurs when you migrate from a Enterprise
11 version where a database is stored on Google Cloud Platform.

00811887 The Cloud Migration Utility no longer encounters an error when
you use a custom port number to connect to the Enterprise 11
database.

00815097 Enterprise 11 bots that are checked out by a user are now
successfully migrated to Automation 360 Cloud.

00802360 You can now update the value of Enterprise 11 credential

attributes after they are migrated to Automation 360 Cloud.
Previously, the system encountered an error when you updated
the value of a credential attribute that was added or updated by a
user in Enterprise 11 and that user was no longer available when
Enterprise 11 data was migrated to Automation 360 Cloud.

When you migrate from Enterprise 11 to Automation 360 Cloud,
an error no longer occurs when a locker is deleted in Enterprise
11 but its related permissions are still used in other entities.

An error no longer occurs when you update from Version
11.3.5.2 to any Enterprise 11 version and then migrate from that
Enterprise 11 version to Automation 360 Cloud.

The Refresh and Back options are now available on the
Summary screen of the Cloud Migration Utility when enough
disk space is not available to store the backup of Enterprise 11
Control Room data.

00787240, 00781349

Migrated bots no longer encounter an error when a parent bot
and its child bot are opened through Internet Explorer and the
child bot extracts a table from Internet Explorer.
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Fixes

Service Cloud case ID Description

- There is no limitation now on the number of ActiveMQ
connections that are allowed when running an automation
that is looped 5 times, with each loop running over 20 bots. In
previous releases, the automation sometimes failed after the
fourth loop.

0074312 You can now successfully migrate bots that contain Trim
operation of the String and the output is assigned to an Array
variable.

00760963 Migrated bots that contain the Go To Cell command now work
properly in Automation 360 after migration.

- Bot Scanner now loads the modified cache.properties file
from the conf folder. Previously, you had to place the modified
cache.properties file in the executable file location of the
Bot Scanner for the file to be loaded.

00754003 Bots that contain the SOAP Web Service command now
successfully run after migration without encountering any error.
Previously, an unexpected error occurred when the SOAP Web
Service with WSDLs defined with external dependencies were
not invoked.

00790360 In the Terminal Emulator package, when you send any key
to the terminal with the Send text or Send key action, if the
terminal is in a busy state or the keyboard is in a locked state,
these actions now wait for 5 seconds for the terminal to return
to a normal state. After 5 seconds, the system moves to execute
the next action without any exception.

00742000 Migrated bots that contain the Prompt > For value command
with the Don't write in any windows option selected now work
as expected in Automation 360 after migration and no text is
written in the file if any window is open. Previously, even if this
option was selected, if any text file window was open, the text
was written in the file.

00781072 When bots are migrated using the Bot Migration Wizard,
migration no longer fails if the bot name includes a special
character. Previously, an internal error occurred when the bot
name included an apostrophe (') character.

00780713, 00778164 A migrated bot is no longer unresponsive when that bot uses the
App Integration package to capture text from a target application
and the target application becomes unresponsive.

- Migrated Enterprise 11 bots that use the Terminal Emulator
command to clear the terminal screen of the VT and ANSI type
terminals no longer encounter an error when they are executed.
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Fixes

Service Cloud case ID Description

00748647 Migrated Enterprise 11 bots that use two-dimensional array
and the Variable Operation command no longer encounter an
error. Previously, the migration process used to set the number
of rows and columns for the two-dimensional array to 1x1
irrespective of the values set in Enterprise 11.

- The migration process continues to migrate bots if the
connection between the Control Room and the Bot Agent is lost
and then reestablished. Previously, the migration process failed
when the connection between the Control Room and the Bot
Agent was lost.

00764441 In the Excel: Get single cell action of the Excel advanced
package, you can now access the value of a specific cell defined
in the cell address. Previously, migrated bots encountered a
Must match pattern error when a Japanese character was
entered in the Cell address field.

00757713, 00764985, The Excel advanced package now enables you to read from a

00820376 protected sheet. Previously, migrated bots encountered an error
when you retrieved a cell from a protected sheet using the Excel
advanced: Open action.

00761911 You can now migrate bots using the Excel column system
variable where the key is the column name; an error is no longer
encountered.

00769321 Migrated bots no longer encounter an error when the Run Excel

Macro command is included in the bots. Migrated bots now run
properly using the Run macro action of the Excel advanced
package.

00790858 You can now migrate a bot when there is a variable mismatch
and the respective command is disabled. Previously, when
the bot was assigned a certain variable type and the Variable
Operation command in that variable was disabled, Bot Scanner
displayed an error for the variable when the type was later
changed.

00744318, 00744326, You can now download an exported bot file with Japanese

00745318 characters in the filename through email. Previously, when an
exported file with a Japanese name was downloaded using the
email link, an error occurred or the characters in the exported
Zip filename were garbled and . zip was appended to the
filename.

00762975 After you migrate Enterprise 11 bots that use the Error handling
command with the Send email function and the Attach variable
and Attach snapshot option, the bots now correctly send error
emails with attachments containing a snapshot or variable text
file.
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Fixes

Service Cloud case ID

Description

00731577, 00746226,
00760649, 00759973,
00767618, 00789545,
00821824

The includePackages parameter of the Export APl now works
as expected. If you set the value of the parameter as True the
packages are included in the exported file, and if the value is set
to False the packages are not included in the exported file.

You can now migrate bots with variable names that include
full-width and lowercase characters. Previously, migration

of bots with a variable name that included full-width and
uppercase characters was not supported because the variable
was mistakenly converted to a half-width character.

00759189

Migrated bots now use the date format specified in the
AADefaultDateFormat global value for email-related automation.
You must create the AADefaultDateFormat global value before
migrating the bots and specify the date format you want to use
in the migrated bots.

Recommended: Specify the same date format in the
AADefaultDateFormat global value that is used in Enterprise 11.

00784001

Enterprise 11 bots that are migrated now contain all the
properties of an object captured from a SAP application.

00786362, 00802274

Enterprise 11 bots that are migrated no longer encounter an
error when the child bot and parent bot use different versions of
the If package.

00807986

Enterprise 11 bots that are migrated no longer encounter an
error when a variable that is mapped between a child bot and
the parent bot is not available in the child bot.

00808026

Enterprise 11 bots that are migrated no longer encounter an
error when they use a shared session for Terminal Emulator
related tasks when a session is shared between nested child bots
and an intermediate child bot does not contain any Terminal
Emulator actions.

For example, consider that you have three bots: Botl, Bot2, and
Bot3, where Botl calls Bot2 and Bot2 calls Bot3. Botl and Bot3
share a session for Terminal Emulator related tasks; however,
Bot2 does not contain any actions from the Terminal Emulator
package. When you share a session between Botl and Bot3, an
error is no longer encountered.

00762368

Previously, when bots were migrated using Oracle database
processes with passwords containing the symbol, an issue
occurred. The issue is now fixed and passwords using the "@”
symbol are now supported.

00768466, 00769099

An error no longer occurs when you migrate MetaBots that
contain logic that are available within a folder.

00772885

The system now retrieves all rows in a table in a SAP application
when the last page of the table contains a single row.
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Fixes

Service Cloud case ID Description

00801733 An increase in CPU usage no longer occurs when the Control
Room is in an idle state.

00774821 An error no longer occurs when you run migrated bots that
contain a Loop action within another Loop action.

00786732 For Enterprise 11 bots that use the Extract Table command
along with other commands within the Error Handling
command and only the Extract Table command is disabled,
only the equivalent action for the Extract Table command is
disabled after migration. Previously, all the actions within the
Error Handling action were disabled in the migrated bot.

00743892 An error no longer occurs when you run migrated bots that use
DLLs that return a value of user-defined type. Such values are
converted to the string type in the migrated bots.

- Enterprise 11 bots that use variable operations to re-initialize
an array type variable to contain more than 160,000 cells (for
example, 400 rows and 400 columns, or 800 rows and 200
columns) no longer encounter an error when they are executed
after migration.

00737025 Enterprise 11 bots that pass system variables such as Month,
Year, and Day as an input variable to a MetaBot no longer
encounter an issue after they are migrated.

00773407 Previously, historical activity reports exported to CSV did not
display the Last Modified information correctly because some
of the Modified On and Modified By information was not
accurately processed. The error is now fixed and historical
activity reports can now be correctly exported to CSV files.

00767597 The Last Modified (date) value displayed in the historical activity
and bot page reporting was previously not translated correctly
when the Control Room language was changed from English to
non-English, and then back to English. This error is now fixed,
and the data is preserved when the language is changed in the
Control Room.

00762975 Japanese language text is now updated in the interface for
recent user experience (UX) changes. Previously, there were
some errors in the translated text in the interface, which are now
fixed.

00763228, 00776154 Database constraints, such as foreign key constraint violations,
previously prevented users from deleting bots after migration.
This limitation is now fixed and users can delete migrated bots
(.atmx files) without any issue.

00749375,00763262 After migration, if text file encoding was set to UNICODE or
UTF8, you can now use the String: Import string from text file
key to read values from the text file during bot runtime.
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Fixes
Service Cloud case ID Description
00739268 You can now migrate bots that have large html data associated

with the Object Cloning command without any issues.

00674147, 00682390 The Stop service action of the Service package now enables
you to stop all child and dependent services of a selected
window or application. Previously, the dependent service did
not stop automatically when a user tried to stop any window or
application service.

00754835 Temporary devices are now automatically deleted if the auto-
delete option is enabled for device settings in the Control Room.

00751058, 00761099 When you use the Database Connect action for workload
automation, work items from the second iteration are now
executed for automation. Previously, only the first work item in
the workload automation was executed.

00771098 After you edit a schedule from the Scheduled activity page and
save the schedule, the correct page (Scheduled activity) is now
opened instead of the In progress activity page.

00733614, 00741358 You can now use the Extract image action of the PDF package
to convert a PDF file that contains JPX images to any other
image format. Previously, the action failed to extract image from
the PDF file because the JPX image reader was not supported.

00765851 Recorder actions now work properly and do not cause any delay
when the Set text value contains brackets or [] (which enables
you to run a migrated bot without delay). Previously, it took a
longer time to run the bot when Set text contained [] (brackets).

00771197 In the Open action of the Browser package, the description
below the Time out after (seconds) (optional) field is now
translated correctly as Min= 9 seconds in the Japanese
language. Previously, the description was translated as Max= 9
seconds.

00761395 In the Database package, when you connect with the Oracle
Database and use the Read from action option in a loop to
retrieve records from the database, the bot is now executed
successfully. Previously, bot execution failed with an error.

00727530 The Move all action in the Email package now works properly
and does not encounter any issue.

00739978 An error no longer occurs when you choose the Manual input
option to open a VB Script file.

00728180 The issue with event triggers when creating folders in bulk is
now resolved. If you configure an event trigger to start a bot
whenever a folder is created and then create folders in bulk, the
bot is now deployed for every folder that you create. Previously,
the bot was not deployed for all the folders created.
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Service Cloud case ID Description

00711134, 00750164, If you configure multiple triggers to start bots based on file

00847916 events and if all the files reside in the same folder, the bots
associated with all the triggers are now deployed. Previously,
only some bots were deployed.

00719612 When you log in to the Control Room as an unattended Bot
Runner, you can now execute bots using the Run as self option.
Previously, an unattended Bot Runner could not run the bot with
the Run as self option even when the device was set as the
default device.

00745095 In the Database package, when you connect to the Microsoft
Access database using the JDBC connection, the select query
now extracts the file name for the Attachment data type.
Previously, an error was displayed.

00772194 Data from any database type is now exported correctly in CSV
format. Previously, if the data had special characters such as
double quotation marks, the output was displayed in a new line.

00773961 When you create a new worksheet by name in the Google
Sheets package, an error no longer occurs when you execute
the bot.

00762029 An error no longer occurs when you execute a bot using the
Google Calendar package. Previously, when the Disconnect
action was used to terminate the connection, the email address
attribute was stored in the session name instead of the user
session name attribute. As a result, bot execution failed with an
error.

00758333 If all versions of a particular package are disabled, then the
package is no longer listed in the Actions palette of the Bot
editor.

Previously, when a package was disabled, the Bot Creator still
displayed it in the Actions palette and users were able to use
the package when creating a bot. However, these bots failed on
execution because the package was disabled.

00780221 A bot created using the Run function action in the Run DLL
package now executes without any issues. Previously, an error
was displayed on bot execution due to the unavailability of some
embedded resources such as satellite assembly.

- An error no longer occurs when you create a bot using the Send
text action of the Terminal Emulator package and pass a variable
with an empty value. Previously, the bot failed to execute when
any variable options (Credential, Variable, Insecure String) that
had no value was selected.
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Service Cloud case ID

Description

00776430

When you connect to the Terminal type TN3270E in the
Terminal Emulator package, select any of the Terminal model
options from the list, and execute the bot, the correct screen
resolution is now displayed. Previously, a wrong value was sent
for each Terminal model and a screen with incorrect resolution
was displayed.

00773415, 00781487

When you open a spreadsheet in the Google Sheets package
and select the Beginning of the row option in the Go to cell
action, the output is now displayed correctly. Previously, the
output was displayed at the column level.

00773415, 00781493

An error no longer occurs when you open a new or blank
spreadsheet in the Google Sheets package and you select an
action such as Go to cell or Set cell to perform an operation.
Previously, bot execution failed with an error.

00779561

In the System package, when you use the Get environment
variable action in view mode, the environment variables are now
always displayed in the list. Use the refresh option to retrieve all
the environment variables in the list. Previously, the environment
variables were sometimes not displayed in the list.

00775073

In the Excel advanced package Get worksheet as data table

> Read option, the description for the Read cell value option
now reads correctly as 50% will be read as 50 whenitis
translated to the Japanese language. Previously, the description
was translated as 50% will be read as 50%.

00767246

The SOAP Web Service package now works for URIs, where the
service endpoint can be passed as a URI parameter. Previously,
an error was displayed for such requests.

00734463, 00754570,

00766456

When the Connect action of the Database package is used

to establish a connection with the Microsoft SQL Server using
Windows authentication, the bot now executes successfully
even when the parent and child bots use different versions of the
Database package.

Previously, the bot failed if the parent and child bots used
different versions of the Database package.

00780921

An error no longer occurs when you use the PDF extract text
action to extract text from a PDF file. Previously, when structured
text was extracted from a PDF file, an error was displayed
because the index exceeded the 1000 range.

In the Excel advanced package, when you use the same session
name to open multiple Excel spreadsheets, the bot now displays
an error on execution. Previously, if the same session name was
used in multiple spreadsheets, the bot overwrote the existing
open session when the second Open action was executed.
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Service Cloud case ID

Description

00785198

In the Data Table package, when you now use the Write to file
action to extract data from a table with large records, 1000 rows
of data are read in batches and written to a CSV file.

Previously, a Java heap space error was displayed because the
configured Java heap memory ran out of space. As a result, data
could not be retrieved from a table with large data and written to
a CSV file.

00757593

In a Cloud deployment, child bots can now be migrated
using the Migrate Bot action from the Bot Migration package.
Previously, child bots were not migrated but a migration
successful message was displayed.

00731012, 00747385,
00746320

If you install the Control Room in the default location in C: \ and
configure the logs directory in another location (for example, E:
\), WebCr logs are now generated dynamically in the custom
location.

00768318, 00760835

An error no longer occurs when you try to capture objects using
AlSense Recorder on any version of Windows that does not have
the default media feature pack. Previously, the AlSense Recorder
did not highlight the objects on a page.

00737710

In the Capture action of the Recorder package, when you select
the Set Text action and enter a string variable with a delay set for
each keystroke, the output is now displayed correctly on a new
line for all Microsoft applications. Previously, on bot execution,
the output was shown on one line when a delay was set in the
Keystroke.

If you deploy bots using event triggers and you install the Bot
Agent on a device as a non-admin user for self or a local admin
user, the Bot Agent is now updated automatically. The device is
no longer shown as disconnected in the Control Room.

00782596

You can now migrate workload automation bots from Enterprise
11 to this release. A client protocol exception message is no
longer displayed.

00743810, 00785703

You can now map variables with different letter cases between
parent and child bots when you run bots after migrating them
from Enterprise 11 to this release. For example, if the variable
name in Enterprise 11 is Vvarl and the variable name is changed
to varl after migration, you can map the variables and continue
to run the bots.

Bot deployments on Bot Agent devices no longer fail when you
close a terminal window using the close Window action from
the Window package or manually close the Terminal Emulator
window.
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Fixes
Service Cloud case ID Description
00767587 You can now run bots from the In progress activity page.

Previously, bots were stuck in the Pending execution state and
as a result other bots did not run. You had to manually move the
bots stuck in this state to the Historical activity page to run the
other queued bots.

00789682, 00798933 You can now delete, reset, or place on hold workload
automations because work items are no longer stuck in the
ready to run status. Also, the following message is no longer
displayed: Work item cannot be deleted in this
state.

00720471 An error no longer occurs when you use the Recorder package
to capture an object and perform the click action on the
capture coordinates. Previously, when you captured the object
properties and if the download bar in Google Chrome was open,
object properties in the browser could not be captured.

00754651 In the If action of the If package, when you select any condition
from the Condition list, and drag any other action inside the If
action, the condition is no longer deleted from the Condition
list and the action no longer disappears from the List and Flow
view.

00768354 An error no longer occurs when you use the AlSense Recorder
in child bots when running them in a loop. Previously, when
the AlSense Recorder was used in a child bot and the bot was
executed, external processes were not terminated, causing the
system to run out of memory.

- Previously, when bot migration was performed, the process sent
various, occasionally multiple, email notifications to all existing
Control Room users, even if the administrator had disabled email
notifications. An option is now added to enable the administrator
to disable email notifications when Credential Vault data is
created during bot migration.

00762368 Previously, when bots were migrated using Oracle Database
processes with passwords containing the “@” symbol, an issue
occurred. The issue is now fixed and passwords using the "@”
symbol are now supported.

- Previously, during migration, a parent bot was successfully
processed even if associated child bots did not exist. This
created errors during runtime. In this release, if associated child
bots do not exist for the parent bot, a message naotifies the user
of the required action before migration can continue.

00762975 Bots that used the Error Handling action to capture screenshots
were incorrectly modified and appended as .PNG files. Migrated
bots are no longer modified and appended in this manner.

00751496 Attended Bot Runner devices now show an improved time
performance when running bots on Microsoft Edge browser.
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00753673

When you run a migrated bot that contains the Excel Advanced
> Delete cell > Specific cell option with comma-separated
input cell values such as Al, B1, the migrated bot now runs
successfully and displays the output correctly.

00736473

Fixed an issue where a migrated bot containing the Excel
Advanced > Open action did not load the Excel add-ins even
when the Load Add-ins check box was selected. Now, the Excel
add-ins are loaded successfully.

00767917

You can now run bots with a queue on single user devices that
were previously configured for multiple users.

00712719

An error no longer occurs when you run bots that contain
actions from the Terminal Emulator package on your device.
Previously, bots could not be run due to a synchronization issue
with the terminal.

00753121

An error no longer occurs when you use the Convert excel to
PDF action of the Excel advanced package to save a converted
PDF to a shared network drive.

00763746, 00773924

When you select the Keystrokes action in the Simulate
keystrokes package and enter a variable or static text containing
half-width Japanese characters, the output now displays the
correct Japanese characters. Previously, on bot execution, the
output displayed incorrect characters.

00774872, 00807106,
00824486

When you use the Close action of the Browser package to close
the last Chrome browser window, the last tab of a Chrome
browser window, or all Chrome browsers, the bot no longer
encounters an error. Previously, when the Close action was
used to close the last Chrome browser window, the last tab

of a Chrome browser window, or all Chrome browsers, bot
execution failed because the Chrome communication channel
was shut down.

00762178

When you deploy bots using RDP on unattended user devices
configured for multiple users, a black screenshot is no longer
captured.

00800573, 00796393,

00804854

When you select a run-as user to deploy a bot, you can add a
Bot Runner user back from the list of Selected Bot Runners to
the list of available Bot Runners on the Run bot now page.

00744929

When incorrect Git credentials are entered, the credentials are
now hidden and not recorded in the WebCR_Commons . Log file.
Previously, incorrect Git login credentials were recorded and not
hidden in the log file.

00751304

The error model in Swagger docs is now updated to display all
the fields appearing in the APl response body. Previously, there
was a mismatch between the fields displayed in the APl response
body and the error model in Swagger docs.
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00763398

An error no longer occurs when multiple Excel files are opened
and you use the Run macro action in the Excel advanced
package. Previously, an error was displayed when a macro was
run with multiple sessions.

00759183

The Open action of the File package now opens any file using
the default application set by the user. For example, if Microsoft
Paint is set as the default application for all . jpg files, the
action now opens these files without any error. Previously, bot
execution failed with an error.

00750185

An error no longer occurs when you run a migrated Enterprise 11
bot containing the Object Cloning command even if it contains
some Unicode 8964 characters in some of its properties. The
bot now captures objects after migration without any error.
Previously, the bot failed to capture objects after migration if it
contained Unicode characters in its properties.

00774091

All object properties of the Object Cloning command are now
migrated without any errors. Previously, bot execution failed with
an error because the HTML ID and HTML name properties were
changed after migration.

00796322, 00823082

When you insert a variable as a parameter in any action of

a package, add additional text to this variable, save the bot,
and then edit the name of the variable from the variable list,
the additional characters added to the variable are no longer
deleted.

00731066 The Capture action in the Recorder package now works
properly, and you no longer encounter any delay when creating
and running new bots to extract any data from a DataGridView
control in certain Ul automation applications.

00784177 A bot deployment error is no longer displayed when you edit

and run a bot using Run bot now from the Bot editor of a Cloud
Control Room.

00782307, 00787807,
00811404, 00788178

Bot deployments are no longer stuck in a queue and now display
the error Picked at runtime after Automation 360 On-
Premises is updated from the previous release to this release.

00786786, 00806775

You can now capture a single object using a recorder from
Google Chrome browser, and the following message is no
longer displayed: Error performing single capture.

00780202, 00798826,

00808779

When you deploy bots using RDP on unattended user devices
configured for multiple users and you set the RDP screen
resolution to 1366x768, the resolution no longer changes to
1368x768 during bot execution.
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Service Cloud case ID Description

00769647, 00767674, The View historical activity page now shows the correct run
00773115, 00777239, details of start date and time for bots that fail during execution.
00778972, 00777752,

00792839, 00804603,

00806606, 00815687,

00829496

Limitations

If you configure an external key vault in External Key Vault Integration and select the
SQL authentication mode for database authentication in the Windows installer Database
Server page to install Control Room (On-Premises), the installation fails, and the following
error message is shown: Control Room database tables fail to create.

Workaround: Add the database credentials in the external key vault and use those
credentials for database configuration.

The Task bots runs metric on the Home dashboard page of the Control Room displays the
count as zero even if you have run bots from the same Control Room.

(Service Cloud case ID: 00837271) If you are migrating from Enterprise 11 with a database
that has a large amount of repository data, the installation might fail. This issue occurs
because Liquibase update for a few SQL queries is not completed during migration.

Workaround: Contact Automation Anywhere Support.

When you are installing the Bot Agent, if you run out of disk space and click OK on the Out
of disk space window, the Bot Agent installation wizard might display the previous installer
windows.

Workaround: In the Setup type window, click Cancel and relaunch the Bot Agent
installation wizard.

(Service Cloud Case ID: 01021889) In this release, when you schedule or deploy a bot from
the Control Room, you will not receive an email notification if the bot fails to run.

(Service Cloud Case ID: 00780635, 00791587, 00795559, 00795632, 00797130, 00797113,
00791783, 00765770, 00826805, 01859661) When you update from the previous release,
schedules disappear from Control Room instances configured on a single-node or multi-
node environment. In some cases, after the update, previously deactivated schedules
disappear and are reactivated automatically.

Workaround: Divide large schedules into smaller schedules or reduce the schedule
frequency.

» Divide large scheduled automations into smaller schedules of two hours each. For
example, divide an automation schedule that runs for a 12-hour period, such as 9 AM
to 9 PM daily, into two-hour intervals, such as 9 AM to 10:59 AM, 11:00 AM to 12:59 PM,
and 1:.00 PM to 2:59 PM.

« Reduce the schedule frequency to 10 minutes.
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Migration of Enterprise 10 MetaBots with the password type variable with null value is not
yet supported. To migrate successfully, provide a default value to the password variable
when creating MetaBots in Enterprise 10.

When you attempt to log in to the Control Room configured with Active Directory, using
the Log in with Windows option is not currently supported in this release. Selecting this
option can generate a java.lang.NoSuchMethodError error.

Recommended: Enter the domain credentials directly.

(Service Cloud case ID: 00831886) As a Bot Creator, you cannot run bot tasks through the
Automation Co-Pilot process. Although human tasks appear fine, the Activity page displays
the In Progress state and seems stuck on the Waiting for user and/or device action.

Workaround: Remove the process discovery license - recorder from the Automation Co-
Pilot Bot Creator user. Please refer to AARI process discovery license assignment for more
information.

You cannot use the Global session option to share a Microsoft Excel session using the
Excel advanced package with the Loop package.

Alternate solution: Use the Get multiple cells action and save the data into a datatable
variable. Then, use the Loop package with the Data Table option selected.

The migration process successfully migrates bots that contain brackets or [] but the
process fails when you migrate the same bots again to migrate the delta changes even
when the overwrite option is selected.

Workaround: Delete existing bots from Automation 360 that contain brackets or [ before
migrating them again.

Users with the AAE_Bot Migration Admin role are not able to run migrated bots because
the Run my bots and Create folders permissions are not available in this role. As a result,
these users can start the migration process, convert the bots but cannot run the migrated
bots.

Workaround: Create a custom role with the Run my bots and Create folders permissions
and assign this role to the users with the AAE_Bot Migration Admin role.

When Enterprise 11 MetaBots that use a DLL that returns a two-dimensional array of

type single as output and stores the value to a file using the Log To File command are
migrated as Task Bots to Automation 360, these Task Bots encounter an error when they
are executed.

Migrated bots that are used to automate tasks using RDP encounter an error when the DPI
of the remote device is different from the current device.

Newly created Control Room users on Windows for On-Premises Google Cloud Platform
VMs cannot change their password. The security questions option is not available on the
Change password screen and as a result the Control Room displays an error when they try
to save the password.

Workaround: Refresh the page and change the password again.
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(Service Cloud case ID: 00770816) When you connect to an Exchange Web Services
server, multi-factor authentication (MFA) must be disabled, including in all organizational
level security policies where multi-factor authentication might be enabled. If multi-factor
authentication is not disabled completely, users might encounter connection and or
authorization errors.

Automation 360 does not support the Kibana version in Elasticsearch for which a privilege
escalation error is shown in the Black Duck report.

The Bot Agent is not updated automatically from a previous release to this release when
you perform different operations simultaneously such as running bots, configuring device
settings in the Control Room, and updating the Control Room.

Workaround: Restart the Bot Agent from the Task Manager.

A file is not deleted when you execute the bot with the following sequence of actions:
1. You use the CSV/TXT > Open action to open a .csv file.
2. You use a loop action within another loop action to retrieve values from the . csv file.
3. You use the CSV/TXT > Close action to close the file.
Here, all the actions are using the same Default session.

4. You use the File > Delete action to delete the file.

The issue (file is not deleted) occurs because the bot fails to close the Default session.

Bot execution can fail with an error when you execute the bot with the following sequence
of actions inside a loop:

1. You use the Browser > Open action to open a window.
2. You use the Recorder > Capture action to capture required objects on the window.

3. You use the Browser > Close action to close the window.

Workaround: Use the Window > Close action to close the window instead.

If you update the device information from the Administration > Settings > Devices page,
only the first update is captured in the Audit Log page. Subsequent updates to the device
are not captured.

When you register a new Bot Agent user device from the bot editor after creating and
running a bot, the following message is intermittently displayed: Device is either
disconnected or it needs to be upgraded.

Workaround: Click Run to deploy the bot on the new Bot Agent user device.

When you use the Universal Recorder to record multiple tabs in a SAP application, the Set
text action in the Client control of SAP does not work because it is currently not supported.

When multiple users check in their bots simultaneously, some of the check-ins fail
although Git is not corrupted and no data is lost.
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When you use the 2.3.0-20210806-215200 version of the Recorder package to capture any
control using HTML technology in Google Chrome or Microsoft Edge Chromium browser
and run the bot, the bot might fail with the following error message: Unable to find
control. Search Criteria did not match

Workaround: Use the 2.2.0-20210722-211132 version of the Recorder package instead.

When you try to automate any process in a Java application that is using version 11.0.8 of
AdoptOpendDK, the Recorder might not be able to capture the drop-down elements on
the application.

Automation Co-Pilot (Automation Co-Pilot)

What's new

Output variables support in Process Editor

The Output variables section in the process editor enables you to create a user-defined
variable that can be set as an output to any process. This helps you pass the output from
the child (sub) process, which was called in the Process Task, to the parent (main) process.

Use an Output variable on page 3003

Select File element input supported for Create a Request action

The Create a Request action in the AARI Web package now supports passing input in
the request creation forms for the Select File element. You can now use bots to create

a request and upload or download files as input with the Select File element. These
input files are uploaded to the storage service to be available for further processing in the
request.

Detail view in Tasks page

The new Detail view option in the Tasks page provides better insight into individual tasks
for better task management. The detail view previews each task in its respective request
view page without opening another page, which helps organize and correspond your tasks
with the available requests. Users can interact with their tasks as well.

Additional support for interface triggers on Google Chrome

You can use the following additional actions for interface triggers on the Google Chrome
browser during bot runtime:

» Hyperlink element: Click, Set focus, or Lost focus actions

e Checkbox element: Select, cleared, Set focus, Lost focus, or Selection changed
actions

» Radio Button element: Select, deselect, Set focus, Lost focus, or Selection changed
actions

Add an interface trigger on page 2950
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What's changed

Font size retained during bot runtime

When you create a form, the font size that you selected in the Formatting > Font size
drop-down menu is retained on the form during bot runtime.

Cancel option in the process and team setup page

When a user edits a process or team in the Process setup and Process setup pages, the
Cancel option replaces the previous X option to provide better clarity for the user to cancel
the current page.

Fixes

Service Cloud case ID Description

00781358 You can now add bots with table variables that do not have a
default value to a process without encountering any errors.

00791703 When you the use the desktop tray icon to open Automation

Co-Pilot Desktop Assistant, dependent files are no longer
displayed along with the application.

- In the process editor, the Go To option now shows the Filter
Task and Process Task options.

- When you enter data in a form of your process that contains a
hyperlink, the process data is no longer ignored and now works
correctly.

-- When you use Process Task in the process editor, you can now
use the Public folder option in the Select process file field.

- In Bot Task and Human Task, when you select a box, the input
is now accurately selected.

- The Requests page is now correctly updated with the latest
request events (such as completion of tasks) for users with an
Attended license.

- When you update to this release, a built-in scheduler now
periodically checks for any disconnected or temporary devices
and clears these entries.

- When you open a form in the public folder, it cannot now be
edited by changing the term View to Edit in the URL.

- When a user logs in to Automation Co-Pilot Desktop Assistant,
all the triggers associated with that user name are now available.
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Users cannot edit a form or process in a public workspace, they must check out a form
or process in order to edit in a private workspace. However, when users attempt to edit a
form or process in a private workspace, they receive an Access denied error message due
to the cache not being refreshed.

Workaround: Navigate to the your private workspace, refresh the page to clear the cache,
then edit your form or process.

An Automation Co-Pilot user with the AAE_Robotic Interface User license who is not apart
of an assigned team can view all requests and tasks from other teams in the web interface.
However, when the user attempts to access a request or task, they are prompted with an
error message.

When a form is opened during bot runtime, the automated focus on the first form element
is lost. For example, consider that Form A has various elements, and a Text Box element
called Name is the first one. When Form A is opened during bot runtime, the focus is lost
from the Name element and you cannot enter any values.

Workaround: When a form is opened during bot runtime, click the form element to enter
or change the value.

When you log in to the web interface as an administrator, for certain languages, the
translated text on the left navigation pane is truncated (not displayed completely).

Workaround: Hover over the menu item to view the tooltip, which displays the completely
translated text.

In the Google Cloud Platform instance of the Automation Co-Pilot on the web interface,
when you open a request that contains previously uploaded files, you might intermittently
experience an error while downloading the files.

Workaround: Retry downloading the file.

If a form has a table element and you use the Set action from the Interactive forms
package during bot runtime, values are not applied to the table element.

If you selected the action trigger as Changed value for a Dropdown element within a
trigger loop, any associated event is triggered during bot runtime even when there is a
Reset action.

In an SDS setup, when you create a request to upload a file, the upload fails and a
SecurityTokenInvalidException error message is displayed.

The Override output variable option in the End Process endpoint is not currently
functional for users to override a variable definition.
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Discovery Bot

What's new

View Groups of steps

When reviewing a process view, you can now use the group option or icon to display
groups of steps that belong to the primary level action and secondary level action (and
subgroup level actions) used during the recording session.

Use the group icon to help you decide what groups of steps to select for a task you want
to automate. For example, a primary level action displays Microsoft Outlook, a secondary
level action displays Outlook mail notification, and subgroup level actions display terms
such as Email -Add To, Email = Add Subject.

Create a process view with branches and opportunities

Use Dynamic option for system-generated views

You can now use the Dynamic option from the Model options to view recordings where
groups of steps display a set of repeating patterns that belong to the same application or
same primary level action used during the recording session.

Use this option to decide the context of the process or the task you want to automate.
Groups of steps that are labeled belong to supported applications such as Microsoft (Excel,
Outlook, and Notepad), Notepad++, text editors, most windows use cases, and Chrome
browser functionality.

Create a process view with branches and opportunities

Enhancements to PDD Word document

The PDD Word document now includes a process recording flow chart and the time on
each individual step in hours, minutes, and seconds.

Review opportunities and convert to

Fixes

Service Cloud case ID Description

-- The Control Room installer for Red Hat
Enterprise Linux (version 7.7 or 7.9) now
includes the Discovery Bot package.
Previously, you had to log in to the Control
Room as admin, select Manage > Package
> Upload, and upload the Discovery Bot
package.
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In a Linux environment, when you record a process using the Discovery Bot recorder,
the recorder window opens for 4 seconds and then disappears. The error occurs
because the ProcessDiscovery folder is missing in the following directory: /var/
automationanywhere/enterprise/appdata/Server Files/.

Workaround: Perform the following steps to create an empty ProcessDiscovery folder
manually and provide write access to the folder:

1. Navigate to the following path in the Control Room directory:

a) If you have updated from an earlier version to v.22, navigate to  /opt/
automationanywhere/enterprise/appdata/Server Files

b) If you perform a new installation of v.22, navigate to  /opt/
automationanywhere/automation360/appdata/Server Files

2. Runthe sudo mkdir ProcessDiscovery command to create an empty folder for
ProcessDiscovery in the specified Control Room directory.

3. Run the following command to provide the required read and write permission for the
newly created ProcessDiscovery folder:

a) sudo chown -R crkernel:controlroom ProcessDiscovery/

b) sudo chmod -R 775 ProcessDiscovery/

When you upgrade to A360 v.22, you might receive multiple email notifications about the
PDD generated in A360 v.21.

When you add branches to the left and right sides of the main branch, the Recording flow
chart section of the PDD might not capture the entire process work flow, including all the
branches.

IQ Bot

What's new

IQ Bot standard forms integration with 1Q Bot Extraction

You can now use the 1Q Bot Extraction package for data extraction from standard forms
documents.

Using IQ Bot Process documents action on page 2431

Confidence threshold applicable on standard forms learning instance

For a standard forms learning instance, if the Confidence threshold value that you have
set does not match any field, the document is moved to the Validator and a notification
icon is displayed. This update now enables you to validate the document for the learning
instance and also save the document.
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What's new

Additional OCR engines for |IQ Bot Extraction package

In addition to the existing OCR engines, IQ Bot Extraction package now supports the
following OCR engines:

e Microsoft Azure 2.0
*  Google Vision API

|Q Bot Extraction package on page 2423

Export IQ Bot dashboard data

A user with the AAE_IQ Bot Admin role can now export the following data from the
dashboard to a CSV file using the Export icon:

* Documents processed

* Pages uploaded

» Straight-Through Processing
* Accuracy

The CSV file is saved to the local Downloads folder.

IQ Bot support for self-signed certificates

You can create a self-signed certificate with Subject Alternative Name (SAN) to use an SSL
certificate for multiple domains.

Creating a self-signed certificate with Subject Alternative Name on page 1296

What's changed

IQ Bot package supports external proxy server settings (Service Cloud case ID: 00727414,
00725235, 00757568, 00753560, 00753560, 00786609)

The Download all documents and Upload Document actions in the IQ Bot package now
support external proxy server settings.

IQ Bot Python library upgrade (Service Cloud case ID: 00756943, 00791511)

IQ Bot now uses Python version 3.9.5 for data extraction.
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What's deprecated

IQ Bot [Local Device] package

The 1Q Bot 1Q Bot [Local Device] package is deprecated from this Automation 360 v.22
(Build 10526). Instead, use the IQ Bot Extraction package, which provides the same
capabilities as the 1Q Bot [Local Devicel package, along with additional improvements.

IQ Bot [Local Device] package replaced by |Q Bot Extraction package (A-People login
required)

Note: Before using the 1Q Bot Extraction package, update the bots associated with the IQ
Bot [Local Device] package and restructure the output folders.

IQ Bot Extraction package on page 2423

Fixes

Service Cloud case ID Description

- If you delete a . csv file from the Success folder, you can now
download the remaining files from that folder.

- When you use the 1Q Bot Extraction package for processing a
large set of documents, you no longer encounter any document
processing issues with Bot Agent.

- If an incorrect value was used in the providerVersion field
when you uploaded standard forms configurations to |Q Bot,
an error notification is now displayed when you select this
configuration when creating a standard forms learning instance.

00806805 You can now import a learning instance using the Migration Utility
feature as the Invalid Group error message is now resolved.

- When you creating a learning instance using standard forms,
all the available pre-trained models are now listed in the Select
Model drop-down menu.

00703856 |Q Bot now correctly extracts table rows with numeric values
even when they are within parenthesis.

- The File Download APl now returns a correctly formatted JSON
response with a colon (:) separating the key-value pairs.

00694656 |IQ Bot now successfully extracts values from the documents that
have new table fields added after training.

00636887 An error notification is now displayed if you upload documents
with file names longer than 150 Asian language characters in the
staging environment.

Note: This is not applicable to a production environment.

- |Q Bot cloud data query is now optimized to prevent overloading
of the Amazon Relational Database Service.
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Fixes

Service Cloud case ID Description

00782994 When you use the Migration Utility to move a learning instance
between environments, unclassified data is no longer exported.

00747137 You can now import learning instances using the Migration Utility
feature without any issues.

Limitations

The value displayed in the My totals > Accuracy field sometimes does not match the value
in the My learning instances > Field accuracy for the available learning instances.

If you try to import a learning instance into an 1Q Bot environment that has a deleted
learning instance with the same name, the following message is displayed even though the
learning instance is not imported: Import process initiated

If you access |Q Bot without the correct permissions, they are redirected to an Access
denied page, where the back button does not work.

Workaround: Close the current tab and open the Control Room.

When you select Other domain in the learning instance creation page, the tooltips for the
table and form fields state that these fields are optional. However, these fields are required
to create a learning instance.

IQ Bot installation sometimes fails and the following message is displayed: Failed to
upgrade the DB: -1.When this issue occurs, retry the installation.

(Service Cloud case ID: 01016516, 00757943, 00787404, 00788421, 00807528, 00822941,
01018972) If you add multiple ABBY OCR based commands (such as |IQ Bot Pre-processor,
IQ Bot Classifier, AlISense Recorder, OCR) in a single bot, an error message is displayed
when you run the bot.

Workaround: Ensure that you do not add multiple commands in a single bot.

(Service Cloud case ID: 01063054)You cannot import a learning instance with a long name
(>50 characters) because 1Q Bot only supports up to 50 characters in the Label field.

If you use the Process documents action from |1Q Bot Extraction package to upload
documents, the validation rules from the default the validation group that you set are not
applied. As a result, the failed documents are not classified into any of the existing groups
and are moved to Validator.

In the 1Q Bot Community Edition, when you use a Cloud OCR to create a learning
instance, if you use the |Q Bot Process document action from the 1Q Bot Extraction
package, the values from the uploaded invoices or documents are not processed
successfully.

Workaround: If you use the Cloud OCR to create a learning instance, use the 1Q Bot
Upload Document action from the |Q Bot package.
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Limitations

After you train a bot and click Save and go to next group, the system fails to load the next
group. Instead, it reloads the same group.

Workaround: Perform the following steps:
1. Refresh the page.

2. Navigate to Learning Instances and click Bots to edit the Learning Instances.

System identified regions are not generated when a non-English filename is uploaded using
the Invoice domain and processed with the AutoExtract command.

Workaround: To process the document, convert the non-English filename to English
characters.

Bot Insight

Fixes

Service Cloud case ID Description

00788583 In the Profile tab, when you edit, save and generate a
business dashboard and the dashboard is not saved, the error
message description is now translated correctly in the Chinese
language. Previously, if an error occurred when